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Welcome to atvise
This manual will familiarize you with setting up and working with atvise webMI and scada.

atvise offers two different product options: atvise webMI and scada. While the engineering tool and
the visualization features are the same for all two options,they differ in operational area as well as in
functional range. They are also in terms of engineering and how the resulting files are handled.
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How to use this help
Additional Documentation

Additional documentations, tips and useful examples can be found as a registered user in our 
knowledge base at http://support.atvise.com/.

In the atvise builder library you can right click each of our Object Displays and select "Help" to open
their specific documentation.

For each QuickDynamic a documentation can be opened by the button "Help" on the bottom right
corner:

Symbols used in this manual

The following are used in this help:

Symbolizes a warning or very important information.                                               
                                      

Symbolizes a hint.

http://support.atvise.com/
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Symbolizes a left mouse click

Symbolizes a mouse double-click

Symbolizes the clicking and holding of the left mouse button (dragging)

Symbolizes a right mouse click
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Before you start

Before starting your projects, please pay attention to the following information:

1. Please read the System Requirements below before proceeding with your projects!
2. Please check compatibility to older versions of atvise under Migration Information.
3. Information regarding external created SVG files.
4. Please read the Software License Agreement before proceeding with your projects!

1. System Requirements

Typical system requirements (depending on your project size):

atvise (scada, engineering)

Hard disk [MB] 128 (depends on project size/archiving)

Memory [MB] 128 (depends on project size)

Resolution [pixel] 800x600

CPU [type/MHz] Intel 500MHz (for small servers and projects)

CPU [type/MHz] Intel 1.6GHz (for standard servers and engineering)

Operating Systems Windows 7 (32 bit and 64 bit), Windows 8 (32 bit and 64 bit), Windows 10
(32 bit and 64 bit) and Windows Server 2012 R2 (64 bit)

When using aggregate functions:
Operating system: like atvise scada, but only 64 bit
CPU: at least 4 cores
RAM: at least 8GB, additional 1.5GB for each 1GB of source data (raw or aggregated data) to be
aggregated simultaneously

atvise pure web HMI-tested web browsers can be found on www.atvise.com under "System
Requirements".

If you have a virus scanner on your system, we strongly recommend to configure it to
exclude the files used by atvise! Failure to do so may lead to unexpected and hard to
diagnose errors.

2. Migration Information - short description

Information how to upgrade a project created with an atvise version 2.5.x can be found in the
document „Conversion Guideline.pdf“.

3. Information for SVG

SVGs which are created in external editors must not use CSS styles and also must not be saved as
editor specific formats (like e.g. Inkskape SVG, ... ).

http://www.atvise.com
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The display editor supports SVG Tiny 1.2 https://www.w3.org/TR/SVGTiny12/. CSS is not supported.

4. Software License Agreement

Please read the Software License Agreement regarding the usage, licensing and copyright of atvise®
and the third party software used in atvise®.

https://www.w3.org/TR/SVGTiny12/
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Installing & licensing

Installing atvise

If you have already installed atvise, you can move on to the second part -
"Getting an atvise webMI or scada license".                                 

Follow the instructions in the setup to install atvise. The setup will
automatically register the atvise server as a service ("atserver").

After the installation, setup will create an atvise monitor icon in the right corner of your task bar.

Getting an atvise webMI or scada license

1 Right-click on the atvise icon in the right corner of the task bar.

2 Choose "License" from the menu which appears.

3 Enter your atvise.com username and password in the "Online Activation" dialog which appears in
order to continue. Please note that Internet access is required. You can also go to 
www.atvise.com to view or download your recent licenses and statements.

Enter manually: Click on the bottom left button, "Enter manually". Copy your hardware code
from the dialog which appears, paste it on www.atvise.com and generate a license. Copy the
complete license code into the text field below.
If you have any problems or need more licenses, please contact info@certec.at. 

4 Choose your atvise webMI or scada license from the "Online Activation" dialog and generate it
by clicking "OK".

http://www.atvise.com
http://www.atvise.com
mailto:info@certec.at
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Enter atvise.com username and password
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Getting an atvise webMI license 
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Getting an atvise scada license 
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atvise scada CCD licensing

This section only has relevance when using atvise scada. 

Depending on your license type, you have a certain number of CCDs (concurrent connected data
variables) available for visualization: 

License Type Available CCDs

atvise scada micro 50

atvise scada small 150

atvise scada standard 1500

atvise scada unlimited unlimited

atvise scada trial licenses principally offer unlimited CCD usage.

Every different data variable that gets displayed in the visu will use one ccd.

CCDs are counted for every active browser session (if you connect to the visu from two browsers on
the same machine, both will count CCDs).

If a client wants to subscribe to new data variables while no more CCDs are available, a message
""CCD exceeded!"" will appear and there will be no communication with these data variables.

If a client disconnects from the visu (e.g. browser gets closed), it will take some time
until the browser session expires and the CCDs from this client become available
once again (session timeout of the scada server: 2 min.).

To check the number of currently-used CCDs, you can use the following internal data variables:

Open the node browser and go to Objects.AGENT.WEBACCESS. There you'll find 2 variables:

ccd_available Number of currently available CCDs (if 0 -> no more clients can connect to data
variables in the visu).

ccd_used Number of currently used CCDs.
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If you want to display this information in your visu, simple drag & drop these data
variables into one of your displays. Attention: These variable will also use CCDs!

Fixed client licensing

Fixed clients are excluded from the CCD counting, so a fixed client can always connect to an
unlimited number of data variables without using any CCDs.

The number of available fixed clients is usually defined in the last line of your license code (right-click
on atvise monitor -> license), e.g.: webaccess.fixedclients = 1. If there is no line containing
"webaccess.fixedclients", you have no fixed client available.

Some licenses include fixed clients per default. You can also purchase additional fixed clients for
your current license (for details please contact your local distribution partner or sales@certec.com).

Definition of the fixed client(s)

You can define the IPs of the fixed clients in the atserver.ini file:

The atserver.ini file is located directly in the atvise install directory. This file won't be
created automatically. If you haven't used it before, simply create a new text file
named "atserver.ini".

[webaccess]
fixedclients=[IP1],[IP2],...

e.g.:

[webaccess]
fixedclients=192.168.0.10,192.168.0.20

When defining your local host as a fixed client, please note:

- If defining "127.0.0.1" in the ini file, client sessions via http://localhost and
http://127.0.0.1 will run in fixed client mode, while sessions via http://[network IP] or
http://[network hostname] will use CCDs!

- If defining your network IP in the ini file, client sessions via http://[network IP] or
http://[network hostname] will run in fixed client mode, while sessions via http://
localhost and http://127.0.0.1 will use CCDs!
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First steps: atvise webMI tutorial
The main goal of this tutorial is to familiarize you with the engineering process of a web visualization
using atvise with a webMI license. In small steps and using specific examples, you will learn how
essential tools and interfaces work.

In the first step you will learn how to import data variables, how to draw a simple display and how to
generate and view the visualization.

After this we will take a look at the dynamization of elements, including the four ways of addressing
a data variable.
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1 Start atvise
1.1 Starting the atvise server

If atvise has been activated successfully, the server will start automatically (green icon in the
taskbar), otherwise follow these steps to start the server manually:

1 Right-click on the atvise icon in the right corner of the task bar.

2 Choose "Project Console" from the menu which appears.

3 Start the server by clicking the button shown in the picture below.

The icon in the task bar will change its background color to yellow when the server is booting.
When the server has started, it will turn to green.
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Starting the atvise server

The atvise server is up if the icon in the task bar is green  ("atserver" service is
running). Otherwise, you won't be able to connect to the server. If the server doesn't
come up after starting it, check out the "atserver_std.log" file in your atvise installation
directory for potential error messages.

The atvise server uses the standard OPC UA port 4840 to communicate with atvise
builder. If you encounter any problems with starting the atvise server, please make sure
that no other application uses this port.
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1.2 Starting atvise builder

1 Right-click on the atvise icon in the right corner of the task bar.
Open the "Project Console" and click on "Builder" to open the atvise builder.

You can also choose "Programs -> atvise -> atvise builder" from your Windows start
menu.

Starting atvise builder
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Please note: if you started the atvise builder from the project console as described
above and don't want to connect to another server, please move on to section 2 and
skip section 1.5.

1.3 Connecting to a server

After starting the atvise builder from the task bar, you will automatically be connected to the OPC UA
module of the atvise server on your local machine.

If you start the atvise builder via the Windows start menu or if you want to connect to another server,
you can do so by following these steps:

1 Choose "builder -> Connect to server" from the menu bar.

2 A dialog will appear in which you must enter the address of the server to which you want to
connect (opc.tcp://[host]:[port]). The default is your local host and the default OPC UA port
("opc.tcp://localhost").

You could also enter the address of another server instance, for example, the IP address
of a machine in your local network.

3 Apply the dialog by pressing the "OK" button to connect your atvise builder to the server.

Connect to server on localhost

If you want to connect to another server, you first have to disconnect the current
session by choosing
"builder -> Disconnect from server" from the menu bar.
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After that, choose "builder -> Connect to server" again and connect to the new server
the same way as described before.

You can see the currently-selected server address at the top left of the atvise builder
interface.                            
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2 Add server and import data variables
2.1 Adding and configuring a demo server to the project 

In the first step, we will add a "webMI DEMO Webserver" to the project. To do so, we will use the
"Guided Actions" located in the menu bar.

1 Choose "Guided Actions -> Add atvise webMI DEMO Webserver" from the menu bar. 

2 Choose a project directory for the demo server.

3 Now you can choose a layout and size for your default display.

The webMI DEMO Webserver will start in a console window. The server uses port 81 to
deliver the webMI visualization.

You  could also start the DemoServer after adding it to the project by choosing             
                                  
"Guided Actions -> Start atvise webMI DEMO Webserver"

4 Confirm the dialog which appears by clicking "Yes" to start the demo web server (if you haven't
started it yet).

5 Now the "DemoServer" appears in the server list at the upper left side of the atvise builder
interface

Adding an atvise webMI DEMO Webserver to the project

The DemoServer appears in the server list

2.2 Importing data variables
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In this step, we will import the data variables that are integrated in the "DemoServer" (the
corresponding data structure is defined in the variables.xml file located in the [atvise_folder]/webmi
folder).

1 Choose "Guided Actions -> Import all variables from -> DemoServer" from the menu bar. 

2 Confirm the dialog which appears by clicking "Yes". Now the data variables will be imported into
the atvise builder's object structure.

3 A window will appear, informing you that all variables were imported successfully. Apply the
dialog by clicking "OK".

Import the data structure of the DemoServer (defined in the variables.xml file)
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3 Draw a display and generate visualization
In this section, we will add a simple display to our project and generate the web visualization
afterwards.

3.1 Adding a new display to the project

1 Right-click on the "Servers -> DemoServer -> DISPLAYS -> MAIN" folder.

2 Choose "Add Display...".

3 Now you can enter the desired display name. For our example, let us choose "TestDisplay1".

4 After acknowledging the display name by clicking "OK", you will see an entry for the new
display if you open the structure of the MAIN folder.                           

Adding a new display to the project

3.2 Editing the display and drawing simple elements

1 Double-click the new "TestDisplay1" entry to open the included graphics editor for this display.

This editor offers you many powerful tools to design the optimal display for your project.
For detailed information see the atvise help .

For our example, we will simply add a rectangle and a circle to the display.

393
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2 Click on the  symbol to select the rectangle drawing tool.

3 Click somewhere in the drawing area, press down the left mouse button, move the mouse till the
rectangle has reached the desired size, and release the button.

4 Click on the  symbol to select the circle drawing tool.

5 Draw the circle the same way as described in step 3.

6 Click the  symbol after you have finished the drawing interactions to save the display.

Drawing simple elements and saving the display

3.3 Generating a web visualization

1 Choose "Guided Actions -> Distribute to Webserver -> Demoserver" from the menu bar.

2 The visualization files will be generated and saved to the "Data Root Target" (configured in the
server settings) after the process has finished.
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Generating a visualization

Another way to generate the visualization is by right-clicking on "DemoServer" and
choosing "Distribute".
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4 The visualization
In this section, we will take a look at the output of the engineering process in the atvise builder - the
visualization.

4.1 Navigation - viewing the new display

1 Choose "Guided Actions -> Open Web Browser For Server -> DemoServer" from the menu bar.

2 This will open your standard browser with the URL of the "DemoServer".

3

Choose "TestDisplay1" from the main menu   to view the display you have drawn in
section 3.

Open the visualization

Viewing the new display in a web browser

You could also open the visualization of the DemoServer manually by entering
"http://127.0.0.1:81/" in the address bar of any browser you'd like to use.
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If you encounter any problems with viewing the visualization, please clear your browser
cache and reload the page (especially if you have used previous atvise versions before).

4.2 Zooming

After you have opened a display, you can try using the zooming functionality. To do this, use the 

,  and  buttons in the middle of the control panel. To show the display in its

original size, click on the  button.

Try out the zooming feature to become familiar with it. For example, you could try to zoom into the
circle using area zooming.

Using the zooming functionality
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5 Parameterization option 1 - direct
addressing

In the following sections, we will add the first dynamics to our project using direct addressing.

Use this type of parameterization to display and set individual data variables in your
structure that do not belong to any kind of object type.

There are 3 ways to create dynamics using direct addressing:
using predefined controls
using "Quick Dynamics"
using "Simple Dynamics"

In the following sections, you will learn how each of these methods work and how you can use them
to create dynamic elements.
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5.1. Using predefined controls
In this section we will take a look at how to use predefined controls to create dynamic elements.

5.1.1. Bar control

1 Create and open a display "TestDisplay2"  as described in section 3.1.

2 In the bottom area of the graphics editor you can see a selection of predefined controls.
Drag & drop the "Bar vertical" control into your drawing area.

3 On the right side, you can see a list of all parameters of the referenced control.
Select the "VariableNumber" data variable from the DemoServer as the base address for this

control by using the  selector.

4 The control is now fully operative; you can also change the other parameters if you want to.
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Adding a bar control

5.1.2. Increment control

1 Drag & drop a "Button Increment/Decrement" control into your drawing area.

2 Select the "VariableNumber" data variable as the base address for this control by using the 
selector.

3 Enter "10" as the step. Now the value of the base will be increased by 10 every time you click on
the button.
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Adding an increment control

You can also change other parameters if you want to. Mandatory parameters are
highlighted in red, all other parameters are optional. For example, to adjust the font
size of the control, change the value of the parameter "Font -> size". 

5.1.3. Decrement control

1 Copy & paste the increment control.

2 Choose -10 instead of 10 for the "step" parameter.
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Adding a decrement control

5.1.4. Opening the browser and testing the controls

Save the display by clicking  and generate the visualization by choosing "Guided Actions ->
Distribute to Webserver -> DemoServer". Then start the web browser and open "TestDisplay2" (as
described in section 4) to view the predefined controls you have created in this section. Try setting
the value of "VariableNumber" by using your increment and decrement buttons. Now the bar should
change according to the value of "VariableNumber".
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5.2 Using quick dynamics
In this section, we will take a look at how to use quick dynamics to add dynamization to your own
graphic elements.

5.2.1. Textual display of a data variable

1 Add a new text element to your display. To do so, choose the "Add Text" symbol in the symbol
bar and click somewhere in the drawing area. Type in some random characters to get a preview
of how the text will look in the visualization.

2 Mark the text element and choose "Quick Dynamics -> Set Text" from the symbol bar.

3 Select the "VariableNumber" data variable for the "Node from which value will be taken" property

by using the  selector. 

4 Apply the dialog by clicking on "OK".

Create a dynamic text using quick dynamics

Afterwards, you will see an entry for this quick dynamization in the dynamics list of
this text element located on the lower right side of the atvise builder interface. To
edit or view an existing quick dynamic, simply double-click on the entry.
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5.2.2. Drawing a simple button to set the VariableNumber
variable to 100

1 Click on the "Add polygon" symbol to select the polygon drawing tool. We want to use this tool
to draw a triangle.

2 Click somewhere in the drawing area, then move the mouse to draw the first side of the triangle.
Click again and move the mouse to draw the two remaining sides. Finish the drawing by double-
clicking.

3 Give the triangle a button-like look by choosing one of the design templates. Make sure the
triangle is marked, then click on "Templates" and choose one of the templates in the menu
which appears.
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Drawing a triangular button

5.2.3. Dynamizing the button to set the VariableNumber
variable to 100

1 Make sure the triangular button is marked, then chose "Quick Dynamics -> Set Node" from the
symbol bar.

2 Select the "VariableNumber" data variable for the "Node to be set" property using the 
selector.

3 Type in "100" as value. Now the "VariableNumber" variable will be set to 100 if you click on this
element in the visualization.
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Dynamize your own element to set the value of VariableNumber to 100

5.2.4. A simple button to set the VariableNumber variable
to 0

1
Create and dynamize a second triangle the same way as described in the last two sections, but
now enter "0" as the value instead of 100.
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Create a second element that sets the value of VariableNumber to 0

5.2.5. Opening the browser and testing the controls

Save the display by clicking  and generate the visualization by choosing "Guided Actions ->
Distribute to Webserver -> DemoServer". Then start the web browser and open "TestDisplay2" to
view the quick dynamics you have created. Try setting the value of "VariableNumber" using your
triangular buttons. You will see the results by looking at the dynamized text element and the bar.
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5.3 Using the simple dynamics dialog
In this section we will take a look at how to create your own individual dynamics using the simple
dynamics dialog.

5.3.1. Adding a text element, editing it and starting the
simple dynamics dialog for it

First, we will directly display the value of a data variable in the visualization using simple dynamics.

1 Open "TestDisplay1" in the graphics editor as described in section 3.2.

2 Add a text element to the display. Click on the "Add Text" symbol to do so.  

3 Click somewhere in the drawing area and type in some random characters to get a preview of
how the text will look in the visualization.

4 Make sure that the text element is marked. Change the text size to 72 in the style area on the
middle right side of the atvise builder interface.

5 Right-click -> "add" in the dynamics area on the bottom right of the atvise builder interface. The
"Simple Dynamics" dialog will appear on your screen.

There are 3 ways in total to open the "Simple Dynamics" dialog. Each of them will open
the very same dialog, so it's your choice:
-> You can right-click on the dynamics area as described above.
-> You also can double-click on the whitespace in the dynamics area.
-> The third way to use simple dynamics is by right-clicking on the element to which you
want to add a          
     dynamization and choosing "Add dynamics".
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Adding a new text element and starting the "Simple Dynamics" dialog

5.3.2. The "Simple Dynamics" dialog

The "Simple Dynamics" dialog offers you a very powerful way to create individual dynamics with
minimal effort.

You can create many different types of dynamics in four steps:

In this step you can check a user right which is then necessary to
activate the dynamization. We don't need this for our current
example.

In this step you can decide which event activates the dynamization.
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1 In our case we want to react to the change of a data variable,

so we choose  from the possibilities on the left
side.

2 Now we have to specify this data variable. Click on the 
symbol and choose "VariableString" from the list which
appears.

In this step, you can change the result of the event. We don't need
this for our current example.

In this step, you can define the action that will be executed when
the event is triggered. For our example we will define the way the
result is displayed in the visualization.

3 We want to display the value of the data variable directly, so

we choose  from the possibilities on the left
side. 

4 Check   .

5 Now that all the necessary information is entered, we can
apply the dialog by clicking "OK".
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Adding dynamization to the text element using simple dynamics

Afterwards, you will see an entry for this dynamization in the dynamics list of this text
element. To edit or view an existing dynamization, you can open the "Simple
Dynamics" dialog for this entry by double-clicking on it.

5.3.3. Adding an input element to set VariableString

In order to change the value of VariableString, we have to add an input element.
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1 Open the "Servers -> DemoServer -> Objects" folder in the structure on the left side of the atvise
builder interface.

2 Drag & drop the "VariableString" data variable into the drawing area of "TestDisplay1".

3 An "In/Out Value" control which is assigned to "VariableString" will appear. You can use this
control to set the value of "VariableString" in the visualization. 

Adding an "In/Out Value" control to set "VariableString"

5.3.4. Activating and viewing the dynamization

Now we want to view our dynamization in the visualization.

1 Save the display and generate the visualization by choosing "Guided Actions -> Distribute to
Webserver -> DemoServer".

2 Open "TestDisplay1" in the browser of your choice (as described in section 4.1).

3 Change the value of "VariableString" several times. To do so, click on the "In/Out Value" control
and enter several texts, for example "I am dynamic".

4 In the visualization, you will see that the random characters of the text element are replaced by
the current value of the data variable "VariableString".
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Change the value of "VariableString" and see how it is displayed in the dynamic text element.

5.3.5. Adding simple dynamics to change the color of an
element

In this section, we want to change a graphic attribute of one of our elements in dependence on a
data variable. Let's say we choose the circle in our "TestDisplay1" and we want its color to depend
on the value of our "VariableBoolean" data variable. If the value is true, we want to fill the circle with
green, if the value is false, we want to fill it with red.

1 In the first step, we have to mark the element to which we want to add a dynamization. Go back
to the graphics editor, click on the circle to mark it and start the "Simple Dynamics" dialog by

right-clicking -> 

2 The event we want to react to is a change of "VariableBoolean", so we choose this variable as
described in section 5.3.2 .

3 Now that we have an event to react to, we must define the action that is to be executed. We

want to change the color of our circle, so we choose  from the possibilities on the
left side.

4 We want to react to discrete values, so we choose  from the type selection list.

5 If the value is true, we want to fill the circle with green, so we choose a green color for this

condition by clicking  at the right side of the condition list.

6
Furthermore, we will add a second condition by clicking on . 

7 We change the "Value" column of the new condition to "false" and select a red color by clicking

on  .

8 Now that all the necessary information is typed in, we can apply the dialog by clicking "OK".
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"Change Color" dialog

5.3.6. Adding a control to change the state of
VariableBoolean

In order to change the state of "VariableBoolean", we have to add a new control.

1 Open the "Servers -> DemoServer -> Objects" folder in the structure on the left side of the atvise
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builder interface.

2 Drag & drop the "VariableBoolean" data variable into the drawing area of "TestDisplay1".

3 A switch control which is assigned to "VariableBoolean" will appear. You can use this control to
change the state of "VariableBoolean" in the visualization. 

Adding a control to change the state of "VariableBoolean"

5.3.7. Activate and view the dynamization

1 Save the display and generate the visualization by choosing "Guided Actions -> Distribute to
Webserver -> DemoServer".

2 Open "TestDisplay1" in the visualization. If you have already opened this display, please reload
it.

3 You will see that the color of the circle now shows the state of the "VariableBoolean" variable.

4 Change the value of "VariableBoolean" several times by clicking on the switch control and look
at how the color of the circle changes.
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Change the state of "VariableBoolean" and see how the color of the circle changes.
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6 Parameterization option 2a - object
oriented

In this section we will start with object-oriented engineering. We will create a dynamic object display
for the light objects (L001, L002) in our object structure using a display parameter for every required
data variable. But first, we will add a background display.

Use this type of parameterization to create an object display for single data variables or
for multiple data variables that belong to an object type logically but do not have a clear
object structure.

6.1 Adding a new background display

In the first step we will add a background display to the main menu.

1 Create a new display "Light_Background" by right-clicking on the
"DemoServer -> Displays -> MAIN" folder and choosing "Add Display".

2 Double-click on the "Light_Background" entry to open it.

3 Click on "File ->  Open file" in the symbol bar and in "[atvise directory]/library/displays",
choose the file named "office_light_bg.svg". This file shows a floor plan of an office and will act
as the background image.

4 Save the display.

Adding a background display

6.2 Adding a new object display
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In the following sections we will create our own display object which will be used to set and display
the value of data variables.

1 Right-click on "Library -> PROJECT -> Object Displays" and choose the "Add Folder".

2 Name the folder "MyObjectDisplays" and add it by clicking "OK".

3 Right-click on the new "MyObjectDisplays" folder and choose "Add Display".

4 Type in "Office_Light1" as name for the display and add it to the project by clicking "OK".

Add "MyObjectDisplays" folder



56 atvise® - documentation

© 2018 Certec EDV GmbH

Add a new display to the folder

6.3 Designing an object display

6.3.1 Creating a background

1 Double-click on the "Office_Light1" node to open the graphics editor.

2 First, we draw the background of our object display. Draw a rectangle of the desired size - it is
possible to change its size afterwards.

3 For our background we want to have a gradient fill, so make sure the rectangle is marked and
click on the "fill" option just below the drawing area. In the window which appears, click on the 

 symbol to choose a gradient fill.

4 You can change the colors of the gradient by double-clicking on the small triangles under the
gradient bar.

5 Change the angle of the gradient by moving the red circles in the preview box. Define a matching
gradient.

6
When you have finished the background design, click on "File ->  Settings" in the top symbol
bar.

7 Click on the "Fit" button in the dialog which appears to adjust the page size to the size of the
background rectangle.
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Creating a background for "Office_Light1"

6.3.2 Drawing a bulb

We want to display our "LightIntensity" data variable through the color of a light bulb.

1 Draw a small rectangle in the middle left side of the object display. Use the rectangle drawing
tool as described in section 3.2.

2 Draw a circle on top of the rectangle to make it look like a bulb. Use the circle drawing tool as
described in section 3.2.
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Try to draw a form that looks like a bulb

6.3.3 Drawing a red border to display a malfunction

A red border is intended to signalize an internal malfunction.

1 Draw a rectangle around the object display.

2 Select "None" in the "Fill" tab.

3 Choose a bigger line width and a red color in the "Stroke" tab.
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Draw a red border around the object

6.3.4 Creating display parameters

In this step we will define parameters for every data variable we want to use in this display.

1 Choose "File -> Parameters" from the symbol bar.

2 Type in the names of the two data variables of the light object. For our example, let us choose
"LightIntensity" and "InternalMalfunction".

3 Type in a description for the two parameters.

4 Select "mandatory" in the "Behavior" column for both parameters.

5 Apply the "Edit Parameters" dialog by clicking "OK"
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Adding parameters to the display

6.4 Adding dynamization

In this section we want to use predefined controls and simple dynamics to add dynamization to our
object display.

6.4.1 Adding and parameterizing three buttons

We want to set the value of LightIntensity, so we are going to add three buttons for zero, fifty and one
hundred percent light intensity to our display.

1 In the bottom area of the graphics editor you can see a selection of predefined controls.
Drag & drop the "Button Set Address" control into your drawing area.

2 On the right side, you can see a list of all parameters of the referenced control.
Set the text of the button by entering "0" in  the "label" field.

3 To set its "base" parameter, click the  button to activate relative addressing.

4 Use the drop-down list to choose "LightIntensity".

5 Set the "value" parameter by entering "0". This value will be set to the base address when
clicking the button.

6 Add a button with the label "50"  and value "50" the same way.

7 Add a button with the label "100"  and value "100" the same way.
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Adding and parameterizing three buttons to set "LightIntensity"

6.4.2 Color change of the light bulb to display the light
intensity

In this section, we want to add a simple dynamic to our bulb to display the light intensity.

1 Click on the circle of the bulb to mark it and open the "Simple Dynamics" dialog as described in
section 5.3.1

If you have worked through section 5.3, you are already familiar with this dialog. The only
new thing is that we want to address our data variable relatively.

2
Choose  from the possibilities on the left.

3 Click on the relative button  to activate relative addressing.

4 Use the drop-down list to choose "LightIntensity".

5 Choose "Number" as the value type.
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6
We want to change the color of the circle, so we choose  on the left in the ACTION
section.

7 The range of our "LightIntensity" variable is from 0 - 100, so we choose "Value Range" as the
type and enter the minimum and maximum values.

8 We want to display the circle in a color range from gray to yellow, so we check the fill box and

choose a gray color as the start fill and a yellow color as the stop fill by clicking on .

If the value of the data variable is 0, the start fill will be displayed, if it is 100, the stop fill
will be displayed. Values in between are merged according to the gradient from the start
fill to the stop fill.

We are now finished with the dynamization. Apply the dialog by clicking "OK".
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"Simple Dynamics" dialog for the circle of our light bulb

6.4.3 The visibility of the malfunction border

In this step, we want to change the visibility of our red border in dependence on the value of the
"InternalMalfunction" parameter.
If the value is true, we want the border to be visible, if the value is false, we want the border to be
invisible.

1 Mark the red border you drew in step 6.3.3 and start the "Simple Dynamics" dialog.
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2
Choose  from the possibilities on the left.

3 We want to write a relative parameter, so click the  button.

4 Use the drop down list to choose "InternalMalfunction".

5 Choose "Boolean" as the value type.

6
We want to change the visibility of the border, so choose  in the ACTION part.

7 If the value is true, we want the border to be visible, so choose "visible" for this condition.

8
Add a second condition by clicking on , changing the value column to "false" and
choosing "invisible".

9  Apply the "Simple Dynamics" dialog by clicking "OK".
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Changing the visibility of the border in dependence on a boolean value

Now we have finished the engineering of our object display.

6.5 Adding objects to a main display

1 Open the "Light_Background" display from the MAIN folder.

2 Drag & drop the "Office_Light1" object display into the "Light_Background" display.

3 Make sure the "Office_Light1" object is marked. On the right of the atvise builder interface, you
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will see a list of all its parameters.

4 Select the "L001.LightIntensity" variable as the address for the light intensity parameter and
the "L001.InternalMalfunction" as the address for the internal malfunction parameter using the 

 selector.

5 Drag & drop the "Objects -> L001 -> InternalMalfunction" variable into the "Light_Background"
display. A small button will appear which can be used to set the variable in the visualization. 

6 Repeat 2 to 5, but now choose "L002.LightIntensity" and "L002.InternalMalfunction" as
parameters and drag & drop "Objects -> L002 -> InternalMalfunction"  into the
"Light_Background.

7 Position the 2 displays in 2 different rooms of the office plan.

Drag & Drop the "Office_Light1" display into the "Light_Background" display and set the parameters

6.6 Generating and viewing the visualization

Save the display by clicking  and generate the visualization by choosing "Guided Actions ->
Distribute to Webserver -> DemoServer" from the menu bar. Then start a web browser (as described
in section 4) and view the "Light_Background" display in the visualization. Set the value of the light
intensity of one of the objects using the three buttons and see how the color of the bulb changes.
Also use the InternalMalfunction buttons to make the red border appear and disappear.
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7 Parameterization option 2b - object
oriented

In this section we will take a look at another way of object-oriented engineering in the atvise builder.
We will create a dynamic object display for the light objects (L001,L002) in our structure as
described in the previous section, but this time we will only create one display parameter for the
object's base address. All data variables of the object will be addressed relatively to this base
address.

Use this type of parameterization if you use multiple data variables in your object
display that belong to an object type and have a clear object structure.

7.1 Adding a new object display

In the first step, we will add a new display named "Office_Light2" to the project.

1 Right-click on the "Library -> PROJECT -> Object Displays -> MyObjectDisplays" folder which
we've created in section 6.2 and choose "Add Display".

2 Type in "Office_Light2" as name for the display and add it to the project by clicking "OK".
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Adding a second display to the MyDisplayObjects folder

7.2 Designing an object display

Open the "Office_Light2" display in the graphics editor.

Design an object display similar to section 6.3. You can also copy the elements from the display
you have drawn in section 6.3 and remove the dynamizations afterwards.

The following steps illustrate how to remove the dynamizations from the copied elements:

1 Click on the circle to mark it.

2 Right-click on the color change entry in the dynamization area located at the lower right side of
the atvise builder interface.

3 Choose the "Delete" option from the menu which appears.

4 Remove the dynamization of the red border the same way.

5 Mark one of the three buttons by clicking on it. Delete the value of the "base" parameter in the
"Attributes" area located at the middle right side of the atvise builder interface. 

6 Delete the values of the base parameters of the remaining two buttons the same way.

Deleting dynamics
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Deleting the value of the "base" parameter

7.3 Creating display parameters

In this step we will define a parameter for the object's base address.

1 Choose "File -> Parameters" from the symbol bar.

2 Type in "mybase" as the name for the object base parameter.

3 Type in a description for the parameter.

4 Select "mandatory" in the "Behavior" column.

5 Apply the edit parameters dialog by clicking "OK".

6 Save the display.
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Adding a parameter for the object's base address to the display

7.4 Adding dynamization

In this section we want to use predefined controls and simple dynamics to add dynamization to our
object display.

7.4.1 Parameterizing the three buttons

We want to set the value of LightIntensity, so we have to parameterize the three buttons for zero, fifty
and one hundred percent light intensity.

1 Mark one of the three buttons by clicking on it.

2
On the right side, you can see a list of all parameters of the referenced control.
Set the text of the button by entering "0" in  the "label" field.

3 To set its "base" parameter, click the  button to activate relative addressing.

4 Use the drop-down list to choose "mybase".

5 Enter ".LightIntensity" into the address field manually as the relative part. (Don't forget the ".")

6
Set the "value" parameter by entering "0". This value will be set to the base when the button is
clicked.                 

7 Parameterize a button with the label "50" and value "50" the same way.

8 Parameterize a button with the label "100" and value "100" the same way.
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Parameterizing the three buttons

7.4.2 Color change of the light bulb to display the light
intensity

In this section, we want to add a simple dynamic to our bulb to display the light intensity.

1 Click on the circle of the bulb to mark it and open the "Simple Dynamics" dialog as described in
section 5.3.1

The simple dynamics in this section will be similar to section 6.5. The only new thing is
that we will address our data variables relatively with reference to the object's base
address.

2
Choose  from the possibilities on the left.

3 Click on the relative button  to activate relative addressing.

4 Use the drop-down list to choose "mybase".

5 Enter ".LightIntensity" into the address field manually (Don't forget the ".").
 ".LightIntensity" is the relative part which is found in all base objects. 

6 Choose "Number" as the value type.

7
We want to change the color of the circle, so we choose  to the left in the ACTION
part.

8 The range of our "LightIntensity" variable is from 0 - 100 so we choose "Value Range" as the
type and then type in the minimum and maximum value.

9 We want to display the circle in a color range from gray to yellow, so we check the fill box and

choose a gray color as the start fill and a yellow color as the stop fill by clicking on .
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If the value of the data variable is 0, the start fill will be displayed, if it is 100, the stop
fill will be displayed. Values in between are merged according to the gradient from the
start fill to the stop fill.

We are now finished with the dynamization. Apply the dialog by clicking "OK".

"Simple Dynamics" dialog for the circle of our light bulb

7.4.3 The visibility of the malfunction border
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1 Mark the red border and start the "Simple Dynamics" dialog.

2
Choose  from the possibilities on the left.

3 We want to add a relative address, so click the  button.

4 Use the drop-down list to choose "mybase".

5 Enter ".InternalMalfunction" into the address field manually as relative part (Don't forget the ".").

6 Choose "Boolean" as the value type.

7
We want to change the visibility of the border, so choose  in the ACTION part.

8 If the value is true, we want the border to be visible, so choose "visible" for this condition.

Add a second condition by clicking on , changing the value column to "false" and
choosing "invisible".

9  Apply the "Simple Dynamics" dialog by clicking "OK".



75First steps: atvise webMI tutorial

© 2018 Certec EDV GmbH

 
Changing the visibility of the border in dependence on a VariableBoolean

Now we have finished the engineering of our object display.

7.5 Adding objects to Light_Background

1 Open the "Light_Background" display (which we added in step 6.1).

2 Drag & drop the "Office_Light2" object display into the "Light_Background" display.

3 Make sure the "Office_Light2" object is marked. On the right of the atvise builder interface, you
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will see a list of all its parameters.

4 Select "L001" as the address for the "base address of the object" parameter using the 
selector.

5 Drag & drop the "Objects -> L001 -> InternalMalfunction" variable into the "Light_Background"
display. A small button will appear which can be used to set the variable in the visualization. 

6 Repeat 2 to 5, but now choose "L002" as the "base address of the object" and drag & drop 
"Objects -> L002 -> InternalMalfunction" into the display .

7 Position the 2 displays in 2 different rooms of the office plan.

Dragging & dropping the "Office_Light2" display into the "Light_Background" display and setting the base

parameter

7.6 Generating and viewing the visualization

Save the display by clicking  and generate the visualization by choosing "Guided Actions ->
Distribute to Webserver -> DemoServer". Then start a web browser (as described in section 4) and
view the "Light_Background" display in the visualization. Set the value of the light intensity of one of
the objects using the three buttons and see how the color of the bulb changes. Also use the
InternalMalfunction buttons to make the red border appear and disappear.
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8 Parameterization option 3 - display at the
object type

In this section you will learn how to add a display to an object type, how to dynamize it using relative
addressing and how to add displays of object instances to the visualization.

Use this type of parameterization to create object displays for object types you have
defined in the import XML file.

8.1 Adding a new display to the object type

The first step is to add a new display to the object type.

1 Open the "Servers -> DemoServer -> OBJECTS" folder and right click on the "L001" object.        
                

2 Choose "Add Display to corresponding type..." from the menu which appears.

3 Type in "MainDisplay" as name for the display and add it to the object by clicking "OK".

Add a display to the object

8.2 Designing an object display
Design the "MainDisplay" similar to section 6.3. You can also copy the elements from the display
you have drawn in section 6.3 and remove the dynamics afterwards as described in section 7.2.
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Designing an object display

8.3 Adding dynamization

In this section we want to use predefined controls and simple dynamics to add dynamization to our
object display.

8.3.1 Parameterizing the three buttons

We want to set the value of LightIntensity, so we have to parameterize the three buttons for zero, fifty
and one hundred percent light intensity.

1 Click on one of the three buttons to mark it.

2 On the right side, you can see a list of all parameters of the button.
Set the text of the button by entering "0" in  the "label" field.

3 To set its "base" parameter, click the  button to activate relative addressing, then the 
button to open the node select dialog.

4 In the left box you can select the object type for the relative addressing, so click
on "Variable Types -> OfficeLight".

5 In the right box you can select the variable whose change you want to react to, so select
"LightIntensity". Apply the dialog by clicking "OK".

6 Set the "value" parameter by entering "0". This value will be set to the base address when
clicking the button.

7 Parameterize a button with the label "50" and value "50" the same way.

8 Parameterize a button with the label "100" and value "100" the same way.
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Parameterizing the three buttons using relative addressing

8.3.2 Color change of the light bulb to display the light
intensity

In this section, we want to add a simple dynamic to our bulb to display the light intensity.

1 Click on the circle of the bulb to mark it and open the "Simple Dynamics" dialog as described in
section 5.3.1.

The simple dynamics in this section will be similar to section 7.4., but this time the
object display is located directly in the object type, so we can use the default base
parameter for the object's base address.

2
Choose  from the possibilities on the left.

3 Click on the relative button  to activate relative addressing.

4 Open the "node select dialog" by clicking on  .

5 In the left box you can select the object type for the relative addressing, so click
on "Variable Types -> OfficeLight".

6 In the right box you can select the variable whose change you want to react to, so select
"LightIntensity". Apply the dialog by clicking "OK".

7
We want to change the color of the circle, so we choose  on the left in the ACTION
section.

8 The range of our "LightIntensity" variable goes from 0 - 100, so we choose "Value Range" as the
type and enter the minimum and maximum values.

9 We want to display the circle in a color range from gray to yellow, so we check the fill box and

choose a gray color as the start fill and a yellow color as the stop fill by clicking on .

We are now finished with the dynamization. Apply the dialog by clicking "OK".
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"Simple Dynamics" dialog for the circle of our light bulb

8.3.3 The visibility of the malfunction border

1  Mark the red border and open the "Simple Dynamics" dialog as described in section 5.3.1.

2
Choose  from the possibilities on the left.

3 We want to add a relative address, so click the  button.

4 Open the "node select dialog" by clicking on  .
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5 In the left box you can select the object type for the relative addressing, so click
on "Variable Types -> OfficeLight".

6 In the right box you can select the variable whose change you want to react to, so select
"InternalMalfunction". Apply the dialog by clicking "OK".

7
We want to change the visibility of the border, so choose  in the ACTION part.

8 If the value is true, we want the border to be visible, so choose "visible" for this condition.

Add a second condition by clicking on , changing the value column to "false" and
choosing "invisible".  

9  Apply the "Simple Dynamics" dialog by clicking "OK".
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Changing the visibility of the border in dependence on a boolean value

Now we have finished the engineering of our object display.

8.4 Adding objects to Light_Background

1 Open the "Light_Background" display (which we added in step 6.1).

2 Drag & drop the objects L001 and L002 from the DemoServer into the "Light_Background"
display.
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3 Drag & drop the "Objects -> L001 -> InternalMalfunction" variable into the "Light_Background"
display. A small button will appear which can be used to set the variable in the visualization. 

4 Repeat 3 , but now drag & drop "Objects -> L002 -> InternalMalfunction" into the display .

5 Position the two object displays in rooms of your choice.

Dragging & dropping the OfficeLight objects into the display

8.5 Generating and viewing the visualization

Save the display by clicking  and generate the visualization by choosing "Guided Actions ->
Distribute to Webserver -> DemoServer". Then start a web browser (as described in section 4) and
view the "Light_Background" display in the visualization. Set the value of the light intensity of one of
the objects using the three buttons and see how the color of the bulb changes. Also use the
InternalMalfunction buttons to make the red border appear and disappear.



First steps: atvise scada
tutorial

Part VI
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First steps: atvise scada tutorial
The main goal of this tutorial is to familiarize you with the engineering process of a web visualization
using atvise with a scada license. In small steps and using specific examples, you will learn how
essential tools and interfaces work.

In the first step you will learn how to import data variables, how to draw a simple display and how to
generate and view the visualization.

After this we will take a look at the dynamization of elements, including the four ways of addressing
a data variable.
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1 Starting atvise
Starting the atvise server

If atvise has been activated successfully, the server will start automatically (green icon in the
taskbar), otherwise follow these steps to start the server manually.

1 Right-click on the atvise icon in the right corner of the task bar.

2 Choose "Project Console" from the menu which appears.

3 Start the server by clicking the button shown in the picture below.

The icon in the task bar will change its background color to yellow when the server is booting.
When the server has started, it will turn to green.
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Starting the atvise server

The atvise server is up if the icon in the task bar is green  ("atserver" service is
running). Otherwise, you won't be able to connect to the server. If the server doesn't
come up after starting it, check out the "atserver_std.log" file in your atvise installation
directory for potential error messages.

The atvise server uses the standard OPC UA port 4840 to communicate with atvise
builder. If you encounter any problems with starting the atvise server, please make
sure that no other application uses this port.
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You can stop the atvise server by choosing "Stop Server" from the same menu or by
stopping the "atserver" service.
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2 Start and connect atvise builder
The atvise builder is the engineering tool for atvise projects. It allows you to manage data variables,
objects, users & groups, displays and many other essential things for your project. One of the main
features is the powerful atvise graphics editor included.

2.1. Starting atvise builder

1 Right-click on the atvise icon in the right corner of the task bar.
Open the "Project Console" and click on "Builder" to open the atvise builder.

You can also choose "Programs -> atvise -> atvise builder" from your Windows start
menu.
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Starting the atvise builder

                            
Please note: if you started the builder from the project console as described above
and have no need to add another server to the project, please move on to section 3
and skip 2.2 below.

2.2. Connecting to a server
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After starting the atvise builder from the task bar, you will automatically be connected to the OPC UA
module of the atvise server on your local machine.

If you start the atvise builder via the Windows start menu or if you want to connect to another server,
you can do so by following these steps:

1 Choose "builder -> Connect to server" from the
menu bar.

2 A dialog will appear in which you must enter the
address of the server to which you want to
connect (opc.tcp://[host]:[port]). The default is
your local host and the default OPC UA port
("opc.tcp://localhost").

You could also enter the address of another
server instance, for example, the IP address
of a machine in your local network.

3 Apply the dialog by pressing the "OK" button to
connect your atvise builder to the server.

Connect to server on localhost

After connecting to / adding a server, you get asked to choose a default layout.
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Choose a default layout

If you want to connect to another server, you first have to disconnect the current
session by choosing
"builder -> Disconnect from server" from the menu bar.

After that, choose "builder -> Connect to server" again and connect to the new server
the same way as described before.

You can see the currently-selected server address at the top left of the atvise builder
interface.                            
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3 Step 1: The first display
After covering some basics, we will now proceed to an interaction with the atvise builder. In this
section we will add a simple display to our project and view it in the visualization afterwards.

3.1. Adding a new display to the project

1 Open the "Servers -> My Server -> Display" folder, then right-click on the MAIN menu entry. 

2 Choose "Add Display" from the list which appears.

3 Now you can type in the desired display name. For our example, let's choose "TestDisplay1".

4 After acknowledging the display name by clicking "OK", you will see an entry for the new
display if you open the structure of the MAIN menu.

Add a new display to the MAIN menu

3.2 Editing the display and drawing simple elements

1 Double-click the new "TestDisplay1" entry to
open the included graphics editor for this
display.
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This editor offers many powerful tools to
design the optimal display for your project.
For detailed information see the atvise
help .

For our example, we will simply add a rectangle
and a circle to the display.

2 Click on the  symbol to select the rectangle
drawing tool.

3 Click somewhere in the drawing area, press
down the left mouse button, move the mouse till
the rectangle has reached the desired size, then
release the button.

4 Click on the  symbol to select the circle
drawing tool.

5 Draw a circle the same way as described in
step 3.

6 Click the  symbol after you have finished the
drawing interactions to save the display.

Draw a rectangle and a circle, save the display and...

Also try to zoom in the drawing area using the mouse wheel.

393
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3.3. Viewing the display in the web visualization

1 Now you can call up the new display in the visualization. Start a browser of your choice.

2 Call up the visualization by entering the URL of the machine on which the atvise server is
running. If this machine is your local machine, type in "http://127.0.0.1/" to open the
visualization.

3 Open the display by choosing "TestDisplay1" from the main menu.

...view it in the browser of your choice.

If you change a display after you have already launched the visualization, reload the
current page to be sure that you see the updated version.

If you encounter any problems with viewing the visualization, please clear your
browser cache and reload the page (especially if you have used previous atvise
versions before).
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4 Step 2: The first dynamics
In this section we will change the properties of some graphic elements in dependence on the value of
data variables.

4.1.1. Adding data variables to the project

First, we need some data variables which we want to display in the visualization. For this purpose,

click on the "Objects" tab on the left of the atvise builder interface. You will see some objects ( )

and data variables ( ) from the demo in the list.

For our example, we will add the following data variables:
"testString" of the data type "String"
"testBool" of the data type "Boolean"
"testInt" of the data type "Int16"

1 Right-click on the "Servers -> My Server -> Objects" folder.

2 Choose "Add Node -> Data Variable" from the menu which appears.

3 Choose "String" from the data types list.

4 Type in "testString" in the dialog which appears and apply the variable name by clicking "OK".

5 Add a data variable "testBool" of the data type "Boolean" in the same way.

6 Add a data variable "testInt" of the data type "Int16" in the same way.
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Add data variables

4.1.2. Reading and changing values of data variables

After working through the last section, you will see an entry in the object list for each of the three
newly added data variables. Now we want to change the value of one of them.

1 Double-click on the entry of "testString" to open a detail tab for the variable.

2 Double-click on the "AttributeValue" column in the "Value" row to edit the value of the data
variable. For our example let's type in "my test text" as the value for the testString data variable.
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Changing the value of a data variable
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4.2 Using predefined controls
4.2 Creating dynamic elements using predefined controls

In this section we will take a look at how to use predefined controls to create dynamic elements.

4.2.1 Bar control

1 Create and open a display "TestDisplay2"  as described in section 3.

2 In the bottom area of the graphics editor you can see a selection of predefined controls.
Drag & drop the "Bar vertical" control into your drawing area.

3 On the right side, you can see a list of all parameters of the referenced control.

Select the "testInt" data variable as the base address for this control by using the  selector.

4 The control is now fully operative; you can also change the other parameters if you want to.

Adding a bar control



100 atvise® - documentation

© 2018 Certec EDV GmbH

4.2.2 Increment control

1 Now drag & drop a "Button Increment/Decrement" control into your drawing area.

2 Select the "testInt" data variable as the base address for this control by using the  selector.

3 Enter "10" as the step. Now the value of the base will be increased by 10 every time you click
on the button.

Adding an increment control
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You can also change other parameters if you want to. Mandatory parameters are
highlighted in red, all other parameters are optional. For example, to adjust the font
size of the control, change the value of the parameter "Font -> size". 

4.2.3 Decrement control

1 Copy & paste the increment control.

2 Choose -10 instead of 10 for the "step" parameter.

Adding a decrement control

4.2.4 Opening the browser and testing the controls

1 Save the display, then open "TestDisplay2" in your browser and change the value of the "testInt"
data variable using your increment and decrement buttons. Now the bar should change
according to the value of "testInt".
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4.3 Using quick dynamics
4.3 Creating dynamic elements using quick dynamics

In this section, we will take a look at how to use quick dynamics to add dynamization to your own
graphic elements.

4.3.1 Textual display of a data variable

1 Add a new text element to your display.

2 Mark the text element and choose "Quick Dynamics -> Set Text".

3 Select the "testInt" data variable for the "Node from which value will be taken" property by using

the  selector.

Create a dynamic text using quick dynamics

Afterwards, you will see an entry for this quick dynamization in the dynamics list of
this text element located on the lower right side of the atvise builder interface. To edit
or view an existing quick dynamic, simply double-click on the entry:
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4.3.2 Drawing a simple button to set the testInt variable to 100

1 Click on the "Add polygon" symbol to select the polygon drawing tool. We want to use this tool
to draw a triangle.

2 Click somewhere in the drawing area, then move the mouse to draw the first side of the
triangle. Click again and move the mouse to draw the two remaining sides. Finish the drawing
by double-clicking.

3 Give the triangle a button-like look by choosing one of the design templates. Make sure the
triangle is marked, then click on "Templates". Choose one of the templates in the menu which
appears by simply clicking on it.
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Drawing a triangular button

4.3.3 Dynamizing the button to set the testInt variable to 100

1 Make sure the triangular button is marked, then chose "Quick Dynamics -> Set Node"

2 Select the "testInt" data variable for the "Node to be set " property by using the  selector.

3 Type in "100" as value. Now the "testInt" variable will be set to 100 if you click on this element
in the visualization.
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Dynamizing your own element to set the value of testInt to 100

4.3.4 A simple button to set the testInt variable to 0

1 Create and dynamize a second triangle the same way as described in the last two sections,
but now enter "0" as the value instead of 100.
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Creating a second element that sets the value of testInt to 0

4.3.5 Opening the browser and testing the controls

1 Save the display, then open "TestDisplay2" in your browser and change the value of the "testInt"
data variable by clicking on your new controls. You will see the results by looking at the
dynamized text element and the bar.
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4.4 Using simple dynamics
4.4 Creating individual dynamics using the simple
dynamics dialog

In this section we will take a look at how to create your own individual dynamics using the simple
dynamics dialog.

4.4.1 Adding a text element, editing it and starting the simple
dynamics dialog for it

In this section, we will directly display the value of a data variable in the visualization using the
simple dynamic dialog.

1 Open "TestDisplay1" in the graphics editor as described in section 3.2.

2 Add a text element to the test display. 

3 Click somewhere in the drawing area and type in whatever you want to get a preview of how the
text will look in the visualization.

4 Make sure that the text element is marked. Change the text size to 72 in the style area on the
middle right side of the atvise builder interface.

5 Right-click -> "add" in the dynamics area on the bottom right of the atvise builder interface. The
"Simple Dynamics" dialog will appear on your screen.

There are 3 ways in total to open the "Simple Dynamics" dialog. Each of them will open the
very same dialog, so it's your choice:
-> You can right-click on the dynamics area as described above.
-> You also can double-click on the whitespace in the dynamics area.
-> The third way to use simple dynamics is by right-clicking on the element to which you
want to add a          
     dynamization and choosing "Add dynamics".
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Adding a new text element and starting the "Simple Dynamics" dialog

4.4.2 The "Simple Dynamics" dialog

The "Simple Dynamics" dialog offers you a very powerful way to create individual dynamics with
minimal effort.

You can create many different types of dynamics in four steps:

In this step you can check a user right which is then necessary to
activate the dynamization. We don't need this for our current
example.

In this step you can decide which event activates the
dynamization.
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1 In our case we want to react to the change of a data variable, so

we choose  from the possibilities on the left side.
2 Now we have to specify this data variable. Click on the 

symbol and choose "testString" from the list which appears.

In this step, you can change the result of the event. We don't need
this for our current example.

In this step, you can define the action that will be executed when
the event is triggered. For our example we will define the way the
result is displayed in the visualization.

3 We want to display the value of the data variable directly, so we

choose  from the possibilities on the left side. 
4 Check   .
5 Now that all the necessary information is entered, we can apply

the dialog by clicking "OK".
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Adding dynamization to the text element using simple dynamics

Afterwards, you will see an entry for this dynamization in the dynamics list of this text
element. To edit or view an existing dynamization, you can open the "Simple
Dynamics" dialog for this entry by double-clicking on it.

4.4.3 Activating and viewing the dynamization

Now we want to view our dynamization in the visualization.
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1 Save the display.

2 Open "TestDisplay1" in the browser of your choice 
(as described in sections 3.1., 3.3).

3 You will see that the random characters are replaced by the current value of the data variable
"testString".

4 Change the value of "testString" several times as described in section 4.1.2. and look at how it
is displayed in the browser.

Change the value of the "testString" data variable...

... and see how it is displayed in the browser.

4.4.4 Adding simple dynamics to change the color of an
element

In this section, we want to change a graphic attribute of one of our elements in dependence on a
data variable. Let's say we choose the circle in our "TestDisplay1" and we want its color to depend
on the value of our "testBoolean" data variable. If the value is true, we want to fill the circle with
green, if the value is false, we want to fill it with red.

1 In the first step, we have to mark the element to which we want to add a dynamization. Go
back to the graphics editor, click somewhere in the circle (which we drew in section 3.2) to
mark it and start the "Simple Dynamics" dialog by right-clicking -> 
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2 The event we want to react to is a change of "testBool", so we choose this variable as
described in section 4.4.2.

3 Now that we have an event to react to, we have to define the action that is to be executed. We

want to change the color of our circle, so we choose  from the possibilities on the
left side.

4 We want to react to discrete values, so we choose  from the type selection list.

5 If the value is true, we want to fill the circle with green, so we choose a green color for this

condition by clicking  at the right side of the condition list.

6
Furthermore, we will add a second condition by clicking on . 

7 We change the "Value" column to false and select a red color by clicking on  .

8 Now that all the necessary information is typed in, we can apply the dialog by clicking "OK".
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"Change Color" dialog

4.4.5 Activating and viewing the dynamization

1 Save the display.

2 Open "TestDisplay1" in the visualization. If you have already opened this display, please reload
it.

3 You will see that the color of the circle now shows the state of the "testBoolean" variable.

4 Change the value of "testBoolean" several times and look at how the color changes in the



114 atvise® - documentation

© 2018 Certec EDV GmbH

browser.

Change the value of the "testBool" data variable...

... and see how it is displayed in the browser.
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5 Connecting to a foreign server
This section shows how to add a foreign server, browse a foreign server and how to create local data
variables that are mirrored against a foreign server.

5.1 Starting the OPC UA test server

First, we have to start the OPC UA test server, which is necessary to import a data structure.
This test server will be added as a foreign server in the next section.

Therefore, go to the atvise entry in the Windows start menu and choose "OPC UA testserver".

Starting the OPC UA test server

5.2 Adding a foreign server

1 Open "Servers -> My Server -> Data Sources"

2 Right-click on "Data Sources". 

3 Choose "Add Data Source" and then "OpcUa" to open the dialog for adding a data source to
the list.

4 The test server runs on port 4841, so we type in "TestServer" as the server name and
"opc.tcp://localhost:4841" as the server URL in the dialog which appears.

5 Apply the dialog by clicking on the "OK" button to add the data source.

5.3 Browsing a foreign server

1 Right-click on the new entry in the server list. 

2 Choose "Browse" from the menu which appears to open a browsing window for this server.
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Browsing a foreign server

Browsing in the structure of a foreign server is very useful for copying browse paths
and node IDs for creating mirrored variables.

5.4 Creating mirrored data variables

Now we want to display the value of a foreign variable in our visualization. It is not possible to access
variables on a foreign server directly from the visualization, so we have to create a mirrored local
counterpart for them. The atvise builder includes some functions for creating mirrored variables
easily. 

1 Open the structure of the "TestServer" and browse into the folder "Objects". 

2 Right-click on "VariableString". 

3 Choose "Copy" from the menu which appears.

4 Right-click on "Server -> My Server -> OBJECTS".

5 Choose "Paste & Mirror -> Input -> node" from the menu which appears. Name the variable
"VariableString_input".

6 Right-click again on "Server -> My Server -> OBJECTS" and choose "Paste & Mirror -> Output
-> node" from the menu which appears. Name the variable "VariableString_output".

Now the value of VariableString on the "TestServer" is mirrored to the local
"VariableString_input". If you change the value of "VariableString_output", this value is
written to "VariableString" on the "TestServer".

7 Display the value of "VariableString_input" directly in the visualization as described in section
4.3.

8 Change the value of "VariableString_output". This value is written to "VariableString" on the
"TestServer". After the change of "VariableString" on the other server, our local
"VariableString_input" is set to this value which will be displayed in the visualization.
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Copying & pasting a variable from a foreign server
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6 Object-oriented engineering
In this section we will take a look at object-oriented engineering. Our goal in the following example is
to design a type which displays and controls the state of electric lights in an office building. For this
purpose, we will handle the following variables:

Light intensity (0-100, display and set the value)
Internal malfunction (handle alarm states)

If you browse in the "TestServer" you will find the counterparts to the objects we want to create:

Object structure on the other server

6.1 Adding a new object type

1 Right-click on "Object Types" in the tree structure. 

2 Choose "Add Node -> Object Type".

3 In the dialog which appears you can now type in a name for the new type; for our example we
will choose "Light".

4 After acknowledging the type name by clicking the "OK" button, we can see the object type
node "Light" in the object types list.

Adding a new object type
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6.2 Adding data structure

To get a clear data structure, we will add folders to the new type.

1 Right-click on the "Light" type.

2 Choose "Add Node-> Folder" from the menu which appears. 

3 Name the folder "ALARMS" (contains data variables with alarm configurations) and add it to the
"Light" type by clicking "OK".

4 Choose "Add Node-> Folder" and add the folder "COMMANDS" (contains data variables which
are mirrored to another server) to the "Light" type.

5 Choose "Add Node -> Folder" and add the folder "SIGNALS" (contains data variables which are
mirrored from another server) to the "Light" type.

Add folders to the type to obtain a clear data structure

6.3 Adding relatively-mirrored variables to the object type

In the next step, we will add relatively-mirrored variables to these folders.

1 First, we have to browse to the server that we want to use for mirroring. Choose the
"TestServer" from the server list and open the browsing window as described in section 5.3.

2 In the node tree which appears, browse to "Objects". There you will find "L001 - L005", the
complements of the objects we want to add to our local server.
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3 Open the structure of one of these objects, right-click on "LightIntensity" and choose "Copy"
from the menu.

4 Then go back to the "Object Types" tab, right-click on the "Light -> COMMANDS" folder and
choose "Paste & mirror-> Output -> node" from the menu.

5 In the dialog which appears, we have to select the start index of the browse path. "L001" is the
base node of the object, so we have to choose this node. It is already selected in the list, so
we can apply the dialog by clicking "OK".

6 Apply the dialog to create the mirrored variable.

7 Paste the "LightIntensity" variable from the other server into the SIGNALS folder as input as
described in steps 3 - 6 above.

8 Paste the "InternalMalfunction" variable from the other server into the ALARMS folder as input
as described in steps 3 - 6 above.

Copying & pasting a data variable relatively into the object type

The structure of the "Light" type should now look like this:
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Object type structure w ith three relatively-mirrored data variables

If you right-click on one of the new variables and open the "ModellingRule" submenu,
you will notice that "New" is checked (default modellingrule for data variables). This
means that for every instance of this type, the variables will be added as a new node.

6.4 Creating object instances

In this step we will create five instances of our object type.

1 Right-click on "Servers -> My Server -> Objects" and choose "Add Node-> Object". In the
submenu which appears, you will see an entry for our "Light" type. Click on the entry to open
the dialog for creating object instances. 

2 Our goal is to create five numbered object instances, so we click on "Numbered" to the left in
the dialog.

3 To get clear object names, we replace "NewNode_%1" with "OfficeLight_%1". The "%1" is a
wild card and will be replaced by 001-005.

4 The default start index is set to "001", so we do not need to change this value.

5 We want to instantiate five objects, so we set the object count to 5.

6 In the last section, we added relatively-mirrored variables to the type, so we have to
add a "RelMirrorBase" to the instances to make the mirroring work. The individual
object mirror base plus the relative mirror part of the data variable give the full mirror
path of this variable.

Activate the check box and click on the select button. Now choose "Testserver -> Objects ->
L001" from the menu which appears and click "OK". Then you have to change "L001" into "L%
1" as in Step 3.

7 Now that all the required information is typed in, you can apply the current dialog by clicking
"OK". Afterwards, the five mirrored objects are added to your local server structure.
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Creating object instances
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7 Adding an object display
In this section, you will see how to add a display to an object, how to dynamize it using relative
addressing and how to add displays of object instances to the visualization.

7.1 Adding a new display to the object type

The first step is to add a new display to the object type.

1 Right-click on the "Light" type and select "Add display" from the menu which appears. 

2 Type in "MainDisplay" as name for the display and add it to the object by clicking "OK".

Add a display to the object

If you right-click on the new display node and open the "ModellingRule" submenu, you
will notice that "Shared" is checked (default for data variables). This means that the
display of the type is referenced from every object instance which you create. The
display looks and behaves the same for every object instance, so it would not make
sense to create a new display for every instance.

7.2 Designing an object display

7.2.1 Creating a background

1 Double-click on the "MainDisplay" node to open the graphics editor.
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2 First, we draw the background of our object display. Draw a rectangle of the desired size -
it is possible to change its size afterwards.

3 For our background we want to have a gradient fill, so make sure the rectangle is marked
and click on the "fill" option just below the drawing area. In the window which appears, click

on the  symbol to choose a gradient fill.

4 You can change the colors of the gradient by double-clicking on the small triangles under
the gradient bar.

5 Change the angle of the gradient by moving the red circles in the preview box. Define a
matching gradient.

6
When you finish the background design, click on "File ->  Settings" in the top symbol
bar.

7 Click on the "Fit" button in the dialog which appears to adjust the page size to the size of
the background rectangle.
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Create a background for "MainDisplay"

7.2.2 Drawing a bulb

We want to display our "LightIntensity" input variable through the color of a light bulb.

1 Draw a small rectangle in the middle of the left side of the object display.

2 Draw a circle on top of the rectangle to make it look like a bulb.

Try to draw a form that looks like a bulb

7.2.3 Adding and parameterizing three buttons

We also want to set the value of the "LightIntensity" output, so we want to add three buttons for
zero, fifty and one hundred percent light intensity to our display.

1 In the bottom area of the graphics editor you can see a selection of predefined controls.
Drag & drop the "Button Set Address" control into your drawing area.

2 On the right side, you can see a list of all parameters of the referenced control.
Set the text of the button by entering "0" in  the "label" field.

3 To set its "base" parameter, click the  button to activate relative addressing, then the 
button to open the node select dialog. *

4 In the left box, you can select the object type for the relative addressing, so click on
"Light".

5 In the right box you can select the variable whose change you want to react to, so select
"COMMANDS -> LightIntensity". Apply the dialog by clicking "OK".

6 Set the "value" parameter by entering "0". This value will be set to the base when the button
is clicked.

7 Add a button with the label "50"  and value "50" the same way.

8 Add a button with the label "100"  and value "100" the same way.
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9 We are done with the design of our object display for now, so click on the  symbol to
save it.

Adding and parameterizing three buttons to set "LightIntensity"

* Note: Relative addressing can be used only in conjunction with modellingrule "New". If a
variable type or object type contains a node defined with modellingrule "Shared", this node can
be addressed only absolutely. This is a consequence of the fact, that one node can only have
one node id.

E.g: if LightIntensity would be defined with modellingrule "Shared", then change following
steps 

3. relative addressing must be deactivated by releasing the  button
4. In the left box, you must select the ObjectTypes
5. In the right box you must select "ObjectTypes -> Light -> COMMANDS -> LightIntensity".

7.3 Color change of the light bulb to display the light
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intensity

In this section, we want to add a simple dynamic to our bulb to display the light intensity.

1 Click on the circle of the bulb to mark it and open the "Simple Dynamics" dialog as described
in section 4.4.1

If you have worked through section 4, you are already familiar with this dialog. The
only new thing is that we want to address our data variables relatively.

2
Choose  from the possibilities on the left.

3 Click on the relative button  to activate relative addressing.

4 Open the "node select dialog" by clicking on  .

5 In the left box, you can select the object type for the relative addressing, so click on "Light".

6 In the right box you can select the variable whose change you want to react to, so select
"SIGNALS -> LightIntensity". Apply the dialog by clicking "OK".

7
We want to change the color of the circle, so we choose  on the left in the
ACTION section.

8 The range of our "LightIntensity" variable is from 0 - 100, so we choose "Value Range" as the
type and enter the minimum and maximum values.

9 We want to display the circle in a color range from gray to yellow, so we check the fill box and

choose a gray color as the start fill and a yellow color as the stop fill by clicking on .

If the value of the data variable is 0, the start fill will be displayed, if it is 100, the stop
fill will be displayed. Values in between are merged according to the gradient from the
start fill to the stop fill.

We are now finished with the dynamization. Apply the dialog by clicking "OK".
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"Simple Dynamics" dialog for the circle of our light bulb

For now we are done with the dynamization. We will take a look at how to handle alarms in section 9
.

7.4 Adding objects to the visualization

In this section we will add the five light objects to a display so they can be seen in the visualization.

1 For this purpose, add a new display to the MAIN menu called "OfficeLight" as described in
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section 3.1 .

2 Double-click on the display to open the graphics editor for it.

3 Click on "File ->  Open file" and in "[atvise directory]/library/displays", choose the file
named "office_light_bg.svg". This file shows a floor plan of the office in which we want to
display our five lights.

4 Now we want to add the five light objects to this display. For this purpose open the "Server ->
My Servers -> Objects" folder on the left in the atvise builder interface.

5 Click on the top node of the first object instance ("OfficeLight_001") and drag & drop it in the
drawing area of the graphics editor.

6 Do this with all five object instances, positioning them in the five offices with a blue
background and save the display.

7 Open the "OfficeLight" display in the browser of your choice as described in section 3.1.

8 Change the "LightIntensity" of one of the objects using the buttons.

The value of COMMANDS.LightIntensity is changed, written to the "TestServer" and
the SIGNALS.LightIntensity data variable is given the new value which is displayed
through the color of the circle.
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Adding the objects to a display
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8 Adding historization
In this section, we will add historization to the values of the data variables of the "Light" object.

8.1 Configuring the historization of data variables

1 Open the object types list by clicking on the "Object Types" tab on the left side of the atvise
builder interface.

2 Open the object structure of the light type and right-click on "COMMANDS -> LightIntensity".

3 Choose "Historize" from the menu and check the "DataValues" entry.

4 Do the same with the "SIGNALS -> LightIntensity" data variable.

Adding historization to the "LightIntensity" data variables

You can add "Smoothing" like absolute deadband to your data variables to reduce the amount of
historized data - see chapter "Smoothing ".

8.2 Viewing the history in the visualization

Now we can take a look at the history list in the visualization.

1 Open the "Office_Light" display in the visualization.
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2 Change the "LightIntensity" for some rooms several times.

3

Click on the history list symbol  in the control panel to see the value changes in the
history list.
You could also place this symbol in any display you like by using the display object
"Historylist" in the "Standard -> hmi" folder.

Viewing the history list in the visualization 
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9 Adding alarms
9.1 Adding an alarm configuration

In this section, we will configure the internal malfunction alarm of our light object.

1 Open the object types list by clicking on the "Object Types" tab on the left side of the atvise
builder interface.

2 Right-click on the "Light -> ALARMS" -> InternalMalfunction" data variable.

3 Choose "Add AlarmConfiguration" from the menu which appears.

4 Type in a name for the AlarmConfiguration, for our example let's choose "LightMalfunction".
Apply the name by clicking the "OK" button.

5 The "LightMalfunction" node will be added under the data variable; double-click it to open the
alarm configuration interface.

6 At first, select the "OfficeLight" display using the  button.

7 Now we must define a condition. Type in "light malfunction" as the "Condition Name" and
"Warning: lights went down!" in the "To Active Text" field. Then enter "true" in the "Value" field
and make sure "match" is chosen from the drop-down box. 

8 Accept the dialog by clicking "OK". Now the alarm will be triggered when the value of
"InternalMalfunction" is set to "true".
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Adding an alarm configuration to the "InternalMalfunction" data variable.

After applying the dialog to the object type, the alarm is configured for all object
instances.

9.2 Displaying the alarm in the object display

The alarm is already working. In this section, we also want to display the state of the alarm in the
object display.

9.2.1 Adding a border to the object display which signalizes
the alarm

1 Open the object display by double-clicking on the "Object Types - > Light -> MainDisplay"
node.

2 Draw a rectangle around the object display.

3 Select "None" in the fill tab.
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4 Choose a bigger line width and a red color in the "Stroke" tab.

Drawing a red border around the object

9.2.2 Add a dynamization to the border

1 Make sure that the border is marked and start the "Simple Dynamics" dialog by right-
clicking.

2
Choose  from the possibilities on the left side of the EVENT part.

3 Select the ".ALARMS.InternalMalfunction.Malfunction.light malfunction" condition relatively
as described in section 7.3.1.

4 The combobox should be automatically set to "alarmstate".

5 We want to change the visibility of the border in dependence on the alarm state, so we
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choose  from the possibilities on the left side of the ACTION section.

6 Basically, there are five alarm states:
Off, Acknowledged (the red border should be invisible)
On, Unacknowledged (the red border should blink quickly)
On, Acknowledged (the red border should be visible)
Off, Unacknowledged (the red border should blink slowly)
On Off, Unacknowledged (the red border should blink very quickly)

Click the  button four times and enter the values as determined in the list
above.

7 Apply the dialog by clicking "OK" and save the object display afterwards.
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the "Simple Dynamics" dialog to display the state of the InternalMalfunction alarm

9.3 Viewing the alarm states in the visualization

1 Browse to "My Server -> OBJECTS" in the left part of the atvise builder and activate an
"InternalMalfunction" alarm for one of the five OfficeLight objects by changing the value of the
data variable to "true".

2 Load the "Office_Light" display in the visualization and see how the alarm state is displayed in
the object.

3 Deactivate the alarm by changing the value of the data variable to "false".

4

Go back to the visualization and click on the alarm list symbol  in the control panel to
view a list of all active and/or unacknowledged alarms.

5 Acknowledge the inactive alarm in the list by clicking on "ACKNOWLEDGE".

6 Activate, deactivate and acknowledge the alarm several times to become familiar with the five
alarm states.

Open the alarm list to acknowledge an alarm
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10 Adding user rights
In this section, we will create a user right which will be required to change the "LightIntensity" value
in the visualization. For this purpose we will:

add a user-defined right to the project
add a new group for this right
add a user to this group
and, finally, check this right in the visualization.

10.1 Adding a right to the project

1 Open the users & groups view by clicking on the "Users&Groups" tab on the left if the atvise
builder interface.

2 Open the "Rights" folder and right-click on "Userdefined rights".

3 Choose "Add right" from the menu which appears.

4 In the dialog which appears, you can type in a name for the right; for our example we will
choose "change_light_intensity".

5 Add the right by clicking "OK".

Add a right to the project

10.2 Adding a group to the project

1 Right-click on the "Groups" folder.

2 Choose "Add group" from the menu which appears.

3 Name the group "Administrators" in the dialog which appears.

4 An entry for the new group is added under the top group folder; double-click on it to open the
"Group Editor".

5 Type in a description, for example "Group of Administrators".

6 Check the "USER - change_light_intensity" entry in the "Rights List" on the bottom
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7 Apply the changes by clicking "OK".

Adding a group to the project

10.3 Adding a user to a group

1 You can add users directly to a group. To do this, right-click on the "Administrators" group
entry.

2 Choose "Add new user" from the dialog which appears.

3 Name the user "admin1".

4 An entry for the user is added under the "Administrators" group folder. Double-click on this
entry to open the user editor.

5 Type in a name, description and language.

6 Click on the "Set Password" button and type in a password of your choice.
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7 Save the information by clicking "OK".

8 After this, double-click on the "Administrators" group again. You will see the new user in the
users list.

Creating a new user, "admin1"
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Group editor for the "Administrators" group

10.4 Adding right checking to the buttons of the light
object

Finally, we want to check our new right in the visualization.

1 Go back to the objects view by clicking on the "Objects Types" tab on the left side of the
atvise builder interface.

2 Open the structure of the "Light" object and double-click on the "MainDisplay".

3 Click on one of the buttons to mark it. On the right of the atvise builder, you can see the
"Attributes" window belonging to this button. Open the "Security" tab and choose

"change_light_intensity" as the necessary right by using the   selector.
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4 Add the same right checking to the other two buttons.

Adding right checking to the three buttons

10.5 Checking the right in the visualization

1 Load the "Office_Light" display in the visualization.

2 Try to change the light intensity by clicking on the buttons of one of the objects. You will notice
that the buttons are inactive now because you don't have the necessary user right.

3

To gain the necessary right, you have to log in as "admin1". Click on the  symbol in the
control panel and type in "admin1" and your password in the dialog which appears.

4 After the login, you will finally be able to change the light intensity by using the buttons.
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Logging in w ith the new user
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Reference manual
In the following sections, you will be guided through atvise features and functionality. Below, you can
see an overview of the major components of atvise:

Visualization

Use your web HMI with web-enabled devices including PC, laptop, touch panel, Windows mobile,
iPhone, and many more. No matter where you are, open your HMI with a standard web browser and
enter the target address of your web server in its address field. The browser does the rest for you
without the need for any further installation or configuration. Further Information can be found in the 
atvise visualization  section.

atvise server

The basis for atvise technology is a slim web server. Implement a compliant web server in your
device (PLC, PC, embedded PC) / software or use the built-in webserver that comes with atvise
scada. All necessary functions - strictly web-compliant - are specified in the atvise webMI guidelines.
We offer the complete specification and an SDK (ANSI-C based: slim and highly portable) for fast
and easy implementation.

149
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atvise monitor

After the successful  download and installation of atvise, the application is started by executing
atvise monitor in the MS "start menu". The atvise monitor icon is then located in the sys-tray. With a
right mouse click, various selections are offered, including starting the "License" panel in order to
activate your atvise software as well as the "Project Console", which allows you to add, select or
start a project. Further information can be found in the section atvise monitor .

atvise builder

The atvise builder gives you professional HMI design capabilities, lets you add event-based,
sophisticated dynamics, supports object-oriented programming at its best and all other features
needed to create a professional HMI and SCADA environment - in dependance on which atvise option
has been chosen. Every atvise webMI-compliant server can be engineered with the atvise builder. The
project is stored in a nodes.db on the PC where the atvise builder is running. After the engineering
process is finished, the project is distributed to the specific device  (PLC, PC, embedded PC) where
the atvise server was first implemented. Further Information can be found in the atvise builder
section.

209

217



148 atvise® - documentation

© 2018 Certec EDV GmbH



149Reference manual

© 2018 Certec EDV GmbH

atvise visualization
1. Basics

1.1. Concept

The whole atvise webMI visualization is based on open web standards. All individual displays are
stored in the SVG (Scalable Vector Graphics) format and are delivered to the browser of your
choice by the web server included in the atvise server.

Basically, every web browser that supports SVG, JavaScript and xmlhttp request should be able
to display this visualization.

1.2. Tested with the following browsers

The visualization has been tested with the following browsers:

To view a detailed up-to-date compatibility list, please visit www.atvise.com -> Compatibility
List.

1.3. Starting the visualization

To view the visualization of your project, start a compatible web browser and call up the machine
on which the atvise server is running. To do this, type in the IP address or the host name of this
machine in the address bar of the browser.

If the atvise server is running on your local computer, you can start the visualization by
typing in http://localhost.

Calling up the visualization

1.4. Basic layout

The user interface of the visualization is generally divided into two areas:

1.4.1. Control panel

This area is located at the top of the visualization page. The control panel enables you to

http://www.atvise.com
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navigate through the visualization, to zoom in the current display and to handle alarms.

The control panel consists of the following control and output elements:

Element Description

1 Information block
Displays the current date, time, the logged-in user and the active
language.

2 Display Folders
Show the structure of the MAIN, USER, SYSTEM and REPORT
display folders.

3 Zooming tools Tools which enable you to zoom in the currently opened display.

4
Log in/Switch
Language

Enables you to log in and switch the language.

5 Alarm controls Controls which allow you to view and handle alarms.

6 History list. Opens the history list.

7 Alarm log Displays information about the last three alarm status changes.

Control panel

1.4.2. Display area

In this area, below the control panel, the individual SVG displays are displayed.

1.5. Licensing Information

Due to the interdependence between visualization and licensing, please note:

For information about the CCD licensing in atvise scada, see the subsection "atvise scada
- CCD licensing" .

2. Navigation

This section shows how to navigate through the displays of the visualization.

All displays you add to the MAIN, USER or SYSTEM folder in the atvise builder are directly
accessible from the control panel. Move the mouse over the corresponding folder symbol and click
on the desired display name in the menu which appears to open this display in the display area.

19
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The menus of the visualization are built from the menus in the atvise builder

This section shows how to navigate through the displays of the visualization.
 
All displays you add to the MAIN, USER, SYSTEM or REPORT folder in the atvise builder are
directly accessible from the control panel. Move the mouse over the corresponding folder symbol and
click on the desired display name in the menu which appears to open this display in the display
area.
 
Please note that it is also possible to add different kinds of references to the navigation menus:

Reference to single display from pool
Reference to display structure from pool
Reference to resource
Reference to URL

 
These references will also be displayed in the corresponding menu list. It is not possible to open a
reference to a single display from pool with the Button Open Display as the reference functionality is
only linked to the navigation menus. (Also all the other references can only be used with the
navigation menu)

3. Zooming

The zooming tools allow you to zoom in the currently opened display.

Tool Description

Zoom in Enlarges the zoom factor by 10%.

Zoom to
origin

Sets the zoom factor back to 100%, the display will look the same as after
opening it.

Zoom out Reduces the zoom factor by 10%.
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Area
zooming

Zooms to a desired area. To use this tool, first click on the area zooming
symbol, then click at the spot in the display where the upper left corner of the
desired area should be, enlarge the rectangle which appears by moving the
mouse and clicking at the spot where the bottom right corner of the area should
be.

When you zoomed in, hold the ALT key to drag the display.

4. Alarms
This section shows how the occurrence of an alarm is signaled in the control panel, how to
acknowledge an alarm and how to use the alarm controls.

4.1. Alarm controls

Control Description

Alarm horn
Anytime an alarm occurs, the visualization will start to play a sound
signal. Click this button to acknowledge the alarm horn and stop the
sound.

Jump to display

Jump to a display with an unacknowledged alarm.

The purpose of this function is to make it possible to view all
unacknowledged alarms in the assigned display(s) and to acknowledge
them display after display using the Acknowledge all function.
If there are many unacknowledged alarms which are assigned to various
displays, the sequence in which you step through the displays is ordered
by:
1. Active unacknowledged alarms before inactive unacknowledged alarms
2. Priority
3. Time (the latest comes first)

Acknowledge all 

Acknowledges all unacknowledged alarms which are subscribed with the
function "webMI.alarm.subscribe" on the currently opened display. 

This will not work on the alarm list since the function
“webMI.data.subscribeFilter” is used there and the alarms have to be
acknowledged separately.

You can use this function in combination with the jump-to-display button
to view and acknowledge all alarms of the project display by display in
case the alarms have been subscribe with the function
"webMI.alarm.subscribe".

Open alarm list

Opens the alarm list.

A blinking alarm symbol indicates the existence of a currently
unacknowledged alarm.
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4.2. Alarm list

You can open the alarm list by clicking the open alarm list symbol to the right in the control
panel. The alarm list shows all active and/or unacknowledged alarms, ordered by the time of the
occurrence,  including information about:

1 Priority of the alarm

2 Time of the occurrence / last state change

3 Time of acknowledgement

4 Assigned display

5 Source (ID of the alarm condition) of the alarm.

6 Event text of the alarm.

7 Current state of the alarm.

8 Value of the alarm activating data variable

9 User who has acknowledged the alarm. If the alarm is currently unacknowledged, you will
see the "ACKNOWLEDGE" button to acknowledge the single alarm. In the case of events
the user is displayed, which has triggered the event - this may be empty.

Columns of the alarm list

If you use the "Source" filter, an exact match is required if the alarm condition was selected with
the selector. If the source was input directly, the value of the input field must be contained in the
alarm condition.

Information on how to personalize the alarmlist can be found in the corresponding Object Display
help.

Note: Alarms of the type acknowledged / unacknowledged are, if both active, displayed in two
rows as a pair of alarms with the same background color. This alarm is always displayed as a
couple, regardless of the filtering. 

The CSV button is for exporting data in CSV data format. If the server supports server
scripts a CSV file will be downloaded. If no server scripts are supported a pop up will
appear to download the data via copy&paste.

Note: This CSV button will be automatically disabled on mobile devices due to
inconsistent behaviour on mobile browsers.

4.3. Alarm log
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The alarm log displays the last three changes of any alarm status, including information about:

1 Time of the alarm status change.

2 Source (ID of the alarm condition) of the alarm.

3 Event text of the alarm.

4

Symbol for the new alarm state:

 Active unacknowledged (state = 1)

 Active acknowledged (state = 2)

 Inactive unacknowledged (state = 3)

Columns of the alarm log

4.4. Signaling of the occurrence of an alarm

Basically, the occurrence of an alarm is signaled in the control panel in three ways:
Blinking of the alarm list symbol
Audio signal
Entry in the alarm log

5. History list

You can open the history list by clicking the history list symbol in the control panel. The history list
shows the history data and live data (values and events) of the current project.

  5.1. Filter inputs

To filter the data, the following inputs can be set in the filter input area, where depending on the
type different criteria are supported:

Input fields of the history list for values, events and alarms

Input fields of the history list for aggregates

When the history list is opened, the advanced filters are hidden and can be shown by clicking
the button "Advanced filters".

The filter "Type" defines which types (Value, Event, Alarm, Aggregate) are included in the
search. Following criteria can be used with all types.
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From Start time (related to the time of the occurrence of the historized entry).

You can choose a desired date from the integrated date picker. Click on

the  symbol to the right in the date input box to open the related date
picker.

To End time (related to the time of the occurrence of the historized entry).

Address Address of the historized entry:

Type Value: NodeId
Type Alarm: Alarmcondition
Type Event: Name of event

You can select a data variable from your server by using the "..."
selector.

Value Value of the historized entry. Related to the attribute "value" for the types
"Value" and "Aggregate" and to the alarm triggering value for the type "Alarm".
Not used for the type "Event".

Archive Raw archive for values, aggregate archive for aggregates, event archive for
alarms and events.

Additional for types "Alarm" and "Event":

Username User who caused the historized entry.

Message Active/inactive text for alarms, event text for events.

Min.-
Severity

Minimum priority of the historized entry. Everything greater or equal than this
priority will be returned.

For type "Aggregate" the desired aggregate function and interval can be set. Parameterized
aggregate functions and intervals can be selected directly, but it is also possible to set all
criteria to arbitrary values.

Notes:
To activate a filter, click the button „Apply filter“ or activate the live data-checkbox. If the live
data-checkbox is activated the filter cannot be edited. To edit the filter the checkbox has to be
deactivated.
The type "Aggregate" cannot be filtered concurrently with any other type.
If the type "Aggregate" is selected it is not possible to switch to the live mode and specific
filters (Aggregate, Interval) are shown.
If multiple types are selected, fields are only considered for entries which contains the
respective field. E.g. a username will be ignored for entries of type "Value".
Entries for the "From" time are always included while entries for the "To" time are always
excluded.
For the filters Username, Message and Value, the value of the input field must be contained in
the attribute of the entry, an exact match is not required.
For the Address filter, an exact match is required if the adress was selected with the selector.
If the address was input directly, the value of the input field must be contained in the attribute
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of the entry.

5.2. Data output

Clicking on the "Apply filter" button or activating the Live Data-Checkbox button will send the
query to the atvise server and list the resulting data below the input area. The list contains the
following columns: 

Sev. Severity of the historized entry (for alarms and events).

Time Time of the occurrence of the historized entry.

Address Address of the data variable which caused the historized entry.
Type Alarm: Alarmcondition
Type Value: NodeId
Type Event: Name of event

Type Type of the historized entry (Alarm, Event, Value).

Message Active/inactive text for alarms, event text for events.

Value Value of the historical entry (raw value, aggregated value or alarm
triggering value).

User User who caused the historized entry (only for alarms and events).

Columns of the history list

Information on how to personalize the historylist can be found in the corresponding Object
Display help.

The CSV button is for exporting data in CSV data format. If the server supports server
scripts a CSV file will be downloaded. If no server scripts are supported a pop up will
appear to download the data via copy&paste.

Note: This CSV Button will be automatically disabled on mobile devices due to
inconsistent behaviour on mobile browsers.

6. Logging in

Click on "Button Login" to open the log-in dialog.
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Logging in w ith another user
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Responsive Design Lite
The "Responsive Design Lite" is a framework in atvise which delivers different displays due to
different resolutions or proportions of a device. The displays, which are supplied by the framework,
can be automatically created with the help of a Menu Script for your current project.

To apply the Menu Script to your existing project, run the script Responsive ->
GenerateDisplayStructure:

After successful execution of the script, the folders "TABLET" and "MOBILE" will be found in your
display folder. In each of these new folders you will find the two sub-folders "Landscape" and
"Portrait":
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If the sizes of the respective default displays should be changed, this must be done
before the first execution of the script. The displays that are used as default are
defined in the following path: Library -> ATVISE -> Object Displays -> Responsive ->
TABLET / MOBILE. If the size of the iFrame has been changed, the properties
"atv:contentwidth" and "atv:contentheight" must be adjusted to the size of the iFrame
in the display code. These properties will be used for all created displays included in
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the sub-folders.

The existing displays will be copied to the responsive structure (TABLET and MOBILE) with adapted
display sizes. You can now adjust the displays manually and check if all elements are in the visible
area of the display.

Original display:

Tablet Portrait mode display:
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If a display is subsequently added, the respective display for TABLET and MOBILE can be created
by executing the Menu Script again. The already existing displays in the TABLET and MOBILE
structure will not be overwritten.

The framework can be (de-)activated at any time by setting "responsiveLite" in the Configuration .

The configuration of the Responsive Design Lite is now complete and will be used after a browser
reload.

The menu navigation of the visualization is also always created for "TABLET" and
"MOBILE" based on the structure of the standard area (DISPLAYS, MAIN, USERS,
SYSTEM, REPORT). The structure must therefor always be identical.
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Scaling
Scaling technique

Since atvise 3.1.0, scaling of the visualization is done through CSS. This means, that when a display
is loaded into an iframe, its foreignobjects are not directly resized, but through styleable attributes
we reach a shrinked or enlarged representation of them. Also, when changing the size of the browser
window, the visualization as a whole while be shrinked or enlarged visually through CSS instead of
manipulating the size of the elements.

Check the following example:

Original display

On a certain visualization page, there is an iframe that loads a so-called Slider-Display. But the
Slider-Display is projected too big to be shown within that iframe. 

To be able to show the Slider-Display within the iframe, it is scaled through CSS:
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Display scaled through CSS

Now the display is shown shrinked, without any change in size to the display projected in the atvise
builder.
By doing this, all elements that have no SVG origin (foreignobjects) can also be seamlessly scaled
and a change of the screen resolution the visualization does not require an adjustment by the
developer.

Configuration

Starting with atvise 3.1.0, CSS based scaling is used by default. However, its possible to switch to a
compatibility mode in webmicfg.js .

What to take care about CSS based scaling

As described in Scaling technique above, the actual proportions of the displays and their elements
are not changed. This could lead to incorrect event coordinates under certain circumstances. Also,
positions in relation to the top left corner of the browser window can be calculated incorrectly by
libraries like JQuery.

Only foreignobject elements are affected by these restrictions.

For that reason, the webMI library provides following helper methods to retrieve correct event
coordinates and offsets:
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getAbsoluteOffset
getAbsoluteScaleFactor
getBoundingClientRect
setScaledEvents
scaleEventCoordinates

Alle functions are described in Graphics functions  and are used in large part in the following
practical example.

Practical example

This example shall illustrate the usage of the previously mentioned methods. It is about projecting a
display which shows a circle that follows the position of the mouse cursor.

Coordinate correction using scaleEventCoordinates

To make it possible that the circle follows the mouse position correctly in every possible scaling
state of the visualization, we have to help ourselves with the „getAbsoluteOffset“ and
„scaleEventCoordinates“ methods:

<?xml version='1.0' encoding='UTF-8' standalone='no'?>

<svg height="680" xmlns:atv="http://webmi.atvise.com/2007/svgext"

xmlns="http://www.w3.org/2000/svg" width="1280" version="1.2"

xmlns:xlink="http://www.w3.org/1999/xlink">
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 <defs/>

 <metadata>

  <atv:gridconfig enabled="false" gridstyle="lines" height="20" width="20"/>

  <atv:snapconfig enabled="false" height="10" width="10"/>

 </metadata>

 <foreignObject height="680" y="0" x="0" width="1280" id="id_0">

  <div style="width:100%;height:100%" xmlns="http://www.w3.org/1999/xhtml">

   <div style="width:100%;height:100%" id="moveArea">

    <div

style="position:absolute;top:20px;left:20px;height:40px;width:40px;background-

color:green;border-radius:50%" id="myMovable"/>

   </div>

  </div>

 </foreignObject>

 <script type="text/ecmascript"><![CDATA[

 webMI.addOnload(function(){

   var myMovableElement = document.getElementById("myMovable");

   var myMoveArea = document.getElementById("moveArea");

   var myMovableElementCenter = 20;

   webMI.addEvent("moveArea","mousemove",function(e){

      var myMoveAreaOffsetLeft = webMI.gfx.getAbsoluteOffset("left", true,

myMoveArea);

      var myMoveAreaOffsetTop = webMI.gfx.getAbsoluteOffset("top", true,

myMoveArea);

      var point = webMI.gfx.scaleEventCoordinates(myMoveArea, e.clientX,

e.clientY, true);

      myMovableElement.style.left = (point.x - myMoveAreaOffsetLeft -

myMovableElementCenter) + "px";

      myMovableElement.style.top = (point.y - myMoveAreaOffsetTop -

myMovableElementCenter) + "px";

   });

});]]></script>

</svg>

By calling the „scaleEventCoordinates“ method, the passed coordinates are converted (scaled)
onto the „moveArea“-element and with the help of „getAbsoluteOffset“, the “real” offset of the
current HTML element (relative to the HTML body) can be subtracted.

Coordinate correction using setScaledEvents

The usage of the „setScaledEvents“ method is intended for external libraries that access event
coordinates. Anyway, it is also possible to use it for your own display code:

<?xml version='1.0' encoding='UTF-8' standalone='no'?>

<svg height="680" xmlns:atv="http://webmi.atvise.com/2007/svgext"

xmlns="http://www.w3.org/2000/svg" width="1280" version="1.2"

xmlns:xlink="http://www.w3.org/1999/xlink">

 <defs/>

 <metadata>

  <atv:gridconfig enabled="false" gridstyle="lines" height="20" width="20"/>

  <atv:snapconfig enabled="false" height="10" width="10"/>

 </metadata>

 <foreignObject height="680" y="0" x="0" width="1280" id="id_0">

  <div style="width:100%;height:100%" xmlns="http://www.w3.org/1999/xhtml">

   <div style="width:100%;height:100%" id="moveArea">

    <div

style="position:absolute;top:20px;left:20px;height:40px;width:40px;background-
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color:green;border-radius:50%" id="myMovable"/>

   </div>

  </div>

 </foreignObject>

 <script type="text/ecmascript"><![CDATA[

 webMI.addOnload(function(){

   var myMovableElement = document.getElementById("myMovable");

   var myMoveArea = document.getElementById("moveArea");

   var myMovableElementCenter = 20;

   webMI.gfx.setScaledEvents(myMoveArea);

   webMI.addEvent("moveArea","mousemove",function(e){

      var myMoveAreaOffsetLeft = webMI.gfx.getAbsoluteOffset("left", true,

myMoveArea);

      var myMoveAreaOffsetTop = webMI.gfx.getAbsoluteOffset("top", true,

myMoveArea);

      myMovableElement.style.left = (e.clientX - myMoveAreaOffsetLeft -

myMovableElementCenter) + "px";

      myMovableElement.style.top = (e.clientY - myMoveAreaOffsetTop -

myMovableElementCenter) + "px";

   });

});]]></script>

</svg>

Would we deal with an external library here, the eventlistener for the „mousemove“ event would
be processed within that external library. In this case we are calling „getAbsoluteOffset“ to get
the correct offset, also under different scaling conditions. Would an external library calculate this
offset by adding up offsets of every parent element, then the parameter „useUnScaledOffset“
could be used to compensate this behavior, as it does not respect scaling factors. It can also be
necessary to alter the invocation of the „getBoundingClientRect“ method, to use the webMI
equivalent instead.

Coordinate correction using getAbsoluteScaleFactor

Should it be necessary to correct event-coordinates on your own, you can do this as follows:

<?xml version='1.0' encoding='UTF-8' standalone='no'?>

<svg height="680" xmlns:atv="http://webmi.atvise.com/2007/svgext"

xmlns="http://www.w3.org/2000/svg" width="1280" version="1.2"

xmlns:xlink="http://www.w3.org/1999/xlink">

 <defs/>

 <metadata>

  <atv:gridconfig enabled="false" gridstyle="lines" height="20" width="20"/>

  <atv:snapconfig enabled="false" height="10" width="10"/>

 </metadata>

 <foreignObject height="680" y="0" x="0" width="1280" id="id_0">

  <div style="width:100%;height:100%" xmlns="http://www.w3.org/1999/xhtml">

   <div style="width:100%;height:100%" id="moveArea">

    <div

style="position:absolute;top:20px;left:20px;height:40px;width:40px;background-

color:green;border-radius:50%" id="myMovable"/>

   </div>

  </div>

 </foreignObject>

 <script type="text/ecmascript"><![CDATA[

  webMI.addOnload(function(){

   var myMovableElement = document.getElementById("myMovable");



167Reference manual

© 2018 Certec EDV GmbH

   var myMoveArea = document.getElementById("moveArea");

   var myMovableElementCenter = 20;

   webMI.addEvent("moveArea","mousemove",function(e){

    var myMoveAreaOffsetLeft = webMI.gfx.getAbsoluteOffset("left", true,

myMoveArea);

    var myMoveAreaOffsetTop = webMI.gfx.getAbsoluteOffset("top", true,

myMoveArea);

    var reverseScaleFactor = 1/webMI.gfx.getAbsoluteScaleFactor(true,

myMoveArea);

    myMovableElement.style.left = ((e.pageX - myMoveAreaOffsetLeft)

*reverseScaleFactor – 

myMovableElementCenter) + "px";

    myMovableElement.style.top =  ((e.pageY - myMoveAreaOffsetTop)

*reverseScaleFactor – 

myMovableElementCenter) + "px";

   });

 });]]></script>

</svg>

By the invocation of the „getAbsoluteScaleFactor“ method, the absolute (multiplicated) scaling
factor gets returned and therefore it is possible to convert the coordinates pageX and pageY with
the help of „getAbsoluteOffset“.

Relation between SVG- und viewport coordindates

In web technology there is a general difference of coordinates within an SVG element (user
coordinates) and the coordinates that are relative to the browser window, the viewport coordinates:

Viewport coordinates (DOC) and user coordinates (SVG)

The relation of the two different coordinate systems is defined through an object (matrix), which can
be retrieved in JavaScript by calling the getScreenCTM method. The webMI library provides an 
extended „getScreenCTM“ method  to cover atvise specific use cases.

getScreenCTM()

A simple use case is a slider, that is projected as an SVG element within a display:
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webMI.addEvent("mySliderKnob", "mousemove", function(e) {
  var p = webMI.gfx.createPoint(e.clientX, e.clientY)
    .matrixTransform(webMI.gfx.getScreenCTM().inverse());

  //p.x, p.y -> move slider-knob accordingly
});

getScreenCTM(true)

The “true”-parameter makes sense in combination with a foreignobject element, which represents
a drop-down-list. This drop-down-list should be positioned in the HTML element
"#mainContainer". Point of origin for the calculation is a fixed point within the SVG coordinate
system of the display:
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To be able to show the drop-down-list at the correct position, the SVG offsets must be multiplied
with any scaling factors. This behavior can be reached by the usage of the parameter “true”.

var p = webMI.gfx.createPoint(svgPointX, svgPointY);

//transform up to #mainContainer – consider scalefactors
p = p.matrixTransform(webMI.gfx.getScreenCTM(true));

webMI.display.showPopup(p.x, p.y, menuObj);

getScreenCTM("subDisplayID")

Usually the webMI method „getScreenCTM“ always returns the corresponding matrix of the
respective context. This means, when the call of the method is projected in the display code, the
matrix is always calculated in the context of the display on which the call was actually projected
in. Even if the respective display is displayed within a different display as "sub-display":
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In order to read the matrix for the sub-display from the display code of the main-display, the
method must be called with the #ID of the sub-display.

var matrix = webMI.gfx.getScreenCTM("sub_display");

getScreenCTM("foreignObjectID")

If the ID of a foreignobject is passed, the returned matrix can be used to transform coordinates
that originate from an event of a foreignobject into coordinates for the SVG element of a display:
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//e.clientX/Y: HTML-Body-Coordinates
var offset = webMI.gfx.createPoint(e.clientX, e.clientY)
  .matrixTransform(
    //transform into SVG-part of display
    webMI.gfx.getScreenCTM("foreignObjectID").inverse()
  );
//-> offset: SVG-Coordinates

If corrected coordinates are requested using webMI.gfx.setScaledEvents , the clientX and
clientY values of the "atviseOriginalEvent" must be used.
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Tabhandler
The Tab Handler Quick Dynamic enables to switch between object displays (e.g. input-/output
elements, buttons) in the visualization without having to use the mouse.
Like in other applications this works with the tab key to switch to the next object display. With the
Shift-Tab combination the previous object display can be selected.

To define a certain order, the tab index parameter in the "Option" group of the atvise standard object
displays has to be set. This parameter is an integer number. If no tab index parameter was set,
switching between the object displays happens according to the order the object displays were put
on the display in the atbuilder. The same order applies, if the tab index parameter of several object
displays was set to the same value.

The return key is used to confirm input values or to perform typical functions related to the return key
like pressing a button.

Note: Usually, the button "Button" fires a trigger called "click". When using a button
with a dynamic the trigger name has to be set to "clicked" at the item "1. Event" in
the simple dynamics dialog. After this an action can be defined which will be called
when the enter key is pressed. I.e., using a button which calls an action when
pressing the enter key can only be used with the event "Trigger" and when the trigger
name is set to "clicked".

The following list shows how the object displays can be used with the keyboard:

Button: return key
Button Image Display: return key
Button Increment/Decrement: return key
Button Open Display: return key
Button Set Address: return key
Button Switch: return key
Checkbox: return key, space
Clickarea: return key
Combobox: open the dropdown list (return key, space bar), close the dropdown list (escape key)
In/Out Value:
o Parameter – allow direct input set to „yes":  typical use of return key to confirm and space bar to

insert spaces.
o Parameter – allow direct input set to „no": return key und space bar open input dialog.

Picker Address: return key opens the input dialog and space bar opens the context menu.
Picker Color: return key and space bar open the Color picker dialog.
Picker Date: return key and space bar open the Date picker dialog.
Picker Value: return key and space bar open the input dialog; cursor up and cursor down keys
change the value.
Radiobutton: return key, space bar
Rocker Switch (small & large): return key and space bar open the input dialog; cursor up and
cursor down keys change the value.
In/Out Date: tab key and Shift-Tab switch between the single rocker switches; cursor up and
cursor down keys change the value (the same applies to In/Out Date-Time and In/Out Time).

Note: The context menu of the combobox and of the button „Picker Address" cannot be operated
with the keyboard.
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Disable Tabhandler

In case that you want to use foreignobject and svg input elements combined on a display you will
have to deactivate the tab handler functionality as the tab handler only supports svg elements. (e.g. if
you do not deactivate the tab handler functionality, pressing „return" in a foreignobject element will
not work.)
Deactivation: Simply open your default display and then select the „Tab Handler" from the Quick
Dynamics dropdown menu located in the toolbar. There the opportunity is given to deactivate the tab
handler.

Foreignobjects specifics

The functionality of defined keys has been deactivated by default. Otherwise an undesired behaviour
could be caused. (e.g.: backspace key - if pressed, while an SVG element is focused it would cause
a step backwards in the browser history). There are two opportunities given to handle foreignobjects
specifics:

Tab Handler is not required: 
simply deactivate the tab handler on the default display. Afterwards all defined keys will work
perfectly in combination with html input elements.

Tab Handler and html Input elements are required: 
in this case the method setAcceptKeys() can be used. Via a boolean parameter the function can
be instructed to activate/deactivate the following keys:

o KeyCode 9 - Tabulator

o KeyCode 13 - Enter

o KeyCode 27 - Escape

o Keycode 8 - Backspace

Explanation: In case that a html input element is being clicked, e.g. the backspace key should be
activated and when it loses the focus the backspace key has to be deactivated immediately.

How-To
Example for a html input element with the ID: "myInput":

var tabHandler = webMI.callExtension("SYSTEM.LIBRARY.ATVISE.QUICKDYNAMICS.Tab
Handler");
var myInput = document.getElementById("myInput");
myInput.onclick = function() {

tabHandler.setAcceptKeys(false);
}
myInput.onblur = function() {

tabHandler.setAcceptKeys(true);
}
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Highcharts Trend
The new chart components are based on the „Highcharts“ library and succeed the currently used
EJSCharts trend, whereas Highcharts is provided additionally to EJSCharts to ensure backwards
compatibility. Please note: The EJSCharts trend will not be further refined. It‘s strongly
recommended to use the Highcharts components!

In the project tree and the library beneath the design area in atvise builder the folder „ATVISE“ can be
found. Therein every style (in the project tree below the folder „Object Displays") contains the sub
folder „highcharts" which contains several object displays for creating customized chart variants. On
right click on an object display the relevant help sheet is opened, where a detailed description will
help you choosing the right display for your purpose.

The chart can view live and historic (only with atvise scade) data simultaneously. To view historized
data of a certain time period, the nodes to be acquired have to be defined as described in chapter 
atvise builder - Historizing data . 

Brief description of the most important object displays

Main display

The main display with its modules is the most considerable part. This object display joins several
objects of the „highcharts“ folder together. It consists of the „Chart container“ (the chart view), the
„Legend table“ (table showing the data sets) and the „Toolbar“.

Toolbar

This display provides tools for controlling the chart. It offers control of the view mode (live mode),
visibility of both measurement cursors and the possibility to open the configuration dialog.

Chart container
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The „Chart container“ displays a chart and the raw and aggregate values of a node. The nodes are
added by display parameters in atvise builder or by using the configuration dialog. This display can
be used alone or in combination with the toolbar display and/or the legend display.

Legend table

The legend shows information about the data presented in the chart in the form of a table. Important
settings such as color and visibility can be altered here directly.

Configuration dialog

The configuration dialog consists of several displays. The “Top display” acts as main display and
offers the possibility to change between the following displays: „Data“, „X-Axis“, „Y-Axis “, „General“
and „Load / Save“.

Within the „Data“ display the two chart types „Line/Area“ and „Column“ in different forms can be
chosen. A pie chart is not supported currently.

Configuration of a Chart

The configuration dialog offers the possibility to make changes directly in the visualization.
Alternatively, the most important settings can also be edited via the parameters in the atvise builder
(limited to line charts). The configuration dialog can be opened via the „Toolbar“ display, therefor the
parameters of the “Toolbar” and the “Chart container” have to be linked to the same chart name.

Changes made in the configuration dialog are directly applied to the chart instance and can be
viewed by clicking the „Preview“ button or pressing the „F2“ key on the keyboard. If a configuration is
saved under a defined name to a defined node in the „Load / Save“ display, it will be available to all
users and across all systems. This configuration node as well as its configuration name must be
defined in the display parameters in the atvise builder to have it loaded on the next activation of the
visualization.
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Additionally the configuration is saved under the name „autosave“ after each alteration. This protects
against configuration losses at possible system crashes. By using the „Quicksave“ button the
current configuration is saved under the specified node with the specified name (specified in the
display parameters). Please note: Configurations with the same name on this node will be
overwritten!

Further information for highcharts can be found on www.highcharts.com. The highcharts API
reference documentation can be downloaded here:
https://code.highcharts.com/zips/Highcharts-6.0.4.zip

Extended developer documentation for the atvise specific API of the integration of highcharts with a
description of the classes and modules (trendFactory, MeasuringCursor, DataHandler, Datasource,
Legend, Renderer, Utils) is available on request from the sales or support team.

https://www.highcharts.com
https://code.highcharts.com/zips/Highcharts-6.0.4.zip
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EJSCharts Trend (deprecated)

Beginning with atvise version 3.2, the EJSCharts trend is deprecated. You can still
use it in your projects, but we recommend to use the new Highcharts Trend
instead.

Configure a trend

Located in the atvise builder you will find within the project tree as well as in the library below the
drawing area the folder "atvise". Herein the appropriate sub-folder "trend" contains the different object-
displays that are used to create tailor-made flexible trend variations.

The largest is the "Main Trend Display" and its modules. This object display is assembled out of
several objects from the subfolder "trend" and consists of the "trend" (graphical trend display), of the
"trend nodes table" (display of the selected nodes) and the "trend config menu".

By clicking and using the right mouse button on an object display, a "Help" function is offered that
provides detailed information on the respective display and facilitates the selection.
The trend in the browser can display live as well as historical data (only with atvise scada). In order
to view historical data over a certain period please follow the instructions in the chapter "atvise builder
– History Archives ", how to select the data-points in order to be displayed in the trend.

The most important trend configuration and adaptation
options of the relevant object-displays

Here is a brief description of the main configuration options:

Trend (Chart)

When using the Object Display "trend" and "trend including control buttons" in the atvise builder
the following properties can be selected and changed individually within the attributes area:

1. In the field "parameters" data points and data archives, which shall be displayed can be
selected among other options.

Note: You can view several trends in a display. This requires using the same trend groups
(ID) of the corresponding display (trend, trend nodes table, button start / stop, etc.), which
can be set in the parameters section.

2. "Time Axis": here, the time format to be changed. For example in order to display seconds
the preset can be changed to the format HH:MM:SS.

3. "Time Buttons": making visible of forward / backward buttons on the chart.

4. Among other things axe labeling can be chosen and user rights can be set as requested.

174
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Trend Menu Display

Here the functionality of the "trend config menu" and its display modules are described.

Note: These functions can be found partly in the other offered trend object-displays. 
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1 List/CSV

Additional display options of the selected trend configuration.

The CSV button is for exporting data in CSV data format. If the server supports server
scripts a CSV file will be downloaded. If no server scripts are supported a pop up will
appear to download the data via copy&paste.

Note: The CSV Button will be automatically disabled on mobile devices due to
inconsistent behaviour on mobile browsers.

2 Start/Stop

Starts or stops displaying the selected trend configuration.

3 Trend configuration

You can save trend configurations and remove the same.

Note: trends tend to lose their settings when changing displays. Therefor it is of
advantage to store the trend settings.

Note: webMI projects only support this function, if a string variable with sufficient length
(greater than 255 characters) is ??supported by the control side of the project.

4 Time configuration

There are two choices: select a timespan of the historical data you want to display or watch
the live data according to the time period you have chosen.

5 Node Configuration

Here you can choose the most important options for the appearance of the selected node in
the chart.
Please note that when selecting a node this has to be confirmed by clicking the button "Add
node" in order to be displayed!

Note: Does not work with atvise webMI. Nodes can only be directly addressed in the
trend chart within the attribute section of the builder (trend and trend with control
button).

6 Aggregate

If you want to show aggregated values, you can select the desired aggregate function and
interval here.

Note: Aggregated values cannot be displayed "live". To refresh the trend and show new
values you must restart the trend configuration (see point 2).

7 non-stop

The trend will be extended with a horizonzal line from the start and end value up to the start
and end of the trend display.
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Trend Legend

Is used to display the selected data points, with the possibility to manipulate the appearance
and deselect nodes as needed.

Trend legend with an example for displaying one selected node.

Querylimit (scada only) 

The amount of history records which are sent from the atvise server to visualiaztion is limited by a
constant parameter "querylimit". Per default, this querylimit parameter is 10.000, to change this
number add the following two lines in the atserver.ini file in your project directory:

[history]
querylimit=nnn

nnn is an integer (e.g. 20000) specifying the maximum amount of records sent from the atvise
server to the browser. If more than nnn records would be available "truncated...." is shown in the
top right  corner of the trend.
If nnn is set to 0, no limit is active and all records will be transferred.
If no querylimit parameter is specified, a default value of 10000 is assumed and no more than
10000 records are transferred from the atvise server to the browser. 



182 atvise® - documentation

© 2018 Certec EDV GmbH

Tooltips
The following object displays contain a parameter „tooltip":

Button
Button Image Display
Button Increment/Decrement
Button Open Display
Button Set Address
Button Switch
Checkbox
Clickarea
Combobox
In/Out Value
Picker Address
Picker Color
Picker Date
Picker Value
Radiobutton
Rocker Switch (small & large)
In/Out Date
In/Out Date-Time
In/Out Time

If this parameter is specified, the related tooltip is shown in the visualization. The tooltip will be
shown in the language according to language selected in the visualization.
The tooltip supports multiline and may contain HTML tags (e.g. line break, bullet list)
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Consistency handler
The Quick Dynamic „Consistency Handler" allows to define a group of object displays when creating
a display, whose variables will be consistently read form or written to the PLC. The object displays
(related variables) can be grouped by the display parameter "consistency group" (in the group
"Options"). Afterwards the Object Display "Button" can be used to consistently write these Object
Displays (related variables) to or read them from the PLC.

Therefore the following parameter of the Object Display "Button" in the parameter group
"Consistency" has to be set:

group: name of the consistency group (according to the group of the Object Displays)
function: Function (read/write), which will be executed on click, as far as a group is specified
(standard: write)

At the first display load, the parameterized group of Object Displays (related variables) are
consistently read.

The following Object Displays support the consistently read and write of variables:

Checkbox
Combobox
In/Out Value
Picker Address
Picker Color
Picker Date
Picker Value
Radiobutton
Rocker Switch
Rocker Switch small
In/Out Date
In/Out Date-Time
In/Out Time
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Preloading
Mainly preloading reduces time when switching displays on slower devices. If preloading is enabled,
all displays will be preloaded first. When switching a display the SVG does not need to be fetched
from the server. Instead the old display gets hidden and new one unhidden.

Basically the preloading function can be activated by adding the URL parameter „preload=true" or
preload=false&includePreload[]=desired Display or folder

Only displays under the folder "DISPLAYS" will be preloaded (e.g. no alarmlist or
historylist included):

For example: 

http://127.0.0.1:88/?preload=true.

In the case that only few displays should be preloaded, the opportunity is given to set the preloading
parameter to the value „false" and to add individual displays, which should be preloaded by including
them with the URL parameter "includePreload[]".

For example:

http://127.0.0.1:88/?preload=false&includePreload[]=AGENT.DISPLAYS.Main&includePreload[]
=AGENT.DISPLAYS.MAIN.2 . 

In this case the following displays would be preloaded:

AGENT.DISPLAYS.Main
AGENT.DISPLAYS.MAIN.2

In the case that only few displays should be excluded from preloading it is possible to set the
preloading parameter to the value „true" and to exclude individual displays, which should not be
preloaded by using the URL parameter "excludePreload[]".
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For example:

http://127.0.0.1:88/?preload=true&excludePreload[]=AGENT.DISPLAYS.MAIN.2&excludePreload[]
=AGENT.DISPLAYS.MAIN.3&excludePreload[]=AGENT.DISPLAYS.MAIN.4 . In this case the
following displays would not be preloaded:

AGENT.DISPLAYS.MAIN.2
AGENT.DISPLAYS.MAIN.3
AGENT.DISPLAYS.MAIN.4

Please note that the preloading functionality is memory intensive.

For example:

http://127.0.0.1:88/?preload=true&excludePreload[]=AGENT.DISPLAYS.MAIN

Here you can disable preloading for the whole folder "MAIN".

For example:

If you have two different default displays with two different main content displays you can decide
which one you want to preload:

http://127.0.0.1:88/?defaultdisplay=Default2&preload=true&excludePreload[]
=Default&excludePreload[]=Main
or
http://127.0.0.1:88/?defaultdisplay=Default2&preload=false&includePreload[]
=Default2&includePreload[]=Main2

You have to exclude the default displays or include Default2 and Main2.

If you want to have more than one default display, the name of the main
content iframe on EACH default display has to be named "content".
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URL parameters
useSVGKeyboard
With the help of the URL parameter „useSVGKeyboard"  the following input elements can be globally
set to the svg-input mode:

picker_address
picker_value
rocker_switch
rocker_switch_small
in_out_value

This will also work with all displays in which the above mentioned input elements are being used
referenced. 

Example: http://127.0.0.1/?useSVGKeyboard=true

With this example all mentioned input elements would open the SVG-Keyboard on the click event.

preload, excludePreload, includePreload

Preloads displays before showing the visualization to switch displays faster on slower devices.

This parameter has it's own topic .

autofit

Fits a display automatically to the browser window. Parameters can be "true" or "false".

Example: http://127.0.0.1/?autofit=true

defaulturl

The defaulturl parameter is used to target any URL in popups. The functionality is included in the
webMI.display.openWindow function.

Because of security reasons defaulturl can not be used in the main display anymore.

Example: webMI.display.openWindow({extern:true,height:500,title:"",toolbar:false,url:"http://
atvise.com"});

defaultdisplay

You can define a display which should be loaded as default display.

Only displays within the folder AGENT.DISPLAYS can be set as default display. You don't have to
declare the whole path to the display. Simply use the display name.
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Example: http://127.0.0.1/?defaultdisplay=Default2

scrolling

With this parameter you can define the scrolling parameter for the main iframe. Values can be
"auto", "yes", "no".

Example: http://127.0.0.1/?scrolling=no

language

Defines the default language for the visualization. The language you want to set must exist in your
project.

Example: http://127.0.0.1/?language=en

viewportwidth - deprecated

Deprecated - with version 3.0 the viewportwidth parameter is obsolete and will
be ignored, the value will be set automatically to the device width.

Defines the width in pixel of viewport (width of the visualiaztion resp. width of the default display) and
is only applicable for Apple iOS6 devices (iPad, iPhone).

Example: http://127.0.0.1/?viewportwidth=1280
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webMI events
The webMI library is triggering the following events, which can be handled with event listeners:

Event Description

clientvariableschange language switch, user login, etc. are performed

serverstatechange returns the status of the servers in redundancy mode

servertimeoffsetchanged offset of server time has changed

statechange returns the connection status to the server

requesttimeout fired if a request was not responded

The functionality of the event listeners is described in webMI.data.addEventListener .
477
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Timer

Note: The Timer can not be used with atvise webMI

Located in atvise builder you will find within the project tree as well as in the library below the drawing
area the folder "atvise". Here, the appropriate sub-folder “timer” contains the relevant object display.

The timer display embraces a „Scheduler List“ with filter options and a button „Add new/edit event“ to
add or edit events at the „Scheduler List“.

The „Scheduler List“ displays all events which where configured using the „timer“.

Configuration

timer configuration node: 
Default =„AGENT.OBJECTS.TimerConfig“: includes the timer configuration (added events).

timer id: 
This is the unique id for each "timer" object display. Moreover it is necessary if you use more than
one "timer" object display. Otherwise you will see all added events at the second "timer" object
display too.

Variable start address: 
Default = „AGENT.OBJECTS“. Location from where the existing nodes can be chosen in the timer.

Timer step interval: 
Default =  „5“ (min). Interval to choose start time of events.

Security

necessary right: 
The right which is necessary to use the "timer" object display in the visualization.

activation address: 
if the value of this address equals to "activiation value", then the timer will be active and can be used.

activation value: 
Value which activates the control.

Scheduler list

Schedule List Filter options
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Start from: 
Date to filter all events with a first occurrence that is later then the selected start date. 

Start to: 
Date to filter all events with a first occurrence that is earlier then the selected start date. 

End from: 
Date to filter all events with a last occurrence that is later then the selected end date.

End to: 
Date to filter all events with a last occurrence that is earlier then the selected end date.

Address: 
Used to filter a specific address.

Status: 
Filter all events according to the selected status.

Button  „Apply“: 
Button that activates the selected filter options.

Button „Reset“: 
Button to reset the filter options.

Schedule List colums

#: 
Unique IDs of events in the „Scheduler List“.

Recurring: 
Show the Recurring of an event (daily, weekly, monthly & yearly).

First occ.:
Date of the first occurence of an event.

Last occ.:
Date of the last occurence of an event.

Start time:
Start time of an event.

Duration (min):
Duration of an event in minutes.

Description:
Description of an event.

Node:
Selected node which changes its value at the start and end of an event.

Value on:
Value on which the node will be set at the start of an event.
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Value off:
Value on which the node will be set at the end of an event.

Status:
Shows the state of an event (active: if the event runs again, inactive: if the event has finished)

Action:
The possibility to edit an event.

Button „Add new / edit“ events:
Button to add or edit an event in the Scheduler List. If you push the button a calender, called
„Timer Scheduler“ will open at the display.

Timer Scheduler

The „Timer Scheduler“ is a calender which represents a daily/weekly/monthly view and also shows all
created events. You are able to create a new event by clicking and dropping down at a day in the
„Timer Scheduler“. The actual day and time will also be marked in the „Timer Scheduler“.

If you use different timer IDs the „Timer Scheduler“ only shows the events from the corresponding
"timer".
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Description of the buttons

Today:
Button to skip to the current day.

Arrow left/right:
Button to switch from day/week/month to the next day/week/month or to the last day/week/
month.

Save:
Button to save the created/edited events. (First you have to add and save an event and then save
the Timer Scheduler with this button)

Day:
Button to show the calender in the daily view.

Week:
Button to show the calender in the weekly view.

Month:
Button to show the calender in the monthly view.

Add a new event

Add a new event by clicking on a date in the “Timer Scheduler”.
Another dialog will be opened in which all relevant settings can be configured.
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Description of the settings for an event

Description:
A Text which describes the event. This text will also be displayed in the calendar at the
corresponding event. 

Status:
The state for the event. If you select the checkbox “Active” the event will be activated otherwise the
event will be deactivated.

Variable:
The address on which the start value and end value will be written. Only the variables from the
“Variable start address” will be shown in the dropdown list in the section “Variable”.

Repeat event:
It is possible to repeat an event with following options:

daily
o Every day: The event is triggered every day.

o Every workday: The event is triggered every workday (Mo, Tue,We, Thu, Fr).

weekly
o Repeat every week at following day [Mo, Tue,..] : The event is triggered every week at the

selected day.
monthly
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o Repeat [1,2,3,. ] day every month: The event is triggered every month at the [first, second,

third,.. ] day of the month. 
yearly
o Every [1,2,3,..] day at month [January, February,..]: The event is triggered every [first, second,

third,..] day at the selected month.

 
Settings to complete an event

No end date: The event has still not finished.
After [1,2,3,..] occurrences : The event ends after the selected number of occurrences.
End by [01.01.2012] : The event ends at a defined date.

Time period:
Starting date: The starting date of the event.
Starting time: The starting time of the event.
Duration (in min): The duration in minutes of the event.
Full day: With this option the event runs the whole day.

Value:
Start Value: The value which will be written on the selected variable at “Starting date & Starting
time”.
End Value: The value which will be written on the selected variable at the end of the chosen
duration.

Button “Enabled/Disabled”:
Button to enable/disable the “Repeat event” index for an event.

Button “Save”:
Button to save the event to the calendar.

Button “Cancel”:
Button to cancel the event without saving the event to the calendar.

Button “Delete”:
Button to delete the event from the calendar.

Attention: The event is stored or deleted at the calendar but not at the Scheduler
List. Therefore click also the “Save” – Button at the Timer Scheduler.
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Table
table filter

The following chapter gives an overview of the different filter types, which are supported by the
table quickdynamic. 

matches
This filter checks if the searched value matches exactly to a value existing in the table.
Before the comparison the search value as well as the values in the table will be converted to a
string.

Wildcard-support: yes.
Based-on: the text attribute of a cell.

Examples:

Searching for "house" | in the table exists "House" : search unsuccessful
Searching for "house" | in the table exists "house" : search successful
Searching for "house" | in the table exists "houseboat" : search unsuccessful

contains
This filter checks if the searched value is being partially contained by a value existing in the
table. Before the comparison the search value as well as the values in the table will be converted
to a string and both will be compared written in lower case.

Wildcard-support: yes.
Based-on: the text attribute of a cell.

Examples:

Searching for "house" | in the table exists "House" : search successful
Searching for "house" | in the table exists "houseboat" : search successful
Searching for "house" | in the table exists "house" : search successful
Searching for "fa" | in the table exists "false" : search successful
Searching for "8?" | in the table exists "8" : search unsuccessful
Searching for "8*" | in the table exists "878" : search successful
Searching for "T*E" | in the table exists "table" : search successful

valuecontains
This filter checks if the searched value is being partially contained by a value existing in the
table. Before the comparison the search value as well as the values in the table will be converted
to a string and both will be compared written in lower case.

Wildcard-support: yes.
Based-on: the value attribute of a cell.

Examples:

Searching for "house" | in the table exists "House" : search successful
Searching for "house" | in the table exists "houseboat" : search successful
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Searching for "house" | in the table exists "house" : search successful
Searching for "fa" | in the table exists "false" : search successful
Searching for "8?" | in the table exists "8" : search unsuccessful
Searching for "8*" | in the table exists "878" : search successful
Searching for "T*E" | in the table exists "table" : search successful

greaterEqual
This filter checks if the values in the table are equal to or greater than the searched value. Before
the comparison the values will be converted to a floating-point number using parseFloat.

Wildcard-support: no.
Based-on: the text attribute of a cell.

Examples:

Searching for "3" | in the table exists "5" : search successful
Searching for "5" | in the table exists "5" : search successful
Searching for "55" | in the table exists "5" : search unsuccessful

lowerEqual
This filter checks if the values in the table are equal to or lower than the searched value. Before
the comparison the values will be converted to a floating-point number using parseFloat.

Wildcard-support: no.
Based-on: the text attribute of a cell.

Examples:

Searching for "3" | in the table exists "5" : search unsuccessful
Searching for "5" | in the table exists "5" : search successful
Searching for "55" | in the table exists "5" : search successful

greaterThan
This filter checks if the values in the table are greater than the searched value. Before the
comparison the values will be converted to a floating-point number using parseFloat.

Wildcard-support: no.
Based-on: the text attribute of a cell.

Examples:

Searching for "3" | in the table exists "5" : search successful
Searching for "5" | in the table exists "5" : search unsuccessful
Searching for "55" | in the table exists "5" : search unsuccessful

lowerThan
This filter checks if the values in the table are lower than the searched value. Before the
comparison the values will be converted to a floating-point number using parseFloat.

Wildcard-support: no.
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Based-on: the text attribute of a cell.

Examples:

Searching for "3" | in the table exists "5" : search unsuccessful
Searching for "5" | in the table exists "5" : search unsuccessful
Searching for "55" | in the table exists "5" : search successful

beforeEqual
This filter checks if a date in the table exits equal to or before the searched date. An internal
parseDate is being performed before the comparison.

Wildcard-support: no.
Based-on: the text attribute of a cell.

Example:

Searching for "Wed Nov 28 2012 14:45:12 GMT+0100" | in the table exists "Wed Nov 28 2012
11:07:11 GMT+0100" : search successful

afterEqual
This filter checks if a date in the table exists equal to of after the searched date. An internal
parseDate is being performed before the comparison.

Wildcard-support: no.
Based-on: the text attribute of a cell.

Example:

Suche nach "Mon Nov 28 2011 14:51:35 GMT+0100" | in der Table steht "Wed Nov 28 2012
11:07:11 GMT+0100" : search successful

Attention: 
beforeEqual and afterEqual work exact to the second. (not exact to the ms)

Explanation of the sections "based-on"
Every cell in the atvise table can have a "text" attribute as well as a "value" attribute. A cell in
source code looks as follows:

var datarow = [
[{name:"index", text:++i, fontColor:"#ababab"}, {
name:"name", text:"8", fontColor:"#ababab",
value:"acht"}]

];

This could can be interpreted as follows:

In the array named datarow we have an array for each row. The objects inside, represent the
columns for the corresponding row.
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name : describes what is being represented by the cell value (in this case it would be an
index).
text : this is the value displayed in the cell.
fontColor: represents the font color for the text.
value: a cell could also have a value, which will not be displayed. (the filter valuecontains is
based on this value)

Explicit search for the characters "?", "*", and "\"
If it is required to search for a question mark, star or a backslash, so it is required to escape
these characters. This is being done by a backslash "\" written in front of the desired character.

Attention: 
If it is being searched for a "\" by typing "\\", so it is not possible to use a wildcard (* or ?)
immediately afterwards, as the backslash has been escaped.

atviseTable.dataExportCSV()

This chapter generally describes the csv export functionality of the atvise table quickdynamic.
The csv export is mostly being used for storage or for the movement of structured data between
tables. 

The dataExportCSV method was developed based on the RFC 4180, as there is no official
standard for CSV. Particular attention should be paid to the aspects listed below.

Basic rules

Records are being separated by a line break. (attention: Therefore it is not allowed to use the
line break as the separator for columns).
For the separation of columns within the records basically the comma is being used. An
individual separator can be specified when calling the dataExportCSV() method. (example in
How-To below) 
In order to be in a position to use the separator for columns within the data, the atvise table
escapes the separator with a single quote ("). (attention: Therefore it is not allowed to use the
quote as the separator for columns).
If the table consists of a header, so the header content will be the first row, which describes
the column definitions.
It is recommended, that each record should have the same amount of columns.
Whitespaces are considered to be part of the cell and therefore will not be ignored.

How-To
The following example describes how to use the atviseTable.dataExportCSV() method
in combination with a button (ID: "export") to write the csv data in a new window.

webMI.trigger.connect("clicked", function(e) { function
openEmptyWindow() { return webMI.display.openWindow({ 
extern:true,width: 600, height: 800 }).openedWindow; }
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var w = openEmptyWindow();
w.document.open();
w.document.write(table.dataExportCSV(";").replace(/\n/g,
"<br/>"));
w.document.close();

}, "export");
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atvise server
The atvise server is automatically registered as a service by the atvise setup.

Configuring atvise service

To configure the atvise server service behavior (manual/automatic startup, log on, auto recovery,...),
go to the Windows service center (Control Panel -> Administrative Tool -> Services) and right-click
the "atvise server" entry -> Properties.

Starting the atvise server in console mode

You can start the atvise server console manually by selecting "Programs-> atvise-> atvise server
(console mode)" from the Windows start menu or by directly launching the atserver.exe in your atvise
installation directory.

atvise server console commands

Type in a "?" character followed by the enter key to list all atvise server console commands.

atvise server console commands

Commandline parameters

/registerService Register the application as a service

/unregisterService Unregister the application as a service

/displayName=name Specify a display name for the service (only with /registerService)

/description=text Specify a description for the service (only with /registerService)
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/startup=auto|manual Specify the startup mode for the service (only with /registerService)

/help display help information

/port=portnr OPC UA port number

/http=portnr HTTP port number

/https=portnr HTTPS port number

/log=level log level (trace, debug, info, notice, warning, error, critical, fatal)

/boot boot (start) the project

/proj=dir project directory

/hardwarecode display hardwarcode

/checklicense check if there is a valid license file
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atserver.ini
The configuration parameters of the server can be specified in the file atserver.ini. The file is optional,
if it doesn't exist, default values will be used for all parameters.

The search order for atserver.ini will be read:

1. In the installation directory of atvise server, if it is not found there, in each parent directory it will

be searched continuously. The first found is used.

2. in %ALLUSERSPROFILE%\atvise

3. in the project directory

In each step, a atserver.ini file can be found. If one is found, it will be loaded. Settings from later

loaded ini files have priority over previously loaded files.

The format of the file is:

[section]
key = value
;this is a comment

The settings are organized in sections with the name of the section in brackets, e.g. [database].
Each setting is a key/value pair. A line starting with a semicolon is a comment.

Here is the description of the possible sections, settings and according default values:

[general]

loglevel = info
Note: Replaced by the "all" setting in the section [log].

tbbMaxThreadCount = number of logical CPU cores
The maximum number of threads to be used by the thread library.

[history]

datadir = database
Location of the history directory, where archive sets are stored. This setting may be specified as an
absolute or relative path. If given relative it will be located under the project path (nodes.db)

swapindir = swapin
Location of the history swap in directory, where read only archives may be placed. This setting may
be specified as an absolute or relative path. If given relative it will be located under datadir.

timetolerance = 300
Time interval in seconds which the system accepts for historising data and events where sourceTime
is in the future. Timestamps being newer than the currenttime + timetolerance will be rejected.

querylimit = 10000
The limit for the maximum number of results that the „queryFilter" and the "history.query" call
returns. All values above this limit will be truncated. Set to 0 for no limitation.



203Reference manual

© 2018 Certec EDV GmbH

The following configuration parameters apply to aggregating data :

aggregationCheckInterval = 30
Interval (in seconds) used to check whether aggregates have to be calculated. Lowest value allowed
is 1 second.

aggregationPeriodStartup = 7
Period (in days) for post-aggregation during start-up (up to and including first check according to the
entry “aggregationCheckInterval”). A value of 0 means no limit, i.e. the post-aggregation will be done
back to the last existing historized aggregate. Setting the value to -1 will deactivate this functionality,
i.e. no post-aggregation will be done during start-up.

reaggregationTolerance = 7
Limit (in days) in which a value change with a source time in the past will trigger a post-aggregation
considering the setting for the entry “reaggregationDelay”. If the value change is older than the
specified limit, no post-aggregation will be done. A value of 0 means no limit, i.e. any value change
with a source time in the past will trigger a post-aggregation. Setting the value to -1 will deactivate
this functionality, i.e. a value change with a source time in the past will never trigger a post-
aggregation.

reaggregationDelay = 300
Time span (in seconds) that will be waited before triggering post-aggregation, in case a value change
with a source time in the past was received. Additional older value changes that are received during
this time span can thus be combined and reduce the number of aggregation requests.

maxNrOfNodesPerAggregationRequest = 50
Number of different nodes which will be processed as part of an aggregation request. The entry is
ignored for aggregation intervals smaller than 10 minutes. In case of huge amounts of data to be
processed this setting can be decreased to lower memory utilization.

maxAggregationDelay = 1440
Time span (in minutes) to wait for the next value change (= "future bound" for the previous interval)
after an interval is elapsed, before an aggregate will be calculated in any case. If the specified value
is larger than the aggregation interval, the aggregation interval will be used. If setting the value to 0,
the aggregation interval will always be used. This entry only affects aggregates which are directly
based on raw values – chained aggregates are therefore not affected; they will be calculated as soon
as the interval is elapsed.

maxAggregationThreads = 1
Number of threads available for the parallel execution of aggregation requests. Setting the value to 1
will result in a sequential calculation.

[opcua]

hostname=
Allows to set the OPC UA hostname to a specific IP address. Can be used when a certain network
adapter wants to be used or in case of a faulty configured operating systems hostname.

port = 4840
OPC UA port for the atvise server
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enabletrace = false
Enable/Disable OPC UA tracing

pushedarraysize = 1000
Size of the project history‘s circular buffer

searchlimit = 1000
Maximum number of results for global search. Set to 0 for no limitation.

[mirror]

translateSingle = false
Resolve every single browse path in a separate call.

[script]

plugindir = ./plugins/v8/
Location of the v8 plugins directory
 
minthreads = 15
Minimum number of threads in the script thread pool
These threads are reserved in the process. If  the number of concurrent running scripts are less than
15, it is worth to reduce this number up to 10.
 
maxthreads = 20
Maximum number of threads in the script thread pool

[webaccess]

enablehttpparsedisplaygetvalues = true
Pass all GET parameters of the HTTP request to the generator 

fixedclients =
Comma ',' seperated list of clients (IP addresses) that can subscribe to an unlimited number of
nodes (no CCD counting)

httpport = 80
Specifies the http port of the atvise Webserver named 'http1'. This value cannot be changed during
runtime in the Webserver dialog. '0' disables the Webserver 'http1'.

httpsport = 443
Specifies the https port of the atvise Webserver named 'https1'. This value cannot be changed during
runtime in the Webserver dialog. '0' disables the Webserver 'https1'.

Following webaccess parameters are obsolete and are not supported anymore in the current version
of atvise. The settings can now be changed in the HTTP settings  dialog in the atvise builder.

loginmethod = 
requirelogin = 
private_key_file = 
certificate_file = 
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[log]

trace =
debug = 
info =
warning =
error =  
Comma ',' separated list of module names to set the given log level for these modules. If the module
name ends with a semi colon ';' the given log level will be set only for the module itself, otherwise for
all it's sub modules as well. Possible values are the names (case insensitive) of all modules and
submodules or the string 'all' which means that all modules will be set to this log level. The following

modules can be selected: ALARM, CNM, CONSOLE, CORE, GENERATOR, HISTORY, LICENSE,
MIRROR, RELMIRROR, SCRIPT, TASK, THREAD, WEBACCESS

filtert = 
filterd =
filteri=
filterw =
filtere =
A PCRE regular expression to filter the appropriate log level.

Example:

The redu manager and the log task will be switched to 'trace' level. Log entries on the log level
'warning' that contain the expression 'Long frame time' or originating from the 'SWITCHOVER'
manager will be not written into the log file. Log entries on the log level 'trace' and 'debug' from the
’REDU’ manager will be only written into the log file if they contain the expression 'Send.*status' or
'Got.*status': e.g. 'Send internal status'

[log]
trace = core.redu, core.logtask
filterw = ^(?:(?!Long frame time|SWITCHOVER).)*$
filtert = SYNC|REDU Send internal status|REDU Got internal status
filterd = SYNC
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atvise x64 setup
To enable the usage of atvise x64 server with OPC COM data sources, the following steps must be
completed:
 
1.) Deinstall all OPC Core Components previously installed - x64 and x86 as well.
2.) Download OPC Core Components x64 3.00 (105.1) or higher from http://www.opcfoundation.org.
3.) Install OPC Core Components x64 3.00 (105.1) or higher. This will install x86 version as well.
 
After the installation atvise server is ready for OPC COM data sources. No restart is needed.
The atvise builder will show the available OPC COM data sources

http://www.opcfoundation.org
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Default import and standard resources
General

When a new project is created, atvise is importing the atvise library from a set of XML files. Which
files are imported depends on the kind of your license. The XML files provided as part of the atvise
installation can be found in the sub-directory "defaultimport" of the installation directory (Windows)
respectively in "/usr/share/atvise/defaultimport" (Linux). Only files with the extension ".xml" are
considered.

The XML files in the "defaultimport" directory are always imported, regardless of the kind of your
license. If you have a "scada" license, the XML files in the "defaultimport/scada" directory are also
imported. If you have a "redundancy" license, the XML files in the "defaultimport/scada/redundancy"
directory are imported. Other directories are always ignored.

If you start a project that was created with a more restrictive license, the additional XML files
matching your current license are automatically imported. E.g. if you start a project that was created
with a "scada" license and you currently have a "redundancy" license, the XML files in the
"defaultimport/scada/redundancy" are imported.

Customer specific import files

If you have import files that should be imported into every new project on your PC, create a
"defaultimport" directory in the "%ALLUSERSPROFILE%/atvise" (Windows) respectively "/etc/atvise"
(Linux) directory and copy your files there. The sub-directories "scada" and "scada/redundancy" are
optional.

These XML files are imported after the files provided by atvise.

Project specific import files

Sometimes it is useful to prepare a directory for a new project where specific XML files should be
imported when the new project is started. In this case you can create a "defaultimport" sub-directory
in your project directory and place the XML files there. When you start your project the first time,
they will be imported. The sub-directories "scada" and "scada/redundancy" are optional.

These files are imported after all other files found in the directories described above. Note: If the
installation directory is used as the project directory, they will not be imported again.
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Statistics of atvise server
The internal statistics of atvise server can be accessed in the information folder of the project tree.

Information folder in the project tree

The statistic nodes can be viewed in the information folder in the project tree. In the visualization the
statistic nodes must be explicitly read and cannot be subscribed. 
 
The statistic nodes reflect internal states of modules and they cannot be written. The statistic nodes
of the modules may change dynamically depending on the module state. E.g. in the WEBACCESS
module the number of sessions and the statistics on each session may vary. 
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atvise monitor

The following sections are covered by the atvise monitor documentation:

1. Basics : Startup and basic operation
2. Project Console : Creation and monitoring of atvise projects
3. Licensing : Getting an atvise license

210
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Basics
Starting the atvise monitor manually

The atvise monitor is automatically registered as an autostart program by atvise setup.

You can start the atvise monitor manually by selecting "Programs-> atvise-> atvise monitor" from
the Windows start menu or by directly launching the atmonitor.exe in your atvise installation
directory.

atvise monitor icon

The atvise monitor adds an icon to the Windows system tray. The color of the icon represents the
state of the atvise server service:

atvise is starting

atvise is running

atvise is stopping

atvise is not running

Context menu
The context menu of the atvise monitor icon offers you the following functions:

License Opens the license dialog .

Help Opens the atvise documentation.

Community Opens the atvise homepage in your default browser.

Language Change the language of the user interface of the atvise monitor.

Project Console Opens the Project Console .

Quit Quits the atvise monitor (not the atvise server).

211

213
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Licensing
How to get or activate an atvise license:

1 Right-click on the atvise icon in the right corner of the task bar.

2 Choose "Get License" from the menu which appears.

3 Enter your atvise.com username and password in the "Online Activation" dialog which appears in
order to continue. Please note that Internet access is required. You can also go to 
www.atvise.com to view or download your recent licenses and statements.

Enter manually: Click on the bottom left button, "Enter manually". Copy your hardware code from
the dialog which appears, paste it on www.atvise.com and generate a license. Copy the complete
license code into the text field below.
If you have any problems or need more licenses, please contact info@certec.at. 

4 Choose your scada license from the "Online Activation" dialog and generate it by clicking "OK".

Enter atvise.com username and password

http://www.atvise.com
http://www.atvise.com
mailto:info@certec.at
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Get a webMI license 



213Reference manual

© 2018 Certec EDV GmbH

Server and project console
Overview

The Project Console is the central place for all project-related activities. With the Project Console
you can:

Add Projects
Remove Projects
Change Project/Server settings
Monitor the atvise server service

The Project Console is split into two parts. One for activities related to the atvise server service and
one for advanced tasks like starting an additional project in console mode.

Service Tab

On the "Service" tab you can control and monitor the project that is started by the atvise server
service.

1 Enables you to change the current project.

2 Opens a menu that allows you to add and remove projects and change the settings of the current
project (see below for details).

3 Lets you start and stop the atvise server.
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4 Shows the most important information from the log file while starting or stopping the server.

5 Starts the builder.

6 Shows the visualization in the default browser.

Menu

The menu (to the right of the selected project) offers you the following options:

Add Project Allows you to add a new or existing project to the list. See below for details.

Copy Project Creates a copy of the selected projects and adds it to the list. See below for
details.

Remove
Project

Removes the project from the list. Does not remove the project from the file
system!

Show Server
Log

Shows the log file of the project.

Settings Lets the user change the settings of the project. See below for details.

Add Project

Input the name of the project and input or select the directory of the project. When you select a
directory and the name field is empty, the last part of the directory will be used as the name
automatically.

Copy Project

Similar to "Add Project", but in addition to creating a new project, the nodes.db of the current project
is copied to the project directory.

In order for the Copy Project to succeed, the nodes.db of the current project may not be in use and
the target directory may not already contain a nodes.db.

Settings
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If the atvise server doesn't start up because a port is in use, you can change the OPC UA port, HTTP
port and HTTPS port here.

When setting http/https port value to 0, it is disabled.

Advanced Tab

On the "Advanced" tab you can manage the list of projects and start projects other than the default
project.

The first project in the list is always the project in the atvise installation directory. This project always
exists and cannot be deleted. The other projects in the list are fully editable by the user. The current
project (the project that is started by the atvise server service) is written in bold characters. To
change the current project, switch to the "Service" Tab and select the project.

A project in atvise is a directory which contains all project-related files. Most notably
these are nodes.db, the log file and the database directory (historical data). The atvise
server automatically creates nodes.db at startup if it does not already exist in the
project directory.

Context menu

The context menu offers you the same functionality as the context menu in the Service tab and adds
the following additional function:

Start In Console
Mode

Starts the project in console mode. See below for details.

Start In Console Mode
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Allows you to start the currently-selected project in console mode. In the dialog that pops up, you
can change the ports to be used and the log level of the server. The settings are only used as startup
parameters for this session and are not stored for subsequent calls.

The console mode can be used to start more than one project at the same time or for advanced
diagnostics (different log level, credentials of the currently logged in user, ...).
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atvise builder
The atvise builder is the engineering tool for your projects. Please start the atvise builder either from
the program menu or the project console.

To assure the best possible collaboration between atvise builder and atvise server, an
atvise builder can only connect to an atvise server with matching major and minor
version number (e.g. a connection from atvise builder version 3.1 to atvise server
version 3.1.1 is possible, but not from version 3.0 to 3.1).

If the atvise server refuses a connection, an appropriate message is written to the log
file.

The builder is structured as follows:

1 Menu Builder's menu bar

2 Tree Area to browse through the structure of your project.
You can edit the view in the builder preferences.
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There are two different library folders:

ATVISE:

This folder contains the atvise standard catalog (e.g. object
displays, quick dynamics) and is not to be modified. Any
modifications will be overwritten if a new atvise standard catalog
from a new atvise version is installed.

PROJECT:

Use this folder for project-specific modifications and extensions
(e.g. own object displays). Elements in this folder supersede
elements in the ATVISE library if they have the same name.

3 Graphic Editor
and Viewer

This is the place to draw and adapt displays and to add dynamization to
elements.

Double clicking elements in the tree will either open a dialog or a new tab will be opened in the
section „Graphic-Editor and Viewer“ (e.g. for displays).

As soon as such an element has been modified this will be indicated by a “*” next to the name of the
tab.

When double clicking displays, scripts or quick dynamics they will be locked automatically to
enhance multiuser engineering. Opening such an element by another user (atbuilder) will result in the
following message:

  
The suffix „[RO]“ next to the name of the tab indicates that such an element is locked.

Locked elements can be modified but cannot be saved – the functions “Save as” and export are still
available.

The lock will automatically be removed when the tab or the atvise builder is being closed.
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Menu
Menu bar

Below you will find the submenus of the menu bar and descriptions of how to use them:

Connect or disconnect to/from a server
Opens the Project Console
Changes the server log level
Imports an XML document
Shows the client log file
Shows your project's history
Opens atvise live in a tab
Opens the preferences dialog
Change builder's language
Closes the builder

Adds a OpcUA, OpcCOM or webMI source to a
scada server
Adds an atvise webMI-compliant server to your
project
Adds an atvise webMI demo web server to your
project
Starts an atvise webMI demo web server in
console mode
Imports all variables from a specific source
Adds a display to a specific server
Generates the complete visualization and sends
it to a target device
Opens the visualization in your standard browser
Opens an external tool

Switch between the profiles which were added in
the preferences dialog

233
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View or hide the Global Search  window
View or hide the Navigator window (contains the
Project and Node Browser tabs)
View or hide the Project tab
View or hide the Node Browser tab

Opens the atvise help file
Context sensitive help for certain areas
Version information and further information about
Qt
Information about the atvise builder

Enabling atvise service for users without Administrator rights

The user(s) can be given the permissions for the service, so that the atvise project
console detects it, using the Microsoft’s  SubInAcl.exe tool. The tool can be
downloaded here:

http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=23510

After downloading the tool, enter the following commands in the windows command
prompt:

subinacl.exe /service atserver /grant=<username>=qscto

This will give the user the right to use the atvise server/builder. If the user should also be
able to configure settings, following permissions have to be given using the command:

subinacl.exe /file atserver.ini /grant=<username>=wr

subinacl.exe /file project.ini /grant=<username>=wr

The rights can, using the same syntax, be given to groups of users. Just instead of the
username, type in the group name. The described process works under Windows 7
although it is not mentioned in the download link.

Alternatively, any other tool can be used (such as SetACL - http://helgeklein.com/
setacl/), as long as it sets the necessary permissions. Here are the commands for the
SetACL tool:

SetACL.exe -on "atserver"  -ot srv  -actn ace  -ace "n:domain1\user1;p:full" 

SetACL.exe -on "atserver.ini"  -ot file -actn ace -ace "n:domain1\user1;p:full"

SetACL.exe -on "project.ini"  -ot file -actn ace -ace "n:domain1\user1;p:full"

Preferences

226
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With the help of the preference settings, you can customize the builder´s setup to your needs:

General Preferences

Under general preferences you can
have the atvise builder remember the size of the parameter dialog
set a default profile
have the builder remember a specific number of the last-connected servers

Profiles

Root Nodes:
Customize the tree view's items according to your preferences by selecting an item and using
the arrows in the middle to add it to or remove it from the target.

General:
Show or hide the node browser in the "View" menu
Allow or disallow webMI type and instance manipulation

SVG Editor:
Show or hide different toolbar or menu items
Enable bindings
Allow catalog editing
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Show or hide default transformation items

Dynamics:
Allow or disallow simple dynamics
Show or hide dynamics and identifier

Attributes:
Enable or disable SVG attributes
Allow or disallow manual overwrites

Text Editor

Font Colors:
Make a selection from the list below and change its font

Behavior:
Set the tab size

Display:
Enable text wrapping
Show or hide line numbers
Enable or disable highlighting of the current line
Enable or disable visualizing whitespaces and tabs
Show or hide matching parentheses
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Completion:
Enable or disable automatic completion
Show or hide function declarations

External Tools
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Here you can collect external Tools/Applications which can be started from the menu.

Enter a unique name that will be displayed in the menu
Command, that starts the tool/application (e.g. the path of the *.exe-file)
Optional arguments for the tool
Optional working directory for the tool

Starting external tools from the menu:

Names are listed in order given in dialog.
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Command will be called.
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Global Search
General

The global search allows to search the address space for node names and node content containing a
given string. You can select which areas of the address space are to be searched. The result is
presented in a table and allows to select a found node in the project tree and to open the node in its
editor (e.g. display editor), if applicable.

The global search window can be opened via the "View" menu or via the keyboard shortcut Ctrl-Alt-F.
By default, the search window opens as docked window at the bottom edge of the atvise builder
window. You can dock the window at any edge or move it out of the atvise builder window to make it
a separate, resizable window.

On the top of the window is the area where the search criteria and options can be input. The table in
the center shows the result of the search. The status bar on the bottom shows status information for
the search like the number of matches.

Search criteria

The area with the search criteria consists of:

An input field for the string to search for. The string is a regular expression to allow the definition of
complex search strings (see note below).
A toggle to indicate if the search string is case sensitive or not.
A toggle to indicate if the search string has to match as a whole word.
A combined settings button and menu for more search options.

Note: Following characters have a special meaning in a regular expression: .[{}()
\*+?|^$

If you want to use these characters in the search string, you must escape them with a
backslash ("\").
E.g. to search for AGENT.OBJECTS you must enter AGENT\.OBJECTS as search

string.

Examples of commonly used regular expressions:
match a single, arbitrary character: "int." matches "inta", "int1", "int_", "int." but
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not "int"
match any number of arbitrary characters: "int.*" matches "int", "int1", "int_a1"

match a single digit: "int[0-9]" matches "int0", "int1", "int2" (but not "int12" if

match whole word is enabled)
match one or more digits: "int[0-9]+" matches "int0", "int100" but not "int" 

escape special characters: "\.\./data" matches "../data" but not "xy/data"

For a comprehensive description of the regular expression syntax, search online for
"perl compatible regular expression" or "pcre". You may also visit https://
regex101.com/ to test regular expressions online.

To start a search, enter the search string in the input field and press the ENTER key.

Clicking on the settings button will open the settings dialog where you can select which areas of the
address space are to be searched. Clicking on the triangle to the right of the button will open
following menu:

The menu offers following functions:

Settings Open the settings dialog

Search Options The following two menu items specify if the search should consider node
names or node content. A checkmark is shown, if an option is enabled.

Content Search in node content

Name Search in node name

Doubleclick Action The following two menu items specify the default action(s) to trigger
when you double click or press ENTER in the result table. A checkmark
is shown, if an option is enabled.

Open Open editor, if applicable. If multiple nodes are selected, the editors of
all nodes are opened.

Select in Project Tree Select node in the project tree. If multiple nodes are selected, only the
first node is selected in the project tree.

Settings dialog

https://regex101.com/
https://regex101.com/
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The search settings dialog allows to specify the areas to be searched. The upper part contains areas
where node name and content will be used for the search. The lower part contains areas where only
the node name will be searched for. By default, the search will not include results from the library
supplied with atvise.

Displays Search in the name and content of displays, wherever they are located

Serverside Scripts Search in the name and content of server side scripts, wherever they are
located

Quick Dynamics Search in the name and content of Quick Dynamics

Resources Search in the name and content of resources

Languages Search in the name of a language and content of translations

Alarm Texts Search in alarm texts

Alarms Search in the name of alarm configurations and conditions

Archives Search in the name of archive groups as well as aggregate templates
and functions

Global Parameters Search in the name of global lists and parameters

Security Search in the name of groups, users and user defined rights

Other Search in the name of anything not included in the areas above
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Search atvise Library If enabled, the search will include nodes in "Library->ATVISE"

Table of search results

The search results are shown in a table with following columns:

Node The node id of the matching node

Type The type of the matching node, icon and name resemble the project tree
to a large extent

Line If the search string is found in the content, a snippet of the line with the
first match

The table can be sorted by clicking on any of the column headers. You can select multiple entries
with the mouse or keyboard and trigger the default action(s) (see above) with a double click or by
pressing the ENTER key. A right click will open a context menu which allows to select an action
regardless of what you did set as default action(s).

Status bar

The status bar shows the number of matches and the hint "truncated", if the server truncated the
results. See the setting "searchlimit" in the "[opcua]" section in atserver.ini  on how to change the
search result limit.

Use of the global search in the object selectors

The global search can also be used in the various object selectors (variables, displays etc.) to
search for nodes with a matching name. To use the search in a suitable selector, click on the search
icon in the bottom left or press Ctrl-Alt-F:

202
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As the selectors are mostly designed for specific node types, the search is automatically limited to
those node types. The toggles for case sensitive search and matching as a whole word are also
available here.

You can select one of the found nodes with a double click or by pressing the ENTER key.

To return to the tree, click on the search icon or press Ctrl-Alt-F again.
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Project history and change log
The project history allows keeping track of single changes made during the engineering process

The following events performed by the user are logged:

Project opened/closed
Server added/removed/modified
Display added/removed/modified
Acquired datapoints (ATTENTION: webMI only)
Distributed visualization (ATTENTION: webMI only)

Calling "Show Project History" from the atbuilder displays the following information in a table:

Timestamp: time of action
User: the operating system user performing the action
Status: Status of the action (successful / failure)
Action: type of action
Additional text: additional text related to the action

The top input field of the table allows entering a filter text which will be applied to all columns.

The logging is done in a configurable ring buffer. The size of this buffer (= number of rows) can be
configured in the atserver.ini file as follows:

 [opcua]
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pushedarraysize=1000
;default is 1000.
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XML export and import
Menu items

In the project tree, every node has following 3 menu items inside the "Node Action" menu:

Export hierarchy as XML…
Export single node as XML…
Import (relative) from XML…

In the "builder" menu you will find the menu item "Import (absolute) from XML…".

These 4 items offer following functionality:

1. Export hierarchy as XML…
The selected node (multiple selection is supported) and nodes below will be exported (e.g.
alarm configurations).

2. Export single node as XML…
Only the selected node (multiple selection is supported) without any nodes below will be
exported.

3. Import (relative) from XML…
A previously exported node (single or hierarchical) can be imported relative to the node
where the XML import is started. This means the nodes in the XML file will be imported
below the current node, regardless of the original position of the exported nodes.

Example:

Export the node „OBJECTS.Folder1.mynode" (single or hierarchical).

Import the node relative to „OBJECTS.Folder2.Folder3". This results in creation of the node
„OBJECTS.Folder2.Folder3.mynode". If it was a hierarchical export, the nodes below are
also created.

4. Import (absolute) from XML…
A previously exported node (single or hierarchical) can be imported at an absolute position.
This means the nodes in the XML file will be imported at the exact same location in the
project tree from where it was exported (single or hierarchical) before.

Example:

Export the node „OBJECTS.Folder1.mynode" (single or hierarchical).

Import the node in a different project. This results in the creation of the node
„OBJECTS.Folder1.mynode". If it was a hierarchical export, the nodes below are also
created.
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The export does not resolve dependencies between the exported nodes! If you export
an instance of an ObjectType, then only the instance will be exported, but not the
ObjectType. The import in a different project will only succeed, if the ObjectType does
already exist in the project.

The exported XML files conform to the XML Schema definition published by the OPC Foundation: 
http://opcfoundation.org/UA/2011/03/UANodeSet.xsd.

The format of the XML files has been changed in atvise 2.2. Thus, atvise 2.1.x is not
able to import XML files created with atvise 2.2 or younger! However, atvise 2.2 and
younger are able to import XML files in the new and the previous format.

Relative import

To support relative imports, atvise specific, XML Schema conforming extensions are written to the
XML file. The extensions are attributes of the XML tag <atvise> inside the <Extensions> tag. If the
attributes are missing, only absolute import is possible. Following extensions are supported:

ExportedNodeId: NodeId of the exported node. Can occur multiple times if multiple nodes where
selected for export.

ExportedBrowseName: BrowseName of the exported node. Can also occur multiple times like
ExportedNodeId.

Upstream: All nodes hierarchically above the exported node get this attribute with the value "true".
Such nodes are created on import, if they do not already exist. If they exist, the import will not
touch the node at all.

Requirements and recommendations for the XML import
format

If an XML file conforms to the XML schema, this doesn't automatically mean that it can be imported
into atvise. To be able to be imported into atvise, the nodes and references in the XML file have to
conform to the atvise address space. Following are the requirements the XML file must fulfill:

1. It must contain a namespace table with the atvise namesapce as the only entry. This implies that
all nodes in atvise have the namespace index 1 (with the exception of nodes defined by OPC UA
which have the namespace index 0).

2. The attributes NodeId and BrowseName must be present at every node.
3. The references HasTypeDefinition and HasModellingRule can only be specified as forward

references, i.e. the attribute IsForward="false" is not allowed for those references.
4. UAObject and UAVariable must contain a HasTypeDefinition reference to the respective

TypeDefinition.
5. A node referenced with <Reference> must already exist in the address space when it is

encountered. From this and the previous two items follows, that types (ObjectType, VariableType)
used as a TypeDefinition must always be created before they are referenced.

6. UAVariable must - in case the node doesn't already exist in the address space - contain the initial

http://opcfoundation.org/UA/2011/03/UANodeSet.xsd
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value in the XML tag <Value>.
7. UAVariableType must - in case the node doesn't already exist in the address space and a

DataType is given - contain the initial value in the XML tag <Value>.

To increase readability of the XML file we recommend to define commonly used NodeIds (DataType,
ReferenceType, ...) in the Alias table and use them throughout the XML file.

An example with embedded comments as clarification of the items above:

<?xml version="1.0" encoding="UTF-8" ?>

<UANodeSet xmlns="http://opcfoundation.org/UA/2011/03/UANodeSet.xsd" xmlns:uax="http://opcfoundation.org/UA/2008/02/Types.xsd">

<NamespaceUris>

<Uri>http://www.atvise.com/atServer/UA/</Uri>

</NamespaceUris>

<Aliases>

<!-- data types -->

<Alias Alias="Double">i=11</Alias>

<!-- references -->

<Alias Alias="HasTypeDefinition">i=40</Alias>

<Alias Alias="HasSubtype">i=45</Alias>

<Alias Alias="HasComponent">i=47</Alias>

</Aliases>

<!-- create the VariableType first -->

<UAVariableType NodeId="ns=1;s=VariableTypes.PROJECT.MyVariableType" BrowseName="1:MyVariableType">

<DisplayName Locale="en">MyVariableType</DisplayName>

<Description Locale="en">MyVariableType</Description>

<References>

<!-- HasSubtype is normally always a "backward" reference, because the supertype has to exist before the subtype -->

<Reference ReferenceType="HasSubtype" IsForward="false">ns=1;s=VariableTypes.PROJECT</Reference>

</References>

<!-- The initial value can be omitted if the VariableType has no DataType (or the DataType "i=0") defined -->

<!-- An empty Value tag should still be present in this case or you will see a warning message in the log file -->

<Value/>

</UAVariableType>

<!-- create the Variable after the VariableType used as TypeDefinition -->

<UAVariable NodeId="ns=1;s=AGENT.OBJECTS.MyVariable" BrowseName="1:MyVariable" DataType="Double">

<DisplayName Locale="en">MyVariable</DisplayName>

<Description Locale="en">MyVariable</Description>

<References>

<Reference ReferenceType="HasComponent" IsForward="false">ns=1;s=AGENT.OBJECTS</Reference>

<!-- HasTypeDefinition is always a "forward" reference to an already existing type -->

<Reference ReferenceType="HasTypeDefinition">ns=1;s=VariableTypes.PROJECT.MyVariableType</Reference>

</References>

<!-- The initial value of the variable must be present -->

<Value>

<uax:Double>1.5</uax:Double>

</Value>

</UAVariable>

</UANodeSet>
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atvise live

You need an internet connection to use atvise live.

Start

The integrated atvise live browser starts from the menu builder -> atvise live and opens in a new tab.

Content

Navigation:
The navigation on atvise live takes place in the same tab.
The default browser will be used for external navigation.

HINT:
atvise live has no context menu. You can navigate one site back by using the
[BACKSPACE] key.

Range:
FAQ
various info sites (eg. compatibility list, important news)
atvise add-ons (without any warranty)

Download:
By clicking "Download" the affiliated dialog pops up. Choose

Import - for direct import to your project (ATTENTION: existing data will be overwritten!)
Save - You can save the file on your hard drive and import it later.
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Tree
This is the area to browse through the structure of your project.
You can edit the tree view in the builder preferences.

Servers

This tree enables you to add data sources, displays,
objects and historical configurations to your local
scada server (atvise SCADA) and to add and edit webMI
servers  (atvise webMI).

Global Parameters

This tree enables you to add global parameters and
global lists to your project.

Display Pool

Displays added to the display pool can be referenced
from multiple servers (e.g. a general start page which is
used on every server, ...).

Library

Your project library (see next section for details).

Object Types

This tree enables you to add and configure your own
object types (atvise SCADA).

Variable Types

This tree enables you to add and configure your own
variable types (atvise SCADA) or to view and configure
imported types (atvise webMI).

Languages

Manage your translations.

Users & Groups

Enables you to manage the users, groups and rights of
your project.

Views

Enables you to create views on your address space.

343
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Library Tree

There are two different library folders:

ATVISE:

This folder contains the atvise standard catalog (e.g. object displays, quick dynamics)
and is not to be modified. Any modifications will be overwritten if a new atvise
standard catalog from a new atvise version is installed.

PROJECT:

Use this folder for project-specific modifications and extensions (e.g. own object
displays). Elements in this folder supersede elements in the ATVISE library if they
have the same name.

Library

o ATVISE

Quick Dynamics

A set of predefined simple dynamics which can be
used

Object Displays

A set of predesigned object displays (such as
buttons, text fields, etc.) which can be used to create
great visualizations in a few steps.

Resources

Internally-used resources such as images and/or
scripts

Alarm Categories

A set of predefined alarm categories which can be
used for alarm 

webMI Method Scripts

Menu Scripts

o PROJECT

Quick Dynamics

Object Displays

Script Library
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Custom scripts which can be called from other scripts

Menu Scripts

Extend the Node Actions

webMI Method Scripts

Scripts which can be called via "webMI.data.call"

Alarm Categories

Resources

[VENDOR SPECIFIC] optional
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Add and edit server
To add a new webMI server to your project, right-click on Servers and choose Add Server... ->
webMI.

Alternatively you can also click on "Guided Actions" in the menu bar and select "Add atvise webMI
Compliant Webserver".

General

Enter the name, hostname and type of your server.

Advanced
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If the General Settings checkbox is not checked, all settings will be automatically
generated using the server defaults and the specified hostname.

URL

URL of the visualization (including leading "http://").

Config Source

XML file which contains the data structure of the webMI server.

There are four different possible protocols for adding a config source:

file:///local_path
Here you can enter the local path of the file.

http://host or https://host
Enter the complete URL of the source here.
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ftp://[user]:[pw]@[host]
Enter an ftp address with the syntax above to add an ftp source. "user" and "pw" stand for the
FTP account data, host is the address of your ftp account.

Config Target

The folder where your cfg files (e.g. license.cfg) are saved.

You can also use the file:/// or ftp:// protocol as for the config source.

Data Root Target

The folder where the visualization files (displays, resources,...) are transferred to when
distributing the server.

You can also use the file:/// or ftp:// protocol as for the config source.

Distribution

Compress: If checked, the data will be compressed in a gzip format.
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Cleanup Dataroot: If checked, the entire contents of the Data Root Target will be deleted before
every generation of a visualization.

Write only changed files: Write only files that have been changed since the last distribution.

Case Sensitive: Use case sensitive algorithm to compare filenames listed by ftp servers with
generated files. Disabled by default because of some compatibility issues.

Files

Select additional files to upload from disk.

Layout

Choose a default-layout and a default-displaysize for the server.
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Editing a webMI server

To edit an existing webMI server, double-click on it in the server list or right-click on it and choose
"Edit server...".
For information about the configuration settings, see the sections above.
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webMI Server
This page will guide you through the basic webMI procedure. A few steps are needed after you have
added a webMI server. The procedure is explained in the following picture and table:

Procedure for building a webMI visualization

1 The first step is to add a new webMI server  in the atvise builder.

2 In the second step, an XML file which includes your data structure can be imported .

3 Create your displays and object displays with the graphics editor  included and dynamize
them using simple dynamics .

4 The last step is to generate  the visualization  to the root folder of your web server.

241
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Objects - Importing

To import the data structure from the specified data-variables xml file, you can right-click on your
webMI Server and choose "Acquire Data Points" or click on "Guided Actions" and choose your
server at "Import all variables from":

1. Right-click on Server -> Acquire Data Points:

Import data structure via "Acquire Data Points'"

2. Guided Actions -> Import all variables from:

Importing a data structure via "Guided Actions"

Example of the XML file and the server structure after importing the file:
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Example of how a data structure is built in XML



249Reference manual

© 2018 Certec EDV GmbH

Generate visualization

The last step in the webMI engineering process is to generate the visualization files and transfer
them to the data root and config target of your webMI server:

Right-click on server -> Distribute 

To generate and transfer the visualization files, right-click on your webMI server and choose
"Distribute". 

Generating the visualization
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My Server

Procedure for engineering an atvise SCADA project

1 You can create the complete data structure of your project (including your own individual object
types for object-oriented engineering). Add any number of data sources (OPC UA and standard
OPC) and connect your local data variables with the variables of these data sources via
mirroring to establish communication.

2 In the next step you can apply typical SCADA functions such as historizing and alarms.

3 Create your own visualizations with the graphics editor included and dynamize them using
simple dynamics.

4 Open a web browser of your choice and view your visualization which is delivered by the web
server included in the atvise SCADA server.
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DataSource

To establish communication between atvise and other OPC servers, you must first define these OPC
servers as data sources in your project. This enables you to browse these data sources and to
connect your local data structure with these data sources (see the section Mirror variables from data
sources ).

Browsing a data source

Right-click a data source -> Browse to browse the data structure of the server:

Browse a data source

You can directly Copy&Paste data variables from a data source to your local object structure  or
your local object types .

If you have problems with the connection to a OPC DCOM server, please check out
the OPC DCOM configuration page .

For webMI datasources a search function is not implemented yet.

Configure atvise OpcUa to S7

Right-click the data source -> Configure… to configure the data source:

279
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288
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Configure a data source

Further details are given in the opcua2s7 documentation which is part of the opcua2s7 installation.

Add Data Source

Right-click a data source -> "Add Data Source..." to add a new data source.

Add OpcUa Data Source
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Add OPC UA Data Source - General

Parameter Type Description

Name String The name of the OPC UA data source. Mirrored nodes use
this name for identification.

Source URL String The network address of OPC UA data source (e.g.
opc.tcp://localhost:4840)

Connection Status String
(RO)

Status information about the connectivity of the data source.

Connected Yes|No
(RO)

Indicator, whether or not the data source is connected.

Activated Yes|No Activates or deactivates the data source connection.
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Add OPC UA Data Source - Connection

Parameter Type Description

Publishing Interval Number This interval defines the cyclic rate that the data source
returns notifications to atvise server. This interval is
expressed in milliseconds. The data source may revise this
interval.

The field “Revised” shows the actual interval used by the
data source.

Sampling Interval Number The interval that defines the fastest rate at which the data
source should access data. This interval is defined in
milliseconds.
The value 0 indicates that the data source should use the
fastest practical rate.
The value -1 indicates that the default sampling interval
defined by the publishing interval is used. The data source
may revise this interval.

The field “Revised” shows the actual interval used by the
data source.

Queue Size Number The requested size of the data source data queue.  
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The following values have special meaning:
Value Meaning 
<0 the queue size is calculated from Publishing and
Sampling Interval.
1 the queue has a single entry, effectively disabling queuing.
>1 a first-in-first-out queue is to be used.
If 0 is passed, the data source shall use the default queue
size which shall be 1.

The data source may revise this value.

The field “Revised” shows the actual value used by the data
source. 

Lifetime Count Number If atvise can't communicate with the data source for a period
shorter than Lifetime Count * Publishing Interval, then the
subscription data is still available in the data source. After
that period, the data source will delete the subscription
data, which may increase duration of the reconnect. With a
Publishing Interval of 500 ms the default is 20 minutes.
Please make sure that you adjust the Lifetime Count if you
change the Publishing Interval.

The data source may revise this value.

The field “Revised” shows the actual value used by the data
source.

Max. Notifications per
Publish

Number The maximum number of notifications that atvise wishes to
receive in a single publish of the data source. A value of
zero indicates that there is no limit. The default value of 0
shall work in most cases. However, some data sources may
require to set this value to something else.

Deadband Number This parameter applies only to variables with a numeric data
type.

If Deadband is absolute, then a notification is generated by
the data source if the difference between the previous and
the new value is bigger than the provided absolute value.

If Deadband is relative, then a notification is generated by
the data source if the difference between the previous and
the new value is bigger than the provided percent value with
regard to the value range of the variable. It is therefore only
used if the variable in the data source is an AnalogItem with
the property EURange.

Example: A variable has an EURange of -50 to +150, the
relative deadband is set to 5%. The value has to change at
least for an absolute amount of 10 (= 5% of 200) for a
notification to be generated.

If the item is an array of values, the entire array is returned if
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any array element exceeds the Deadband, or the size or
dimension of the array changes.

Trigger Type String Defines, in which case the data source shall send a
notification to atvise:

status: only in case the status of the node has been
changed
status or value: in case the status or value of a node has
been changed
status or value or timestamp (=default): in case the
status or value or timestamp of a node has been changed

Connection Timeout Number The timeout for watchdog calls in milliseconds. After one
unsuccessful call the connection status of the data source
will be set to WatchdogWarning and the timeout will be two
times this value for the next call. Mirrored variables are not
affected.
After the second unsuccessful call the connection status of
the data source will be set to LostConnection and atvise will
try to reconnect to the data source. The status of the
mirrored variables will be set to BadServerNotConnected.
The default value is 5000 milliseconds.

String Encoding String Encoding schema for strings: (empty = UTF-8) (default),
ASCII, Windows-1252, UTF-16, ISO-8859-1, ISO-8859-15.

Object Type Prefix String The string to prepend to object types of the data source
when using "Paste&mirror" functionality. The prefix may be
empty.
E.g. if ‘prefix=A1’ then the object type ‘ns=3;s=MyTypes.T1’
of the data source A1 will be mirrored to
‘ObjectTypes.PROJECT.A1.MyTypes.T1’ and can be seen
in builder under ‘Object Types’->’A1’.
Use an Object Type Prefix if you have multiple data sources
and identically named object types with different structures
or you want to separate the automatically created object
types from the manually created ones.

NOTE: The Object Type Prefix is prepended after the
"Object Type Trim" string is removed. If a prefix is defined, it
is recommended to use the name of the data source. 

Object Type Trim String The string to remove from the front of the NodeId string of
the object types of the data source when using
"Paste&mirror" functionality. The trim may be empty.
E.g. if ‘Object Type Trim= MyTypes.’ then the object type
‘ns=3; s= MyTypes.T1’ of the related data source will be
mirrored to atvise with the NodeId
‘ObjectTypes.PROJECT.T1’. Only the internal
representation (=NodeId) is affected. The BrowseName and
therefore the appearance of Object Types in atbuilder remain
unchanged.
The usage of this parameter makes only sense in case of
data sources where the NodeIds incorporate the type- and
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object hierarchy (e.g. atvise, where NodeIds are composed
from the BrowsePaths).

NOTE: The “Object Type Trim” is removed before the “Object
Type Prefix” is prepended.

Variable Type Prefix String Same as "Object Type Prefix", but for variable types.

Variable Type Trim String Same as "Object Type Trim", but for variable types.

Add OPC UA Data Source - Security

Parameter Type Description

Security Policy String Connection security policy. Possible Values are: None
(default), Basic128Rsa15, Basic256, Basic256Sha256

Message Security
Mode

String The type of security to apply to the messages between
client and server during a session. Possible Values are:
None (default), Sign, Sign and Encrypt. 

CA Location String The base location of certificate files. The accepted data
source certificates must be located in the sub directory
‘certs’ of this directory. If CA location is left empty, then the
default directory is <installation_directory>/PKI/CA. For
further details see: Handling certificates

Certificate String File name of client certificate used by atvise. The data
source must accept this certificate. For further details see: 
Handling certificates

Private Key File String File name of private key located in the ‘private’ sub directory
of the base location of certificate files.

258

258
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User Name String User name for data source login

Password String Password for data source login

Handling certificates

Using security policy others then "none" for data source connectivity the certificates must be
installed correctly on both sides: at the atvise server and at the data source.
 
1. The first step is to provide a SSL certificate to atvise. To generate a self-signed certificate, you

should use a current version of openssl (http://www.openssl.org). Creating a self-signed certificate
includes the following steps:

I. Modify the openssl config file
II. Create private key and certificate file

An example of using these steps to create a certificate usable by atvise is given below:
I. Check if the openssl configuration file (openssl.cfg) contains the following items (comma

separated parameters must be entered on one line; only important file snippet is shown. For
detailed description see https://www.openssl.org/docs/apps/req.html):

[ req ]
x509_extensions = v3_ca
 
[ v3_ca ]
nsComment = "OpenSSL Generated Certificate"
subjectKeyIdentifier = hash
authorityKeyIdentifier = keyid:always,issuer:always
basicConstraints = critical,CA:false
keyUsage =
critical,digitalSignature,nonRepudiation,keyEncipherment,
dataEncipherment,keyCertSign
extendedKeyUsage = critical,serverAuth,clientAuth
subjectAltName = URI:http://www.atvise.com, DNS:atvise

II. Create key and certificate file (command line parameters must be entered on one line):

openssl req -new -x509 –nodes -days 365 -set_serial 0x12345678
-subj "/C=AT/ST=VIE/L=Vienna/O=Organization/OU=Unit/CN=atvise"
-config <openssl_dir>\bin\openssl.cfg -outform DER 
–keyout <atvise_dir>\PKI\CA\private\your_privateKey.pem
-out <atvise_dir>\PKI\CA\certs\your_untrustedRootCert.der 

Replace <openssl_dir> and <atvise_dir> with the corresponding directory names.
Change the values for "-days", “-set_serial” and "-subj" according to your needs. The “-
subj” argument may have the following values:

CN - Common name used as URL
C - Country, two letter code
ST - State
L – Locality
O – Organization
OU – OrganizationUnit
emailAddress

http://www.openssl.org
https://www.openssl.org/docs/apps/req.html
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2. The next step is to setup the data source with the appropriate data. Open the data source dialog
and enter the private key file and the certificate file generated in the previous section.

3. Install the atvise certificate at the data source. This procedure depends on the data source. It
probably provides a utility to install and trust certificates. One shall install and trust the same
atvise certificate as selected in the dialog box of data sources.

4. Install the data source certificate at the atvise server. If the certificate does not exists as a file,
then the certificate must be exported by some data source utility into a physical file. The
certificate file must be copied into the subdirectory ‘certs’ of the base directory of certificate files of
atvise as defined in the data source dialog item ‘CA Location’.

5. The security policy and the security mode defined in the data source dialog must be the same as
defined at the data source endpoint. It depends on the data source, how this information can be
accessed.

Add atvise OpcUa to S7 Data Source

Add OPC UA to S7 Data Source - General
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Add OPC UA to S7 Data Source - Connection

For a description of the dialog parameters please refer to the OpcUa Data Source above.

Add OpcCom Data Source
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Add OPC COM Data Source - General

Parameter Type Description

Name String OPC COM data source name. This name will be used as
group name in the communication.

Source URL String URL to connect to the OPC COM data source - only local
data sources are supported! (e.g. opcda://localhost/
Graybox.Simulator.1)

Connection Status String
(RO)

Status information about the connectivity of the data
source.

Connected Yes|No
(RO)

Indicator, whether or not the data source is connected.

Activated Yes|No Activates or deactivates the data source connection
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Add OPC COM Data Source - Connection

Parameter Type Description

Canonical Datatype
Precedence

true|false Indicator of mirroring data type determination:
true = mirroring will use the canonical data type of the
variable (=default)
false = mirroring will use data type of the actual value

Sampling Interval Number The interval that defines the fastest rate at which the data
source should access data. This interval is defined in
milliseconds.

The data source may revise this interval.

The field “Revised” shows the actual interval used by the
data source.

Dead Band Number Defines in which case the data source will send a
notification to atvise.

The range of the deadband is from 0.0 to 100.0 percent.
Deadband will only apply to items of the data source that
have a dwEUType property of “Analog” available and their
properties “EU Low” and “EU High” are set. The data
source will only send a notification if: 

absolute value of (last cached value - current value) >
(deadband/100.0) * (EU high – EU Low)

Connection Timeout Number The timeout for watchdog calls in milliseconds. After one
unsuccessful call the connection status to the data
source will be set to WatchdogWarning and the timeout
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will be two times this value for the next call. Mirrored
variables are not affected.

After the second unsuccessful call the connection status
to the data source will be set to LostConnection and
atvise will try to reconnect to the data source. The status
of the mirrored variables will be set to
BadServerNotConnected.

The default value is 1000 milliseconds.

String Encoding String Encoding schema for strings: (empty = UTF-8) (default),
ASCII, Windows-1252, UTF-16, ISO-8859-1, ISO-8859-
15.

Add webMI Data Source

Add webMI DataSource - General

Parameter Type Description

Name String webMI data source name

Source URL String URL to connect to the webMI data source
(e.g. http://localhost)

Connection Status String
(RO)

Status information about the connectivity of the data
source

Connected Yes|No Indicator of data source, whether or not is connected

Activated Yes|No Activates or deactivates the data source connection
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Add webMI DataSource - Connection

Parameter Type Description

Browse Path Delimiter String Delimiter character for Browse Path

Add SNMP Data Source

An SNMP data source provides the ability to retrieve data from external sources via SNMP protocol.
Relevant OIDs are hereby being polled in a configurable interval. Supported protocol versions are 1
and 2c. SNMP security (version 3) is currently not available.
In addition, writing of values via SNMP-Set request, handling of Traps and Informs as well as MIB tree
browsing and MIB translation are not supported.
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Add SNMP DataSource - General

Parameter Type Description

Name String SNMP data source name

Source URL String URL to connect to the SNMP data source
(e.g. snmp://localhost)

Connection Status (RO) Status information about the connectivity of the data
source.

Connected Yes|No
(RO)

Indicator, whether or not the data source is connected

Activated Yes|No Activates or deactivates the data source connection
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Add SNMP DataSource - Connection

Parameter Type Description of the SNMP agent configuration

Community Name String A community string which is accepted by the SNMP
agent providing at least read-only access rights

Version String SNMP protocol version: 1 or 2c

Polling Intervall Number Polling interval of the mirrored nodes in seconds. The
actual update rate depends on the update rate (caching)
of the SNMP-Agent.

On Windows platforms for instance, the SNMP service can be used as an SNMP
agent.

This service can be set up as follows:
Open the Control Panel on your Windows machine. 
Click Turn Windows features on or off in section Programs.
Check Simple Network Management Protocol (SNMP) and install it.
Open services.msc after the SNMP installation is completed. 
Double-click SNMP Service to open its Properties.
On the General tab, select Automatic for Startup Type.
On the Security tab, click on Add... for accepted community names, leave Community
Rights as Read-Only and choose a Community Name, e.g. „public“. Click on OK. You may skip
this step if it is already configured.
On the security tab in the lower half you can choose which IP addresses are allowed to access
the SNMP service. You must at least choose the IP address of the machine running atvise.
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On the Agent tab fill out all edit fields and enable all check boxes to make all SNMP values
available.

Add redundant Data Source

With the functionality of redundant data sources one can combine several identical physical data
sources and/or several physical connections to a data source to one logical data source. In case of a
connection failure the system switches to the next available connection.

This functionality can be used for all types of data sources (OPC UA, OPC COM, atvise opcua2s7,
webMI, SNMP).

To be able to use redundant data sources, a dedicated license is required.

If such a license is available, the tab “General” of the “Edit Data Source” dialog will change as
follows:

Dialog: Add data source

The items from „Alternative URLs“ to „Current Connection“ can be used for the configuration of
redundant data sources as follows:

1. Alternative URLs
Clicking the button „Add“ will add further URLs to the list in addition to the Source URL. Such a
URL can either be a URL to the same data source via a different network or a URL to a second
physical data source.
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The order of the Source URL and of the alternative URLs defines the priority where the Source URL
has the highest priority. In case of a connection failure, the system will always switch to the
available connection with the highest priority. I.e., first the system will try to establish a
connection via the Source URL. If this is not possible, the connection to the “alternative URL 1” will
be established. Is this also not possible, then the connection to “alternative URL 2” will be
established and so on.

If the system communicates over a low priority connection (e.g. “alternative URL 2”) and a
connection of higher priority becomes available (e.g. Source URL), then the system will switch to
the connection of higher priority. With the modes “Hot” and “Monitored” (see below) the switching
will happen as soon as the connection of higher priority is available. When using the mode “Cold”
such switching will only occur in case the current connection is lost.

Clicking the button “Delete” will remove the selected alternative URL from the list.

2. Behavior of alternative URLs
Defines how the switching to the next connection will be performed in case of a connection failure.

Cold: The connection to the alternative URLs will not already be established during start-up but
only when switching to such an alternative URL. In this mode the communicated data volume is
the lowest since the communication is only done over one connection. Thus, switching to
another connection will take more time than in other modes, since the whole connection has to
be established. In case the connection cannot be established the system will switch to the next
connection. In this mode data loss might occur when switching between connections.

Monitored (=default): The connection will already be established to all configured URLs during
start-up. The highest priority connection will be used for communication. For the other URLs
only a keep alive for monitoring the connection will be established. In this mode the
communicated data volume is a little bit higher than in “Cold” mode, since in addition to the
normal communication the keep alive will be sent to the other connections. Thus, switching to
another connection will be faster since the next available connection is known due to the keep
alive and only the monitored items have to be subscribed for the already established connection.
However, data loss might also occur when switching between connections.

Hot: The connection (including subscriptions) will already be established to all configured URLs
during start-up. The atvise system will only process notifications from the connection of highest
priority. Notifications from other connections will be buffered for a short period. Therefore this
mode has the highest communicated data volume since the notifications will be sent over all
connections. But the switching is the fastest and will be done without data loss.

3. Switching Mode
Defines whether in case of a connection failure the system shall switch between the connections
according to the configured priority (= “Automatic”) or the communication is bound to an explicit
configured URL (e.g. “Only alternative URL 1”).

In case an explicit connection is configured and this connection will fail, no switching
to another connection will be performed.

4. Current Connection
This field indicates which configured URL is used for the current communication.
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Example:

Given the following configuration:

Source URL: opc.tcp://192.168.111.1:4840
Alternative URL 1: opc.tcp:// 192.168.111.2:4840
Alternative URL 2: opc.tcp:// 192.168.222.1:4840
Alternative URL 3: opc.tcp:// 192.168.222.2:4840

Assumption: “Alternative URL 1” is not available, all other connections are OK and the current
communication is done via the Source URL.

Mode „Cold“:

1. Source URL fails -> switching to „Alternative URL 2“ (since „Alternative URL 1“ is not
available)

2. „Alternative URL 1“ is available again -> nothing will happen
3. „Alternative URL 2“ fails -> switching to „Alternative URL 1“ (since „Alternative URL 1“ has a

higher priority than „Alternative URL 2“ and the Source URL is still not available)

Modes “Monitored” and „Hot“:

1. Source URL fails -> switching to „Alternative URL 2“ (since „Alternative URL 1“ is not
available)

2. „Alternative URL 1“ is available again -> switching to „Alternative URL 1“ (since „Alternative
URL 1“ has a higher priority than „Alternative URL 2“ and the Source URL is still not available)

Import Methods from Data Sources

When you browse an OPC UA data source and find an OPC UA method in the address space of the
data source, you can create a wrapper script for the method to be able to call it from a server-side
script. To create the script, right-click the method and select "Import method" from the context
menu:
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Importing an OPC UA method

A script with the same name as the method will be created in the METHODS folder of the data
source. If a script with the name already exists, you will be asked to supply a different name. The
input and output arguments of the original OPC UA method are reflected in the generated script.

The input and output arguments of the OPC UA method are only available in the script
if they are exposed by the data source.

For example, to be able to import XML directly into an atvise server used as a datasource, follow
these steps:

Add an OPC UA data source, e.g. with the name "ds1"
Browse to the "importNodes" OPC UA method in the data source and import it (see screenshot
above)
Write a server-side script to call the "importNodes" method in the data source

var xml = "<?xml version=\"1.0\" encoding=\"UTF-8\" ?><UANodeSet ...";
var res = call("AGENT.DATASOURCES.ds1.METHODS.importNodes", {
  XmlNodeSet: xml
});
if (res.error)
  console.log("Import error: " + res.errorstring);
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else
  console.log(res.result.Success);

The result of the call is an object with following properties:

error error code; supplied only if the function could not be called

errorstring error text; supplied only if the function could not be called

result On success an object with the output arguments of the OPC UA method call.
Each output argument is available as a property with the same name as the
argument.

OPC DCOM Configuration

If you are running the atvise server as a service (default installation), you may have communication
problems with some OPC DCOM servers because of DCOM rights (even if the DCOM server and the
atvise server run on the same machine). The reason for this is that the atvise server service is
executed per Windows default by the "System" user, the OPC DCOM server by the local user.

To resolve this problem, reconfigure the authentication of the atvise server service and the OPC
DCOM server so that they are both executed by the same user:

1. atvise server service

Start -> Settings -> Control Panel -> Administrative Tools -> Services -> atvise server -> right-click ->
Properties -> Log On tab:
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Configure a user for the service log-on 

2. OPC DCOM server

Start -> Settings -> Control Panel -> Administrative Tools -> Component Services -> Computers ->
My Computer -> DCOM Config -> [Your DCOM OPC Server] -> right-click -> Properties -> Identity
tab:
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Configuring the OPC server to the same user
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Objects

In atvise scada, you are able to create your own data structure in the atvise builder.

The structure of your scada server is located in the Servers->My Server->OBJECTS tree.

Right-click  and choose  to create folders, data variables, properties and
instances of your own object types:

 Folder

Allows you to add folders to structure your object tree.

 Data Variable

Allows you to add data variables to your object tree.

The following (OPC UA) data types are available :

Data type Description

Boolean Boolean resp. bit (true/false).

SByte Signed byte (builder displays decimal value). Range: -128 to 127 inclusive.

Byte Unsigned byte (builder displays decimal value). Range: 0 to 255.

Int16 16-bit integer (signed). Range: -32,768 to 32,767.

UInt16 16-bit integer (unsigned). Range: 0 to 65,535.

Int32 32-bit integer (signed). Range: -2,147,483,648 to 2,147,483,647.

UInt32 32-bit integer (unsigned). Range: 0 to 4,294,967,295.

Int64 64-bit integer (signed). Range: -9,223,372,036,854,775,808 to
9,223,372,036,854,775,807.

UInt64 64-bit integer (unsigned). Range: 0 to 18,446,744,073,709,551,615.

Float Defines a value that adheres to the IEEE 754 Single Precision data type definition.

Double Defines a value that adheres to the IEEE 754 Double Precision data type definition.

String Defines a Unicode character string that may not include control characters that are
not whitespaces (0x00 - 0x08, 0x0E - 0x1F or 0x7F).

DateTime OPC UA DateTime. Defines a Gregorian calendar date.

ByteString Defines a value that is a sequence of byte values.

XmlElement OPC UA XmlElement.

Variant Defines a value without a specific data type. The value of such a variable can only
be set within a server side script.

Array Allows you to add an array of the described data types.



275Reference manual

© 2018 Certec EDV GmbH

Adding a data variable

Property

Basically, a property is the same as a data variable (for a description, see section above). The only
relevant difference is that a property must always be a leaf in the object tree (so it can have no child
nodes).

 Object 

Allows you to add instances of your own object types to your project's data structure.

To add an object instance, choose Add Node. -> Object -> [object type]
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Adding an instance of an object

Now the "Create Object Instance(s)" window appears and you can choose from 3 possibilities of how
to create instances:

Single

Creates a single object instance. You only have to key in the name of the object you want to add
and then click "OK".

You can directly add a "RelMirrorBase" to the object instance - go to the section "Relative mirroring"
 for a detailed explanation.288
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Creating a single object instance

Numbered

If you want to add several consecutively numbered object instances, choose "Numbered". Here you
put in an object name, a start index for your numbering and the number of object instances you want
to create.

Use %1 as a wild card for your numeration.
For example: LightObject_%1 will be LightObject_001, LightObject_002, ... after being added.

You can directly add a "RelMirrorBase" to the object instances - go to the section "Relative
mirroring"  for a detailed explanation.288
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Creating several consecutively numbered object instances

List

If you click on list, you can import a csv file for your object instances.
The list contains a locale name and a corresponding browse name for the data source (to add a
relative mirror base to the instances - see "Relative mirroring" )

Syntax for the "Source Browse Name":
[namespace]:[browse name]

288
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Creating several object instances from a csv file

Mirror variables from data sources

Basics

This section describes how to mirror variables from a defined data source into the atvise data
structure ("MirrorInput") and how to mirror atvise variables to a variable of a defined data source
("MirrorOutput").
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"MirrorInput" and "MirrorOutput"

Basically, there are two ways to create mirrored data variables in the atvise builder:

Direct method - "Absolute mirroring"
Object-oriented method - "Relative mirroring"

If you have problems with the connection to a OPC DCOM server, please check out
the OPC DCOM configuration page .

When browsing the TwinCAT DCOM server an object instance can be found as a byte
string variable without any sub-node and additionally as a folder with the same name,
which includes all sub-nodes. Even so the byte string variable might appear first in the
list and the folder further down, for the mirroring of the sub-elements only the folder
can be used and the byte string variable has to be ignored.

MirrorInput

A local data variable with a "MirrorInput" property will automatically receive the current data values of
the foreign data variable which is defined in this "MirrorInput" property.

If the connection to the data source from which the variable is mirrored breaks down,
the status of the local value will change to "BadNotConnected".
When the data source is reconnected, the state of the value will switch back to
"Good" and the current value of the foreign variable will once again be input mirrored.

285

288

271
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MirrorOutput

All data values set to a local data variable with a "MirrorOutput" property will be written to the foreign
data variable which is defined in this "MirrorOutput" property.

If the connection to the data source to which the variable is mirrored breaks down, the
status of the local value will change to "BadNotConnected".
When the data source is reconnected, the state of the value will switch back to
"Good" but the current local value will not be written to the data source (the current
value on the data source - usually a PLC - has higher priority and will not be
overwritten).

MirrorInputOutput

MirrorInputOutput is a combination of MirrorInput and MirrorOutput.

MirrorDisable

With MirrorDisable you can disable communication with a datasource for a single variable or a sub-
tree. All MirrorInput, MirrorOutput and MirrorInputOutput that exist below the node, where
MirrorDisable was created, will be ignored, if MirrorDisable is set to „true".

If a variable should be communicated despite MirrorDisable, you can create a boolean
property with the name „Permanent" and the value „true" at the respective MirrorInput
(or MirrorOutput, MirrorInputOutput as well as RelMirrorInput etc.). For such a variable
MirrorDisable will have no effect.

RelMirrorDisable

With RelMirrorDisable you can disable the creation of mirroring nodes for a single variable or a sub-
tree. 
All RelMirrorInput, RelMirrorOutput and RelMirrorInputOutput that exist below the node, where
RelMirrorDisable was created, will be ignored, if RelMirrorDisable is set to „true". If RelMirrorDisable
is set to „false" then the subtree is enabled again. RelMirrorDisable can be embedded into a subtree
of other RelMirrorDisable. The RelMirrorDisable nodes of a subtree will be evaluated in top-down order
and the last found value will be used.

RelMirrorDisable is different from MirrorDisable. RelMirrorDisable influences the creataion of mirror
nodes. MirrorDisable influences the communication between mirrored nodes and data sources.

If mirroring nodes of a variable should be created despite RelMirrorDisable, you can
create a boolean property with the name „Permanent" and the value „true" at the
respective RelMirrorInput (or RelMirrorOutput, RelMirrorInputOutput). For such a
variable RelMirrorDisable will have no effect. The „Permanent" property will be copied
to mirroring nodes. 
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Smoothing

Smoothing allows to limit the number of value changes written to a data variable. Smoothing can be
applied to any data variable, but it is mostly used at mirrored variables. It´s possible to use multiple
smoothing properties per variable. Status changes of the variable are always applied independently
from the smoothing.

The following smoothing properties are available:

Change Comparison If you add a "Change Comparsion" property to a mirrored data variable it
has to activated and a new value will only be set on the mirrored data
variable if it differs from the current value or if the status changes.

Deadband Absolute You can set an absolute value to this property; a new value will only be
set if the value has changed by at least this deadband value.
(e.g. if you have a DeadbandAbsolute with a value of 0.1, the new value
has to change at least by 0.1 to be set).

Deadband Relative Similar to deadband absolute, but with a percentage value.
(e.g. if you have a DeadbandRelative with value 10, the new value has to
change at least by 10% to be set).

SuppressFlicker Enter a time in milliseconds. The timestamp of a new value has to differ by
at least this time from the timestamp of the current value to be set.

To add smoothing, right-click a mirrored data variable and choose Add Smoothing from the menu:
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Add smoothing to a mirrored data variable

Linear Conversion

By means of linear conversion the mirrored input/output value in atvise can be converted after
received from or before sent to the data source.

1 Rightclick on the mirroring of a node.

2 Choose "Add Conversion" -> "Linear"

3 Two properties will be added to the mirroring. "LinearConversionSlope" and
"LinearConversionYIntercept".

4 Doubleclick these properties to change their values.
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Adding a linear conversion

The conversion is a simple linear function defined by
value = k * x + d, where
x denotes the value stored in the data source
y denotes the mirrored value stored in atvise
k defines the slope of the linear conversion denoted by the property name "LinearConversionSlope"
d defines the offset of y if x = 0 denoted by the property name "LinearConversionYIntercept" as can
be seen on the next figure:
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Example:

The valuerange of a node in the data source is between 0 and 100.
It should be converted to a mirrored node in atvise in the range between -5 and 5.

Set LinearConversionSlope to 0.1
and LinearConversionYIntercept to -5

Now the range of the value will be converted to the desired range.

Note: Linear conversion can be configured on MirrorInput, MirrorOutput,
MirrorInputOutput and their relative mirroring counterparts RelMirrorInput,
RelMirrorOutput, RelMirrorInputOutput.

In input direction, the conversion function will be applied directly.

In output direction, the inverse of the conversion function will be applied. The result of
the calculation is always of data type "double", therefore the value can only be written
if it is also of data type "double" at the data source!

Copying and pasting data variables from a foreign server

The easiest and most efficient way to create absolute mirrored data variables in the atvise data
structure is to copy and paste them directly from a data source  (foreign server).

Single data variable

You can copy and paste a node from an external server. atvise builder automatically creates a node
with its appropriate type and the property "Mirror".

1 Browse the datasource where you want to copy the node from (like described in section 

251
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Handling data sources ).

2 Right click on the desired node(s) and choose "Copy" from the context menu.

3 Right click on the node in your local object structure where you want to paste the node from the
external server.

4 Choose "Paste&Mirror -> Input -> node" in the context menu. You can rename the node in the
appearing pop-up.

Copy & paste a single mirrored node from a data source

You can select multiple nodes in the structure of the data source by clicking on them
while holding Crtl or Shift and copying & pasting them afterwards.

Structure without types

The atvise builder also offers the possibility of copying & pasting a whole structure of variables. When
choosing "node", only the selected node will be copied (without child nodes); when choosing
"structure without types", all child nodes will be copied too. In the mirrored structure the objects of
the data source are replaced with folders. Only folders and variables will be created in the mirrored
structure.

NOTE: Other options of mirroring structures are described in Object oriented – 
relative mirroring .

1 Browse the data source from which you want to copy variables (as described in the section 
Handling data sources ).

2 Right-click on a desired parent node (folder) and click on "Copy" in the menu which appears.

3 Right-click on the node in your local object structure where you want to paste the structure.

4 Choose "Paste & mirror" -> "Input" -> "structure without types" from the menu. You can type in
a new name for the top node in the dialog which appears.

251

288
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Copy & paste a whole data structure from a data source

Copying and pasting a mirror address from a foreign
server

Another possibility is to paste the mirror property to an existing data variable (only the mirroring
property will be created - no new data variables as with the other two methods).

1 Browse the data source from which you want to copy a variable (as described in the section 
Handling data sources ).

2 Right-click on a desired node and click on "Copy" in the menu which appears.

3 Right-click on the node in your local object structure to which you want to add a mirror property.

4 Choose "Paste & mirror" -> "Input" -> "address" from the menu.

Copying & pasting a mirror address from a data source

251
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If you use this method, be sure that the data types of the local and foreign variables
match - otherwise the mirror module may produce an error and won't work if the data
type cannot be converted!

Concept

The basic concept of relative mirroring is that the complete mirroring property (MirrorInput/
MirrorOutput) of a data variable is generated using

1. Relative mirroring properties at the object type (one for each mirrored data variable)
2. A mirror base (and, optionally, path fragments) at the object instances (one per instance)

Relative mirroring property (for each variable - referenced from the object type)
+ Individual mirror base (for each object instance)
= Complete mirroring address

Example:

Procedures

There is an automatic and a manual procedure of relative mirroring.

NOTE: The automatic procedure will be used  if you choose either "structure from
data source types" or "structure from data source instances" from the menu to copy
the structure.

The procedure of automatically creating relative mirrored nodes consist of two basic steps:

Define the prefix and trim of object/variable types as described in the section Add DataSource
Mirror the specified objects/variables from the data source by the menu option "structure from data
source types" or “structure from data source instances”. The missing object/variable types will be
created automatically. The location of mirrored types is given by the trim and prefix parameters of
the data source. See Add DataSource .

252
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The procedure of manually creating relative mirroring consists of two basic steps:

Adding relative mirror properties to the variables of an object type.
Adding a base (possibly also path fragments) to an object instance(s) to complete the mirror
address.

Mirroring structure from data source instances

The examples below uses the opcuatestserver of atvise.
 

1 Browse the data source from which you want to copy a variable (as described in the section 
Handling data sources ).

2 Right-click on a desired data variable and click on "Copy" in the menu which appears.

3 Right-click on the node in your local object structure where you want to paste the variable.

4 Choose "Paste & mirror" -> "Input " -> "structure from data source instances" from the menu.
You can type in a new name for the base of the structure in the dialog which appears.

 

After successful mirroring the Object Types folder will contain the object types of the mirrored
objects if they were not defined yet. The missing object types will be created from the data source
instances, and are possibly not the same as the corresponding object types in the data source, as
shown on the next picture. Mirroring another object of the same type by any other structure mirroring
method will use the already created types and will not update the mirrored types. It is assumed, that
the OPC UA server exposes objects in the same manner: If they have the same type definition, they
have the same structure. If this condition is not fulfilled, the mirrored objects or types must be
corrected manually.

251
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Since the type information is taken from the instance “WeatherStation001” which is an instance of
the “WeatherStationType” object type, only the object type “WeatherStationType” is created. Super
types are not explicitly created but their nodes are inherited and therefore part of the
“WeatherStationType” object type.

If the mirrored types will be changed in atvise, then the next mirroring will use the changed types,
and will not update the type from the data source. An example can be seen on the next figure.
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In the example the "Controller" variable was deleted from the object type
"WeatherStationAnemometerType" in atvise. 
All objects in atvise are updated and the "Controller" variable is removed from the object type
"WeatherStationType" and from the object "WeatherStation001" in atvise.
After that the object "WeatherStation002" in the data source was mirrored by “structure form data
source instance”.
The mirrored object "WeatherStation002" in atvise does not contain the variable "Controller", as the
object type "WeatherStationType" and "WeatherStationAnemometerType" in atvise did not contain it.
The mirroring does not update existing types in atvise.

NOTE: Object instances in the data source may have different structures as the
object types in the data source. E.g. if the type contains elements with Optional
HasModellingRule or the data source is not a standard UA server.  Mirroring with
“structure form data source instances” is in this case the best method to choose.
However this method will flatten the type hierarchy and may duplicate elements.

Mirroring structure from data source types

1 Browse the data source from which you want to copy a variable (as described in the section 
Handling data sources ).

2 Right-click on a desired data variable and click on "Copy" in the menu which appears.

3 Right-click on the node in your local object structure where you want to paste the variable.

4 Choose "Paste & mirror" -> "Input " -> "structure from data source types" from the menu. You
can type in a new name for the base of the structure in the dialog which appears.

 

After successful mirroring the Object Types folder will contain the object types of the mirrored
objects if they were not defined yet. These missing object types will be created from the data
source types with the full type hierarchy as seen on the next figure.

251
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Since the type information is taken from the object type “WeatherStationType” the same object type
hierarchy (including the referenced object type “WeatherStationAnemometerType” with its
“AnemometerType” super type) is created in atvise.
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NOTE: If the object/variable of the data source references a type that is undefined or
empty in the address space of the data source, then a type will be automatically
created in the local address space of atvise from the object/variable of the data
source. Empty means that all supertypes are empty as well. If the type already exists
in the local address space of atvise, this type will be used for creating the object/
variable to mirror.

The other mirroring rules are the same as for “structure from data source instances”.

 
Manually adding relative mirrored variables to an object type

1 Browse the data source from which you want to copy a variable (as described in the section 
Handling data sources ).

2 Right-click on a desired data variable and click on "Copy" in the menu which appears.

3 Right-click on the node in your local object type where you want to paste the variable.

4 Choose "Paste & mirror" -> "Input" -> "node" from the menu.

5 Select the base node of the copied variable. The mirror address will be taken from this point.
The individual base addresses for the object instances will be set in the next section. You can
type in a new name for the variable in the dialog which appears.

Copy & paste a variable relative to its object base into an object type

You can also copy & paste a whole structure of variables, or the mirror address or
you can create the relative mirror properties manually the same way as described in
the section Absolute mirroring .

Manually adding a base to an object instance(s)

When creating a single instance

1 Right-click on the node where you want to add a new object.

2 Choose "Add Node" -> "Object" -> [Objecttype] from the menu which appears.

251
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3 Type in a name for the new object instance.

4 Check "Add RelMirrorBase".

5 Click the "Select..." button and select the base node of the new object instance (the data
source must be connected to use this dialog). This base will be added to the object instance to
complete the mirroring address.

You can optionally also add path fragments to the object instance ("RelMirrorBase" =
OPC Node ID, "PathFragment" = OPC Browse Path).

-> "RelMirrorBase" + [PathFragment(s)] + "RelMirrorInput/Output" = complete address

6 Confirm the dialog to create the object instance.
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Creating a single object instance with a RelMirrorBase

When creating numbered instances

1 Right-click on the node where you want to add a new object.

2 Choose "Add Node" -> "Object" -> [Objecttype] from the menu which appears.

3 Select "Numbered" to the left in the dialog.

4 Type in a name for the new instances. Use the wild card "%1" to give the instances a numbered
name.
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You can use the wild card "%1" in the object name, in the mirror base and in path
fragments to create fully functioning numbered object instances. The substituted numbers
will be defined in the next step.

5 Select the start index and the number of object instances you want to create (this number can
be substituted in the name and the base of the instance using the "%1" wild card ).

6 Check "Add RelMirrorBase".

7 Select any base node of one of the new object instances. The base will be added to the object
instance to complete the mirroring address.

8 Use the wild card "%1" to create numbered mirror bases.

9 Confirm the dialog to create the object instances.
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Creating numbered object instances with RelMirrorBases

When creating a list of instances

1 Right-click on the node where you want to add a
new object.

2 Choose "Add Node" -> "Object" -> [Objecttype]
from the menu which appears.

3 Select "List" to the left in the dialog.
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4 Select a CSV file with the list of the objects.

Format:

[Object Name];[Path
Fragment(Namespace:BrowsePath)]

Example:

Light_1;2:L010
Light_3;2:L003
Light_5;2:L005
Light_10;2:L010

5 Check "Add RelMirrorBase".

6 Select the mirror base of the object.

You can also select the top node of your
data source as the mirror base.

-> RelMirrorBase + [PathFragment(s)] +
RelMirrorInput/Output = Complete address

7 Confirm the dialog to create the object
instances.
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Creating a list of object instances with RelMirrorBases

Copying & pasting to an existing object instance

1 Browse the data source from which you want to copy the base (as described in the section 
Handling data sources ).

2 Right-click on the desired base node and click on "Copy" in the menu which appears.

3 Right-click on the object instance where you want to paste the "RelMirrorBase" and choose
"Paste & mirror" -> "Mirror Base".

251
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New mirror properties may be added to an existing node by using its context menu.

To edit existing mirror properties simply double click the affected property.

Editing absolute mirror properties

The dialog is split into two sections which allow direct editing of the value (=value of the mirror
property including the address) or its components. Whenever a specific component is changed in the
section “Configuration” the preview of the value in the section “Value” is updated as well. In case the
value is changed, the other fields in the section “Configuration” will not be changed automatically.
The following input fields will be available depending on the type of the selected data source.

OpcUa:
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Namespace
Type
Address

atvise OpcUa to S7:
Namespace
PLC
Address

OpcCom:
Address

webMI:
Address

SNMP:
Type: OID data type
o String: Text

o Gauge: Numeric type with range between minimum and maximum of the related data type

o Counter: Numeric permanently increasing counter with overflow

OID: SNMP object identifier or a fixed number
Operand OID / Operator: Optional OID or a fixed number. The value of the parameter “OID” will
be combined with the value of the “Operand OID” according to the selected arithmetic operator.
(Not relevant for type: String)
Filter OID / Filter value: Additional OID and related filter value for determining the table index to
be used with parameters “OID” and “Operand OID”
Note: Filter OID / Filter value do not have to be entered, if the table index are specified in the
OIDs
Aggregate / Sample count: Optional aggregation to be applied to the resulting value.
Depending on type:
o The Aggregate will be applied on the calculated value

o The Aggregate will be applied on the difference of the calculated and the previous value

o String: not relevant

Example:
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Editing the SNMP Mirroring

Assumption: the following OIDs are available (the table index is shown in bold):
HOST-RESOURCES-MIB::hrStorageDescr.1 (.1.3.6.1.2.1.25.2.3.1.3.1) = STRING: "C:\\
Label:Root"
HOST-RESOURCES-MIB::hrStorageDescr.2 (.1.3.6.1.2.1.25.2.3.1.3.2) = STRING: "Q:\\
Label:Data"
HOST-RESOURCES-MIB::hrStorageSize.1 (.1.3.6.1.2.1.25.2.3.1.5.1) = INTEGER: 55834879
HOST-RESOURCES-MIB::hrStorageSize.2 (.1.3.6.1.2.1.25.2.3.1.5.2) = INTEGER: 4460287
HOST-RESOURCES-MIB::hrStorageUsed.1 (.1.3.6.1.2.1.25.2.3.1.6.1) = INTEGER: 44492671
HOST-RESOURCES-MIB::hrStorageUsed.2 (.1.3.6.1.2.1.25.2.3.1.6.2)= INTEGER: 3239229

1. OID/Number: .1.3.6.1.2.1.25.2.3.1.6 (corresponds to „hrStorageUsed“)
2. Filter OID/Filter value: .1.3.6.1.2.1.25.2.3.1.3 (corresponds to „hrStorageDescr“) with related

filter „C:“ to determine the table index for drive „C:“ (would result in value 1)
3. Operand OID/Number Operator: The value from table index 1 (=44492671) of the “OID/Number”

.1.3.6.1.2.1.25.2.3.1.6 (corresponds to „hrStorageUsed“) will be divided by the value from table
index 1 (=55834879) of the „Operand OID/Number“ .1.3.6.1.2.1.25.2.3.1.5 (corresponds to
“hrStorageSize“). This will result in the actual used storage (percent).

HINT: The selection of the namespaces requires a previous established connection to
the data source. When no connection has been established yet namespaces have to
be entered manually.

HINT: Whenever parsing of a mirror property fails (after double clicking a mirror
property), the section “value” will be preselected and the component fields in the
section “Configuration” will be prefilled as far as possible. 
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Editing relative mirror properties

The dialog allows to define a browsepath by entering an arbitrary amount of path fragments which
consist of a namespace and a browsename.

Alarming functions

In the atvise builder, you have the opportunity to add alarms to your data structure. An alarm is
triggered when the value of the corresponding data variable meets the configured condition (e.g.
limit).

To see how alarms are signalized and handled in the visualization go to the atvise webMI
visualization section.

Alarm Categories

Alarm categories are objects that encapsulate common alarm properties such as:

Name
Severity
Acknowledgement Type

Alarm configurations reference alarm categories by their names.

atvise SCADA will be delivered with 3 predefined alarm categories:

Information
Warning
Error
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Alarm Categories

To add your own alarm categories, right-click Library->PROJECT->Alarm Categories and choose
"Add Alarm Category...".
The mandatory properties of an alarm category are:

Name The name of the alarm category used to reference it.

Severity The severity of the alarm condition the category belongs to

Acknowledgement Type Specifies the acknowledgement type of  the condition
Not Acknowledgeable
Acknowledged by Inactive Condition State
Condition will be Inactive upon Acknowledge
Acknowledge Active or Inactive Condition State needed
Acknowledge Active and Inactive Condition State needed

Explicit Acknowledgement Not used.

Note: The usage of optional properties of alarm categories like "Color", "Abbreviation", etc., is user
defined. The optional properties of alarm categories will be sent to the client if the optional property is
defined. The default atvise alarm list makes no use of the optional properties of alarm categories.

The properties of the alarm categories will be sent to the client as a name value pair as additional
alarm information.
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Adding an alarm configuration to a node

Right-click on the desired node and choose "Add Alarm Configuration" from the list which appears:

 

Adding an Alarm Configuration

Alarm Configuration

Double-click the Alarm Configuration property to configure the alarm.

AlarmConfig Condition Type: Select your desired condition type.
Discrete: Triggers an alarm if the source value and the condition value are
matched / unmatched.
Discrete Retrigger: Like "Discrete", but each source value change that fulfils
the condition triggers a new alarm.
Limit: Triggers an alarm if the source value is in the given condition range.
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In case of limit type, you can choose between exclusive or nonexclusive type.
 
exclusive: The ranges of the limit do not overlap. Eg: range1: value > 0 and
value <= 10; range2: value > 10 and value <= ?;

nonexclusive: The ranges of the limit overlap. Eg: range1: value > 0 and value
<= ?; range2: value > 10 and value <= ?;

SourceNode: If the alarm configuration is defined under a variable node, the
source node will be automatically set to this node. If the alarm configuration is
defined at another place of the object structure, the source variable must be
selected here.

Display: Select the corresponding display for your alarm (necessary for the
jump-to-display  visu function).

Conditions: One or more alarm conditions can be defined here.

Name: Each condition must have a distinct name in the alarm configuration.
Category: Specifies the category of the condition: warning, error, etc.
To Active Text: Specifies the text to be displayed if the condition state
changes to active. (this text will automatically be considered for the
translation; no "T{}" required)
To Inactive Text: Specifies the text to be displayed if the condition state
changes to inactive. (this text will automatically be considered for the
translation; no "T{}" required)
Value: Specifies the limit or match value of the condition with the
corresponding operator.

Alarm configuration example for a discrete variable

152
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Alarm configuration example for an integer variable

The additional alarm information will be sent as a name value pair to the client. It must start with a
capital letter. The value part is taken from the node that is defined in the browse path (it is like a
pointer). Additional Alarm Information makes sense for alarm configurations defined at Object Types
as shown in the following figure:

Alarm configuration example of Additional Information
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The atvise alarm log and history table substitute additional alarm information
automatically; for this purpose you can use the printf syntax, e.g.: To Active Text:
HighHigh: %(Info)s

Alarm visualization

Add script to nodes

The script editor is a tool for writing JavaScripts. You have the opportunity to use all JavaScript
elements. You can write a script for every node. This makes working in the atvise builder very flexible
and comfortable.

Using server scripting, you can extend the functionality of atvise SCADA. All internal nodes of atvise
SCADA can be accessed in a server script. Server scripts can be triggered by a time, value change,
alarm, etc.

A detailed description of the server scripting elements can be found at atvise SCADA server scripting
reference .

Adding a script

If you want to add a script to a node, right-click it and choose "Add Script". After double-clicking on
the property "ScriptCode", the script editor opens. In the section server scripts editor  you will find
a detailed explanation about the script editor.

508
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Adding a script to a node
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Historizing data

Add Archive Group

To archive your data, it is necessary to add an archive group.

Data

A Data Archive Group, also called raw archive, is used to save the raw values of a node directly to a
database file. For example, any temperature values or sensor state values will be saved in the
database file. The standard atvise archive group is named "datavalues".

 If you want to historize a node, you have to reference an archive group to this node.
 For more, see the section "Historizing (and aggregating) a node". 

Add Data archive group

A data archive group has the following attributes:

Name Name of the archive group. Due to limitations of the file system, it is
not possible to create multiple archive groups differing only in case
(upper/lower).

Activated Once this option is disabled, no data will be historized in this archive.
A typical use case for raw values is to permanently disable the
archive and only write values with the server-side function 
history.write() .

Interpolation Sloped or Stepped. Only relevant when the archive group is used as
source for an aggregate function other than "Sampled" (see 
Aggregating data ).

562
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Partition interval New database files are created in this time interval for this archive
group

File limit Defines the maximum number of database files for this archive group.
Once this number is exceeded, the oldest database file will be
deleted.

Example: To have historical data for the last 6 months available,
define a partition interval of "Monthly" and a file limit of 7. When the
eighth database file is created, the oldest database file will be
deleted. Thus, the historical data of the last 6 months plus the
current month are always available.

You can open the configuration dialog at a later time by double-clicking again on the
archive group

The database files of the archive groups are stored in the database folder (another directory can be
specified in the atserver.ini file). The .db-file is saved as "archivename_YYYYMMDD_hhmm.db"

Database folder in atvise

 We recommend a maximum of 10 archive groups with a file limit of a maximum of 25,
so that never more than 250 archive records are stored in the database directory. A
greater number of archive groups / archive records leads to significant loss of
performance in both the writing and reading of historical data.

 Note: Without a partition interval / file limit the database file of the archive group is
increasing over time. Since the performance when querying historical data (trend,
historical list, ...) depends on the size of the database file, it is strongly
recommended to define appropriate parameters for each archive group.

To reduce the amount of the original historically recorded data, you can use the 
smoothing  properties

282
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Aggregate

An aggregate archive group stores aggregates calculated according to the aggregate templates.

Add Aggregate archive group

The checkbox “Activated” affects the aggregates as follows:
If an aggregate archive is deactivated then the aggregate will not be calculated, not be historized
and can only be written by post-aggregation (e.g. with the server-side function history.aggregate()

).
If chained aggregates exist, they will not automatically be deactivated.

The remaining options are equal to the data archive group as described in the clause “Data” above.

Event

An event archive group stores following events:

o type "Alarm"

change of an alarm status

o type "Event" (only when triggered from the visualization)

login
logout
write of a value in the visualization

564
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call of a server-side script via webMI.data.call

         
Add Event archive group

If you add an event archive group, all events will automatically be saved in this archive
group. 
Only one such archive group can be created, otherwise alarms etc. will be archived
multiple times.

The remaining options are equal to the data archive group as described in the clause “Data” above.

Historizing (and aggregating) a node

To historize the data values of a node, you have to create a reference to a data archive group. Same
applies if you want to calculate aggregates according to a previously defined aggregate template.

Right-click on a node, select „Historize…“ and the dialog „Assign Raw Archive and Aggregate
Template“ will be opened:
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Historizing a node

In the dialog „Assign Raw Archive and Aggregate Template“ following assignments have to be made:

Raw Archive Select one of the existing raw archives where the raw values of the node
shall be written to or "(None)" for no raw archive.

See note below for additional information when you may need a raw
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archive even if you do not plan to keep an archive of raw values.

Aggregate Template Select one of the existing aggregate templates  and the aggregates
defined in the aggregate template will be calculated for this node.

Set the selection to “(None)" if only historization of raw values shall be
done.

See note below for additional information when a raw archive is also
needed.

If you use aggregate functions other than "Sampled" in the first level of the selected
aggregate template, you also have to select a raw archive! The aggregate functions
use the values from the raw archive to calculate the respective aggregated values.

If you have only "Sampled" in the first level of the selected aggregate template,
selection of a raw archive is optional. "Sampled" will always take the values directly
from the variables through sampling.

For easier parametrization, multiple nodes (even included folders) can be selected as shown in the
figure below. Though folders can be selected, they will be ignored for the assignments. Therefore
they cannot be used to automatically historize all nodes of selected folders:

329
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In case multiple nodes are selected and “Historize…” was selected, it might happen that the entries
in the dialog “Assign Raw Archive and Aggregate Template” are set to “(Multiple archives assigned)”
and/or “(Multiple templates assigned)”:

This will happen when due to the multiple selection of nodes multiple assignments to raw archives
and/or aggregate templates exist. In the example above the nodes of the first two folders are
assigned to the raw archive “datavalues” and to the aggregate template “AT1”. The nodes of the third
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folder are assigned to the raw archive “datavalues2” and to the aggregate templates “AT2”.

In such a case, you can either reassign all selected nodes or reduce the number of selected nodes
to avoid multiple assignments.

If you historize a node of an Object Type, the historization will also change at all
instances.

Query history

The query of historized values can be done as follows:

Using the standard atvise resource history list  in the visualization.
In the visualization using the function webMI.data.queryFilter .
In the server-side scripting using the function history.query .
Via the atvise builder as described below.

Use this functionality to query historized raw values and aggregated values in the atvise builder.

Right-click on the desired node select „Query History…“ will open a tab in the section „Graphic-
Editor and Viewer“. This tab contains the following three tabs:

Raw Values: to query raw values for a specific period.
Aggregated Values: to query aggregated values for a specific period.
At Time: to query raw values for a specific point in time.

Raw Values

154
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Querying raw values of a node

The time period and detailed options can be defined as follows:

Start Time Start time (in local time) of the query period

End Time End time (in local time) of the query period

Number of values to return Limits the number of the returned values to the given value. A
value of 0 means that all values within the query period will be
returned.

Return bounds Activate this option to additionally get one value before the
start time and one value after the end time.

Clicking on „Read History“ will retrieve the data and will show the source and server time (in local
time), the status and value of the historized raw values in a table. If the start time is before the end
time, the raw values will be sorted ascending by the source time and newer raw values will be
truncated if applicable. If the end time is before the start time, raw values will be sorted descending
and older raw values will be truncated if applicable.

Aggregated Values
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Querying aggregated values of a node

The time period and detailed options can be defined as follows:

Start Time Start time (in local time) of the query period

End Time End time (in local time) of the query period

Function Aggregate function for which the historized values will be
queried. Must be contained in the aggregate template
assigned to the node.

Interval Must conform to a parametrized interval in an aggregate
template. If setting the value to 0, the interval will be calculated
from the start time and end time.

Clicking on „Read History“ will retrieve the data and will show the source and server time (in local
time), the status and value of the historized aggregate in a table. The source time represents -
depending on the aggregate function - the start time of the interval or the source time of a node, the
server time represents the end of the interval (when reaggregating the end of the current interval for all
reaggregated values) respectively the original source time for "Sampled" aggregates.

At Time
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Querying the value of a node for a specific time

Here you can add several timestamps to a list for which the query of historized raw values will be
done. If there exists no raw value for the given time stamp, then – depending on the setting “Use
simple bounds” – the raw value will be calculated from its adjacent values.
Activate “Use simple bounds” to calculate in the above mentioned case the value according to
„Simple Bounding Values”; otherwise they will be calculate according to „Interpolated Bounding
Values“ (see Aggregating data ).

As shown in the figure in the section “Raw Values”, no raw value exists at 8:32:00.
Therefore the value (7.78713) at 8:32:00 was calculated based on the value 7 (at 8:31:23) and 8 (at
8:32:09).

When calculating values "At Time", the setting Interpolation  of the data archive
group is used.

Swapping in archive files

For read only access to archived data, backed up archive files can be copied into the "swapin" folder
below the "database" folder (both folders can be specified in atserver.ini ). Any archive files in the
"swapin" folder will automatically be used for queries. If you are finished using an archive file you can
simply delete it.

In case an archive file with the same name can be found in the "database" and
"swapin" folders at the same time, the file in the "database" folder will be ignored and
queries will only return data from the file in the "swapin" folder. Also, new data will not
be written to the archive file in the "database" folder until the file in the "swapin" folder
is deleted.

Historization settings

Activate threshold checks to prevent an overflow of the drive due to the historization.

323
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Right-click on „History Archives“ and select „Edit History Settings…“ will open the dialog „Edit
History Settings“ to configure the percentage (range 0 to 100) of the thresholds “High” and “Critical”.
Setting both thresholds to 0 will deactivate this functionality.

Changing historization settings

To check whether the current storage utilization of the drive exceeds one of the thresholds, the
current storage utilization of the drive, where the archives are located, has to be written on a
dedicated node (range 0 – 100). Therefore the node
“SYSTEM.INFORMATION.DIAGNOSTICS.DISK.atviseHistoryDriveUsedPercent” of type “Float” has
to be created. The used storage can be determined by server-side scripting (FileSystem functions
) or by using SNMP.

In case the current storage utilization exceeds the threshold “High”, a warning will be written to the
atvise logfile. Exceeding the threshold “Critical” will result in deactivating the historization. The query
of historical data will still be possible.

In case the current storage utilization declines below the threshold “Critical” but is still higher than
the threshold “High”, an entry will be written to the atvise logfile but the historization still keeps
deactivated. Only in case the current storage utilization declines below the threshold “High”, the
historization will be enabled again and an entry will be written to the atvise logfile.

533
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Aggregating data

General

Aggregation is the calculation of so called aggregates like minimum, maximum, average based on
raw values or based on already calculated aggregates.

The aggregates used in atvise are based on the OPC UA-specification Part 13 „Aggregates“ (Release
1.03). For the atvise documentation below parts of that specification where taken by courtesy of the
OPC Foundation.

Each aggregate is defined by an interval with the related start and end time and the corresponding
aggregate function.

Example:
5-minute minimum
4-hour average
1-day maximum

OPC UA aggregates need „Bounds“ (= values at the start timestamp and end timestamp of the
interval) for their calculation. Two kinds of calculating bounds exist which are defined by the
aggregate function:

Interpolated Bounding Values: using the first value with status Non-Bad before and after the
timestamp.
Simple Bounding Values: using the first value before and after the timestamp even if the
status is “Bad”.

In addition, each aggregate function has the following two settings:
Interpolation: Will be configured for the raw archive and applies to all aggregate functions of an
aggregate template due to the assignment of the aggregate template and raw archive to a node.
Interpolation will automatically be applied in case a value exists before and after the timestamp
(start time or end time).
Extrapolation: Will be configured directly for the aggregate function.
Extrapolation will automatically be applied, when for an interval boundary (start or end time) only
values before the boundary exist.

Interpolation and Extrapolation can either be set to "sloped" or "stepped":

Sloped and stepped inter-/extrapolation

The supported aggregates include all aggregates according to the OPC UA specification and also the
atvise specific "Sampled" aggregate:
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Aggregate Description

AnnotationCount Returns a count of all annotations in the interval.
The timestamp of the aggregate will always be the start of the
interval.
Note: Since annotations are currently not supported by the
atvise server, the result will always be 0.

Average Adds up all values with status “Good” for each interval, and
divides the sum by the number of values with status “Good”.
This aggregate is not time based so the “Minimum Good
Values” and “Minimum Bad Values” applies to the number of
values in the interval.
The timestamp of the aggregate will always be the start of the
interval.

Count Retrieves a count of all the values within an interval. If one or
more values are non-Good, they are not included. If no Good
data exists for an interval, the count is zero.
The timestamp of the aggregate will always be the start of the
interval.

Delta Retrieves the difference between the earliest and latest Good
values in the interval. The aggregate is negative if the latest
value is less than the earliest value.
The timestamp of the aggregate will always be the start of the
interval.

DeltaBounds Returns the difference between the StartBound and the
EndBound aggregates with the exception that both the start
and end shall be Good. The aggregate is negative if the
EndBound aggregate is less than the StartBound aggregate.
The timestamp of the aggregate will always be the start of the
interval.

DurationBad Divides the interval into regions of Bad and non-Bad data.
Each region starts with a value in the interval. If that value is
Bad the region is Bad. The aggregate is the sum of the
duration of all Bad regions expressed in milliseconds.
The status of the first region is determined by finding the first
value at or before the start of the interval.
The timestamp of the aggregate will always be the start of the
interval.

DurationGood Divides the interval into regions of Good and non-Good data.
Each region starts with a value in the interval. If that value is
Good the region is Good. The aggregate is the sum of the
duration of all Good regions expressed in milliseconds.
The status of the first region is determined by finding the first
value at or before the start of the interval.
The timestamp of the aggregate will always be the start of the
interval.

DurationInStateNonZero Returns the time duration (in milliseconds) during the interval
that the value (also applicable for Boolean) was not zero or
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true. The Simple Bounding Values for the interval are used to
determine the initial value. If one or more values are non-
Good, they are not included in the Duration.
The timestamp of the aggregate will always be the start of the
interval.

DurationInStateZero Returns the time duration (in milliseconds) during the interval
that the value (also applicable for Boolean) was zero or false.
The Simple Bounding Values for the interval are used to
determine the initial value. If one or more values are non-
Good, they are not included in the Duration.
The timestamp of the aggregate will always be the start of the
interval.

End Retrieves the latest value within the interval, and returns that
value and status with the timestamp at which that value
occurs.

EndBound Returns the value and status at the end time for the interval
by calculating the Simple Bounding Values for the interval.
The timestamp of the aggregate will always be the start of the
interval.

Interpolative Returns the interpolated value for the start time of each
interval.

Maximum Retrieves the maximum Good value within the interval. If the
same maximum exists at more than one timestamp, the
oldest one is retrieved.
The timestamp of the aggregate will always be the start of the
interval.

Maximum2 Retrieves the maximum Good value for each interval as
defined for Maximum except that Simple Bounding Values
are included.
The timestamp of the aggregate will always be the start of the
interval.

MaximumActualTime Retrieves the maximum Good value within the interval, and
returns that value with the timestamp at which that value
occurs. If the same maximum exists at more than one
timestamp, the oldest one is retrieved.

MaximumActualTime2 Retrieves the maximum Good value for each interval as
defined for MaximumActualTime except that Simple
Bounding Values are included.
The timestamp of the aggregate will always be the timestamp
of the maximum Good value for every interval.

Minimum Retrieves the minimum Good value within the interval. If the
same minimum exists at more than one timestamp, the
oldest one is retrieved.
The timestamp of the aggregate will always be the start of the
interval.

Minimum2 Retrieves the minimum Good value for each interval as
defined for Minimum except that Simple Bounding Values are
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included.
The timestamp of the aggregate will always be the start of the
interval.

MinimumActualTime Retrieves the minimum Good value within the interval, and
returns that value with the timestamp at which that value
occurs. If the same minimum exists at more than one
timestamp, the oldest one is retrieved.

MinimumActualTime2 Retrieves the minimum Good value for each interval as
defined for MinimumActualTime except that Simple Bounding
Values are included.
The timestamp of the aggregate will always be the timestamp
of the minimum Good value for every interval.

NumberOfTransitions Returns a count of the number of transitions the value had
during the interval. If one or more values are Bad, they are not
included in the count.
The timestamp of the aggregate will always be the start of the
interval.

PercentBad Performs the following calculation:
PercentBad = DurationBad / Interval x 100, where:
DurationBad is the result from the DurationBad aggregate.
The result is in the range from 0 to 100.
The timestamp of the aggregate will always be the start of the
interval.

PercentGood Performs the following calculation:
PercentGood = DurationGood / Interval x 100, where:
DurationGood is the result from the DurationGood aggregate.
The result is in the range from 0 to 100.
The timestamp of the aggregate will always be the start of the
interval.

Range Finds the difference between the maximum and minimum
Good values in the interval. If only one Good value exists in
the interval, the range is zero. Note that the range is always
zero or positive.
The timestamp of the aggregate will always be the start of the
interval.

Range2 Finds the difference between the maximum and minimum
values in the interval as returned by the Minimum2 and
Maximum2 aggregates. Note that the range is always zero or
positive.
The timestamp of the aggregate will always be the start of the
interval.

Sampled Takes a sample of the raw value in the given sampling
interval.
The timestamp of the aggregate will always be the start of the
interval.

StandardDeviationPopulation Uses the formula:
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where X is each Good value in the interval, Avg(X) is the
average of the Good values, and n is the number of Good
values in the interval.

For every interval where n = 1, a value of 0 is returned.
This calculation is for a full population where the calculation
is done on the full set of data. Use StandardDeviationSample
to calculate the standard deviation of a subset of the full
population. An example would be when the underlying data is
collected on an event basis versus sampled from the data
source.
The timestamp of the aggregate will always be the start of the
interval.

StandardDeviationSample Uses the formula:

where X is each Good value in the interval, Avg(X) is the
average of the Good values, and n is the number of Good
values in the interval.

For every interval where n = 1, a value of 0 is returned.
This calculation is for a sample population where the
calculation is done on a subset of the full set of data. Use
StandardDeviationPopulation to calculate the standard
deviation of a full set of data. An example would be when the
underlying data is sampled from the data
source versus stored on an event basis.
The timestamp of the aggregate will always be the start of the
interval.

Start Retrieves the earliest value within the interval, and returns
that value and status with the timestamp at which that value
occurs.

StartBound Returns the value and status at the start time for the interval
by calculating the Simple Bounding Values for the interval.
The timestamp of the aggregate will always be the start of the
interval.

TimeAverage Starting at the starting bounding value a straight line is drawn
between each value in the interval ending at the ending
bounding value. The area under the lines is divided by the
length of the interval to yield the average. Note that this
calculation always uses a sloped line between points.
TimeAverage2 uses a stepped or sloped line depending on
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the setting “interpolation” of the related data archive.
The timestamp of the aggregate will always be the start of the
interval.

TimeAverage2 Starting at the starting bounding value a straight line is drawn
between each value in the interval ending at the ending
bounding value. The area under the lines is divided by the
length of the interval to yield the average. Note that this
calculation uses a stepped or sloped line depending on the
setting “interpolation” of the related data archive; TimeAverage
always uses a sloped line between points.
The timestamp of the aggregate will always be the start of the
interval.

Total Performs the following calculation for each interval:
Total = TimeAverage x Interval (seconds), where
TimeAverage is the result from the TimeAverage aggregate.
The timestamp of the aggregate will always be the start of the
interval.

Total2 Performs the following calculation for each interval:
Total2 = TimeAverage2 x Interval of good data (seconds),
where TimeAverage2 is the result from the TimeAverage2
aggregate.
The interval of good data is the sum of all sub-intervals where
non-Bad data exists; e.g. if a value was Bad for 1 minute in a
5-minute interval then the interval of good data would be the
4-minute period.
The timestamp of the aggregate will always be the start of the
interval.

VariancePopulation Retrieves the square of the standard deviation. Its behaviour
is the same as the StandardDeviationPopulation aggregate.
This calculation is for a full population where the calculation
is done on the full set of data. Use VarianceSample to
calculate the variance of a subset of the full population.
The timestamp of the aggregate will always be the start of the
interval.

VarianceSample Retrieves the square of the standard deviation. Its behaviour
is the same as the StandardDeviationSample aggregate.
This calculation is for a sample population where the
calculation is done on a subset of the full population. Use
VariancePopulation to calculate the variance of a full set of
data.
The timestamp of the aggregate will always be the start of the
interval.

WorstQuality Returns the worst status code of the values in the interval
where a Bad status is worse than Uncertain, which is worse
than Good. If multiple values exist with the worst quality but
different StatusCodes then the StatusCode of the first value is
returned.
The timestamp of the aggregate will always be the start of the
interval.
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WorstQuality2 Returns the worst status of the values in the interval as
defined for WorstQuality except that Simple Bounding Values
are included.
If multiple values exist with the worst quality but different
StatusCodes then the StatusCode of the first value is
returned.
The timestamp of the aggregate will always be the start of the
interval.

Parametrization of aggregates

To get best performance when querying aggregated values, aggregates in atvise are pre-calculated
and historized according to the parametrization. Therefore, when using aggregates, the first step is to
parametrize one or more aggregate archives (see Historizing data ).

Furthermore, aggregate templates need to be parametrized. An aggregate template combines one or
more aggregate functions. Finally, these aggregate templates will be assigned to a dedicated node,
which defines what kind of aggregates will be calculated in what intervals for this node.

Right click on aggregate template and select “Add Aggregate Template...” to create one; e.g. “AT1”:

Creating an aggregate template

This aggregate template now appears in the project tree under “Aggregate Templates”.
Right-click on the aggregate template (e.g. “AT1”) to add aggregate functions:

311
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Creating an aggregate function

In the dialog “Add aggregate function” following items can be configured:

Name Name of the aggregate function (without special characters
and without spaces).

Function One of the supported aggregate functions .

Interval Time span for calculating the aggregate. The intervals
supported by atvise are:

Seconds (only for aggregate function "Sampled")
Minutes
Hours

324
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Days
Months (starts with first day of each month)

Offset Offset to the given interval. In the example “1h_Minimum” the
minimum would be calculated every hour but shifted by 5
minutes, e.g. 02:05, 03:05, 04:05.

Archive Group One of the previously defined aggregate archives to store the
calculated aggregate. In our example the aggregate archive
“Aggregates”.

Interpolation Sloped or Stepped. Only for aggregate function "Sampled".
Will be used by chained aggregates based on this "Sampled"
aggregate function.
See Historizing data  for how to set interpolation for other
aggregate functions.

Extrapolation Extrapolation  behavior.

Minimum Good Values At least the configured percentage of the values in the interval
must have the status Good so that the status of the aggregate
will also be Good (default: 100)

Minimum Bad Values At least the configured percentage of the values in the interval
must have the status Bad so that the status of the aggregate
will also be Bad (default: 100).
Both settings are related as follows: 

If both values are equal, the value of “Minimum Good Values”
will be used.

Tread Uncertain as Bad If activated, values with status Uncertain will be treated as of
status Bad, otherwise as of status Good (default: activated)

An aggregate template can contain more than one aggregate function. We distinguish the following
two scenarios:

1. Assignment on first level, i.e. right-click on an existing aggregate template (e.g. “AT1”). This
means that the aggregate will be calculated based on the historized raw values.

2. Assignment (right-click) on an existing aggregate function. This means that the aggregate will be
calculated based on the selected aggregate. We call this “chained aggregate”. For instance, the
aggregate “4h_Minimum” is a chained aggregate since it is based on the aggregate
“1h_Minimum”. Same applies to “1d_Minimum”.

The aggregate function "Sampled" can only be used on the first level of an aggregate
template. However, at level two, other aggregate functions can be based on the
aggregate function "Sampled".

Example:
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This example illustrates that the aggregates “1h_Minimum” and “4h_Average” are based on raw
values.

In contrast, the aggregate “4h_Minimum” will be calculated based on the calculated aggregate
“1h_Minimum”. Same applies to “1d_Minimum” which will be calculated based on “4h_Minimum”.

Notes for chained aggregates:

The interval of the chained aggregate must be an integral multiple of the subjacent aggregate.
The changed aggregate must not necessarily have the same aggregate function as the subjacent
aggregate. E.g. it may be reasonable to have a daily minimum based on a 5-minute average.
Chose the offsets so that the start time of each interval of the chained aggregate coincides with
the start time of an interval of the subjacent aggregate.
A reasonable choice of the intervals will positively impact the duration of the calculation and
therefore the system utilization. E.g. an aggregate with a one week interval based on raw values
can lead to a huge number of values needed for the calculation of the aggregate. In this case it is
better to parametrize an aggregate with a one day interval based on raw values and use this as
base for the aggregate with the one week interval.

Finally, a raw archive (type “data”) AND an aggregate template must be assigned to a node to enable
aggregates for that node (see Historizing (and aggregating) a node ). Please note that only one
aggregate template can be assigned to a node.

The aggregates are limited by the license in terms of the amount of used aggregates. This amount
can be determined for each aggregate template as follows:

number of aggregate functions in the aggregate template x number of nodes who have assigned
this aggregate template.

In case the number of aggregates according to the license is exceeded, the whole
aggregation will be stopped and not only the aggregation of nodes which are beyond
this limit. This is indicated by an entry in the atvise logfile.

Query of aggregates

Since the calculated aggregates are historized, they can be retrieved similar to raw values (see 
Query history ).
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Diagnostics

Variable on-change counters

To measure how often a certain variable changes, add a UInt32 property with the name
"ChangeCounter" to it.

To reset the value of a certain change counter, you can use the JavaScript array
"server.statistics.changecounters". In Library->ATVISE->ScriptLibrary->Statistics -
>ResetChangeCounters you can find a script that resets all counters under a certain node.
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SMTP Settings

Add and edit an SMTP Server

Add an SMTP Server to your project by right clicking at "SMTP Server" and selecting "Add SMTP
Server":

Adding a SMTP server

SMTP Server dialog

Name name of the SMTP server
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Server address of the  SMTP server

Port port of the SMTP server

Authentication Authentication for the SMTP server (login, plain, md5)

Security For a description of the security options see SMTPClient functions

User Name User Name for the Connection to the SMTP server

Password Password for the Connection to the SMTP server

Calling the "SendMail" function

To send an e-mail with a serverside script you need the "SendMail" function. To call the function add
the following script to the desired serverside script:

call("Mail.SendMail",{ 
smtpserver: "gmail",
from:"me",
to:"you",
cc:"cc",
bcc:"bcc",
reply_to:"reply_to",
content_type:"text/plain",
subject:"Hello",
body: "Hello again"
});

smtpserver Name of the SMTP server (as defined in the "Add SMTP server" dialog)

from MANDATORY_STRING; Specifies the name of the sender.

to MANDATORY_STRING; Specifies the name of the recepient(s). Multiple
recepients are separated by ';'.

cc OPTIONAL_STRING_DEFAULT=""; Specifies the carbon copy recepient(s).
Multiple recepients are separated by ';'.

bcc OPTIONAL_STRING_DEFAULT=""; Specifies the blind carbon copy recepient(s).
Multiple recepients are separated by ';'.

reply_to OPTIONAL_STRING_DEFAULT=""; Specifies the "Reply-To" field of the e-mail
header.

content_type OPTIONAL_STRING_DEFAULT="text/plain"; specifies the "Content-Type" field of
the e-mail header.

subject OPTIONAL_STRING_DEFAULT=""; Specifies the subject of the mail.

body OPTIONAL_STRING_DEFAULT=""; Specifies the message of the mail.
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HTTP settings

Creating and configuring web servers

The http and https web servers can be configured on the following dialogs opening by Web Server
menu.

The predefined names are: http1, http2…etc. If no http access definition exists at startup, one will be
created with default settings named as http1/https1. The default settings for http1/https1 are read
from the .ini file and can be overridden by command line parameters in console mode. If no http/https
port is defined in the .ini file, the default HTTP/HTTPS ports will be set for http1/https1. The port of
http1/https1 are read-only node. The http1/https1  access definition reflects always the port settings
in the .ini file. 

The http access definitions http2…http9, https2…https9 are project specific and can be set to
arbitrary ports and parameters. 

 If an http access definition has port value 0, it is disabled. So it is possible to have
e.g.: https ports only (http1 definition exists always)

You can add and edit web servers using the context menus respectively. The settings dialog for http
and https contains the common group of parameters for both type of web server. The web server can
be activated and deactivated using the upper check box.
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The following table contains the common attributes for all http and https web servers.

Parameter Type Description of the http web server configuration

Web Server Boolean Check box for web server whether or not is enabled

Name String The next predefined name for http server

Port Number Port used by the web server. It is read only for http1

State Readonly
String

Status of the web server

Running: The http(s) server is up and running.
Failed: The http(s) server could not be started. Probably another
port uses the given port.
Configuration Error: The http(s) server could not be started due to
missing or inproper configuration data.
Suspended: The http(s) server is disabled.

Authentication String The login method required from the client. Possible values are the
empty string (no authentication), "form", "digest" and "ntlm" (Note

).

The default login mode is "form". In this mode, login is handled by
the login_dialog object display of atvise. When starting the
visualization, no user is logged in and you have to click the login
button to log in. In this mode, you can log out and log in as different
user without restarting the browser.
The login modes digest and ntlm require a user to be logged in at
any time. If you start the visualization, a browser specific login dialog
appears and ask for the user credentials. A logout is not possible
and you must restart the browser to log in as different user. The
settings for authentication in the .ini file are obsolete and will be
ignored.

IP Address IPv4-String The IP address field is used to bind the web server to a specific IP
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address only. If empty, all known IP addresses will be bound

Redirect WebServer
NodeId

The NodeId of another http(s) access configuration where this port
will be redirected. If it is empty (by default it is done by selecting "No
redirection"), the port will be not redirected

Note: After the configuration of redirection the
browser may require a refresh or emptying the cache.

Caching Boolean If activated, displays will be cached in the server for better
performance when delivering the displays to the visualization.

Note: Only activate caching when all displays are
finished and aren't changed anymore. The cache is
not refreshed when a display is changed.

unauthorized_r
esponse

Script The script that will be called if authentication fails.

Protected
calls

Button To define protected calls, a dialog will be opened.

Protected calls

webMI callable scripts and some internal functions can be protected. They will be referred further as
functions. The protected calls are stored in a list. The list contains the name of the protected
functions and the corresponding rights. If a function is not listed in the protected calls then it is not
protected. If a function is in the list of protected calls, it will be executed only if the logged in user
has the corresponding right. 
To enabe/disable the protected calls right click on 'Web Server' and select 'Protected Calls' then
'Enabled'. Protected calls are enabled, if the Item ‘Enabled’ is checked.

To protect an arbitrary function push the ‘Protected Calls’ button or right click on 'Web Server' and
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select 'Protected Calls' from the context menu.

The following dialog appears:

To protect a function press the 'Add' button. The following dialog appears:

Select the name of the function from the list of available functions that appears in the dropdown list
next to 'Function':
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The corresponding right must be selected from the list of available rights. Press '…' next to 'Right':

Select the right that protect the function. If the logged in user does not have the selected right, then
the function will be not executed if called by a webMI call.
The list of protected calls can be further modified in ‘Protected Calls’ dialog. New functions can be
added or existing functions can be modified or deleted from the list. 

 Note: The list of the protected calls is valid only for the corresponding http(s) server.

Using HTTPS

If you want to use HTTPS to secure your communication, you have to generate an SSL certificate
and a private key for the atvise server. It is important to know if atvise should be accessed by Full
Qualified Domain Name (FQDN) or by an IP address during the generation process. 

Then you can create certificate and private key with following OpenSSL command (entered on one
line):

openssl req -x509 -nodes -days 365 -subj "/CN=[FQDN][IP-ADDRESS]/C=AT/ST=My State/
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L=My Locality/O=My Organization" -newkey rsa:1024 -keyout atvise_key.pem -out

atvise_cert.pem

Please notice: The value of /CN must be adapted! If the FQDN of the atvise server is “my.atvise.com”
this should also be the value of CN. This is important, because some operating systems (e.g. iOS)
only allow access to an HTTPS website if the CN value of the keyfile generation command is equal to
the FQDN. 
You should change the values for "-days" and "-subj" according to your needs, especially the values
for "/C" (Country, two letter code), "/ST" (State), "/L" (Locality) and "/O" (Organization).

Note: For atvise 3.1 we recommend to create a new certificate and private key with
the current version of OpenSSL, because files created with older versions of OpenSSL
may have security holes.

Edit the web server and select the SSL certificate and the private key file to configure HTTPS with
the atvise builder:

The following list contains the attributes related to https web server only.

Parameter Type Description of the https web server configuration

CA Location String The location of certificate files

Certificate String The certificate file name
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Private Key File String File name of private key

To use iOS Devices with HTTPS you have to install the SSL certificate. Receive the certificate as e-
mail attachment and open it to start the installation process.

Using NTLM

NTLM is an Active Directory based single sign-on scheme.

Using atvise server with NTLM authentication the platform must support the Active
Directory Service Interface. The authentication of Active Directory users in atvise is
based on matching group names. The atvise server must contain the same group
name as the Acive Directory group name of the current user for a successful
authentication.

Not all browsers support NTLM. Browsers supporting NTLM have different behavior,
listed in the following table:

browser version server on same PC server on other PC

http https http https

IE 11 Yes Yes Yes Yes

Edge 25.1 Yes (*1) Yes (*1) Yes (*1) Yes (*1)

Chrome 49.0.2623.112m Yes Yes Yes Yes

Firefox ESR 45.0.1 Yes (*2) Yes (*2) Yes (*2) Yes (*2)

*1) username and password must be set in the browser dialog.
*2) The browser must be configured in order to allow Single Sign-On (SSO): 
In the browser address list enter: about:config. Search after network.automatic-ntlm-
auth.trusted-uris. Enter the name of the trusted server in a comma separated list. 
Eg: http://servername.dom.org, https://servername.dom.org.
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Global parameters
Global parameters allow you to specify global parameters and global lists which can be used as
parameters for object displays. To tell an object display parameter to use a global parameter, select
"global" as the parameter type.

Adding a global parameter

Adding a global parameter

1 Right-click "Global Parameters".

2 Click "Add Global Parameter..." to add a new global parameter.

3 Fill in a name and a value for the new global parameter. You can also use the color picker to
select a color as the value.

Press "OK" to save the new parameter.

Adding a global list

Global lists allow you to define lists containing pairs of keys and values.
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Adding a global list

1 Right click "Global Parameters".

2 Click "Add Global List..." to add a new global list.

3 Choose a name for the global list.

4 Define the entries for the global list. Each entry consists of a key and a value.

You can define the value columns using the configuration table. See steps 5 and 6.

5 To open the configuration table, click the button "Config..." at the bottom left corner.

6 The configuration table allows you to specify different value types for the global list. Each row in
the configuration table corresponds to one column in the global list definition (except the key
column).

You may select different types for each column. The possible types are:

address
resource
resource.image
string
number
bool
color

Using global parameters

Using global parameters

1 Create a display "global_parameters_test" at Library / PROJECT / Object Displays. Open the
display and draw a circle. Fit the display dimensions to the circle.

Now right click "Global Paramters" in your project tree on the left and create a folder "color"
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containing some global parameters. E.g.: red, green,...

Right click your folder and copy the NodeID to the clipboard.

2 Open the display parameter window in the display you drew the circle. Enter a name for the
parameter.

3 Enter a substitute beginning and ending with a "$". E.g.: $COLOR$.

4 Enter a description for your parameter.

5 Choose the value type "global" from the drop-down list.

6 First double click and then right click in the field "Config" do paste the NodeID of your global
parameter, which you copied to the clipboard before.

7 Set your substitute as fill value for the circle.

Save your display and drag it from the tree to another open display and choose your global
parameter from the dropdown list in the attributes area.
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Manage displays
Displays

The four folders (MAIN, USER, SYSTEM, REPORT) will be automatically generated in the main tree
when you add a new server. The four newly created folders are displayed as icons in the visualization
(browser) of your project, as shown in the picture below. If you add a display in the folder MAIN, you
will also find it in the drop-down menu of the first icon in the browser of your project.

To add a reference, right-click on a folder and choose "Add Reference". 

Adding a reference

Add Folder Adds a new folder for your displays.

Add Display Adds a new display to your server.
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Add Reference to single display from pool

Adds a reference to a single display from the display pool.

to display structure from pool

Adds a reference to a whole folder from the display pool.

to resource

Adds a reference to a single resource (which can be selected from the
resource folder).

to other URL

Adds a reference to a URL (similar to a hyperlink).

Edit Display Order Edits the order of your displays.
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Layouts
Layouts define the basic structure of the visualization in atvise. The apperance of the "Default"
display depends on the default layout that was selected when opening the project for the first time.
There is a list of predefined layouts available.

When starting a new and empty project, the layout dialog pops up:

Layout dialog when opening a new and empty project

These layouts are defined in the atvise library:
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Layouts atvise

Custom layouts should be created in the project library:

Project specific layouts

You can copy existing layouts from the atvise library to get a basic template. The display
dimensions and descriptions can be modified in the display menu File -> Settings:
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Display settings

Make sure to set the parameter "Display to open" of the referenced object display "IFRAME (Display
Container)" to "%CONTENT%".

IFRAME parameter

Please note that the following parameters have to be modified in the SVG tag:
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atv:contentheight="value"
atv:contentwidth="value"

To edit these parameters, open the source editor of the display.

Example for 1920x1080:

<svg width="1920" version="1.2" xmlns:xlink=
"http://www.w3.org/1999/xlink" height="1080"
xmlns:atv="http://webmi.atvise.com/2007/svgext" 
atv:contentheight="1080" atv:contentwidth="1920" 
xmlns="http://www.w3.org/2000/svg">

NOTE: Newly created layouts are only selectable after restarting the atvise builder.
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Edit quick dynamics
Description

A "quick dynamic" (QD) is based on the atvise "simple dynamics" (SD) such as "On click, open a
display" or "Change the color of the rectangle depending on the value of an address".
A QD can be applied to any element (e.g. a simple rectangle, a button, ...).
QDs are used to prepare common functionality that is often needed in your project so that the user
doesn't have to create the functionality step by step with SDs each time.
In the folder "Library.ATVISE.Quick Dynamics", you can find QDs that we have prepared for you and
that are ready to use (e.g. "Change Color by Node").

Note: To create your own QD collection, please use the folder "Library.PROJECT.Quick Dynamics".
The "ATVISE" folder will be updated with new releases and you will lose all changes that you made
there.

Steps to create a quick dynamic

1 Right-click "Library.PROJECT.Quick Dynamics" and choose "Add Quick Dynamic...".

2 Specify a name and click "OK".

3 Open the Quick Dynamics tree and double-click your QD: The script editor opens.

4

You can find the standard editor functions (Open, save,...) in the menu at the top of the script
editor.

The last button can be used to edit the "metadata" of your QD. You can define the title,
description and an icon here.

5

Below the menu, you can specify a list of parameters that will be passed on to your QD script.
The parameters are typed in by the user when he applies your QD to an element.
Each parameter has a set of attributes:

Name:  The name of the parameter (important to access the parameter in the script).
Description: Description of the parameter that will be shown to the user.
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Behavior: You can specify if a parameter is optional, mandatory or hidden.
Value Type: This attribute defines the type of the parameter (address, display, string, number,
bool, color or enum).

The "display" type, for example, will result in a "Pick display button" where the user can select
a display from the system.
Type "enum": In the "Config" column, you can create a list of values separated with a ";", e.g.
"Option A;Option B;Option C".

Default: You can specify a default value for the parameter.
Config: Used for the "enum" type (for description, see above).
Group: Used to display parameters in a group (e.g. parameter "x" and "y" in the group
"coordinates").

6 After you have specified the parameters, you can start creating your script.

Quick Dynamic Example

Goal: Create a quick dynamic to add or subtract a number from the value of a source node and write
the result to a target node.
The QD will be executed when the user clicks on an element.

1 First we create a new QD and name it "Calculate Example".

2 Now we open the QD.

3 Start with editing the metadata:
Title: Calculate Example.
Description: Add or subtract a number from the value of a source node and write it to a target



354 atvise® - documentation

© 2018 Certec EDV GmbH

node.

4 Also, we will need some parameters (Name | Description | Behavior | Value type | Default |
Config | Group):

sourceNodeID | source address (number) | mandatory | address | (empty) | (empty) | (empty)
targetNodeID | target address (number) | mandatory | address | (empty) | (empty) | (empty)
value | value (numeric) | optional | number | 10 | (empty) | (empty)
operation | mathematical operation | optional | enum | add | add;subtract | (empty)

Important: All parameters have to be accessed in the script with
"base.PARAMETER_NAME" (see example).

5 The next step is to write the script code (Hint: If you don't know the syntax, have a look at the
section "atvise webMI client scripting " in our help or just create some simple dynamics and
copy the script code).

We start with the "click" event:

webMI.addEvent(base.id, "click", function(e) {
   webMI.data.read(base.sourceNodeId, function(e) {
      calculate(e.value);
   });
});

As you can see, the "base.ID" parameter is available by default. You can always read the "ID"
of the source element in this way.
Within the click function, we use "webMI.data.read" to read the current value from our source
node.
Then we pass the value ("e.value") on to the function calculate:

function calculate(newValue) {
   newValue = parseFloat(newValue);
   base.value = parseFloat(base.value);
   if (base.operation == "Add") {
      newValue += base.value;
   } else if (base.operation == "Substract") {
      newValue -= base.value;
   }
   webMI.data.write(base.targetNodeId, newValue);
}

The function calculate first uses the JavaScript default function "parseFloat" to ensure that our
values are numeric.
Then we decide whether to add or subtract the value depending on the option that the user has
chosen.
After we have made our calculation, the result "newValue" is written to our target node.

Test:
Create two numeric variables with value "0" in your system.
Create a new display. Draw a simple rectangle and a circle.
Select the rectangle and apply our "Calculate Example" QD to it.
A parameter dialog will appear which shows all parameters that we have specified for the QD.
Fill out the parameters (use "add" for the rectangle).
Now apply the dialog with the "OK" button.
Do the same for the circle, but choose "subtract" this time and type in "5" for the value.
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Now drag & drop the two numeric variables to your display (the atvise default value display will
appear).
Open your visualization and click the rectangle or circle: Now the target node should display
"10" if you click the rectangle and "-5" if you click the circle.
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Adding displays to variable types
atvise webmi allows creation of custom displays for variable types. After having imported variables
and data types, follow these steps:

Add a display

Right-click on Variable Types -> Type and choose Add Display.

Adding a variable type display

Design the newly-created display

Create the desired display for the specific variable type.

Designing a variable type display

Use the display in the visualization

Now you can use the created display when designing the server's visualization. Just drag and drop
objects of the variable type to one of the server´s displays and the newly designed display will
appear.
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Using the new display
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Languages
The translation for each target language is derived from a meta language. The meta language is the
text defined within "T{}" as well as the "To Active Text" and "To Inactive Text" of the alarm
configurations - see below. For each target language, this text has to be translated into the
corresponding target language. Therefore, a translation file is required.

Generate translation file

A right-click on "Languages" followed by a left-click on "Generate Translation File" (see also image
below) will generate a translation file, i.e. all "T{}" texts from all displays as well as the "To Active
Text" and "To Inactive Text" from the alarm configurations are collected.

Adding a language

The atvise builder offers the possibility of adding several languages for the visualization. You have to
put your translations into an xml file. The "System" tab includes the node "Translations", where new
languages can be added.

Adding a new language

1 Right-click on "Translations" to add a new language.

2 Click on "Add Translation" to open the "Add Translation" dialog.

3 Enter the "Language Code" (it will be displayed under the node "Translations") and the
"Language Description" (it will be displayed in the language drop-down menu in the
visualization).

4 Select the path of your XML translation file.
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Example of an XML translation file:

<?xml version="1.0" encoding="utf-8"?>
<!DOCTYPE TS>
<TS>
  <context>
    <message>
      <source>Example</source>               
      <translation>Beispiel</translation>    
    </message>
    <message>
        <source>Hello world</source>
        <translation>Hallo Welt</translation>
    </message>
  </context>
</TS>

If you make changes to your translation file, be sure to distribute the files if a webMI
server is used. On a scada server, the translation is applied at runtime.

Example of a translation

Example of a translation and a translated text

1 When some text on a display should be translatable, you have to write it between T{ ... } in the



360 atvise® - documentation

© 2018 Certec EDV GmbH

graphics editor.

T{} is the wild card for the translation.

2 You can change the language in the visualization by clicking on the little exclamation mark.

3 In the menu, the displays are shown in the selected language (if they are defined in the xml
translation file).

4 The visualization shows the translated text (if a translation is defined in the XML translation file).

Editing a language

Managing your languages

Delete Deletes the language.

Get Content from Disk You can select a new XML file for the language.

Save Content to Disk Saves the XML file to the selected folder.
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Clicking on the button „Update from file..." allows to select a translation file and merging the
translations in the selected file into the current project. New items will be added and existing items
will be updated if the translated text or the translation status of the item are different. However, if a
text is marked as "translated" in the project and as "not translated" in the file, the translation in the
project will not be overwritten. With this functionality externally translated text can be imported into a
project or transferred from one project to another.

Clicking on the button „Add from project" all "T{}"-text from all displays as well as the "To Active
Text" and "To Inactive Text" of the alarm configurations will be collected and the table will be
updated. Text that is not translated yet will be shown on the top of the table.

As soon as a translation is changed, the check mark is automatically set in the third column to
indicate that the source text has been translated. The check mark can be set manually too by
double clicking the last column or in the context menu that is invoked by right clicking the last
column. In case of selection of several rows the function of the context menu will be applied to all
selected rows.
Text that is still not translated additionally has a different background color.

The input field on the very top of the table allows entering a regular expression which will be used for
filtering the first two columns.
The top right combobox specifies filter of translated, untranslated and all entries.
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Users and groups
atvise scada allows the creation of users who can be given certain rights within the HMI. This is done
in the following way: Rights are set through groups, and the user is granted certain rights as a
member of a certain group or groups.

Adding a User

To add a new user, click on Users & Groups, right-click on Users and then click on Add User.

Adding a new user

Editing user information

To set up user information (full name, description, password, group membership), double-click on
Users & Groups -> Username. The user editor dialog will open.
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The user editor

Adding a group

To add a new group, click on Users & Groups, right-click on Groups and then click on Add Group.

Adding a new group

Adding a new user to a group

To add a new user to a group, right-click on a group and then click on Add New User.

Adding a new user to a group

Editing group information

To set up rights and members for a specific group, double-click on a group under Users & Groups.
The group editor dialog will open.
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The group editor

Adding user-defined rights

To add custom rights, right-click on Users & Groups -> Rights -> User-defined rights

Adding a new right
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Cross references
Cross reference calculation gives the opportunity to display and export the internal structure of your
project. There are different categories of cross references.

Display cross references

Display cross references may be calculated for every single display. One the one hand you are able
to check which displays are referenced by a specific display and on the other hand it is possible to
list all displays which are referencing a specific display.

This feature can be applied to a single display or a folder containing displays.

Find child displays

For each display, all displays which are used within the selected displays will be reported. Only
direct children are searched, i.e. if a child display contains other displays, these displays will not
part of the result.

Find parent displays

For each display, all displays will be calculated which are using the selected one.
I.e., for each selected display will be calculated whether it is used in another display in one of the
following locations:

o <Server>.DISPLAYS

o Object Types
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These functions can be called via the context menu of the project tree from the following locations
and subordinated displays and folders:

o <Server>.DISPLAYS

o Display Pool

o Library.*.Object Displays

o Object Types

Node cross references

Node cross references may be calculated for every single server. This process delivers information
about which nodes are used in which displays and which nodes aren’t used at all.

Find nodes used in displays

For each display (including referenced displays) of the selected server (<Server>.DISPLAYS and
Display Pool) the parameterized nodes will be calculated. Additionally, for each node found it will be
calculated whether it exists in the address space (<Server>.OBJECTS). This will be indicated in the
column "Exists" of the result.

Find unused nodes

For each node in the <Server>.OBJECTS folder of the selected server it will be calculated whether
the node was parameterized in a display (including referenced displays) of the selected server
(<Server>.DISPLAYS and Display Pool). If not, it will be part of the result. System variables will be
not shown in the result.
These functions are available only in the context menu of an arbitrary server.

All cross reference results will be shown in a table. It is possible to sort the table by a specific
column and to filter the whole table to restrict the output to fundamental results. The currently visible
table data may be exported as csv file.

Notes

Due to the architecture of atvise, the calculations for the cross
references are restricted to:

For relative addressing

Only relative addresses which are used as display parameter (display parameter of type "address")
are considered for the cross references. Relative addresses in Quick Dynamics, Simple Dynamics or
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user generated scripts are not considered.

For absolute addressing

For each existing node will be checked whether it is used in Quick Dynamics, Simple Dynamics or
user generated scripts. Since for each node every script will be parsed, delays may occur.

Hook for further checks

To enable user specific checks on the result provided by atvise, a hook may be implemented by the
user. If the script
"SYSTEM.LIBRARY.PROJECT.SERVERSCRIPTS.CrossRef.Lib.DisplayVariablesHook" exists, it
will be executed. For further information on how to implement a hook consult the code
"SYSTEM.LIBRARY.PROJECT.SERVERSCRIPTS.CrossRef.Lib.DisplayVariables".

Details about serverside scripting can be found in section „atvise SCADA server scripting ".
508
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Context menu
builder tree context menu description

Add Server

Acquire Datapoints Retrieve data points from a webMI server.

Add Alarm Category -

Add Alarm Configuration -

Add Conversion Add linear conversion for mirrored nodes.

Add datasource Select and add a datasource.

Add display -

Add display -

Add existing User to Group -

Add folder -

Add Folder Content Add resources from a folder.

Add Global List -

Add Global Parameter -

Add Group -

Add Help -

Add Mirroring Select and add a mirroring to a node.

Add new User -

Add Node Select different types of nodes and add node to the project.

Add QuickDynamic -

Add reference Add references of different types.

Add References to View -

Add Resources Add a single resource from a file.

Add Right -

Add Right to Group -

Add script -

Add Smoothing Select the type of smoothing for a node.

Add SMTP Server Add and configure a SMTP server.

Add Translation -

Add User -
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Add View -

Add Webserver Add and configure a web server.

Archive Strategy Select a predefined archive strategy for the history archive.

Array -

base -

Boolean -

BooleanArray -

Byte -

ByteArray -

ByteString -

ByteStringArray -

Change Comparison Discards values that do not differ from the current value

Copy [Ctrl. + C] -

Copy NodeID to Clipboard -

Copy View [Ctrl. + C] -

Data Variable Select type of data variable.

DateTime -

DateTimeArray -

Deadband Absolute Discards values where absolute difference to current value is too
small

Deadband Relative Discards values where relative difference to current value is too
small

Delete Display [Del.] -

Delete Node [Del.] -

Delete Right [Del.] -

Delete User [Del.] -

Delete View [Del.] -

disable subtree (absolute) -

disable subtree (relative) -

Distribute Distribute the project to a webMI server.

Double -

DoubleArray -
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Edit -

Edit Display Order -

Edit GlobalVariable -

Edit Resource -

Edit Server -

Edit Server Change server settings.

Edit SMTP Server -

Edit Web Server -

Export hierarchy as XML Export the item hierarchy (tree) as a XML file to the disk.

Export single node as XML Export a single node as a XML file to the disk.

Export to Folder -

Find child displays Cross reference list: to find child displays used in the selected
display

Find nodes used in displays Cross reference list: find nodes which are parameterized in the
displays.

Find parent displays Cross reference list: to find parent displays of the selected
display

Find unused nodes Cross reference list: find nodes which are not parameterized in
the displays.

Float -

FloatArray -

Folder -

Generate Translation File -

Get Content from Disk -

Historize Select a predefined history archive.

http -

https -

Import (relative) from XML Import data relative from a XML file.

Import from Folder -

in/output (absolute) -

in/output (relative) -

input (absolute) -

input (relative) -
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Int16 -

Int16Array -

Int32 -

Int32Array -

Int64 -

Int64Array -

Linear -

ModellingRule -

New -

Node actions Select functions which can be performed on any node.

None -

Object Add an instance of a predefined Object Type.

OpcCom Add a OpcCom data source.

OpcUA Add a OpcUA data source.

Open Node Viewer Open the node viewer to manipulate the whole address space.

output (absolute) -

output (relative) -

Paste [Ctrl. + V] -

Paste References into View
[Ctrl. + Alt + V]

-

Paste View [Ctrl. + V] -

path fragment -

Property Select type of property.

Query History Retrieve historized data for a node from the history archive.

Refresh Refresh the project tree.

Reload External Files -

Remove Folder [Del.] -

Remove Resources [Del.] -

Remove Server [Del.] -

Remove User from Group
[Del.]

-

Save Content to Disk -



372 atvise® - documentation

© 2018 Certec EDV GmbH

Save Resources to Disk -

Sbyte -

SbyteArray -

Shared -

String -

StringArray -

Suppress Flicker Discards value changes in the specified time interval

to diplay structure from pool … to a complete display structure from the display pool.

to other URL … to an arbitrary URL

to resource … to an item from the resources area of the tree.

to single display from pool … to a single display from the display pool.

UInt16 -

UInt16Array -

UInt32 -

UInt32Array -

UInt64 -

UInt64Array -

webMI Select and add a webMI server.

webMI Add a webMI data source.

XmlElement -

XmlElementArray -

builder tab context menu description

Close Close the tab.

Close All Close all tabs.

Close All But This Close all other tabs.
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Views
With OPC UA Views you can define entry points into the address space which only show a subset
of the available nodes.

A view can contain further views or references to other nodes.

All elements in views are references to the actual nodes. This means that changes
directly affect the nodes themselves. If you delete a node from a view, the actual node
will be deleted. If you rather want to remove the node only from the view without
actually deleting it, you have to use the menu item "Remove from View" (Alt+Del).   

Views can be created below the entry "Views" with the menu item "Add View…".

There a 3 ways to fill views with content:

Add references

By selecting "Add References to View…" the node selector will be opened, which allows you to
select the nodes you want to add to the view as references.
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Paste references

You can simply copy nodes under "OBJECTS" and then paste them as references into the view by
selecting "Paste References into View…".
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Paste a view

A previously copied view can be added to an existing view by selecting "Paste View". This allows
you to modify the hierarchy of already existing views.
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Menu scripts

In this dialog the parameter values of the menu script can be changed. The initial value is the default
value that you supplied in the script editor. Following data types are supported: boolean, number,
string, filecontent and textfilecontent. Parameters with other types will be ignored by the dialog. If
no parameter is defined, the script will be called directly without showing the parameter dialog.
For a parameter of the type "filecontent" or "textfilecontent" you can select a file in the dialog. The
content of the file (not the name!) will then be passed to the script. Use "filecontent" for binary and
"textfilecontent" for text files.
If the scripts contains a parameter "nodes" of the type "array" the nodes selected in the tree will be
passed to the script as an array of NodeIds (e.g. ["ns=1;s=AGENT.OBJECTS.var1"]).
To pass back data from the script to the atvise builder, you can add a parameter of type "stream"
with the name "output". In the script you can then write data with output.write("something"). When
the script finishes, the previously written data is sent back to the atvise builder and a dialog is
opened to write the data to a file.

Create Views

Views are special nodes that organize other nodes to find nodes specified on some selection criteria.
A criterion can be e.g: ‘find all nodes in the OBJECTS folder that have an Alarm Configuration’. Views
are static. They do not reflect the actual state of address space corresponding to the search criterion
but a snapshot of the address space at certain time stamp.

The menu script CreateViews is used to create views that organize nodes of given node types. E.g:
alarms, scripts and mirrors. The selected node(s) in the builder are the starting point(s) of the search
for these nodes. If the selected node in the builder is a view then the all nodes in the Folder
‘OBJECTS’ and ‘Object Types’ will be searched. Otherwise the created view reflects only the
selected nodes.
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If the menu script CreateViews is called by the builder, then the input parameters may be set in a
dialog before calling the script. The input dialog reflects the parameters of the script.
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The input parameters of MenuScript CreateViews are listed in the following table:

Name Type Description

folder String Specifies the name of the folder under Views, where the result will be
stored. If folder is empty, then the result will be stored under Views.

alarms Bool Specifies if the view of alarms shall be reconstructed. The constructed view
has a Declaration-Instance View structure.

scripts Bool Specifies if the view of scripts shall be reconstructed. The constructed view
has a Declaration-Instance View structure.

mirrors Bool Specifies if the view of mirrors shall be reconstructed. The constructed view
has a Good-Bad-Uncertain View structure for the MirrorInput/Output types
and a Declaration-Instance View structure for MirrorDisable types.

relmirrors Bool Specifies if the view of relative mirrors shall be reconstructed. The
constructed view has a Declaration-Instance View structure for the different
relative mirror types: bases, path fragments, etc.

exportables Bool Specifies if the view referencing all nodes of the specified type shall be
created. The view has the name ‘All Exportables’ and is embedded in the
corresponding view of the specified type. As this view has direct references
to the specified nodes, the nodes can be easily selected and exported.

Declaration-Instance View

The Declaration-Instance View groups the found nodes into a Declaration-Instance structure. 
The Declarations part consists of nodes with the specified type. The found nodes are stored in a
sub-view that is named after the node with some name mangling (‘.’ is replaced by ‘_’). This
make easier to identify the found node. The View contains a reference to the found node and
sub-view named ‘Instances’. The ‘Instances’ sub-view organizes all nodes referencing the found
node in the ‘OBJECTS’ folder.
The Instances part consists of nodes that are referencing the found nodes from the ‘OBJECTS’
Folder.
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Good-Bad-Uncertain View

The Good-Bad-Uncertain View consist of the sub-views ‘Good’, ‘Bad’ and ‘Uncertain’. Each of
these sub-views lists the parent nodes of the specified node type in the corresponding status
view depending on the status of the parent node.

CSVExport

This menu script in atvise enables exporting either a part of the address space or the whole address
space to a CSV file.

Usage

1) Select the node which shall be exported. Right click OBJECTS if the whole address space shall
be exported.
2) Choose Node Actions -> Atvise -> CSVExport.
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3) In the appearing dialog select which node properties shall be exported (value, description, history,
mirroring). For the selected properties, header fields will be added to the CSV file.
  



382 atvise® - documentation

© 2018 Certec EDV GmbH

4) If the script detects an error, it will abort the operation and print the error message in the atserver
log.
5) If a file selection dialog appears, that means the script was successfully executed.
6) Enter a filename for the file in which the information will be stored.

CSVImport

This menu script in atvise enables importing of nodes from CSV files.
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Prerequisites

A CSV import file with the header fields listed below is needed. The order of the header fields as well
as the amount of header fields are arbitrary and have to be specified within the first line of the CSV
file.

<NodeName> [MANDATORY] Node name in format FOLDER1.FOLDER2.nodeName, all specified
folders will be automatically created under "AGENT.OBJECTS"
<DataType> [MANDATORY] Format: object, folder, boolean, int16, uint16, int32, uint32, int64,
uint64, float, double, string, datetime, byte, sbyte
<NodeValue> [OPTIONAL] Numeric or string value for a variable
<Description> [OPTIONAL] Node description
<TypeDefinition> [OPTIONAL] Object type (e.g.: "MyType" or  "ObjectTypes.PROJECT.MyType")
or variable type (e.g. "MyVarType" or "VariableTypes.PROJECT.MyVarType") 

Note: The parts "ObjectTypes.PROJECT" or "VariableTypes.PROJECT" can be
omitted, and the correct type will still be used.

<HistoryGroups> [OPTIONAL] Specifies one or more history groups in the following format:
{group1, group2, group3}
<MirrorInput> [OPTIONAL]  Specifies the mirror input address of the node. e.g. "s7/
ns=1;s=OFFICE.ALARMS.alarm01"
<MirrorOutput> [OPTIONAL]  Specifies the mirror output address of the node. e.g. "s7/
ns=1;s=OFFICE.ALARMS.alarm01"
<MirrorInputOutput> [OPTIONAL]  Specifies the mirror input/output address of the node. e.g. "s7/
ns=1;s=OFFICE.ALARMS.alarm01"
<RelMirrorBase> [OPTIONAL] Specifies the base part of the mirror address. e.g. "s7/
ns=1;s=OFFICE.ALARMS"
<RelMirrorInput> [OPTIONAL] Specifies the path fragment of the mirror input address relative to
<RelMirrorBase>. e.g. {2:Lights, 2:Room01}
<RelMirrorOutput> [OPTIONAL]  Specifies the path fragment of the mirror output address relative
to <RelMirrorBase>. e.g. {2:Lights, 2:Room01}
<RelMirrorInputOutput> [OPTIONAL] Specifies the path fragment of the mirror input/output address
relative to <RelMirrorBase>. e.g. {2:Lights, 2:Room01}
<OnDemand> [OPTIONAL] Determines if "On Demand" feature will be used (true/false). This field
requires a <MirrorInput>, <RelMirrorInput>, <MirrorInputOutput> or <RelMirrorInputOutput>.

Usage

1) Start the script by right clicking on your "OBJECTS" folder and choosing Node Actions -> ATVISE
-> CSVImport.



384 atvise® - documentation

© 2018 Certec EDV GmbH

2) Choose the CSV input file in the appearing dialog.
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3) The script reads the given CSV file line by line - it will create folders/variables/objects OR update
existing folders/variables/object if they already exist.
4) If the script reaches an error, it will abort the operation, and print an error message in the atserver
log and in a dialog box.
5) Wait until the dialog box "Script finished successfully" appears - atvise builder and project console
cannot be used while the import is running!
6) Refresh your "OBJECTS" tree by right clicking it once
 
Example:

<NodeName>;<DataType>;<TypeDefinition>;<NodeValue>;<Description>;<HistoryGroups>;<MirrorInput>;<MirrorOutput>;<MirrorInputOutput>;<RelMirrorBase>;<RelMirrorInput>;<RelMirrorOutput>;<RelMirrorInputOutput>;<OnDemand>
int16;int16;;1;16 bit integer;;;;;;;;;
string;string;;atvise scada;string;;;;;;;;;
history;int32;;0;history;{datavalues};;;;;;;;
mirrorAbsolute;uint32;;0;mirrorAbsolute;;"s7/ns=5;s=RemoteVariable";;;;;;;
mirrorRelative;int16;;0;mirrorRelative;;;;;;"{1:test1,1:test2}";;;
ondemand;int16;;0;ondemand;;"s7/ns=5;s=remote.node";;;;;;;true
object;object;ObjectTypes.PROJECT.MyObjectType;;object;;;;;;;;;
variableType;int16;VariableTypes.PROJECT.MyVariableType;0;variableType;;;;;;;;;

CSVDelete
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This menu script in atvise enables deletion of nodes within the atvise address space. To delete
nodes, a CSV file is needed with only one required field: <NodeName>. All other fields are ignored,
so therefore it is possible to use previously set-up import files or export files.
Usage

1) Start the script by right clicking on your "OBJECTS" folder and choosing Node Actions -> ATVISE
-> CSVDelete.

2) Select the CSV input file in the appearing dialog.
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3) The script reads the given CSV file line by line - it will delete folders/variables/objects
4) Wait until the dialog box "Script finished successfully" appears - atvise builder and project console
cannot be used while the import is running.
5) Refresh your "OBJECTS" tree by right clicking it once.
6) The script will print out a short summary of successfully deleted nodes in the server log.
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Display Editor
Graphics editor

This part of the user guide explains how to draw displays and dynamize elements. As there are a lot
of different functions, they are split up into seven main categories, which are described in the next
sections:

Basic drawing functions
Using quick dynamics
Simple dynamics
Script editor
Display parameters
Object-oriented parameterization
Example: object display (simple bar)

In this section, we will continue with information on the editor, which is generally divided into eight
areas:

1 Menu Builder's menu.

2 Tree Area to browse through the structure of your project.

3 Toolbar Area at the top which contains the drawing functions . The tabs at the top of
it show all open documents.

393
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4 Drawing area Area where you can draw, select and edit elements.

5 Attribute bar Allows the user to edit SVG elements quickly. (more here: Attributes and
styles )

6 Library Contains all atvise object displays and those the user has created.

The library also offers a search function!

7 Attributes
area

Area which enables the user to change the attributes and styles of an element
and to edit the parameters of a referenced display.

8 Simple
dynamics

Area to add dynamics to elements or to manage them.

Basic element handling

Selections

1 Click once to select an item and to scale it. (You can also select multiple items by holding
down the Ctrl key while selecting.

2 Click a second time on an item to enable the rotation handles. Grab the edges to skew and the
corners to rotate your item.

3 Double-click on an item to round the corners by dragging down the red handle. (For exact
rounding, you can set specific values in the item's attributes afterwards.)

409
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4 By selecting a referenced display, the pink handles will appear. You can also rotate a
referenced display as described in 2.

5 To select an item inside a referenced display, hold down the shift key while selecting. This also
works for grouped items.

Reference point

The reference point can be used 
to set the center of a rotation
to set the starting point of a dynamic transformation (Rotate, Scale)

Right-click on an item and select "Center Reference point" to set the reference point to its middle.

Scaling an element

Clicking on an element on the display will mark the element - with squares. Now the user can
transform and scale the element as desired.
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Rotating an element
Clicking a second time on an element will mark the element - with circles. By default, there is a
yellow circle in the middle of the element which is the point of rotation. This point of rotation can be
moved, even outside of the element, so that the element will not rotate around its center. Now the
user is able to rotate and skew the element as desired.
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Editing mode

Double-clicking an element will enable the editing mode for this element. If you double-click a
rectangle, for example, a red square will appear at the top right corner of the element. Moving this
square lets the user change the look of an element by smoothing its edges.You can also change the
single points of a line, a polyline, a polygon or a path in the editing mode.
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Basic functions
Basic functions

The graphics editor offers a number of basic functions to the user, most of them are similar to other
common graphics editors. They are split up into the following categories (Click on a category (title or
picture) to open a detailed description of every icon and setting.):

Standard functions

         

Grid and snap

Zoom

396

400

401
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Freeze

By activating this mode all the elements on the display are locked and can not be moved by mouse
our arrow keys. It is still possible to select elements and use all functions of the graphics editor.

Edit

    

402
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Draw shapes

Attributes and styles

406

409
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Standard functions

Basic functions - Standard functions

     

Display

Undo
Undoes the last action and show information about that action.

Redo
Redoes the last action and show information about that action.

Save File
Saves the current file (in the HMI database).

New
Creates a new empty document.

Open File
Opens the "Open File" dialog to open an existing SVG file.

Print
Opens the 'Print' dialog to print the current document.

Save As
Opens the 'Save File' dialog to save the current document as an SVG file.

Cleanup SVG
Removes unused and unnecessary elements and attributes from the SVG file.
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Parameters
Opens a window to add parameters for the object's base address to the display.

Settings
Opens the settings window to set dimensions, document title and to change the
background of the current document.



398 atvise® - documentation

© 2018 Certec EDV GmbH

Create static preview (only for Object Displays)
Creates a preview image of the currently loaded editor content which will be used for
rendering the preview of the current display in the library section of the display editor.

To enable this function, please create a new profile and activate the checkbox "Static
Preview" in the builder settings dialogue:

Delete static preview (only for Object Displays)
Removes a previously created static preview image.

Clipboard

Copy
Copies a selected element (and save it to the clipboard).

Cut
Cuts a selected element (and save it to the clipboard).

Paste
Pastes the last-saved element from the clipboard.

Quelle

Script Editor
Opens the Script Editor to view and edit the SVG`s scripts of the current document.
Click Accept Changes to save the changes to your current document.
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Source Editor
Opens the source editor to view and edit the SVG source code of the current document.
Click Accept Changes to save the changes to your current document.
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Grid and snap

Basic functions - Grid and snap

The Grid and snap bar offers the following icons:

Show grid
Enables or disables the grid on the display. Choose between lines and points in the config
grid dialog.

Snap to grid
Snaps the elements on the display to the grid. You can define the snap settings in the
config grid dialog.

Config grid
Opens the "Grid settings" dialog. Set the grid size and style as desired. The snap size
can also be changed.
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Zoom

Basic functions - Zoom

There are 6 different ways to change the zoom of the display:

Zoom in
Zooms in the view of the display.

Zoom out
Zooms out the view of the display.

Reset zoom
Resets the zoom to standard view.

Fit zoom
Fits the display to the window.

Zoom to rect
Zooms the display to a desired rectangle

Zoom to Selection
Zooms to a marked element.
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Edit items

Basic functions - Edit items

These icons let you edit elements, z-order, mirror, perform alignment and transformation.

     

   

Edit shape
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Allows to edit shapes afterwards.

Clone style
Clones the style of an element. For example: clone the color of an element to another
element.

Group items
Groups two or more selected elements into a new one (with a new ID).

Ungroup items
Ungroups grouped items.

Bring forward
Brings an element forward in the z-order.

Send backward
Sends an element backward in the z-order.

Bring to front
Brings an element to the top layer of the z-order.

Send to back
Sends an element to the bottom layer of the z-order.

Flip vertically
Flips the currently selected element vertically.

Flip horizontally
Flips the currently selected element horizontally.

Align left
Aligns two or more selected elements at the leftmost place of these elements.

Align vertically
Aligns two or more selected elements centered vertically.

Align right
Aligns two or more selected elements at the rightmost place of these elements.

Distribute horizontally
Distributes two or more selected elements horizontally

Align top
Aligns two or more selected elements with the top element
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Align horizontally
Aligns two or more selected elements centered horizontally

Align bottom
Aligns two or more selected elements with the bottom element

Distribute vertically
Distributes two or more selected elements vertically

Reset Transformation
Resets the transformation of an element to its original representation.

Set as default transformation
Sets the current transformation as default.

Pick an element or a display from the library or the project tree and drag&drop it into the
drawing area. Then you can transform the element as desired. Clicking "Set as default
transformation" will set the transformation as a new default transformation. When the next
element is dropped, it will have the newly set transformation.

Set to default transformation
Sets the transformation of an element back to the default transformation or original
representation, if no default transformation is set.

Templates
Sets a predefined style to an object.
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Draw shapes

Basic functions - draw shapes

Select a shape to draw on the display.

Select items
Is used to select an object on the display.

Add line
Draws a line of the desired size on the display.

Add rectangle
Draws a rectangle of the desired size on the display.

Add circle
Draws a circle of the desired size on the display.

Add ellipse
Draws an ellipse of the desired size on the display.

Add text
Adds text in the desired text size to the display.

Add polyline
Draw a polyline of the desired size on the display. When choosing the polyline icon, move to
the drawing area and click once. Now move further and click again. Repeat this action as often
as desired. To close the polyline, double-click at the desired endpoint.

 

Add polygon
Draw a polygon of the desired form and size on the display. When choosing the polygon icon,
proceed in the same way as when drawing a polyline. Compared to the polyline, the polygon
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is always a closed element. To confirm form and size, use a double-click.

 

Add Bezier curve
Draw a bezier curve of the desired form and size on the display. Click and hold the left mouse
button to draw a curve (Figure 1). When the Bezier curve has the desired form and size, move
the mouse to the starting point and click left or just double-click without moving the mouse
(Figure 2). Now the Bezier curve element is finished (Figure 3).

It is possible to change the form and the size of the Bezier curve afterwards: Double-click the
element to edit it. Clicking a rectangle lets the user move it using mouse drag, thereby
changing the curve at this point (Figure 4).

 

 

Add image
Adds a desired image file from a disk to the display

Add foreign object
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This tool adds HTML code to your display.

Example:
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Attributes and styles

Basic functions - attributes and styles

The controls at the bottom of the graphics editor interface enable you to change the graphic
attributes of the currently-selected element.

Positioning and dimensions

By entering a value for x or/and y, objects can be placed even more exactly.
The w (width) and h (height) values let you set any exact dimension for an object.
The lock symbol between w and h lets you lock up the object's ratio.

Colors

This control enables you to choose none , a solid   or a gradient  fill for the current
selected element or for its stroke.

 No fill 

The fill or the stroke of the element will be completely transparent.

 Solid fill

The fill or the stroke of the element will be filled with a single color.

You can pick a color by clicking on the color palette or you can enter the RGB (red, green, blue)
values or the HSV (hue, saturation, value) manually. You can change the opacity of the color by
changing the alpha value.

If you click the pipette icon   the mouse will change to a cross hair. Move the
cursor over any element on your screen and click it once - the currently-selected
element will be colored.

 Gradient fill
You can select a linear or a radial gradient.

Modifying a linear gradient

1 The vector of the linear gradient is displayed by a white line in the sample box. You can change
this vector by dragging the two red endpoints of the line.
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Drag the two red points to change the vector of the linear gradient

Modifying a radial gradient

1 The center of the radial gradient is displayed by a red point in the sample box. You can change
this point by dragging it.

2 The radius of the radial gradient is displayed by a white circle in the sample box. You can
change this circle by dragging it.

Drag the center point and the surrounding white circle to change the radial gradient. 

Changing gradient colors

The gradient color bar and the gradient opacity bar are located below the sample box. The small
triangles at the bottom of the gradient color bar represent the different colors of the gradient. You can
change the colors of these color stops, change their arrangement and add color stops.
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Gradient color bar and gradient opacity bar

Changing the color of a color stop

Change the color of a color stop by double-clicking on the corresponding triangle and selecting the
new color from the dialog which appears.

Change the color of a color stop by double-clicking on the corresponding triangle

Changing the arrangement of a color stop

Change the arrangement of a color stop by dragging the corresponding triangle.
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Move a color stop by dragging the corresponding rectangle

Adding a color stop

Add a color stop to the gradient by double-clicking somewhere in the area below the gradient color
bar (where the other triangles are located) and choosing the desired color from the dialog which
appears.

Add a color stop by double-clicking in the area below the gradient color bar

Changing the opacity of the whole gradient

Change the opacity of the whole gradient by dragging the small black triangle below the opacity
bar or by clicking on the opacity bar.
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Change the opacity by dragging the small triangle below the opacity bar

Changing the pen style

This tab allows you to change the following graphic attributes of the currently-selected element:

1 Line width (in pixels)

2 Line style

3 Type of line cap 

4 Type of line connection

Controls of the pen tab

Different types of line caps

1 Butt Cap

2 Round Cap

3 Square Cap
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Different types of line connections

1 Line width (in pixels)

2 Line style

3 Type of line cap 

Changing the text style

This tab allows you to change the following graphic attributes of the current text element:

1 Text font

2
Text style (  bold,  italic)

3 Text size

4
Text-align (  left,  centered,  right)

 
Controls of the text tab
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Contextmenufunctions

Following describes the contextmenufunctions of the display editor:

Display editor context
menu:

Description:

Add Simple Dynamic Adds a Simple Dynamic to the selected item.

Center Referencepoint Sets the referencepoint of the selected item to it's center.

Clone style Clones the appearance of the selected item to another.

Copy Copies the item to the clipboard.

Cut Cuts out the item an copy it to the clipboard.

Delete Item(s) Deletes the selected items.

Edit hyperlink … Edits the item's hyperlink or creates a new one.

Edit referenced Display … Lets you edit the referenced display in a new tab.

Edit Shape Edits the shape of the selected item.

Edit text Lets you edit the selected textitem.

Edit Widget Opens the source editor to edit the widget.

Paste Pastes an item from the clipboard.

Reset Transformation Resets an item's transformation to it's default transformation.

Select alternative Symbol Allows to select an alternative symbol for an instance.

Set as default
Transformation

Sets the item's current transformation to default.

Set Binding scroll down for information ...

Set to default
Transformation

Sets an item's transformation to default.

Transform scroll down for information … 

Visibility scroll down for information … 

Z-Order scroll down for information … 

Set Binding:

Bind to Bottom Left Corner Binds the object to the bottom left corner of the display.

Bind to Bottom Right Corner Binds the object to the bottom right corner of the display.

Bind to Center Binds the object to the center of the display.

Bind to SVG Binds the object proportional to the display.
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Bind to Top Left Corner Binds the object to the top left corner of the display.

Bind to Top Right Corner Binds the object to the top right corner of the display.

No Binding Disables the binding of the selected object.

Visibility:

Hidden Hides the item in the visualization.

Visible Shows the item in the visualization.

Transform:

Flip horizontally Flips the item around it's horizontal axis.

Flip vertically Flips the item around it's vertical axis.

Z-Order:

Bring forward Brings the selected item above the item over it.

Bring to front Brings the item in front of all other items.

Send backward Brings the selected item behind the item under it.

Send to back Brings the item behind all other items.
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Shortcuts

Context menu / ribbon menu of the canvas in the atvise builder Shortcut

New Ctrl + N

Open Ctrl + O

Print Ctrl + P

Save Ctrl + S

SaveAs Ctrl + Shift + S

ZoomIn Ctrl + +

ZoomOut Ctrl + -

Copy Ctrl + C

Cut Ctrl + X

Paste Ctrl + V

Delete Item(s) Del

Cleanup SVG Ctrl + Alt + C

Parameters Ctrl + Alt + P

Settings Ctrl + Alt + S

Reset Transformation Ctrl + R

Set as default Transformation Ctrl + Shift + T

Set to default Transformation Ctrl + T

Group items Ctrl + G

Ungroup items Ctrl + Shift + G

Undo Ctrl + Z

Redo Ctrl + Y

Select All Ctrl + A

Zoom

Reset Zoom Ctrl + 0

Fit Zoom Ctrl + .

Transform
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Flip vertically Ctrl + M

Flip horizontally Ctrl + Shift + M

Visibility

Visible Ctrl + Shift + H

Hidden Ctrl + H

Edit Shape F2

Edit Widget F2

Edit Text F2

Edit referenced Display F2

Center Referencepoint Ctrl + Shift + R

Clone style Ctrl + Shift + C

Edit hyperlink... Ctrl + L

Select alternative Symbol... Space

Add Simple Dynamic Ctrl + D

Z-Order

Send backward Ctrl + B

Bring forward Ctrl + F

Send to back Ctrl + Shift + B

Bring to front Ctrl + Shift + F

Align and Arrange

Align left Crtl + Shift + 4

Align horizontally Crtl + Shift + 1

Align right Crtl + Shift + 6

Distribute horizontally Crtl + Shift + 3

Align top Crtl + Shift + 8

Align vertically Crtl + Shift + 7
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Align bottom Crtl + Shift + 2

Distribute vertically Crtl + Shift + 9
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Dynamics
atvise provides the following two dynamics:

1. Quick Dynamics 

which are based on the atvise "simple dynamics" and are used to prepare common functionality that
is often needed in your project so that the user doesn't have to create the functionality step by step
with "simple dynamics".

Go to Quick Dynamics
 

2. Simple Dynamics 

which offer you many different ways to influence existing graphic elements or data variables. They
enable you to add dynamizations to your display to create a fully functioning visualization with
minimum effort.

Go to Simple Dynamics

421

423
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Quick Dynamics

Description

The quick dynamics button is located in the toolbar of the atvise builder:

A "quick dynamic" (QD) is based on the atvise "simple dynamics" (SD) such as "On click, open a
display" or "Change the color of the rectangle depending on the value of an address".
A QD can be applied to any element (e.g. a simple rectangle, a button, ...).
QDs are used to prepare common functionality that is often needed in your project so that the user
doesn't have to create the functionality step by step with SDs each time.

atvise quick dynamics

List of the predefined atvise quick dynamics:

Acknowledge Alarm
Auto Logout
Auto Reconnect
Change Color by Alarm
Change Color by Node
Change Display by Node
Change Display on Event
Change Opacity
Change Stroke by Node
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Change Visibility and Blinking
Move
Open Context Menu
Open Main Menu
Open Popup
Rotate
Save As
Scale
Set Node
Set Text
Tab Handler
atvise SVG table
Tooltip

For all quick dynamics an additional documentation can be opened by clicking the button "Help" on
the right bottom corner. (See image below)
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Simple dynamics

Simple dynamics

The simple dynamics dialog enables you to add dynamizations to your display to create a fully
functioning visualization with minimum effort. It offers you many different ways to influence existing
graphic elements or data variables.

Dynamics toolbox

The dynamics toolbox is located at the bottom right of the graphics editor interface. It shows a list of
all simple dynamics of the currently-selected element and enables you to add, edit and manage
dynamics.

Dynamics toolbox

Functions:

Right-click to see the following functions:

Add a dynamization. The simple dynamics dialog will be opened for the new dynamization
automatically.

Edit the dynamization which is selected in the list. You can also double-click a
dynamization in the list.

Copy a dynamization.

Delete a dynamization.

Double-click on the whitespace in this area to add a dynamization.
Double-click on an existing dynamization to edit it.
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Basic procedure

The following describes the basic procedure for simple dynamics and the related steps in the simple
dynamics dialog.

EVENT: First, an event has to be fired (for example a specific interaction of the user in the
visualization, change of a
data variable,..).

 

You can define this event in step 1 in the simple dynamics dialog

ACTION: When this event is fired, an action will be executed which has an influence on elements in
the display or data variables.

You can define this action in step 3 in the simple dynamics dialog.

Basic procedure for simple dynamics

Optional steps:

RIGHT: A certain user right can be defined as a requirement to execute the action of the event.



425Reference manual

© 2018 Certec EDV GmbH

You can define this right in step 0 in the simple dynamics dialog.

RESULT: The result of the event can be defined (for example modify the value of the event, start a
timer, ...).

You can define this result in step 2 in the simple dynamics dialog.

 

Necessary steps (EVENT and ACTION) and optional steps (RIGHT and RESULT)

As already mentioned, the dynamics are split up into four main categories and each one has its own
functions. Click on a desired category to get more information.
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Address selector

In the "Simple Dynamics" dialog, the address selector is used quite often. For example, to choose a
display or to set a node address. The address selector is split up into three categories.
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Displays

Objects
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Object types

If you choose "Object Types" in your Object Selector, note that you have to select the
Object Type in the left column first and then select the data variable of the chosen
type in the right column (as shown in the screenshot above) to create a correct
relative addressing.

0. RIGHT

Simple dynamics - 0. RIGHT

Choose if user access rights are necessary or not.

User Access Rights
If a user does not have permission to execute dynamics on the display, user
access rights can be set. To show an error message (message box), check the
respective option and choose an error text.

1. EVENT

Simple dynamics - 1. EVENT

The event specified in this part of the Simple Dynamics defines the trigger for executing the
dynamization. On the left side of the dialog you can choose the type of event you want to react to.
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The following describes the different types of events:

Single Node / Alarm Change Event

This event allows you to react to the change of a specified attribute of a specified data
variable. You can type in the following information:

Specify source

In the text box, you can specify the source address of a desired node. Press the  button

to open the node selection dialog. Press down the  button to select a relative address
(starting at the base of an object type).
If the alarmstate has been selected then the alarm condition of the corresponding alarm has
to be selected under "Specific source".

Specify attribute

In the list box on the right of the address text box you can choose between value,
timestamp, alarm state or state of the node defined to react to.

Specify value type

The value type of the source node will be set automatically depending on the data type of
the selected data variable, but it can be changed manually.

Mouse event
This event allows you to react to different kinds of mouse interaction.

Timer event

Specify interval for cyclic execution of an adjusted action.
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Display event

The display event enables you to fire an action when:
a new display is loaded (Load)
an open display is unloaded (Unload)
the zoom of a display is changed (Viewbox (Zoom) changed)

Condition node change event

The condition event will fire an action when all of the added conditions are met.

Columns:

1: Address: Specify the source address and attribute of a desired node.

2: Data type of the specified node:

B - Boolean
N - Number
S - String
A - Alarm
O - Other

3: Comparative operator

4: Value

Keystroke event

The keystroke event is activated when a key (or combination of keys) is pressed. Choose a
modifier (none, alt, ctrl, shift) and a key (alphanumeric, numeric, function keys).

Trigger event

Is executed when another dynamization fires the specified trigger name in the Action-
>Trigger part .

Example:

437
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User-input event

Depending on the user input, an action will be executed (mainly used for widgets). There are
three different input validations:

no validation (waiting for a user input without limitations)
validate by a discrete list of values
validate by range (minimum, maximum) for user input
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2. RESULT

Simple dynamics - 2. RESULT

The following table explains how to use the different types of results.

Take value from node
Specify the source address and attribute from another node to take its value.

Timed actions
Specify the interval and count times for execution of an adjusted action.

maximum counts: 999 times
maximum intervals: 99999 ms

Take value from widget
Specify the ID of the widget to take its value for an action.

Recalculate original result value
Enter a desired value and a mathematical calculation for the new value.

3. ACTION

Simple dynamics - 3. ACTION

The action specified in this part of the simple dynamics will be executed when the event defined in
step 1 is triggered. The action types listed on the left side of the dialog will be executed. The
properties for each type can be set right next to it.
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The different types of actions are explained in the following table.

Rotate element

Specify the min/max value and start/stop angle to rotate an element. In this case, changing
the node value by 100 means rotating the element by 360° (see above).

The element rotates around the point of rotation on an element which is marked yellow. This
point of rotation can be moved as desired, even outside of the element.

Scale element

Enter the min/max value and scale x/y (in %) to scale an element. Changing the node value
will

scale the element up/down (in percent)
scale the element left/right (in percent)

Change Color

To change the color of an element, this action has to be called. Make a selection to change
the color by

discrete values
discrete value ranges
a value range

Change Visibility

To change the visibility of an element, this action has to be called. Choose between visible,
invisible or cycling flashing (in ms). Make a selection for changing visibility

discrete
discrete value ranges

Set Widget

This action must be called to set a widget or display to a node value directly in the widget.



434 atvise® - documentation

© 2018 Certec EDV GmbH

Open / Close Window

Specify if a window should be opened, changed or closed.

To open a window, specify its position and size.

There are several features which can be set for the new window.

To open an information dialog, (alert) enter a desired text.
To change the display, set the display URL.
To close the actual window, choose the last option.

Features:

If the feature „Extern" is activated, then the window to be opened will be opened as
external window, i.e. a new tab will be opened in the browser. In case "Extern" is
deactivated, the window to be opened will be opened internally in the existing tab.

The features "Modal", "Resizeable" and "Moveable" shall only be used for internal
windows.

The features "Scrollbars", "Menubar", "Statusbar" and "Toolbar" are browser specific,
i.e. these elements will only be shown in the browser if they are supported by the browser.
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Target: This represents the parameter called "name" in the iframe Object Display. (If the
iframe is named "myframe" the input field target should be filled with its name if it is desired
to open the address in this frame).

Note: These functions (e.g. also nesting of windows) are browser specific.
Therefore, please test your parameterization with your devices and browser.

Acknowledge Alarm

Specify the address of the alarm condition to be acknowledged.

Change Text

The "Change Text" action has the following useful functions:

show enumerated values (discrete)
show enumerated values (range)
change font (discrete)
change font (range)
display value directly
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Important for "Display value directly": the "Format Output" string has to be printf()-syntax
conform!

Set address(es)

The following functions are useful to set a value to a node address:

take the value directly from the event
discrete values
condition-based value, discrete
condition-based value, range

Move element

Enter the min/max value and position x/y (in %) to move an element. Changing the node
value will

move the element up/down (in pixels)
move the element left/right (in pixels)

Skew element

Enter the min/max value and skew x/y (in %) to skew an element. Changing the node value
will

skew the element up/down (in percent)
skew the element left/right (in percent)

Change Opacity

To change the opacity of an element, this action has to be called. Just as for the "Change
Color" event, a selection must be made:

discrete values
discrete value ranges
a value range
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Set Image

To set a new image, a value (discrete value or discrete value ranges) and an image file
address have to be entered.

Set active / inactive

To enable or disable an element, enter a value and set it to active or inactive.

Zoom

The disabled zoom functionality in the simple dynamics dialog is still present
due to compatibility reasons. Zooming can be handled via the object display
named "group zoombuttons". For more information please refer to the object
display's help.

Start / Stop Sound

To play a sound (once or continuously), enter an alarm-sound file address. To stop a playing
sound (one specific or all playing sounds), deactivate it using the respective functions.

Apple forbids automatic playback of audio sequences without user interaction on
its IOS devices:

Further Information: Link

Start Script

Use this action to start a script as an action within the simple dynamics.

Fire Trigger

You can fire a trigger with any name. All dynamizations that have this trigger name defined
in the Event -> Trigger part  will be triggered.

You can also pass a value on to the trigger event:

430

http://developer.apple.com/library/safari/#documentation/AudioVideo/Conceptual/Using_HTML5_Audio_Video/Device-SpecificConsiderations/Device-SpecificConsiderations.html
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take the value directly from the event
discrete values
condition-based value, discrete
condition-based value, range

Example:

If the actions move, skew and rotate wanted to be used at the same time on the
same item or group, the dynamization has to be applied nested.

Example: 

Rotating engine moving from left to right:

<g> - movement
<engine/> - rotation

</g>

Rotating pointer, that can get shorter and longer:

<g> - rotation
<pointer/> - movement

</g>

Examples

Simple dynamics - examples

Single Node / Alarm Change Event --> Rotate element

Clicking on one of these buttons will change the value of the applied node.
The green block rotates inside the blue border as parameterized.
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Single Node / Alarm Change Event --> Skew element

Clicking on one of these buttons will change the value of the applied node.
The image file skews as parameterized - in this case 100% is equivalent to an angle of 20°
.

Single Node / Alarm Change Event --> Change Opacity

Clicking on one of these buttons will change the value of the applied node.
The circle will change its fill opacity from 0% to 100% green.

Mouse Event --> Set address(es)
Single Node / Alarm Change Event --> Change Color

Moving the mouse in or out of the element will change the value of the node as well as
clicking inside of the element. The current value of the chosen node is shown in the text
field. In addition, it is possible to set another dynamization to the element, such as
changing the color of the element depending on the node value.
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Mouse Event --> Open / Close Window

Parameterizing a mouse click event on a button can open windows, as well as close them.
One possibility is to open an information dialog - with a desired text for it.

 

Mouse Event --> Set address(es)
Mouse Event --> Acknowledge Alarm

When the fire alarm button is clicked, the value of the node is set to 90 (in this case). To
see if the alarm was really fired, it is recommended, for example, that the color of the
circle and/or the visibility be changed, such as flashing every 500 ms, as well as showing
an alarm status text - ON, UNACKNOWLEDGED.

When the alarm is stopped (value is now set to below 80), the flashing becomes slower
and the alarm text is set to OFF, UNACKNOWLEDGED.

For acknowledging the alarm, the Ack Alarm action has to be called when clicking the
appropriate button - alarm status OFF, ACKNOWLEDGED.
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Mouse Event --> Set address(es)
Single Node / Alarm Change Event --> Change Text

For this example, it is usually recommended that a boolean data variable be used. Clicking
one of the two buttons will set the boolean to true or false. Depending on the value of the
node, the test text will be shown in the Times New Roman or Arial font.

Keystroke Event --> Timed Actions --> Open / Close Window

The keystroke event offers many different key combinations for executing an action. In this
example a timed action is set for opening a message box - the timer runs 3 times with an
interval of 5 seconds.

Trigger Event --> Rotate element

Clicking the buttons (+/- 10°) will increase or reduce the angle depending on the value in
the text field (widget) - the pointer starts to rotate. It is also possible to enter a value
manually.
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The trigger is responsible for moving the pointer using the rotate action.

User Access Right --> User Input Event --> Recalculate Original Result Value --> Set
address(es)
Single Node / Alarm Change Event --> Change Text

In this example, the text field (marked red) is the most important element. First, a user
access right has been set. When the user wants to enter a value in the text field, he has
to be logged in. If he is not, an information dialog will appear.

The user is now able to enter a value which will be automatically recalculated to a new
value of the node. In this case, the user's entry of 96 will be recalculated with + 4 and the
new value of the node is set to 100.

In the second part, the node value is shown in the text element (marked green) but not in
the user input text field (marked red). It is similar to read/write where the user input is write
and the value shown is read.

Mouse Event --> Set address(es)
Single Node / Alarm Change Event --> Set Active / Inactive
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To set elements to active or inactive, the enable/disable action has to be used. Using a
boolean data variable will simplify this example a lot. Clicking one of the two buttons will
set the boolean to true or false. Depending on this value, the elements are active, which
means they can be changed in the browser, or inactive.
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SVG attributes
In this area attributes' values like color or height can be changed. Following you find a list of all
possible attributes and their description.

Examples w ith a selected circle

name description

atv:bindtl bind top left coordinate

atv:bindbr bind bottom right coordinate

atv:refpx x position of referencepoint

atv:refpy y position of referencepoint

cx center of a circle (x-coordinate)

cy center of a circle (y-coordinate)

d definition of a polygon

fill fill color in HEX

font-family font family

font-size font size

height height

id unique identification of an object on the display (can be changed in the
SimpleDynamics area)

points point of a polyline

r radius
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rx rounding x

ry rounding y

stroke stroke color in HEX

stroke-width stroke width

transform transformationmatrix (Scale+Skew+Rotate at once)

width width

x x position of an object (upper, left corner)

x1 x position of a line's startpoint

x2 x position of a line's endpoint

xlink:href path to a referenced display or a link to another display

y y position of an object (upper, left corner)

y1 y position of a line's startpoint

y2 y position of a line's endpoint

Binding of graphic elements to displays

By setting these attributes, objects can be bound to different positions on their parent display.
If the parent display will be referenced and transformed on another display, the objects in the parent
display will behave as their binding was set.

The numbers are the percentage of width or height (of the parent display):

e.g.:

1 = 100 %
0.5 = 50 %

Attributes:

bind top left coordinate         atv:bindtl="x,y"
bind bottom right coordinate             atv:bindbr="x,y"
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Script Editor
Script editor

This  opens the script editor.

When elements have received parameterizations generated by the simple dynamics dialog, the script
code can be edited in the script editor. There are some additional functions built in which, for
example, help you to find specific parameterizations much more easily.

 

Accept Changes
After changing the source code, this button will save the changes and close the script editor
afterwards.

Print
Opens the 'Print' dialog.

Load from disk
Opens the 'Load script' dialog to load a script file from the disk.

Save to disc
Opens the 'Save script' dialog to save the script file to the disk.

Undo

Undo the last action.

Redo

Redo the last undone action.
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Copy

Copy a marked text (and save it to the clipboard).

Cut

Cut a marked text (and save it to the clipboard).

Paste

Paste the text from the clipboard.

Find and Replace

Opens the following window to find character strings and/or replace them with other
character strings.

Go to line

Opens the following window to jump to a desired line in the source code:

Select color

Clicking this button will open the select color dialog. Select a color to insert its RGB code
into the script editor.



449Reference manual

© 2018 Certec EDV GmbH

 

Select node

Clicking this button will open the select node dialog. Select a node to insert its node ID into
the script editor.

 

Select display

Clicking this button will open the select display dialog. Select a display to insert its node ID
into the script editor.
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Select font

Clicking this button will open the select font dialog. Select a font to insert it into the script
editor.

 

Increase indent

Increase the indent on a line.

Decrease indent

Decrease the indent on a line.

Edit referenced scripts

Opens a dialog where referenced scripts can be edited.
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Display parameters
Display parameters simplify your work with the atvise builder. Every display can have its own
parameters. They can be set in the graphics editor. There are various ways  of working with
parameters.

"Edit Parameters" in the graphics editor

1 Click on the icon to open the "Edit Parameter" window.

2 Here you can edit the parameters of a display.

Name: 
Enter the name of the parameter.

Substitute:
A wild card for the display. For example, if a standard text is to be displayed which changes
dynamically when the parameter value in the object display is edited. We recommend the
spelling "$<NAME>$" (e.g. $OBJECTID$)

Description:
Describes a parameter.

Behavior:
Changes just the appearance of the input field in the attributes area of the display editor.
Mandatory: The parameter's input field will be shaded in red to indicate a mandatory field.
Optional: Default setting. The field has no special shading.
Hidden: The parameter will not be shown.

Value Type:
There are different kinds of value types (address, display, string, tstring, number, bool, color,
enum, global), which can be used for parameters.

Default Value:
When a default value is set, the substitute value will be displayed with the default value.

Config: 
has different meanings depending on the value type. Example: value type= enum,
config=option1;option2. This results in a drop-down box where opt.1;opt. 2 are displayed in a
list.
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Group:
Multiple Parameters can be structured by entering the same group name, that will be shown in
the attributes area of the display editor. A group name can be chosen freely. 

Eg.: The parameter "fontFamily", "fontColor" and "fontSize" has the same group name "Font".
Now all text specific parameters are clearly classified in one group.

3 If you drag a display like this from your pool into an object display, the "Substitute" value
changes to the "Default Value" if one is defined.

4 If you type in a value as in the picture above, it will replace the "Substitute" value. If you type in
nothing, the "Default Value" will replace the "Substitute" value.
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Object-oriented parameterization
There are three ways to create displays with object-oriented parameterizations:

1. No clear data structure

This option is used if there is no clear data structure available, or if the object display is not going to
be reused again. Here a display is dragged into an object display and then every single parameter of
the display must be entered manually.
If you need the same object display a number of times, it is recommended that you go to Option 2
below. You will find an example of the individual atvise products in the tutorial.

Option 1: drag your display into another display and enter the addresses for each parameter

2. Clear data structure but no object type

As a first step, a new base parameter for a display has to be created. This parameter is the key to
all the other data which is in the object. Instead of selecting all parameters, only the base parameter
created must be selected and the desired attribute with the separator at the beginning must be
entered. After dragging the display into the object display, only the desired object must be chosen
as the value for the parameter. This way, not every single attribute has to be entered, only the base
parameter created.

If a clear data structure has been created on the server and the same display will be used several
times it is recommended that this method be used. You will find an example of the individual atvise
products in the tutorial.
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Option 2: drag your display into another display and enter the address for the base parameter

3. Clear data structure and an object type

If structured data is available as well as an object type for the object, you are able to add a display to
your object type.
No new base parameter must be created as in option 2. Just select the existing base parameter and
then the desired attribute must be entered with the separator at the front. Now every object can be
dragged into the object display without entering any additional parameters.

You will find an example of the individual atvise products in the tutorial.

Option 3: drag your objects directly into your object display
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Example: Object display (simple bar)
In this section you will learn how to create and use your own simple bar display.

In order to do this, we have to add, design and parameterize a new object display.

1 Adding a new object display

First, we have to add a new object display in which we will design our own simple bar control.

1 Right-click on the "Library -> PROJECT -> Object Displays" folder in the structure on the left
side of the builder interface and choose "Add Display...".

This folder is intended for your own object displays. Here you can create all of your
desired displays.             

2 Enter "myBar" as the name and apply the dialog by clicking on "OK".

3 The "myBar" object display will appear in the structure on the left. Double-click on it to open the
graphics editor.

Adding the "myBar" object display

2. Design the "myBar" object display

Now we have to design our own simple bar control in the newly added object display.
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We will draw two rectangles to do so. One will act as the background, the other will represent the bar
itself.

1 Select the rectangle drawing tool in the symbol bar and draw a rectangle of the desired size.

2
Change its color by clicking on the fill tab just below the drawing area and choosing a gray
color.

3
Draw a second rectangle. You don't have to change its color this time. Also make sure that this
second rectangle is smaller than the first one.

4 Position the second rectangle in the middle of the first one.

5

Make sure the smaller rectangle is selected. Then drag and drop its yellow reference point to
the left border of the rectangle. This is important for the "scale" dynamization we will add later.

To position the reference point more precisely, zoom in with your mouse wheel.

6
Choose "File -> Settings" from the symbol bar and click on the "Fit" button in the dialog which
appears. Apply the dialog by clicking "OK".

Add two rectangles
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Position the smaller rectangle and change its reference point

3 Creating display parameters

In this step we will define the parameters we want to use in our object display.
There will be two parameters in total: one to define the color of the bar and a source parameter which
will set the value of the bar.

1 Choose "File -> Parameters" from the symbol bar.

2 Add a new parameter named "barcolor". 

3 Enter "$barcolor$" in the "Substitute" field.

The "Substitute" text will be replaced by the value of the parameter.



458 atvise® - documentation

© 2018 Certec EDV GmbH

We will use this in the next step to make the color of our bar parameterizable.

4 Select "color" as "Value Type".

5 Choose red as the default color in the "Default" field using the  selector.

6 Add a second parameter named "source".

7 Select "address" as "Value Type" for the source parameter.

8 Apply the dialog by clicking on "OK".

Adding parameters to the display

4. Changing fill of rectangle to "Substitute" of barcolor
parameter

Now we are going to set the fill of the smaller rectangle to the "Substitute" text of the "barcolor"
parameter. This substitute will be replaced by the value of the parameter and the rectangle will
change its color to the respective value.

1 Click on the smaller rectangle to mark it.

2 Open the "SVG" tab in the Attributes window on the right side of the builder interface.  

3 Enter "$barcolor$" as the value in the "fill" field.

"$barcolor$" is the substitute text of our "barcolor" parameter which we created in
section 3.
This substitute text will be replaced by the value of the "barcolor" parameter, as you will
see in section 5, step 4.
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4 You will see that the color of the bar will change immediately to the default value of "barcolor"
which we defined in section 3.

changing fill of rectangle to "Substitute" of parameter

5. Adding Dynamization

In this section we will add a simple dynamic to the bar rectangle to scale it according to the value of
the "source" parameter.

1  Click on the smaller rectangle to mark it and start the "Simple Dynamics" dialog by right-

clicking -> 

2
We want to react to the change of a data variable, so we choose  from the
possibilities on the left side.

3  Click on the  button to activate relative addressing.

4 Use the drop-down list to choose "source".

5 Choose "Number" as the value type.

6 Now that we have an event to react to, we must define the action that is to be executed. We

want to change the scale of our rectangle, so we choose  from the possibilities on
the left side.

7 Enter 0 as the "Minimum value" and 100 as the "Maximum value".

8 Check "Scale X". Enter 0 and 100 as the start and stop values.
Make sure "Scale Y" is not checked.

Because we want to create a horizontal bar, the rectangle should only scale in x
direction. If we wanted a vertical bar, we'd only check "Scale Y".

9  Apply the "Simple Dynamics" dialog by clicking "OK".
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the "Simple Dynamics" dialog to add a "scale" dynamization

Another way to add a "scale" dynamization would be by using the "scale" quick
dynamic. To do so, you would have to mark the rectangle and choose "Dynamics ->
Scale" from the symbol bar.

6. Adding the "myBar" object to a display

Now the "myBar" object display is finished, so let's save it by clicking on the  button in the
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symbol bar.

In order to use your bar in another display, you simply have to drag & drop it in the drawing area of
this display.

1 Open a desired display to which you want to add your "myBar" object.

2 Open the "Library -> PROJECT -> Object Displays" folder in the structure on the left side and
drag & drop "myBar" into the drawing area.

3 Make sure your "myBar" object is marked. On the left side you can see a list of all of its
parameters in the Attributes window.

4 If you like, you can change the "barcolor" parameter by using the  selector. For our example
let us choose a green color.

5 Set the "source" parameter by using the  selector. You can choose any desired number data
variables.

6 Add an input control to set the number data variables which you have assigned to the "source"
parameter.

7 Save the display.

Adding the "myBar" object to a display

7. Viewing your "myBar" control in the visualization

Open the display in the visualization and test your simple bar control by setting the value of the
number data variable to between 0 and 100. The bar will change accordingly to the value of the
number data variable.
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Viewing and testing your "myBar" in the visualization
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Server scripts editor
This section describes the functions of the server script editor. If you want to know how to use it, see
the section Server scripting .

Save

After changing the source code, this button will save the changes and the code will be
executed.

Load from disk

Opens the 'Load script' dialog to load a script file from the disk.

Save to disc

Opens the 'Save script' dialog to save the script file to the disk.

Print

Opens the 'Print' dialog.

Undo

Undo the last action.

Redo

Redo the last undone action.

Copy

Copy a marked text (and save it to the clipboard).

Cut

Cut a marked text (and save it to the clipboard).

Paste

Paste the text from the clipboard.

Find and Replace

Opens the following window to find character strings and/or replace them with other
character strings.

309
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Go to line

Opens the following window to jump to a desired line in the source code:

Select color

Clicking this button will open the select color dialog. Select a color to insert its RGB code
into the script editor.
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Select node

Clicking this button will open the select node dialog. Select a node to insert its node ID into
the script editor.
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Select display

Clicking this button will open the select display dialog. Select a display to insert its node ID
into the script editor.

Select font

Clicking this button will open the select font dialog. Select a font to insert it into the script
editor.
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Client/Browserside scripting reference
The following section describes which configurations can be set for the webMI:

Configuration

The following sections are covered by the scripting reference based on webMI technology:

General functions General functionality

Data functions Reading, writing and subscribing of/to data.

Alarm functions Setting, unsetting and acknowledging alarms.

Graphics functions Drawing, transforming and changing attributes of SVG elements.

Widget functions Getting and setting widget values, enabling/disabling widgets.

Display functions Setting and zooming the viewbox, opening child windows.

Sound functions Playing and stopping sounds.

Trigger functions Display trigger

Key functions Read keyboard input
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Configuration
The webmicfg.js is a resource which can be found in Library.ATVISE.Resources.webmicfg.js. This
file can be used to set the following configurations used in the webmi.js. All of these configurations
can also be set by using javaScript (e.g.: webMI.setConfig("data.enablelongpoll", false);). The main
difference is that setting these properties in the file will happen earlier than setting the configurations
by javaScript when the webmi.js is already loaded.
 
"data.enabledeletesession": true/false (boolean) - default: true
 

Setting this property to true will guarantee that "deletesession" will explicitly be called on unload
event and the session will be deleted.

 
"data.enablelongpoll": true/false (boolean) - default: true
 

Setting this property to false will cause that publish will not happen event-driven. The server will
always respond in the defined interval ("data.publishinterval") on publish requests. By setting this
property to true "data.publishinterval" should be set to 0 so that publish will happen event-driven.

 
"data.keepaliveinterval": 4000 (number/ms)  - default: 4000
 

This interval is being used to check if the server is reachable by sending a "read" request. In the
case that the server is not reachable the index.html will trigger an errorscreen. Further details
according to the keepalive mechanism and the errorscreen can also be found in the
QuickDynamic Help for AutoReconnect.

 
"data.publishmaxresults": 0 (number/ms)  - default: 0
 

Limitation for results in publish response (0 = without limit). If more valuechanges occured than
the limit is set to, only the latest valuechanges will be sent according to the limit.

 
"data.publishinterval": 0 (number/ms) - default: 0
 

See "data.enablelongpoll" for more information.
 
"data.requesttimeout": 3000 (number/ms) - default: 3000
 

When a request is being sent to the server a timeout with the defined timespan will start. If the
server does not respond within this timespan a specific timeout callback will be called, which is
internally handled in the webmi.js.

 
"data.sessiontimeout": 0 (number/s) - default: 0
 

This timeout specifies how long a session will be alive without any interaction from the client to
the server. After running in the sessiontimeout the session will no longer be valid which means
that the server will not respond with data on requests. The server will respond with the message
"Invalid Session or Digest". By setting the value to 0 the default timeout of 60 seconds will be
used.

 
"data.url": "/webMI/?" (string) - default: "/webMI/?" 
 

This paramater enables setting a URL for requests.
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"frame.alignment": "left", "center", "right", "top", "bottom" (string) - default: "center"
 

This parameter defines the alignment of the visualization if "autofit" is activated.
 
"frame.displaytype": "xhtml", "svg" (string) - Standardwert: depends on server type
 

Defines the format of the visualization:
"xhtml": The displays are delivered as xhtml files. To use the atvise visualization without
limitations in redundancy mode, this setting should be used. Default for atvise scada.
"svg": The displays are delivered as svg files. Default for generation of the visualization for
webMI servers.

 
If a webMI server supports the mime type "application/xhtml+xml", this setting can be changed
to "xhtml".

 
"frame.documentdomain": true/false (boolean) - default: true (only relevant for atvise scada)
 

Provided that Fully Qualified Domain Names (FQDN) and redundancy mode is used, activate this
setting to ensure that the atvise visualization switches automatically to another connection in
case of a broken current connection.

The setting can be deactivated in standalone mode.

If activated, check your resources in Library->ATVISE->Resources and Library->PROJECT-
>Resources and add this code to all HTML and SVG documents where applicable:

<script src="/webmicfg.js" type="text/javascript"></script>
              <script type="text/javascript">/*<![CDATA[*/
var docDomain=true;
var displaytype="xhtml";
if ("webMIConfig" in window) {
       var config = window["webMIConfig"];
       if("frame.documentdomain" in config)
              docDomain=config["frame.documentdomain"];
       if("frame.displaytype" in config)
              displaytype=config["frame.displaytype"];
}
if(displaytype != "xhtml" && displaytype != "svg") {
       displaytype="xhtml"
}
if(docDomain == true) {
       try {
              if (displaytype == "svg" &&
navigator.userAgent.indexOf("Firefox") > -1)
                    throw false;
 
              var domain = location["hostname"]
                           .split(".")
                           .slice(-2);
 
              document.domain = domain.join(".");
       } catch (e) {}
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}
/*]]>*/</script>
<script src="/webmi.js" type="text/javascript"></script>

 
"frame.enableautofit": true/false (boolean) - default: true
 

Setting this property to true will guarantee that displays will automatically fit to the browser
window.

 
"frame.scaletype": "zoom", "transform", "native" (string) - default: "zoom" or "transform"
 

Defines the type of Scaling  to be used for displays. The decision between “zoom” or
“transform” is browser dependent and taken automatically, as long as you do not set the
“frame.scaletype” property. Following settings are possible:

"zoom":  CSS based scaling by "zoom", recommended for the browsers Chrome and Safari.
"transform": CSS based scaling by "transform".
"native": Scaling by adjusting the size of DOM elements (compatible to versions before atvise
3.1.0).

 
"responsiveLite": true/false (boolean) - default: false
 

Setting this property to true will activate the use of the Reponsive Design Lite  displays.
 

In case that you have a slow internet connection (e.g. GSM), you need to chose an
appropriate interval especially for data.keepaliveinterval and data.requesttimeout to
avoid the errorscreen being displayed permanently. To avoid this case try setting a
timeout of 30000 (ms) for keepalive and requesttimeout.

162
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General functions
webMI.addEvent

webMI.addEvent

webMI.addEvent(
          id,
          name,
          function(e){...});

Registers a callback function for one or more events of an object.
The "id" parameter specifies the object, the "name" parameter the desired events. "name" can be a
single event or an array of events. The possible events are "click", "dblclick", "mousedown",
"mouseup", "mouseover", "mousemove" and  "mouseout". 
When one of the specified events occurs, the callback function will be called.

webMI.addEvent("myRectangle", "click", function(e) {
alert("Rectangle was clicked.");

});

webMI.addOnload

webMI.addOnload

webMI.addOnload(
           function(e){...});

The function callback will be executed after all contents of the display were completely loaded (when
all graphics and scripts are ready).

webMI.addOnload(function() {
alert("Display loaded!");

});

webMI.callExtension

webMI.callExtension

webMI.callExtension(
          id, 
          parameterObject);

Function to call "QuickDynamics" from the Library. The "id" is the full nodeID of the quick dynamic,
"parameterObject" is a JSON object with all the necessary parameters.

webMI.callExtension("SYSTEM.LIBRARY.ATVISE.QUICKDYNAMICS.Change Color
by Node", {"fillInRange":"#00ff00", "fillOutOfRange":"#ff0000",
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"id":"id_1", "maxRange":"", "minRange":"0",
"nodeId":"AGENT.OBJECTS.TEST1.test1", "strokeInRange":"#000000",
"strokeOutOfRange":"#000000"});

webMI.hasRight

webMI.hasRight

webMI.hasRight(
            name);

Used to check if the currently logged in user has the right specified by the parameter "name".
Returns true or false.

var hasRight = webMI.hasRight("VISU.Operate");
if (!hasRight) {

alert("You don’t have the necessary right!");
}

webMI.inList

webMI.inList

webMI.inList(
         element, 
         array);

Checks if the specified "element" is an item of the given "array" – returns true or false.

var animals = ["cat", "dog", "elefant"];
var iHaveACat = webMI.inList("cat", animals);
(iHaveACat is "true")

webMI.sprintf
webMI.sprintf

webMI.sprintf(
          format, 
          value);

Formats a value with the given format String (use "printf()" syntax of programming language C). 

(value = 23, format = "%04.1f")
var value = webMI.sprintf(format, value);
(Result: value = 23.0)
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webMI.query

webMI.query

webMI.query[key];

Returns the specific display parameter when opening the display. If the parameter is not specified,
the default value is returned and if that value is not available "undefined" will be returned.

var myBase = webMI.query["base"];

webMI.escapeHTML

webMI.escapeHTML

webMI.escapeHTML(string);

This function allows to convert special characters in a string to HTML entities. It is designed to
protect the user against malicious code in dynamically set content using innerHTML, outerHTML or
document.write(). In these cases it is recommended to use either webMI.escapeHTML or
webMI.secureString (see below).

li.innerHTML = webMI.escapeHTML(e.value);

webMI.unescapeHTML

webMI.unescapeHTML

webMI.unescapeHTML(string);

This function is the counterpart of webMI.escapeHTML and allows to convert HTML entities back to
the corresponding special characters.

webMI.secureString

webMI.secureString

webMI.secureString(string);

Similar to webMI.escapeHTML, but here some HTML tags and attributes are allowed:

<b>                        - bold
<blockquote>          - specifies a section that is quoted from another source
<code>                  - defines a piece of computer code
<del>                     - delete, used to indicate modifications
<dd>                      - describes an item in a <dl> description list
<dl>                       - description list
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<dt>                       - title of an item in a <dl> description list
<em>                     - emphasized text
<h1>, <h2>, <h3>   - headings
<i>                         - italic
<img>                    - specifies an image tag (attributes alt, src, title, width and height are allowed)
<kbd>                    - represents user input (usually keyboard input)
<li>                        - list item in an ordered <ol> or unordered list <ul>
<ol>                       - ordered list
<p>                        - paragraph
<pre>                     - pre-formatted text displayed in a fixed width font and with unchanged line
breaks
<s>                        - strikethrough
<sup>                    - superscript text
<sub>                    - subscript text
<strong>                - defines important text
<ul>                      - unordered list
<br>                      - line break
<hr>                      - horizontal line

All other elements are masked for security reasons.

li.innerHTML = webMI.secureString(e.value);
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Data functions
webMI.data.call

webMI.data.call

webMI.data.call(
     functionName,
     arguments,
     function(e){...});

Allows you to call a function functionName that was implemented on the server side with a set of
arguments. Optionally, the function callback can be provided and will be executed when the call is
finished.

webMI.data.call("serverCalculateSum", {"key1": "value1", "key2":
"value2"}, function(e) {
   alert("callback function reached");
});

webMI.data.read

webMI.data.read

webMI.data.read(
     [nodeID1, nodeID2,...nodeIDN],
     function(e){...});

Passes a current property object  for every data variable specified by its nodeID to the callback
function.

Example:

webMI.data.read("AGENT.OBJECTS.var1", function(e) {
  alert(e.value);
});

Example - Working with arrays:

var nodeAddressArray =  ["AGENT.OBJECTS.var1","AGENT.OBJECTS.var2"];

webMI.data.read(nodeAddressArray, function(e) {
  console.log(e[0].value);
  console.log(e[1].value);
});

webMI.data.subscribe

483
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webMI.data.subscribe

webMI.data.subscribe(
     nodeID,
     function(e){...});

Subscribes to the data variable specified by nodeID. Every time the process value of this data
variable changes, the callback function is executed.
The current property object  of this data variable is passed on to the function in e.

Returns a subscriptionId, which can be used to unsubscribe the data variable.

webMI.data.subscribe("AGENT.OBJECTS.var1", function(e) {
  alert("var1 changed to " + e.value)
});

Example - Working with arrays

webMI.data.subscribe("AGENT.OBJECTS.testArray", function(e) {
  alert(e.value[0]);
});

webMI.data.unsubscribe

webMI.data.unsubscribe

webMI.data.unsubscribe(
     subscriptionId);

Unsubscribes the data variable with the given subscriptionId (return value from
webMI.data.subscribe). The previously created subscription will not receive a notification of the
callback function anymore.

webMI.data.subscribeBlock

webMI.data.subscribeBlock

webMI.data.subscribeBlock(
     nodeIDs[],
     alarmIDs[],
     function(e){...});

Allows you to subscribe to multiple data variables with one function.
The current property objects  of the specified data variables are passed on to the function in e[idx].

webMI.data.subscribeBlock(["AGENT.OBJECTS.var1","AGENT.OBJECTS.var2"],
[], function(e) {
alert("var1 or var2 has been changed.");

483
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alert("Current value of var1: " + e[0].value + " Current value of var2:
" + e[1].value)
});

webMI.data.write

webMI.data.write

string webMI.data.write(
     [nodeID1, nodeID2,...nodeIDN],
     [value1, value2,..., valueN]);

Writes value1-valueN to the data variables specified by nodeID1-nodeIDN.

var value1 = "myStringValue";
var value2 = 42;
webMI.data.write(["AGENT.OBJECTS.var1","AGENT.OBJECTS.var2"],[value1,
value2]);

Example with "AGENT.OBJECTS.var1" from type Array:

var value1 = ["firstArrayValue", "secondArrayValue"];
var value2 = 42;
webMI.data.write(["AGENT.OBJECTS.var1","AGENT.OBJECTS.var2"],[value1,
value2]); 

webMI.data.addEventListener

webMI.data.addEventListener

webMI.data.addEventListener(
         name, 
         function(e){...});

This is a special function to connect a callback function "callbackFn" to changes of client variables
(e.g. language switched, user logged in, number of CCD exceeded).
So, the parameter name has to be "clientvariableschange".

webMI.data.addEventListener("clientvariableschange", function(e) {

if ("preferredlanguage" in e) {

// language changed

}

if ("username" in e) {

// user logged in

}

if ("CCDexceeded" in e) {

// maximum number of CCD exceeded
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}

});

webMI.data.login

webMI.data.login

webMI.data.login(
          username,
          password, 
          function(e){...});

If the function is called without parameters a browser authentication window will open and ask for
credentials.
If the two parameters username and password are specified the function tries to login the user to the
system. The function callback is a function that will be executed after the user was logged in or an
error occurred.

webMI.data.login("testuser", "password", function(e) {
if ((e[""].hasOwnProperty("username") && !e[""].username) ||
e[""].hasOwnProperty("error")){

// login NOT OK
} else {

// login OK
}});

webMI.data.logout

webMI.data.logout

webMI.data.logout();

The currently logged in user will be logged out.

webMI.data.logout(function(e) {
if (!e[""].error) {

// logout OK
} else {

// logout NOT ok
}
});

webMI.data.pause

webMI.data.pause

webMI.data.pause();
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Pauses the data communication for all subscriptions in the current display (counterpart to
webMI.data.resume).

webMI.data.resume

webMI.data.resume

webMI.data.resume();

Resumes the data communication for all subscriptions in the current display (counterpart to
webMI.data.pause).

webMI.data.isPaused

webMI.data.isPaused

webMI.data.isPaused();

Returns the state of the data communication in the current display. If "true" is returned, the data
communication is paused by the webMI.data.pause function.

webMI.data.queryFilter

webMI.data.queryFilter

webMI.data.queryFilter(
         filters, 
         function(e){...});

This function makes a query to the server and requests historical data. The parameter "filters" is
used to constrain the requested data. The result will be received in the callback function.

The filter consists of a number of properties where every property is an array of conditions. Each
condition consists of a type and a value, separated by a colon. Each condition must be expressed
as a string.

e.g.:
{address: ["v:AGENT.OBJECTS.MyVariable"]}

"address" ist the property, "v" the type and "AGENT.OBJECTS.MyVariable" the value.
The type of a condition must be one of the following:

Type Description

v The value of the property must match the value in the filter exactly.
e.g. {value: ["v:123"]} means, that the value in the entry in the archive must be

exactly "123" for the entry to be returned.

g The value in the filter is a GLOB pattern (supports the wildcards '*' and '?'). The value of



480 atvise® - documentation

© 2018 Certec EDV GmbH

the property must match this pattern for the entry to be returned.
e.g. {address: ["g:AGENT.OBJECTS.data.alarm*"} matches all addresses

starting with "AGENT.OBJECTS.data.alarm".

n The value consists of up to two pairs of an operator and a corresponding numerical value.
The supported operators are <, <=, >=, >, <> and =.
e.g. {value: ["n:>=10<20"] means, that the value in the entry in the archive must

be between 10 (inclusive) and 20 (exclusive) for the entry to be returned.

Following properties are supported:

Name Description

type Type of the requested data: 1 - value changes (incl. aggregates), 2 - alarms, 3
- events
If missing in the filter, value changes, alarms and events will be requested.
(corresponds to {type: ["v:1", "v:2", "v:3"]}).

Behavior for type 2 has changed with atvise 3.0: If type 2 is
requested, older versions of atvise returned entries for alarms (type 2
in the result) and events (type 99 in the result). Since atvise 3.0, type
2 will only return alarm entries and events must be requested
separately with type 3.

address Address of a variable; can - depending on the type of the condition - contain
wildcards.

timestamp The time stamp of the entry (source time, alarm time); is mostly used with the
filter type "n:" (see example below). Time stamps are always expressed as
number of milliseconds since 1970-01-01 00:00 AM UTC (JavaScript time).

value The value of the entry for value changes, the alarm triggering value for alarms.

eventtext Active/inactive text for alarms, event text for events.

priority For alarms only: priority of the alarm.

username For alarms and events only: The user, who generated the entry in the archive
(e.g. acknowledgement of an alarm, login).

language Language code as e.g. "en" for English. The setting has the following effect on
translated attributes (for example, Description, alarm text).
1) filters are only applied to the text translated into that language.
2) values are returned only in this language.

archive The archives to consider for the query.

aggregate The requested aggregate function. Must be used together with "interval" and
"unit" (e.g. {aggregate: ["v:Average"]}). For a list of supported

aggregate functions, see here .

interval The aggregate interval. Must be used together with "aggregate" and "unit".

unit The unit of the aggregate interval. Must be used together with "aggregate" and
"interval". Possibe values are "m" (minutes), "h" (hours), "d" (days) and
"M" (month). For the aggregate function "Sampled" you can also use
"s" (seconds).

324
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select Returns only the specified properties in the result. E.g. if you only need
timestamp and value, use {select: ["v:timestamp", "v:value"]}.

This list of properties is an open list. This means that other webMI servers can support different
properties or only a subset of the properties mentioned above. Usually at least "type", "address" and
"timestamp" are used.
The result of the query is returned in the callback as a Javascript object. The object consists of the
properties:

Name Description

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

More true, if the result is truncated because of the query limit ("querylimit" in atserver.ini
) , otherwise false. Only for atvise server.

result Array with result values, where every element of the array is a type-specific
Javascript object:

Type 1: Data variable object properties
Type 2: Alarm object properties
Type 3: Event object properties

Example:

var filter = {};

// value changes only
filter.type = ["v:1"]

// values from November 20, 2013 11:00 PM to 11:30 PM
// month starts with 0=January!
var from = new Date(2013, 10, 20, 23, 0, 0).getTime();
var to = from + 30*60*1000; // 30min in milliseconds
filter.timestamp = ["n:>=" + from + "<" + to];

// All variables starting with AGENT.OBJECTS.MyData
filter.address = ["g:AGENT.OBJECTS.MyData.*"];

// aggregated values, 5 minute average
filter.aggregate = ["v:Average"];
filter.interval = ["v:5"];
filter.unit = ["v:m"];

webMI.data.queryFilter(filter, function(e){
console.log(e.result);

});

webMI.data.subscribeFilter

202
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webMI.data.subscribeFilter

webMI.data.subscribeFilter(
          filters, 
          function(e){...});

This function subscribes to data on the server depending on the given filter object "filters".
Every time one of the subscribed data/alarm nodes change the callback function will be called.

filters.address = [filterSource];
filters.type = [];
filters.type.push("v:1"); //node
filters.type.push("v:2"); //alarm
webMI.data.subscribeFilter(filters, function(e) {

var item = e;

// …
});

(function also returns a subscription id, e.g. var subscriptionId =
webMI.data.subscribeFilter(…) for unsubscribing)

webMI.data.unsubscribeFilter

webMI.data.unsubscribeFilter

webMI.data.unsubscribeFilter(
          subscriptionId);

Unsubscribes the previously subscribed filter with id "subscriptionId". No more notifications will be
published to the filter’s callback function.

webMI.data.customRequest

webMI.data.customRequest

webMI.data.customRequest(
          method,
          subUrl,
          additionalHttpHeader,
          data,
          function(e){...});

This function allows to send an arbitrary HTTP request to the server. Because of security reasons,
"customRequest" only works with an active and valid webMI connection and session.

"method" can be POST, GET, PUT, DELETE, PATCH or HEAD, whereby the atvise server only
supports POST and GET. The other methods can only be used if they are supported by the
respective webMI server.

"subUrl" is the path of the resource on the server.
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With the optional parameter "additionalHttpHeader", own HTTP header lines can be passed to the
request. If multiple header lines are passed, they must be separated by ", " (e.g. "Pragma: no-cache,
Cache-Control: no-cache").

With the optional parameter "data", the body of the request can be passed if needed.

The result of the request will be passed to the callback function.

Example 1, info request clone:

webMI.data.customRequest("POST", "/webMI/?info", function(e) {
console.log(e);

});

Example 2, read request clone:

webMI.data.customRequest("POST", "/webMI/?read", "",
"address[]=AGENT.OBJECTS.var", function(e) {

console.log(e);
});

webMI.data.loadScript

webMI.data.loadScript

webMI.data.loadScript(
          url,
          callback);

Loads a JavaScript library and includes it in the HTML head of the main document.

"url" is the URL of the library to load, "callback" a JavaScript function that is called either when the
library was loaded successfully or immediately if the library was already loaded. The callback
function is called with two parameters:  the url and a bool that specifies, if the library was already
loaded.

Data variable object properties

The webMI.data.read and the webMI.data.subscribe functions return an object which contains the
current properties of the data variable:

address Address of the data variable

description Multilingual description of the data variable

status OPC UA status of the data variable:
0..........Good
>0........OPC UA error code
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timestamp Source timestamp of the data variable.

type For values always 1

value Current value of the data variable.

Note: If the datapoint is an array, the "value" in the script is also from
type array. The i'th item from the array can be accessed by value[i].

Alarm object properties

Alarm objects can be returned from e.g. webMI.data.queryFilter or passed as parameter to an alarm
triggered script. Properties will not be contained in the alarm object if the corresponding alarm field in
the atvise server is not set.

Standard webMI properties of the alarm object (a webMI server may support only a subset of the
properties):

acktime Timestamp of acknowledgment of the alarm, 0 if unacknowledged

activetime Timestamp the alarm state changed to active

address Address of the alarm condition

description Multilingual description of the variable, for which the alarm is configured

display Name of the display configured at the alarm

eventtext Multilingual alarm text

eventtype For alarms always "AlarmConditionStateType"

inactivetime Timestamp the alarm state changed to inactive

priority Priority of the alarm (1-1000)

retain true, if the alarm should be shown in the alarm list, false if it should be
removed

state webMI alarm state:
0 - inactive acknowledged
1 - active unacknowledged
2 - active acknowledged
3 - inactive acknowledged
5 - active unacknowledged und inactive unacknowledged

timestamp Timestamp of the alarm status change

type For alarms always 2

value The alarm triggering value

valueservertimestamp Server timestamp of the alarm triggering value

valuestatus Status of the alarm triggering value

valuetimestamp Source timestamp of the alarm triggering value
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Additional properties of the alarm object for atvise scada:

AckedState Multilingual textual representation of the acknowledgment status of the
alarm

AckedStateId true, if the alarm is acknowledged, else false

ActiveState Multilingual textual representation of the active state of the alarm

ActiveStateId true, if the alarm is active, else false

AlarmId Unique identifier of the alarm

BranchId OPC UA BranchId of the alarm

Comment Optional comment (e.g. when acknowledging the alarm)

ConditionName Name of the alarm condition (e.g. for
"AGENT.OBJECTS.var.ALARM.COND" the name is "COND")

ConfirmedState Multilingual textual represenation of the Confirm state of the alarm

ConfirmedStateId Always the same as AckedStateId, because in atvise acknowledging
also confirms the alarm

EnabledState Multilingual textual representation of the Enabled state of the alarm

EnabledStateId true, if the alarm condition is enabled, else false

EventId Unique identifier for the event, that was triggered because of the change
of the alarm state

InfoBits Used internally by atvise

InputNode Address of the variable, for which the alarm is configured

LastAlarmId Used internally by atvise

ParentId If active and inactive state of an alarm must be acknowledged, ParentId
contains the AlarmId of the corresponding alarm

ReceiveTime Timestamp when atvise received the changed alarm status

SourceName Name of the alarm configuration (e.g. for
"AGENT.OBJECTS.var.ALARM.COND" the name is "ALARM")

SourceNode Address of the alarm configuration (e.g. for
"AGENT.OBJECTS.var.ALARM.COND" the name is
"AGENT.OBJECTS.var.ALARM")

In addition, the alarm object can also contain following optional properties of the alarm category:

Abbreviation Abbreviation of the alarm category

Color Background color for the alarm

Flashtimeack Blinking interval in milliseconds for active unacknowledged alarms

Flashtimeinack Blinking interval in milliseconds for inactive unacknowledged alarms

Fontcolor Font color for the alarm
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UserColor1 -
UserColor4

User defined colors for arbitrary use

Furthermore all replacement values are also contained in the alarm object.

Event object properties

An event object (e.g. as result of webMI.data.queryFilter) contains at least following properties:

address Internal address of the event source (e.g. "WebAccessLoginEventType")

eventtext Multilingual text of the event

eventtype Browsename of the OPC UA event type

priority Priority of the event (1-1000)

timestamp Timestamp when the event was triggered

type For events always 3

EventId Unique identifier of the event

ReceiveTime Timstamp when atvise received the event

SourceName Internal name of the event source (e.g. "Server/WebAccess/Login")

SourceNode Same as address
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Alarm functions
webMI.alarm.accept

webMI.alarm.accept

webMI.alarm.accept(
      [id1, id2,...idN]);

Accepts the alarm conditions defined by id1-idN. Each id can be an alarm condition (conditionID) or
an AlarmId.

webMI.alarm.acceptDisplay

webMI.alarm.acceptDisplay

webMI.alarm.acceptDisplay();

Accepts all unaccepted alarms that are subscribed on the current display (via
webMI.alarm.subscribe).

webMI.alarm.subscribe

webMI.alarm.subscribe

webMI.alarm.subscribe(
     conditionID,
     function(e){...});

Subscribes to the alarm specified by conditionID. Every time the alarm state of this condition
changes, the callback function is executed.

Returns a subscriptionId, which can be used to unsubscribe the alarm state changes.

e - input parameter object (alarm object) for the callback function: see Alarm object properties

Example:

webMI.alarm.subscribe("AGENT.OBJECTS.bAlarmNode.AlarmConfiguration.Cond
ition1", function(e) {
     var value = e.state;
     if(value == 0)
          alert("State of alarm changed to Off, Acknowledged!")
     if(value == 1)
          alert("State of alarm changed to On, Unacknowledged!")
     if(value == 2)
          alert("State of alarm changed to On, Acknowledged!")
     if(value == 3)

484



488 atvise® - documentation

© 2018 Certec EDV GmbH

          alert("State of alarm changed to Off, Unacknowledged!")
     if(value == 5)
          alert("State of alarm changed to On Off, Unacknowledged!")
});

webMI.alarm.unsubscribe

webMI.alarm.unsubscribe

webMI.alarm.unsubscribe(
       subscriptionId);

Unsubscribes the alarm condition with the given subscriptionId (return value from
webMI.alarm.subscribe). The previously created subscription will not receive a notification of the
callback function anymore.
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Graphics functions
webMI.translate

webMI.translate

webMI.translate(
     value,
     minValue,
     maxValue,
     startValue,
     stopValue);

Calculates an absolute value from the passed value, minValue, maxValue, start Value and stopValue
for use in various webMI.gfx functions.

Example: A data variable can have a value from 0 (minValue) to 100 (maxValue). The current value
(value) is to be displayed by an arrow that rotates from 0° (startValue) to 180° (stopValue):

webMI.translate("Server_1.OBJECTS.var1", function(e) {

var id = "id_1";

var value = e.value;

webMI.gfx.setRotation(id, webMI.translate(value, 0, 100, 0, 180));

});

Transformations of SVG elements

webMI.gfx.setTransformation

webMI.gfx.setTransformation

webMI.gfx.setTransformation(
     elementID,
     translationFactor);

Methods that transform SVG elements (replace Transformation with one of the following):

Rotation, MoveX, MoveY, ScaleX, ScaleY, SkewX, SkewY

Some examples:

webMI.gfx.setRotation

webMI.gfx.setRotation
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webMI.gfx.setRotation(
     elementID,
     angle);

Rotates the SVG element defined by elementID by angle (see webMI.translate).

var angle = webMI.translate(value, minValue, maxValue, startValue,
stopValue);

webMI.gfx.setRotation("elementID", angle);

  webMI.gfx.setMoveX

webMI.gfx.setMoveX

webMI.gfx.setMoveX(
     elementID,
     offset);

Moves the SVG element defined by elementID by offset (see webMI.translate) on the X axis.

var offset = webMI.translate(value, minValue, maxValue, startValue,
stopValue);

webMI.gfx.setMoveX("elementID", offset);

webMI.gfx.setMoveY

webMI.gfx.setMoveY

webMI.gfx.setMoveY(
     elementID,
     offset);

Moves the SVG element defined by elementID by offset (see webMI.translate) on the Y axis.

var offset = webMI.translate(value, minValue, maxValue, startValue,
stopValue);

webMI.gfx.setMoveY("elementID", offset);

webMI.gfx.setScaleX
webMI.gfx.setScaleX

webMI.gfx.setScaleX(
     elementID,
     factor);



491Reference manual

© 2018 Certec EDV GmbH

Scales the SVG element defined by elementID by factor (see webMI.translate) on the X axis.

var factor = webMI.translate(value, minValue, maxValue, startValue,
stopValue);

webMI.gfx.setScaleX("elementID", factor);

webMI.gfx.setScaleY

webMI.gfx.setScaleY

webMI.gfx.setScaleY(
     elementID,
     factor);

Scales the SVG element defined by elementID by factor (see webMI.translate) on the Y axis.

var factor = webMI.translate(value, minValue, maxValue, startValue,
stopValue);

webMI.gfx.setScaleY("elementID", factor);

webMI.gfx.setSkewX

webMI.gfx.setSkewX

webMI.gfx.setSkewX(
     elementID,
     translationFactor);

Skews the SVG element defined by elementID by translationFactor (see webMI.translate) on the X
axis.

var translationFactor = webMI.translate(value, minValue, maxValue,
startValue, stopValue);

webMI.gfx.setSkewX("elementID",translationFactor);

webMI.gfx.setSkewY

webMI.gfx.setSkewY

webMI.gfx.setSkewY(
     elementID,
     translationFactor);

Skews the SVG element defined by elementID by translationFactor (see webMI.translate) on the Y
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axis.

var translationFactor = webMI.translate(value, minValue, maxValue,
startValue, stopValue);

webMI.gfx.setSkewY("elementID",translationFactor);

Functions for adding SVG elements

webMI.gfx.addSVGElement

webMI.gfx.addSVGElement

webMI.gfx.addSVGElement({SVGElementAttributes}, groupElement);

With the webMI.gfx.addSVGElement method, SVG elements can be added to the document, or be
added as child elements to existing elements.
Two parameters can be passed on: An array of element attributes and a group element where the
new element is to be added.

SVGElement can be one of the following objects: Circle, Ellipse, Group, Image, Line, Path, Polygon,
Polyline, Rect, Text.

Some examples:

/* list of possible SVG attributes
X:"x",
X1:"x1",
X2:"x2",
Y:"y",
Y1:"y1",
Y2:"y2",
Width:"width",
Height:"height",
CenterX:"cx",
CenterY:"cy",
RadiusX:"rx",
RadiusY:"ry",
Radius:"r",
FontFamily:"font-family",
FontSize:"font-size",
FillOpacity:"fill-opacity",
FillRule:"fill-rule",
Stroke:"stroke",
StrokeOpacity:"stroke-opacity",
StrokeWidth:"stroke-width",
TextAnchor:"text-anchor"
*/

var groupElement = document.getElementById("group");
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/* addCircle */
var circle =
webMI.gfx.addCircle({CenterX:"600",CenterY:"100",Fill:"#C0C0C0",Radius:
"50"}, groupElement);

/* addEllipse */
var ellipse =
webMI.gfx.addEllipse({CenterX:"600",CenterY:"200",Fill:"#C0C0C0",Radius
X:"150",RadiusY:"45"}, groupElement);

/* addPolyline */
var polyline = webMI.gfx.addPolyline({fill: "brown", points:
[{x:352.868,y:328.949}, {x:452.63,y:328.949}, {x:376.501,y:382.077},{x:
452.619,y:382.077},{x: 355.015,y:413.69},{x: 355.015,y:327.713}],
Stroke: strokeColor, StrokeWidth:strokeWidth,
StrokeOpacity:strokeOpacity}, groupElement);

/* addText */
var text = webMI.gfx.addText({x: 300, y: 550, fill: "red", text:
"Hello, World!", fontSize:"20", fontFamily:"Arial", Stroke:
strokeColor, StrokeWidth:strokeWidth, StrokeOpacity:strokeOpacity},
groupElement);

Functions for getting and setting SVG element attributes

webMI.gfx.get<SVGElementAttribute>,
webMI.gfx.set<SVGElementAttribute>

webMI.gfx.getSVGElementAttribute();
webMI.gfx.setSVGElementAttribute();

webMI.gfx.get<SVGElementAttribute>(
    elementID);
webMI.gfx.set<SVGElementAttribute>(
     elementID,
     value);

With the webMI.gfx.get<SVGElementAttribute> method, the specified attribute of the object with the
ID elementID can be read.
With the webMI.gfx.set<SVGElementAttribute> method, the specified attribute of the object with the
ID elementID can be set to value.

Depending on the element type, the place holder <SVGElementAttribute> can be one of the following
parameters:

CenterX, CenterY, Height, Width, Fill, FillOpacity, FillRule, FontFamily, FontSize, Points, Radius,
RadiusX, RadiusY, Stroke, StrokeWidth, StrokeOpacity, Text, TextAnchor, Visible, X, X1, X2, Y, Y1,
Y2

Some examples:
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var elementID_rectangle = "myRectangle";
var elementID_ellipse = "myEllipse";
var elementID_circle = "myCircle";
var elementID_polyon = "myPolygon";
var elementID_line = "myLine";
var elementID_text = "myText";

/* GETTERS */
var textFontFamily = webMI.gfx.getFontFamily(elementID_text);
var textFontSize = webMI.gfx.getFontSize(elementID_text);
var textContent = webMI.gfx.getText(elementID_text);
var textAnchor = webMI.gfx.getTextAnchor(elementID_text);
 
var rectangleX = webMI.gfx.getX(elementID_rectangle);
var rectangleY = webMI.gfx.getY(elementID_rectangle);
var rectangleHeight = webMI.gfx.getHeight(elementID_rectangle);
var rectangleWidth = webMI.gfx.getWidth(elementID_rectangle);
 
var circleRadius = webMI.gfx.getRadius(elementID_circle);
var polygonPoints = webMI.gfx.getPoints(elementID_polygon);

var startPointX = webMI.gfx.getX1(elementID_line);
var startPointY = webMI.gfx.getY1(elementID_line);
var endPointX = webMI.gfx.getX2(elementID_line);
var endPointY = webMI.gfx.getY2(elementID_line);
var ellipseCenterX = webMI.gfx.getCenterX(elementID_ellipse);
var ellipseCenterY = webMI.gfx.getCenterY(elementID_ellipse);
var ellipseRadiusX = webMI.gfx.getRadiusX(elementID_ellipse);
var ellipseRadiusY = webMI.gfx.getRadiusY(elementID_ellipse);
var rectangleFill = webMI.gfx.getFill(elementID_rectangle);
var rectangleFillOpacity =
webMI.gfx.getFillOpacity(elementID_rectangle);
var rectangleFillRule = webMI.gfx.getFillRule(elementID_rectangle);
var rectangleStroke = webMI.gfx.getStroke(elementID_rectangle);
var rectangleStrokeWidth =
webMI.gfx.getStrokeWidth(elementID_rectangle);
var rectangleStrokeOpacity =
webMI.gfx.getStrokeOpacity(elementID_rectangle);
 
/* SETTERS */
webMI.gfx.setFontFamily(elementID_text, "Arial");
webMI.gfx.setFontSize(elementID_text, "13");
webMI.gfx.setText(elementID_text, "new text for text element");
webMI.gfx.setTextAnchor(elementID_text, "middle");
 
webMI.gfx.setX(elementID_rectangle, "800");
webMI.gfx.setY(elementID_rectangle, "600");
webMI.gfx.setHeight(elementID_rectangle, "300");
webMI.gfx.setWidth(elementID_rectangle, "200");
 
webMI.gfx.setRadius(elementID_circle, "30");
webMI.gfx.setPoints(elementID_polygon, "0.25");
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webMI.gfx.setX1(elementID_line, "10");
webMI.gfx.setY1(elementID_line, "10");
webMI.gfx.setX2(elementID_line, "20");
webMI.gfx.setY2(elementID_line, "20");
webMI.gfx.setCenterX(elementID_ellipse, "800");
webMI.gfx.setCenterY(elementID_ellipse, "600");
webMI.gfx.setRadiusX(elementID_ellipse, "120");
webMI.gfx.setRadiusY(elementID_ellipse, "90");
webMI.gfx.setFill(elementID_rectangle, "#FF000A");
webMI.gfx.setFillOpacity(elementID_rectangle, "0.25");
webMI.gfx.setFillRule(elementID_rectangle, "evenodd");
webMI.gfx.setStroke(elementID_rectangle, "#00FF00");
webMI.gfx.setStrokeWidth(elementID_rectangle, "3");
webMI.gfx.setStrokeOpacity(elementID_rectangle, "0.80");

Changing of element attributes in intervals

webMI.gfx.setFill

webMI.gfx.setFill

webMI.gfx.setFill(
     elementID,
     colorCode /*RGB hex*/);

Fills the SVG element defined by elementID with the color defined by colorCode.

webMI.gfx.setFill (array)

webMI.gfx.setFill

webMI.gfx.setFill(
     elementID,
     intervalArray);

Sets the fill of the SVG element defined by elementID depending on the intervalArray. The
intervalArray can be used to change the fill cyclically. There are 12 possible intervals which are
executed in a loop every 250 milliseconds.

/* EXAMPLE 1: Set color to a fixed value */

var colorCode = "blue"; (or var colorCode = "#0000FF";)
webMI.gfx.setFill("elementID",colorCode);

/* EXAMPLE 2: Color changes every 500ms between black and red:*/
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webMI.gfx.setFill(id,
{0:'black',2:'red',4:'black',6:'red',8:'black',10:'red'});

webMI.gfx.setVisible

webMI.gfx.setVisible

webMI.gfx.setVisible(
     elementID,
     visibilityValue /*true/false*/);

Sets the visibility of the SVG element defined by elementID to visibilityValue.
By setting the value to "null" the state of the parent element will be inherited.

var visibilityValue = true;
webMI.gfx.setVisible("elementID", visibilityValue);

webMI.gfx.setVisible (array)

webMI.gfx.setVisible

webMI.gfx.setVisible(
     elementID,
     intervalArray);

Sets the visibility of the SVG element defined by elementID depending on the intervalArray. The
intervalArray can be used to make an element blink. There are 12 possible intervals which are
executed in a loop every 250 milliseconds.

Example:

/*Element flashes every 250ms:*/

webMI.gfx.setVisible("id_0",
{0:true,1:false,2:true,3:false,4:true,5:false,6:true,7:false,8:true,9:f
alse,10:true,11:false});

/*Element flashes every 500ms:*/

webMI.gfx.setVisible(id,
{0:true,2:false,4:true,6:false,8:true,10:false});

Further graphic functions

webMI.gfx.createPoint

webMI.gfx.createPoint
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webMI.gfx.createPoint(
     x, 
     y);

Creates an SVG point element from the given x and y coordinate.

webMI.gfx.getScreenCTM

webMI.gfx.getScreenCTM

webMI.gfx.getScreenCTM(elementID);

Returns a transformation matrix that can be used to convert coordinates between different coordinate
systems.

The optional parameter elementID defines, which matrix will be returned. elementID can be one of the
following:

undefined: If elementID isn't specified at all, the matrix is read from the display without any
change.
true: Reads the matrix of the current display and transforms it up to the "#mainContainer".
"subDisplayID": Reads the matrix from the given sub-display and transforms it to be used in the
current display.
"foreignObjectID": The matrix is read from the foreignobject and transformed up to the HTML
body. Thus the matrix can be used for calculations on events (coordinates) that were triggered on
foreignobjects.

Examples for all possibilities can be found in the chapter Scaling .

webMI.gfx.getAbsoluteOffset

webMI.gfx.getAbsoluteOffset

webMI.gfx.getAbsoluteOffset(
     property,
     untilBody,
     overrideElement);

This method returns the absolute offset of an HTML element in relation to the <body> or <div
id=“mainContainer“/> element. Any scroll-offsets are included into the calculation.

property: "top" for the offset from the top (y) or "left" for the offset from left (x).
untilBody: true, to calculate the offset to the <body>, false for <div id="mainContainer"/>.
Optional, default is false.
overrideElement: Element to calculate the offset for. Optional, default is the surrounding div
element of the current display.

var myForeignObject = document.getElementById("myForeignobject");
var foreignOffsetY = webMI.gfx.getAbsoluteOffset("top", true,
myForeignObject);

162
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var foreignOffsetX = webMI.gfx.getAbsoluteOffset("left", true,
myForeignObject);

webMI.gfx.getAbsoluteScaleFactor

webMI.gfx.getAbsoluteScaleFactor

webMI.gfx.getAbsoluteScaleFactor(
     untilBody,
     overrideElement);

This method returns the total scaling factor up to the current display (excluding the factor for the
current display itself).

untilBody: true, to calculate the offset to the <body>, false for <div id="mainContainer"/>.
Optional, default is false.
overrideElement: Element to calculate the offset for. Optional, default is the surrounding div
element of the current display.

var factor = webMI.gfx.getAbsoluteScaleFactor(true);

webMI.gfx.getBoundingClientRect

webMI.gfx.getBoundingClientRect

webMI.gfx.getBoundingClientRect(elementID);

This method is based on the native JavaScript method „element.getBoundingClientRect“. By using
the webMI version of it, it is guaranteed that correct values are returned, even when CSS based
scaling through the property „zoom“ is used.

Like the native method, all returned offsets are relative to the top left corner of the browser window
(browser viewport).

The return object contains the properties "top", "left", "height", "width", "bottom" and "right".

var myForeignObject = document.getElementById("myForeignobject");
var foreignObjectSizePosition =
webMI.gfx.getBoundingClientRect(myForeignObject);
//e.g. {top:115.5, left: 50.8, height: 20, width: 77.4, bottom: 135.5,
right: 128.2}

webMI.gfx.setScaledEvents

webMI.gfx.setScaledEvents

webMI.gfx.setScaledEvents(
     targetElement,
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     useUnScaledOffset,
     excludeChildren,
     referenceElement);

The setScaledEvents method provides events to the developer that contain corrected event
coordinates (clientX, clientY, pageX, pageY). The use of this method is intended for external libraries.

targetElement: HTML element, that will be affected by the event coordinate correction.
useUnScaledOffset: Compensate JavaScript libraries, that sum up the element offsets until the
HTML body ignoring any scaling factors. Optional, default is false.
excludeChildren: array of children of targetElement, that should not be affected by the
correction. Optional, default [].
referenceElement: HTML element, that is used as reference to the calculation of the offset to
<body>. Optional, default is targetElement.

The event types MouseEvents, TouchEvents und DragEvents will be corrected. The object provided
as argument to the events is of type CustomEvent und contains the additional properties
"atviseOriginalEvent" (original browser event) and "atviseCustomEvent" (true).

webMI.gfx.setScaledEvents("myForeignobject");

webMI.gfx.scaleEventCoordinates

webMI.gfx.scaleEventCoordinates

webMI.gfx.scaleEventCoordinates(
     targetElement,
     x,
     y,
     relativeToViewport);

The scaleEventsCoordinate method corrects event coordinates, to be able to respect the scaling
state of the visualization. The coordinates (clientX, clientY, pageX, pageY) are passed as parameters
and the method returns them converted in an object with the properties "x" and "y".

targetElement: HTML element the event coordinate conversion should be related to.
x, y: coordinates passed to the "e" object of the callback.
relativeToViewport: true, if the provided coordinates are relative to the viewport (clientX/Y), false,
if they are relative to the document of the visualization(pageX/Y). Optional, default is false.

webMI.addEvent("myForeignobject", "mousemove", function(e){
  var point =
    webMI.gfx.scaleEventCoordinates("myForeignobject", e.clientX,
e.clientY, true);
  // ---OR---
  var point =
    webMI.gfx.scaleEventCoordinates("myForeignobject", e.pageX,
e.pageY);
});
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Widget functions
webMI.widget.getValue

webMI.widget.getValue

webMI.widget.getValue(
     elementID);

Returns the current value of the widget (e.g. textbox) defined by elementID.

webMI.widget.setDisabled

webMI.widget.setDisabled

webMI.widget.setDisabled(
     elementID,
   value);

Disables (value = true ) or enables (value = false) the widget defined by elementID.

webMI.gfx.setValue

webMI.gfx.setValue

webMI.gfx.setValue(
     elementID,
   value);

Sets the value of the widget defined by elementID to value.
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Display functions
webMI.display.openWindow

webMI.display.openWindow

webMI.display.openWindow(
     {url:, x:, y:, height:, width:,
     extern:, modal:, resizable:,movable:,
     scrollbars:, menubar:, status:, toolbar:});

Opens the defined display (url) at the defined coordinates (x,y) in the defined size (height,width).

Example: Open display "Test1" at the left corner of the screen in 800x600 in a new window, modal,
not resizeable, moveable, with scollbars, without menu bar, without status bar and without toolbar:

webMI.display.openWindow(
     {url:"SYSTEM.DISPLAYS.MAIN.Test1",
     x:0, y:0, height:600, width:800,
     modal:true, resizable:false, movable:true,
     scrollbars:true, menubar:false, status:false, toolbar:false});

webMI.display.openDisplay

webMI.display.openDisplay

webMI.display.openDisplay(
     url,
     {parameter: value},
     iframe);

Opens the defined display (url) in the defined iframe (iframe refers to the parameter called "name" in
the iframe object display).

webMI.display.closeWindow
webMI.display.closeWindow

webMI.display.closeWindow();

Closes the window.

webMI.display.showPopup

webMI.display.showPopup

webMI.display.showPopup(
          x, 
          y, 
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         menuObj);

Opens a context menu "menuObj" at the specified coordinates "x" and "y".

NOTE: Currently nested popups (opening a popup within a popup) are not supported.

function getMyFn(itemName) {
return function(e) {
alert(itemName);
};
}

var menuObj = {};
menuObj["item1"] = {text: "item1", value: getMyFn("item1") };
menuObj["item2"] = {text: "item2", value: getMyFn("item2") };
webMI.display.showPopup(100, 200, menuObj);

webMI.frame.getActiveFrames

webMI.frame.getActiveFrames

webMI.frame.getActiveFrames();

Returns the currently visible frames (displays) as an array of iframe objects. It can be used to get the
containing frame and visibility of a display for example.
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Sound functions
webMI.sound.play

webMI.sound.play

webMI.sound.play(
     url,
     playCounter);

Plays the sound file defined by url; playCounter defines the times the file is played (0 = play
continuously). Supports every format that the browser supports natively.

Apple forbids automatic playback of audio sequences without user interaction on its IOS
devices:

Further Information: Link

webMI.sound.stop

webMI.sound.stop

webMI.sound.stop(
     url);

Stops the sound file defined by url (if started before by webMI.sound.play with the same url).

webMI.sound.stop

webMI.sound.stop();

Stops all currently playing sound files.

http://developer.apple.com/library/safari/#documentation/AudioVideo/Conceptual/Using_HTML5_Audio_Video/Device-SpecificConsiderations/Device-SpecificConsiderations.html
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Trigger functions
webMI.trigger.connect

webMI.trigger.connect

webMI.trigger.connect(
          triggerName, 
          function(e){...},
          scope);

Connects to the trigger "triggerName". If the trigger is fired the callback function will be executed.

The parameter "scope" is optional. Three different scopes can be defined as follows:

global – the trigger can be called anywhere in the visualization
webMI.trigger.connect("globalTrigger", function(e){...});

internal – this trigger is valid within the same display
webMI.trigger.connect("internalTrigger", function(e){...}, "");

display – this trigger is valid for a defined object-display
webMI.trigger.connect("displayTrigger", function(e){...}, "myDisplayID"); 

webMI.trigger.connect("setValue", function(e) {
alert(e);
});

webMI.trigger.fire

webMI.trigger.fire

webMI.trigger.fire(
          triggerName,
          value,
          scope);

Fires a value to the trigger with the name specified as "triggerName".

The parameter "scope" is optional. Three different scopes can be defined as follows:

global – the value can be retrieved anywhere in the visualisation
webMI.trigger.fire("globalTrigger", 23);

internal – the value can be retrieved within the same display
webMI.trigger.fire("internalTrigger", 23, "");

display – the specified object-display will retrieve the value
webMI.trigger.fire("displayTrigger", 23, "myDisplayID"); 



505Reference manual

© 2018 Certec EDV GmbH

In the control "in_out_value" exists a trigger "setValue":

webMI.trigger.connect("setValue", function(e) {
var text = passwordMode ? makeStars(e.value) : e.value;
webMI.gfx.setText("input_label", text + unit);
});

Now this trigger can be used to set the value of the control "from the
outside":

webMI.trigger.fire("setValue", 100, "in_out_value_Example");
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Key functions
webMI.keys.addCombinationListener

webMI.keys.addCombinationListener

webMI.keys.addCombinationListener(
          modifiers, 
          keyCode, 
          function(e){...});

Connects a callback function to keyboard input ("modifiers" : "ALT" = 1, "CTRL" = 2, "SHIFT" = 4,
meta key = 8 – the modifiers can be added, so CTRL+ALT = 3). 

webMI.keys.addCombinationListener(0, 13, function(e) {

alert("ENTER key was pressed!");

});

webMI.keys.addDownListener

webMI.keys.addDownListener

webMI.keys.addDownListener(
          function(e){...}, 
          keyCode);

Connects a callback function to a key code "keyCode" and executes the function if the key is
pressed.

webMI.keys.addDownListener(function(e) {
alert("ENTER key pressed!");

}, 13);

webMI.keys.addPressListener

webMI.keys.addPressListener

webMI.keys.addPressListener(
          function(e){...});

Connects a callback function to the keyboard – if any key is pressed the callback function will be
executed. With "e.which" and "e.keyCode" the pressed key can be determined.

webMI.keys.addPressListener(function(e) {
var key = e.which || e.keyCode;

// …
});
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webMI.keys.addUpListener

webMI.keys.addUpListener

webMI.keys.addUpListener(
          function(e){...}, 
          keyCode);

Connects a callback function to a key code "keyCode" and executes the function if the key is
released.

webMI.keys.addUpListener(function(e) {
alert("ENTER key released!");
}, 13);

webMI.keys.isDown

webMI.keys.isDown

webMI.keys.isDown(
           keyCode);

Returns true or false if the specified key "keyCode" is pressed at the moment.
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SCADA serverside scripting
Server scripts can be used in different ways, e.g. as script elements on nodes.
An explanation of the server script editor can be found here :

The JavaScript interpreter of atvise implements the following additional features:

Control and diagnostic functions Flow control and diagnostic

server object Server information and live backup

UaNode functions Manipulation of OPC UA address space

CSVReader functions Reading of CSV data (into table)

FileSystem functions Manipulation of the file system

InputFileStream functions Reading files

OutputFileStream functions Writing files

XMLDoc functions Parsing of XML documents

HTTPClient functions Sending HTTP(S) requests

SMTPClient functions Sending emails via SMTPClient

TCPClient functions Handling TCP Connections

ODBCClient functions Handling ODBC Connections

History functions Writes data values into the history archive

XML export/import functions XML export/import for nodes

Data Source functions Browse, read and write for Data Sources

Please note, especially when using atvise script extensions like TCP or ODBC: Only execute() is
asynchronous. All other calls of methods of extension are synchronous.

Definition

In atvise, scripts are stored in nodes, as is all other information. Nodes containing script must be of
type "VariableTypes.ATVISE.ScriptCode" so that they are recognized by atvise as a script. Creating
scripts using the menu item "Add Script ..." will automatically use this type.

Location

Scripts can be stored below an arbitrary node in the address space. However, some special scripts
must be stored at predefined locations.

webMI callable scripts

These scripts must be located at the Node SYSTEM.LIBRARY.PROJECT.WEBMIMETHODS. In
atvise builder, these scripts are below "webMI Method scripts".
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Scripts callable via HTTP

These scripts work like any other atvise resource (static content delivered by the integrated web
server) and are therefore below System.Resources. They can be managed directly in the
Resources tree.

Script libraries

Script libraries are scripts that contain common code that can be called by any other scripts.
Frequently used code can be implemented in a standalone script and stored at a predefined
location.
The default location for script libraries is SYSTEM.LIBRARY.PROJECT.SERVERSCRIPTS (in
the tree below the "Script Library"). Scripts that are in this folder can be called by their names as
well. By means of folders, the library can be structured thematically, for example.
In addition to the default location of script libraries, script libraries can be located at arbitrary
nodes. In this case, the script can be called by its full nodeID.

Scripts triggered by timer

Scripts that are triggered by timers can be anywhere in the address space. It is recommended,
however, that scheduled scripts be stored in a common folder.

Scripts with relative addressing

Scripts that have relatively addressed parameters can only be accessed by node parameters
that are hierarchically below the base node. A script may be triggered by several relatively-
addressed nodes. All of these triggering node parameters must have one common ancestor, that
is the base node. In most cases, this will be the direct object type or a folder in an object type.

Script Name

The name of scripts can be freely chosen. For scripts that are invoked via a webMI call, the name
must begin with a capital letter, however.

Script Editor

The editor for the script code will be opened by double-clicking on the node that contains the script.
A script consists of two parts: the definition of the parameters that are passed on to the script when
you call them and the actual JavaScript code.

Script Parameters

All scripts have an implicit parameter called "base" that can be accessed in the script. For
scripts triggered by the atvise server, "base" is an object with following properties:

nodeid{String} The nodeID of the base node of the script (e.g. the instance where the script is
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currently running)
trigger{Object} An object specifying the parameter that triggered the script:
o name{String} The name of the parameter

o type{String} Type type of the parameter

However, if a script calls another script via call , only the content of "base.nodeid" will be
passed as "base" to the called script. In any case, "base" can be used to create a valid UaNode
object  with "new UaNode(base)".

All other parameters are defined in the upper part of the editor. The definition of a parameter has
these parts:
Parameter Name: specifies the name of the parameter that can be used in the script.
Type: defines the type of the parameter.

Type Description

alarm The alarm parameter is an alarm condition object. A GLOB pattern
(supports the wildcards '*' and '?') can be used. This parameter will be set,
if a matching condition triggered an alarm.

For a list of properties of the alarm object see Alarm object properties .

boolean boolean

numeric value number

string string

node The node parameter is a Node object with the properties: value, status,
sourcetime, servertime and trigger (true, if the node triggered the script,
otherwise false). The properties can be accessed via dot notation.

node.value OPC UA value of the node

node.status OPC UA status of the node

node.sourcetime OPC UA source timestamp of the node

node.servertime OPC UA server timestamp of the node

timer The script runs daily on one or more specified times. A start or end date
can be set optionally. The repetition time refers to one day and will be
considered if the calculated time is between 00:00 - 23:59. The start time
and end time are given in local time. Triggering times calculated from start
time and repetitions are in local time as well. So if daylight saving time
changes on a day then the day has either duplicated or non-existent times.
The calculated triggering timestamps are in local time as well, so daylight
saving time changes influence the triggering times: If a timestamp is
duplicated on a day the calculated triggering timestamps will trigger on
both timestamps. If a timestamp does not exist on a day then the script
will be not triggered at that time stamp. See: Scheduling rules in atvise

Note: Scripts, which triggered by a timer, are released once the entire
system is up!

Note: Days on daylight saving time changes do not have 24 hours.
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They have either 23 or 25 hours.                              

interval The script runs daily on one or more specified times. A start or end date
can be set optionally. The first daily triggering time is specified by offset.
The number of triggering times is limited by count – or the end of the day -
and the timespan between triggering times is given by interval. The offset is
specified in standard time. Standard time does not take into account
daylight saving time changes. So the triggering times will be shifted by one
hour if daylight saving time is on. See: Scheduling rules in atvise

Note: In Standard time all days – inclusive those with daylight
saving time changes – have 24 hours.                         

once The script runs once at the specified timestamp.

startup The script will start when the atvise server starts.
Note: Scripts of this trigger type are triggered during the startup process
before the WebAccess module and thus before the entire system is up!

shutdown The script will start when the atvise server is shut down.
Note: Scripts of this trigger type are terminated after a runtime of 10
seconds.

http The http parameter is an object with request and response characteristics.
It is only available when the script was called from an HTTP client (but not
by a webMI call).

http.request  The request object. It has the following properties:
query: the full query string of the URL from which the script is called
content: the complete content (body) of the HTTP request
getvalues: a JavaScript object with all the parameters of a query string as
Properties of Objects
postvalues: a JavaScript object with all the parameters of the POST
request as Properties of Objects

http.response The Response object. Allows the use of HTTP header lines via setHeader
(name, value) and writing the content via write (data).

http.ip IP address of the HTTP client

session The session parameter is an object with the user's property. It is only
available for scripts that are invoked by a webMI call.

session.user The login name of the user who is logged in to the browser.

Trigger: Is only relevant for parameters of the types node (including node.value, ...), alarm,
timer, interval and once. For node and alarm, it indicates whether the script is triggered if the
node or the alarm status changes. For timer, interval and once, it is used to enable or disable
the triggering of the script. Several parameters may be defined with triggering. Triggering a script
by another parameter will set the parameters of type ‘alarm’ and ‘timer’ to null.

Relative: Is only relevant for parameters of the type node (including node.value, ...) and
indicates whether the given address is relative to the base or an absolute NodeID.

Value: Depending on the type - the definition of the source of the value:

575
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Type Description

alarm The contents of the value is an OPC UA NodeID of the alarm condition
in the so-called "XML" format (e.g.:
"ns=1;s=AGENT.OBJECTS.TestNode.Alarm.Condition"). If you drag
and drop nodes, the NodeID is entered correctly.

boolean, number,
string

Content of value: a value of the appropriate type (true / false, integer /
floating-point number or an arbitrary string). Value is passed on
directly to the script. Such parameters are useful in scripts that are
called by other scripts, because the value is valid in this case as a
default value if it is not passed on by the script by which it is called.

node, node .* The contents of the value is an OPC UA NodeID in the so-called
"XML" format (e.g.: "ns=1;s=AGENT.OBJECTS.my_node"). If you
drag and drop nodes, the NodeID is entered correctly.

timer, once, startup,
shutdown, session,
session .*, http, http
.*

Value is not used.

Script Code

JavaScript code can be written in the lower part of the script editor. All parameters defined by
"parameter name" in the upper part and "base" can be used as a variable name in the code.

Return values (only for webMI call)

The return value of a call initiated by webMI scripts is always a JavaScript object. The type of the
returned value determines the exact contents of this object:

Return value of the
script

returned value to the caller

No return value empty JavaScript object (no properties)

simple value or array JavaScript Object with the property "result", which contains the value
returned by the script.

JavaScript Object The object is passed to the caller 1:1

Example:

return "a value"; // {result: "a value"}
return [1, 2, 3]; // {result: [1, 2, 3]}
return {name: "hugo", age: 33}; // {name: "hugo", age: 33}

The access via client-side JavaScript to the above examples is:

webMI.data.call("ScriptName", {}, function(ret){
  ret.result; // "a value"
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  ret.result[1]; // 2
  ret.name; // "hugo"
});

Error handling (only for webMI call)

If the script fails, an exception is thrown. If this is not captured in the script itself, then the following
JavaScript object is returned to the caller:

Example:

{Error: -1, error string: "error message"}

Usage of the scripts

HTTP Client 

Scripts that were created in Resources can be accessed directly through web browser input
from a corresponding URL. A script named "myreport", for example, located in the folder
"scripts", can be accessed via http://localhost/scripts/myreport. Parameters with "? Par1 =
value1 par2 = value2 &" are passed on to the script. A complete call could look like this, for
example:

http://localhost/scripts/myreport?format=csv&type=summary

Detailed Examples:

1.) Return a simple report with historical data:

Parameter Name Type Value

request http.request

response http.response

// This script can be called with the corresponding parameters: 
//         node, max
// through a URL in a browser, e.g.:
//http://localhost/simplereport?
node=instance.values.temperature&max=10

var par = request.getvalues;
var n = new UaNode("AGENT.OBJECTS." + par["node"]);
var numvalues = parseInt(par["max"]);
var data = n.datahistory({
  endtime: new Date(),
  numvalues: numvalues
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});

// return web page
response.write("<html><head><title>Simple Report</title></
head><body>");
// write report body...
response.write("</body></html>");

2.) In order to send a PDF file from the harddrive to the Web client via “binary” modus of the
"response.write" function:

var ifs = new InputFileStream("C:\\temp\\test.pdf", "binary");
ifs.open();
response.setHeader("Content-Type", "application/pdf");
response.write(ifs.read(0), "binary");
ifs.close();

webMI call

This method can be used in displays to call scripts and use the return value from scripts in the
display itself.

Example for scripts to create an instance of an object type including a MirrorBase:

Client side script:

webMI.data.call("CreateInst", {
  typedef: "Engine",
  instname: "Engine1",
  mirrorbase: "ds/ns=1;s=engines" },
  function(ret) {
    console.log(ret);
});

Server side script "CreateInst":

Parameter Name Type Value

request http.request

// This script can be called with the parameters: 
//         typedef, instname, mirrorbase
// through webMI call.

var typedef = request.postvalues["typedef"];
var instname = request.postvalues["instname"];
var mirrorbase = request.postvalues["mirrorbase"];

var full_type = "ObjectTypes.PROJECT.MyTypes." + typedef;
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var instance_base = "AGENT.OBJECTS.MYOBJECTS";
var full_name = instance_base + "." + instname;
var node = new UaNode(full_name);

node.create({
  nodeclass: UaNode.NODECLASS_OBJECT,
  parent: instance_base,
  typedefinition: full_type
});

var mirror = new UaNode(full_name + ".RelMirrorBase");

mirror.create({
  nodeclass: UaNode.NODECLASS_VARIABLE,
  parent: full_name,
  typedefinition: "VariableTypes.ATVISE.Mirror.Relative.Base",
  datatype: UaNode.STRING,
  value: mirrorbase
});
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Control and diagnostic functions
call

result call(script, parameters)

 
Calls synchronously another script. The result is the return value of the called script.
 

nodeId{UaNodeId, Mandatory} Specifies the UaNodeID of the script to call. If several script
instances belong to the given script than all instances will be called.In this case the result will be
an array that is composed from the results of each instances called.
parameters{Object, Optional} Specifies the input parameters of the script. The name/value of the
object attribute corresponds to the name/value of the input parameter of the called script. 

 
Example:

var result = call("AGENT.OBJECTS.add.Script",{x:1,y:2});

execute

result execute(script, parameters, settings)

Executes asynchronously another script. The result is the number of script instances scheduled for
execution.
 

nodeId{UaNodeId, Mandatory} Specifies the UaNodeID of the script to execute. If several script
instances belong to the given scripts than all instances will be executed.
parameters{Object, Optional, Default={} } Specifies the input parameters of the script. The name/
value of the object attribute corresponds to the name/value of the input parameter of the called
script.
settings{Object, Optional, Default={} } Specifies the execution control. The following attributes may
be defined:
o delay {Double, Optional, Default=0.0} Specifies the delay of execution in seconds.

o priority {Integer, Optional, Default=5} Specifies the priority of execution: 1 (lowest

priority) ...10(highest priority).

Example:

var result = execute("AGENT.OBJECTS.add.Script", {x:1,y:2}, {delay:1.5,
priority:8});

console

console.log(object[, object, ...])
console.info(object[, object, ...])
console.debug(object[, object, ...])
console.warn(object[, object, ...])
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console.error(object[, object, ...])

Prints the given objects into the atvise log file with the appropriate log level. The functions will convert
the given object(s) into a concatenated string. No extra white space added. The atvise log levels for
these functions are defined as follows:

log() – INFORMATION
info()– INFORMATION
debug() – DEBUG
warn() – WARNING
error() - ERROR

 
Example:
 

console.debug("Debug message:", x);
console.log("log messages:", y);
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server object
server.database

server.database is a predefined object with following properties:

directory{String} Contains the current project directory including the trailing directory separator.
name{String} Contains the name of the current project database.

The directory with historical data can be determined with history.directory .

server.database.backup

server.database.backup(options)

Starts the live backup of the nodes.db of the currently running project, but doesn't wait until the
backup is finished.

The backup functions of SQLite (sqlite3_backup_*) are used to perform the backup. The nodes.db
will be copied in multiple iterations, in each iteration multiple database pages will be copied. The
name of the backup file can be specified as an absolute path or relative to the project directory. If no
name is supplied, "nodes_YYYYMMDD_hhmmss.db" in the project directory will be used.

options{Object, Optional}
o filename{String, Optional:Default=""} Specifies the name of the backup file.

o pages{Number, Optional:Default=10000} Specifies the number of database pages that are

copied in one iteration.
o sleep{Number, Optional:Default=40} Specifies the time in milliseconds between two iterations.

o timeout{Number, Optional:Default=300} Specifies the number of seconds, after which the

backup must be completed.

Returns "true" if the backup can be started. The backup may e.g. not be started if a previously
started backup is still in progress.

To monitor the status of the backup, open the following variables in the folder Information-
>ModuleStatistics->DATABASE:

- BackupStatus shows the status of the backup as text.
- BackupProgress shows the progress of the backup in percent.

Example 1, backup with default options:

server.database.backup();

Example 2, Backup with options:

server.database.backup({
  filename: "C:/backups/newbackup.db",
  timeout: 600,
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  sleep: 20
});

server.script.origin

server.script.origin is a string property holding the NodeId of the script code of the currently running
script.

server.shared.directory

server.shared.directory is a predefined object with following properties:

atvise{String} Contains the directory with commonly used files of the atvise installation.
user{String} Contains the directory with the commonly used, user defined files (e.g. own XML files
for the defaultimport ).

Both directories contain the trailing directory separator.

server.statistics

server.statistics is a predefined object with following properties:

changecounters{Array of UaNode objects} Contains all variables for which a ChangeCounter
property is defined. Each element in the array is a UaNode object .

207

333
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UaNode functions
Node manipulation methods

New UaNode

new UaNode(nodeId);

Create a UaNode.

nodeId{UaNodeId, Mandatory} Specifies the UaNodeID of the UaNode. Note .

Example:

var node = new UaNode("AGENT.OBJECTS.a");
var serverNode = new UaNode(2253);

UaNode.exists

boolean UaNode.exists()

Returns true if the UaNode exists in the address space, false otherwise.

Example:

if (!node.exists())
  node.create(...)

UaNode.create

status UaNode.create(obj)

 
Creates a UaNode specified by the UaNodeID. Returns the status of the operation.

obj - input parameter object:

nodeclass{Number, Mandatory} Specifies the node class of the UaNode as one
of the following constants:
o UaNode.NODECLASS_VARIABLE

o UaNode.NODECLASS_VARIABLETYPE

o UaNode.NODECLASS_OBJECT

o UaNode.NODECLASS_OBJECTTYPE

o UaNode.NODECLASS_VIEW 

parent{UaNodeId, Mandatory} Specifies the parent node of the UaNode.
typedefinition{UaNodeId, Mandatory} Specifies the type node of the UaNode.
reference{UaNodeId, Optional:Default=UaNode.HASCOMPONENT} Specifies

529
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the reference type from the parent UaNode.
modellingrule{UaNodeId, Optional:Default=NULL}

o UaNode.MODELLINGRULE_MANDATORY

o UaNode.MODELLINGRULE_MANDATORYSHARED

browsename{String, Optional:Default='string_after_last_dot_of_nodeaddr'}
browsenamens{Number, Optional:Default=1}
displayname{String, Optional:Default='string_after_last_dot_of_nodeaddr'}
displaynamelocale{String, Optional:Default='en'}
description{String, Optional:Default='string_after_last_dot_of_nodeaddr'}

If nodeclass is UaNode.NODECLASS_VARIABLE or
UaNode.NODECLASS_VARIABLETYPE then

the following additional attributes are defined:

datatype{UaNodeId, Mandatory} Specifies the data type of the UaNode variable.
Common values are:
o UaNode.BOOLEAN

o UaNode.INT16

o UaNode.UINT16

o UaNode.INT32

o UaNode.UINT32

o UaNode.FLOAT

o UaNode.DOUBLE

o UaNode.STRING

o UaNode.DATETIME

valuerank{Number, Optional:Default=UaNode.VALUERANK_SCALAR}
o UaNode.VALUERANK_SCALARORONEDIMENSION

o UaNode.VALUERANK_SCALARORANYDIMENSIONS

o UaNode.VALUERANK_SCALAR

o UaNode.VALUERANK_ANYDIMENSIONS

o UaNode.VALUERANK_ONEDIMENSION

o >1 Specifies the dimension of the array

value{Value, Mandatory}

Example:
 

var status = node.create({
             nodeclass:UaNode.NODECLASS_VARIABLE,

           parent:"AGENT.OBJECTS",
           typedefinition:UaNode.BASEVARIABLETYPE,
           reference:UaNode.HASCOMPONENT,

             datatype:UaNode.INT32,
             valuerank:UaNode.VALUERANK_SCALAR,
             value:1});

var status = folder.create({
             nodeclass: UaNode.NODECLASS_OBJECT,
             parent:"AGENT.OBJECTS",
             typedefinition: UaNode.FOLDERTYPE});
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UaNode.remove

status UaNode.remove()

Removes the UaNode. Returns the status of the operation.

Example:

var status = node.remove();

 
UaNode.browse

 

result UaNode.browse(obj)

Browse the UaNode specified by the input object.

obj - input parameter object:

direction{Number, Optional:Default=UaNode.BROWSEDIRECTION_FORWARD}
o UaNode.BROWSEDIRECTION_FORWARD

o UaNode.BROWSEDIRECTION_INVERSE

o UaNode.BROWSEDIRECTION_BOTH

reference{UaNodeId, Optional:Default=UaNode.HIERARCHICALREFERENCES}
o UaNode.NONHIERARCHICALREFERENCES

o UaNode.HIERARCHICALREFERENCES

o UaNode.HASCHILD

o UaNode.ORGANIZES

o UaNode.HASEVENTSOURCE

o UaNode.HASTYPEDEFINITION

o UaNode.HASEVENTHISTORY

o UaNode.AGGREGATES

o UaNode.HASSUBTYPE

o UaNode.HASPROPERTY

o UaNode.HASCOMPONENT

o UaNode.HASNOTIFIER

o UaNode.HASCONDITION

subtype{Boolean, Optional:Default=True} Specifies if subtypes of the reference
type are included in browse.
nodeclass{Number, Optional:Default=UaNode.NODECLASS_UNSPECIFIED}
o UaNode.NODECLASS_UNSPECIFIED

o UaNode.NODECLASS_OBJECT

o UaNode.NODECLASS_VARIABLE

o UaNode.NODECLASS_METHOD

o UaNode.NODECLASS_OBJECTTYPE

o UaNode.NODECLASS_VARIABLETYPE

o UaNode.NODECLASS_REFERENCETYPE

o UaNode.NODECLASS_DATATYPE

o UaNode.NODECLASS_VIEW
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maxresult{Number, Optional:Default=0} Specifies the maximum number of the
results to return.  If recursive is TRUE then it is set to 0. 0 means no limit.
typedefinition{UaNodeId, Optional:Default=Null}  If not Null then return only
nodes of the specified types.
recursive{Boolean, Optional:Default=False}  Used in conjunction
with typedefinition and nodeclass. If TRUE then all reachable nodes will be
searched otherwise only direct referenced nodes.
exclude:{UaNodeId[], Optional:Default=[]}   If recursive is True then do not
browse on branch of Objects and Variables with the specified types.

result - return object:

if recursive == false, then ARRAY_OF
o node{UaNode}

o reference{UaNode}

o isforward{Boolean}

if recursive == true, then ARRAY_OF
o node{UaNode}

o parent[UaNode}

o reference{UaNode}

o isforward{Boolean}

Example:
 

var result = nodeobj.browse({
           direction:UaNode.BROWSEDIRECTION_FORWARD,
           reference:UaNode.HIERARCHICALREFERENCES,
           subtype:true,
           nodeclass:UaNode.NODECLASS_UNSPECIFIED,
           maxresult:0});
for ( var i = 0; i< result.length; ++i)
     console.log(result[i]["reference"]
["browsename"],",",result[i]["isforward"],":",
     result[i]["node"]["nodeid"]);

UaNode.addreference

status UaNode.addreference(referenceTypeID,  targetNodeID)

Adds a reference to a UaNode. Returns the status of the operation.
referenceTypeId{UaNodeId, Mandatory} Specifies the reference to add by its
UaNodeID.  Note .
targetNodeId{UaNodeId, Mandatory} Specifies the target node by its UaNodeID. Note

.

Example:

var nodeobj = new UaNode("AGENT.OBJECTS");
var node = new UaNode("AGENT.OBJECTS.condition");
var status = nodeobj.addreference(UaNode.HASCONDITION, node);
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UaNode.deletereference

status UaNode.deletereference(referenceTypeId, targetNodeId)

Deletes a reference to an UaNode. Returns the status of the operation.
referenceTypeId{UaNodeId, Mandatory} Specifies the reference to be deleted by its
UaNodeID.  Note .
targetNodeId{UaNodeId, Mandatory} Specifies the target node by its UaNodeID. Note

.

UaNode.assign

status UaNode.assign(obj)

Assigns value/status/sourcetime properties to UaNode specified by the UaNodeID. The
UaNode must be of the nodeclass UaNode.NODECLASS_VARIABLE. Returns the
status of the operation.
 
obj - input parameter object:

value{Any, Optional:Default=current_value } Specifies the value to assign to the
UaNode.
status{Number, Optional:Default=current_status} Specifies the status to assign to
the UaNode.
sourcetime{Date, Optional:Default=now} Specifies the sourcetime to assign to
the UaNode.

If the return value is Good (0) then the properties of the UaNode (defined by the input
parameters) are set and the servertime property of the UaNode is set to the current time.
If the input parameter object is empty or undefined then the sourcetimestamp will remain
unchanged, only the servertime will be set.

Example:

var status = node.assign({value:node.value+1,
status:UaNode.BADNOMATCH, sourcetime:new Date});
node.assign({value:node.value+1, status:0, sourcetime:new
Date(2013, 08, 20, 13)});
node.assign();

History access

UaNode.datahistory

result UaNode.datahistory(obj)

529
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This function reads the data history at certain timestamps (ReadAt) or for a certain
interval. The data in the interval can be raw data (ReadRaw) or aggregated values
(ReadProcessed).
obj specifies the query. It is either an array (ReadAt), or an object (ReadRaw,
ReadProcessed).

obj - input parameter object
case ReadAt:
o  [t1, t2, ...] Specifies the timestamps to query

case ReadRaw:
o starttime{Date, Mandatory}

o endtime{Date, Mandatory}

o numvalues{Number,.Optional:Default=0}

o returnbounds{Boolean, Optional:Default=false}       

case ReadProcessed:
o starttime{Date, Mandatory}

o endtime{Date, Mandatory}

o aggregate|aggregates Either "aggregate" or "aggregates" must be defined,

but not both. Specifies the aggregate function(s).
aggregate{UaNodeId, Mandatory}
aggregates{UaNodeIdArray, Mandatory}
For a list of supported aggregate functions, see here .. An aggregate
function can be specified in the format
UaNode.AGGREGATEFUNCTION_NAME, where NAME must be replaced
with the respective aggregate function in uppercase letters. e.g:
UaNode.AGGREGATEFUNCTION_AVERAGE.

Note: Please note that these queries only return pre-aggregated
data (see Aggregating data ).

o samplinginterval{Number, Mandatory} Specifies the interval of the

aggregate function(s) in milliseconds.
            

The return value is an object:
result - return object
o status: StatusCode

o values: ARRAY_OF

status: StatusCode
servertime: Date
sourcetime: Date
value: Value

If multiple aggregate functions are queried, the return value is an array of objects
above.

Example:

var t1 = new Date(2011, 05, 12, 13, 0, 0);
var t2 = new Date(2011, 05, 12, 13, 30, 0);   
var resultAt = node.datahistory([t1, t2]);
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console.log(resultAt);
var resultRaw = node.datahistory({starttime:t1,
endtime:t2});
console.log(resultRaw);

var resultMinuteAvg= node.datahistory({starttime:t1,
endtime:t2, aggregate: UaNode.AGGREGATEFUNCTION_AVERAGE,
samplinginterval:60000});
console.log(resultMinuteAvg);

var resultMinMax= node.datahistory({starttime:t1,
endtime:t2, aggregates:
[UaNode.AGGREGATEFUNCTION_MINIMUM,
UaNode.AGGREGATEFUNCTION_MAXIMUM],samplinginterval:60000
});
console.log(resultMinMax);

Calling OPC UA methods

UaNode.call

result UaNode.call(object, input)

This functions allows to call any OPC UA method of the atvise server. The UaNode itself
must be the method, the object to act upon and the input arguments are passed to
UaNode.call.

object{NodeId, Mandatory} The NodeId of the object to pass to the OPC UA
method.
input{ArrayOfObjects, Mandatory} The array of input parameters to pass to the
OPC UA method. Each element is an object with following properties:
o type{Number) The data type of the value (UaNode.BOOLEAN,

UaNode.INT32, UaNode.STRING, ...).
o value{AnyType} The value of the variable in the given data type.

            
The return value is an object with following properties:

error{NodeId} The error code, supplied only if the OPC UA method call returned
an error.
argumentError{ArrayOfNumbers} The status codes for each input argument,
supplied only if the OPC UA method call returned an error.
result{ArrayOfValues} The array of output arguments of the OPC UA method.

Example, set the log level of the alarm module to "debug":

var method = new
UaNode("AGENT.OPCUA.METHODS.serverCommand");
var res = method.call({
  object: "AGENT.OPCUA.METHODS",



527Reference manual

© 2018 Certec EDV GmbH

  input: [{type: UaNode.STRING, value: "log d alarm"}]
});
if (res.error)
  console.log("call error: " +
method.statusToString(res.error));
else
  console.log(res.result[0]);

Test/Compare methods

UaNode.good

boolean UaNode.good(statusCode)

statusCode{Number, Optional:Default=this.status} Specifies the status code to test.

Example:

if (node.good()) console.log('good');

UaNode.bad

boolean UaNode.bad(statusCode)

statusCode{Number, Optional:Default=this.status} Specifies the status code to test.

Example:

if (node.bad()) console.log('bad');

UaNode.uncertain

boolean UaNode.uncertain(statusCode)

statusCode{Number, Optional:Default=this.status} Specifies the status code to test.

Example:

if (node.uncertain()) console.log('uncertain'); 

UaNode.equal

boolean UaNode.equal(node1, node2)
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Test equivalence of nodes. The return value is true if node1 and node2 evaluate to the
same UaNodeID, false otherwise.

node1{UaNodeId, Mandatory} Specifies the node to compare as a UaNodeID.  Note
.

node2{UaNodeId, Optional:Default=this.nodeid} Specifies the second node to
compare as a UaNodeID. Note . 

Example:

if (node.equal('AGENT.OBJECTS.a')) console.log('OK');
if (node.equal(node2)) console.log('OK2');   

String conversion methods

UaNode.toString

string UaNode.toString()

Converts the node to a string.

Example:

console.log(node.toString());

UaNode.statusToString

string UaNode.statusToString(statusCode)

statusCode{Number, Optional:Default=this.status} Specifies the status code to
convert.

Example:

console.log(node.statusToString());
console.log(node.statusToString(node2.status));    

UaNode.nodeClassToString

string UaNode.nodeClassToString(nodeClass)

nodeClass{Number, Optional:Default=this.nodeclass} Specifies the node class to
convert.
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Example:

console.log(node.nodeClassToString());  
console.log(node.nodeClassToString(node2.nodeclass));

UaNode object properties

value Actual value of variable node 

status Actual status of variable node  

servertime Server time of variable node. It reflects the timestamp when the server
stored the last known value or status change. 

Note: This time may be different from the server time displayed in
atvise® builder or in other UA clients: they may show the actual
time as the server time if the value was interrogated at the first time
e.g. in a subscription.

sourcetime Source time of variable node. It reflects the timestamp of the last change of
the value or status that was applied to the variable by the data source. 

browsename Name part of the browse name

browsenamens Namespace index of the browse name

displayname Text part of the display name 

displaynamelocale Locale part of the display name

description Text part of the description

descriptionlocale Locale part of the description

nodeclass Node class enum. See UaNode.NODECLASS_### constants

typedefinition NodeID of the type definition

nodeid The node ID of the node in XML-string form. E.g.
ns=1;s='AGENT.OBJECTS.a'

nodeaddr The string part of the nodeID. E.g.: 'AGENT.OBJECTS.a'

datatype The data type of the variable node. E.g.: UaNode.INT32,
UaNode.BOOLEAN, UaNode.STRING, UaNode.DOUBLE,
UaNode.XMLELEMENT, etc.

valuerank The value rank of the variable node. -1=SCALAR, 0=ARRAY, 1--
n=ARRAY_DIMENSION. You can use UaNode.VALUERANKSCALAR,
UaNode.VALUERANKANYDIMENSIONS, etc.

Note: A UaNodeID is an internal identifier of a UaNode. UaNodeID does not exist as a JavaScript
object. Integers are treated as a UaNodeID in namespace 0, strings as a UaNodeID in namespace 1.
A UaNodeID may also be specified in "XML format", including the namespace and the identifier, e.g:
'ns=1;s=AGENT.OBJECTS.MyNode'.
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CSVReader functions
New CSVReader
 

new CSVReader(obj)

 
Creates a new CSVReader object with the specified settings.

 obj - input parameter object:
 

delimiter{String, Optional:Default=’;’} Specifies the delimiter character of the source data.

trim{Boolean, Optional:Default=false} Specifies if data read from source should be trimmed.

encoding{String, Optional:Default=’UTF-8’} Specifies the encoding of the source data:

o ‘UTF-8‘

o ‘ASCII‘

o ‘UTF-16‘

o ‘ISO-8859-1‘

o ‘ISO-8859-15‘

Example:
 

var reader = new CSVReader({delimiter:",", encoding:"ISO-8859-1",
trim:true});

CSVReader.load
 

table CSVReader.load(filename, callback)

 
Load the specified CSV file relative to project path and converts into a table. 
The return value is the table object that is an array containing the rows of the source data.
Each row contains an array containing the column elements of the corresponding row.
If callback object with property onData() is defined, the return value is empty.
There is no distinction between head row and data row.
If a head row is given, it will be the first row in the table: table[0].
 

 filename{String, Mandatory} Specifies the file name of the source data.

callback{Object, Optional:Default=undefined} Specifies the optional event handler properties:

o onError:{Function(msg), Optional:Default=undefined}

If defined, it will be called, if an error occurred.
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msg:{String} The error message.

o onReady:{Function(numRows), Optional:Default=undefined}

If defined, it will be called if all source data are read.

numRows:{Number} The total number of rows read.

o onData:{Function(rowIndex, row), Optional:Default=undefined}

If defined, it will be called on each row read and the return table will remain empty.
Returning CSVReader.STOP will stop processing of source data.
Returning CSVReader.CONTINUE or no return value means continue processing.

rowIndex:{Number} The current zero based row index.

row:{Array} The current row as an array of columns.

Example:
 

var table = new CSVReader({encoding:"ISO-8859-1"}).load("test.csv");
console.log(table);
new CSVReader({encoding:"ISO-8859-1"}).load("test.csv", {

onError:function(msg) {console.log(msg);},
onReady:function(num) {console.log("Total rows read: ", num);},
onData:function(rowIdx, row) {console.log("Header (first) row: ",

row); return CSVReader.STOP;}
});

CSVReader.parse
 

table CSVReader.parse(source, callback)

 
Parse the specified CSV string and converts into a table. 
The return value is the table object that is an array containing the rows of the source data.
Each row contains an array containing the column elements of the corresponding row.
If callback object with property onData() is defined, the return value is empty.
There is no distinction between head row and data row. 
If a head row is given, it will be the first row in the table: table[0].
 

 source{String, Mandatory} Specifies the source string to parse.

callback{Object, Optional:Default=undefined} Specifies the optional event handler properties:

o onError:{Function(msg), Optional:Default=undefined}

If defined, it will be called, if an error occurred.

msg:{String} The error message.

o onReady:{Function(numRows), Optional:Default=undefined}

If defined, it will be called if all source data are read.
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numRows:{Number} The total number of rows read.

o onData:{Function(rowIndex, row), Optional:Default=undefined}

If defined, it will be called on each row read and the return table will remain empty.
Returning CSVReader.STOP will stop processing of source data.
Returning CSVReader.CONTINUE or no return value means continue processing.

rowIndex:{Number} The current zero based row index.

row:{Array} The current row as an array of columns.

Example:
 

var source = '"h1,h1", h2, h3, "\xe4\xf6\xfch4\nh4"\n\n1,2,3,4\n1,,3,
\n1,,,4\n,,,4\n1,,,\n,,,\n"",",","",""';
var table = new CSVReader({encoding:"ISO-8859-1"}).parse(source);
console.log(table);
new CSVReader({encoding:"ISO-8859-1"}).parse(source, {

onError:function(msg) {console.log(msg);},
onReady:function(num) {console.log("Total rows read: ", num);},
onData:function(rowIdx, row) {console.log(rowIdx, ": ", row);

return CSVReader.CONTINUE;}
});

CSVReader object properties
 

delimiter {String} The column delimiter character of the CSV source data.

encoding {String} The encoding of the CSV source data. Possible Values are: UTF-8, ASCII,
Windows-1252, UTF-16, ISO-8859-1, ISO-8859-15

trim {Boolean} If true leading and trailing whitespaces will be removed from the read column
data.

Constants
CONTINUE

STOP
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FileSystem functions
Introduction

The FileSystem functions allow a server-side script to access files and directories.

Some functions allow the usage of GLOB patterns (support the wildcards "*" and "?"). Multiple files
and directories that match the pattern can thus be passed to a function at once. If a function
supports wildcards is noted at each function below.

All functions support relative and absolute paths. A relative path always refers to the current
project directory.

If a function returns a size, it is always a float point value with the unit KiloByte (KB).

listDirectory and directorySize can notify errors only as JavaScript exceptions, all other functions
return false or -1 in case of an error. What a function returns exactly is noted at each function below.

However, every function may throw a JavaScript exception. This exception must be caught in the
script code with try-catch (see examples), or the execution of the script will be terminated. A
possible cause for such an exception may be a missing access permission for a file or directory.

Attention! Check all parameters passed to the FileSystem functions carefully to
prevent unintentional removal or movement of files you still need or are part of the
operating system!

General functions

New FileSystem object

new FileSystem()

Creates a new FileSystem object.

var fs = new FileSystem();

FileSystem.capacity, FileSystem.freeSpace

FileSystem.capacity(path)
FileSystem.freeSpace(path)

Returns the total (capacity) resp. free (freeSpace) space of a drive in KB.

path{String, Mandatory} The path to return the space for.

An arbitrary path can be passed to the function.
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Example 1, total space of drive "C:" (trailing colon is necessary!):

var capacity = fs.capacity("C:");

Example 2, free space of the drive where the archives are stored:

var free = fs.freeSpace(history.directory);

FileSystem.copy

FileSystem.copy(source, destination, options)

Copies files and/or directories from one place to another.

source{String, Mandatory} Files/directories to copy. Wildcards are allowed.
destination{String, Mandatory} Destination of the copy action. If a single file is copied, destination
can also be a file. In all other cases, destination must be a directory. Intermediate directories will
be created automatically.
options{Object, Optional:Default=undefined} Object with options.
o overwrite{Boolean, Optional:Default=false} If true, files already existing at the destination will be

overwritten.

Returns true, if all files/directories were copied or false, if an error occurred (e.g. overwrite is false and
a file was already existing at the destination).

Example, copy all log files from the project directory to "C:/temp", overwriting existing files:

fs.copy("*.log", "C:/temp", {overwrite: true});

FileSystem.move

FileSystem.move(source, destination, options)

Moves files and/or directories from one place to another.

source{String, Mandatory} Files/directories to move. Wildcards are allowed.
destination{String, Mandatory} Destination of the movement. If a single file is moved, destination
can also be a file. In all other cases, destination must be a directory. Intermediate directories will
be created automatically.
options{Object, Optional:Default=undefined} Object with options.
o overwrite{Boolean, Optional:Default=false} If true, files already existing at the destination will be

overwritten.

The function can also be used to rename files/directories.

Returns true, if all files/directories were moved or false, if an error occurred (e.g. overwrite is false and
a file was already existing at the destination).
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Example, move a file into a directory (both in the project directory). The directory "mydata" and its
sub-directory "backup" will be created automatically, if they do not already exist:

fs.move("file.txt", "mydata/backup/");

Functions for files only

FileSystem.createFile

FileSystem.createFile(file, options)

Creates a new, empty file.

file{String, Mandatory} The name of the file to create. Intermediate directories will be created
automatically
options{Object, Optional:Default=undefined} Object with options.
o overwrite{Boolean, Optional:Default=false} If true, the file will be overwritten if it already exists.

Returns true, if the file could be created or false, if an error occurred (e.g. overwrite is false and the
file was already existing).

Example:

fs.createFile("mydata/file.txt");

FileSystem.deleteFile

FileSystem.deleteFile(file)

Deletes a file.

file{String, Mandatory} The file to delete. Wildcards are allowed.

Returns true, if the file could be deleted or false, if an error occurred (e.g. the file didn't exist).

Example, catch JavaScript Exception with "catch" and write the exception text into the log file:

try {
  fs.deleteFile(fileWithoutAccess);
}
catch (errMsg) {
  console.log("Error deleting a file: " + errMsg);
}

FileSystem.isFile
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FileSystem.isFile(file)

Checks if the given name is a regular file.

file{String, Mandatory} The name to check.

Returns true, if it is an existing regular file, otherwise false.

Example:

fs.isFile("nodes.db"); // returns true
fs.isFile("database"); // returns false

FileSystem.fileSize

FileSystem.fileSize(file)

Returns the size of a file in KB.

file{String, Mandatory} The name of the file.

Returns -1, if the size could not be determined (e.g. file doesn't exist or is not a regular file).

Example:

var size = fs.fileSize("nodes.db");

Functions for directories only

FileSystem.createDirectory

FileSystem.createDirectory(directory)

Creates a new directory.

directory{String, Mandatory} The name of the directory to create. Intermediate directories will be
created automatically.

Returns true, if the directory could be created or false, if an error occurred (e.g. the directory was
already existing).

FileSystem.deleteDirectory

FileSystem.deleteDirectory(directory)
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Deletes a directory recursively.

directory{String, Mandatory} The name of the directory to delete. Wildcards are allowed.

Returns true, if the directory could be deleted or false, if an error occurred (e.g. the directory didn't
exist).

FileSystem.isDirectory

FileSystem.isDirectory(directory)

Checks if the given name is a directory.

directory{String, Mandatory} The name to check.

Returns true, if it is an existing directory, otherwise false.

Beispiel:

fs.isDirectory("nodes.db"); // returns false
fs.isDirectory("database"); // returns true

FileSystem.listDirectory

FileSystem.listDirectory(directory, options)

Lists the content of a directory.

directory{String, Mandatory} The directory, whose content should be listed.
options{Object, Optional:Default=undefined} Object with options.
o recursive{Boolean, Optional:Default=false} If true, sub-directories will be search and listed

recursively, otherwise only the given directory will be listed.

Returns an array of objects, where each object contains following properties:

isFile{Boolean} true, if the entry is a file, false, if it is a directory.
name{String} Name of the file or directory.
path{String} Absolute file-/directory name of the entry, directories include the trailing directory
separator.

Example:

// project directory is C:/proj
var options = {recursive: true};
var ret = fs.listDirectory("mydata", options);
/*
[
  {
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    isFile: false,
    name: "backup",
    path: "C:/proj/mydata/backup/"
  },
  {
    isFile: true,
    name: "file.txt",
    path: "C:/proj/mydata/backup/file.txt"
  }
]
*/

FileSystem.directorySize

FileSystem.directorySize(directory, options)

Provides the size of a directory, whereupon sub-directories are always included.

directory{String, Mandatory} The directory, whose size should be calculated.
options{Object, Optional:Default=undefined} Object with options.
o recursive{Boolean, Optional:Default=false} If true, the size of all sub-directories will be provided

individually, otherwise only the total size of the given directory is provided.

Returns an array of objects, where each object contains following properties:

size{Number} Size of the directory including all sub-directories in KB.
name{String} Name of the directory.
path{String} Absolute directory name of the entry including the trailing directory separator.
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InputFileStream functions
New InputFileStream

New InputFileStream(filename,format )

Creates and opens the specified input file stream. Streams can be opened either in BINARY or UTF8
formats. The name of the file can be specified as an absolute path or relative to the project directory

filename{String, Mandatory} Specifies the name of the file to be opened.
format{String, Mandatory} Specifies the format of the file to be opened: 'utf8' or 'binary'

Returns the stream object created or 0 on error.

var ifs = new InputFileStream('TestUtf8.txt','utf8');

InputFileStream.open

InputFileStream.open( );

Opens the input file.

Example:

ifs.open();

InputFileStream.close

InputFileStream.close( )

Closes the input file

Example:

ifs.close();

InputFileStream.read

string InputFileStream.read(size);

Read the given number of characters from the opened stream into a string. Reading a BINARY
stream will convert each byte into a 16-bit CharCode of JavaScript string. Only plane 0, BMP is
supported. In this case, elements in JavaScript can be accessed by .charCodeAt(index). Reading
UTF8 streams assumes Utf-8 encoded 16-bit long unicode codes. Only plane 0, BMP is supported.
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size{Number, Mandatory} Specifies the maximum number of characters to read. 0 means the
whole content.

Returns the characters read converted into a JavaScript string. If no data can be read, the length of
the JavaScript string is 0.

Example, reading and processing blocks of data from a stream:

for(;;)
{
  var data = ifs.read(1024);
  if (data.length > 0)
    process(data);
  if (ifs.eof)
    break; // reached end of file
}

 InputFileStream.readLine

string InputFileStream.readLine( );

Read the next line from the opened stream into a string. Reading a BINARY stream will convert each
byte into a 16-bit CharCode of JavaScript string. Only plane 0, BMP is supported. In this case,
elements in JavaScript can be accessed by .charCodeAt(index). Reading UTF8 streams assumes
Utf-8 encoded 16-bit long unicode codes. Only plane 0, BMP is supported. The CR/LF is not
included in the string. The default is to treat <CR/LF> as a line separator. If only CR or LF is given,
treat CR or LF as a line separator. If the string is empty, either an empty line read or eof reached.
This can be interrogated by the corresponding attribute.
Returns the line read converted into a JavaScript string.

Example:

var line = ifs.readLine();

InputFileStream object properties

name Current filename.

format Current fileformat

utf8
binary

mode Not used

opened File status:

true - if the file is opened
false - if it's closed
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good File status:

true - the stream is intact
false - no more operations available

bad File status:

true - no more operations available
false - the stream is intact

eof File status:

true - end of file reached
false - not at the end of file
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OutputFileStream functions
New OutputFileStream

new OutputFileStream(filename, format, mode);

Creates and opens the specified output file stream. Streams can be opened either in BINARY or
UTF8 formats. The name of the file can be specified as an absolute path or relative to the project
directory

filename{String, Mandatory} Specifies the name of the file to be opened.
format{String, Mandatory} Specifies the format of the file to be opened: 'utf8' or 'binary'
mode{String, Optional:Default='output'} Specifies the output mode of the file: 'output' or 'append'

Returns the stream object created or 0 on error.

var ofs = new OutputFileStream('TestUtf8.txt','utf8','append');

OutputFileStream.open

OutputFileStream.open( );

Opens the output file.

Example:

ofs.open();

OutputFileStream.close

OutputFileStream.close( );

Closes the output file.

Example:

ofs.close();

OutputFileStream.write

integer OutputFileStream.write(content);

Writing a BINARY stream will convert each CharCode of a JavaScript string into a byte. The
CharCode must be in the range of 0-255. Writing UTF8 streams will save the Utf-8 value of the
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JavaScript String.

content{String, Mandatory} Specifies the content string to write to the stream.

Returns the number of characters written to the stream.

Example:

ofs.write('Hello');

 OutputFileStream.writeLine

integer OutputFileStream.writeLine(line);

Writes the given string into the opened stream and appends a newline. Writing a BINARY stream will
convert each CharCode of a JavaScript string into a byte. The CharCode must be in the range of 0-
255. Writing UTF8 streams will save the Utf-8 value of the JavaScript string. The platform dependent
NEWLINE will be inserted into the stream after writing the string.

line{String, Mandatory} Specifies the line without the ending newline to write to the stream.

Returns the number of characters written to the stream.

Example:

ofs.writeLine('This is a new line äüö');

OutputFileStream properties

name Current filename.

format Current fileformat

utf8
binary

mode Current mode

output (default)
append

opened File status:

true - if the file is opened
false - if it's closed

good File status:

true - the stream is intact
false - no more operations available
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bad File status:

true - no more operations available
false - the stream is intact

eof File status:

true - end of file reached
false - not at the end of file
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XMLDoc functions
New XMLDoc

new XMLDoc(data, type);

Creates a new XMLDoc object from the specified string or file relative to project path.

data{String,Mandatory} Specifies the XML string or file to load and parse.
type{String, Optional:Default="string"} Specifies the type of the first parameter. Available values
are:
o "string" The first parameter contains the XML data as string.

o "file" The XML data will be read from the file specified by the first parameter.

Example:

var x = new XMLDoc("testfile.xml", "file");
var x2 = new XMLDoc("c:/test/testfile.xml", "file");
var x3 = new XMLDoc("<root><data/></root>", "string");

XMLDoc object properties

root {XMLNode} The root node of the XML document.

version {String} The version string in the XML document.

encoding {String} The encoding of the XML document.

standalone {Bool} The standalone attribute of the XML document.

constants
(according
to libxml2)

ELEMENT_NODE
ATTRIBUTE_NODE
TEXT_NODE
CDATA_SECTION_NODE
ENTITY_REF_NODE
ENTITY_NODE
PI_NODE
COMMENT_NODE
DOCUMENT_NODE
DOCUMENT_TYPE_NODE
DOCUMENT_FRAG_NODE
NOTATION_NODE
HTML_DOCUMENT_NODE
DTD_NODE
ELEMENT_DECL
ATTRIBUTE_DECL
ENTITY_DECL
NAMESPACE_DECL
XINCLUDE_START
XINCLUDE_END
DOCB_DOCUMENT_NODE
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XML navigation and query

string XMLNode.attribute(name, namespace);

Returns the current node's attribute.

name{String, Mandatory} Specifies the name of the attribute to query.
namespace{String, Optional:Default=""} Specifies the namespace of the attribute.

Example:

console.log(x.root.first("script").attribute("type"));

XMLNode.first, XMLNode.last

result XMLNode.first(nameOrType, namespace);  result XMLNode.last(nameOrType, namespace);

Returns the first/last child node of the current node or null no such node exists.

nameOrType{String/Number, Optional:Default=""} Specifies the name(String) or type(Number) of
the child to search for. Ignored if empty(String) or 0(Number).  For type the XMLDoc constants can
be used e.g: XMLDoc.ELEMENT_NODE .
namespace{String, Optional:Default=""} Specifies the namespace of the child node to search for.
The namespace will be taken into account if the first parameter is a name. 
result{XMLNode or null}

Example:

var doc = new XMLDoc("testfile.xml", "file");
var x = doc.root;
for (x = x.first(); x; x = x.next())
  console.log(x.name);

XMLNode.next, XMLNode.previous

result XMLNode.next(nameOrType, namespace);  result XMLNode.previous(nameOrType,
namespace);

Returns the next/previous sibling node of the current node or null if no such node exists.

nameOrType{String/Number, Optional:Default=""} Specifies the name(String) or type(Number) of
the sibling to search for. Ignored if empty(String) or 0(Number).  For type the XMLDoc constants
can be used e.g: XMLDoc.ELEMENT_NODE .
namespace{String, Optional:Default=""} Specifies the namespace of the sibling node to search
for. The namespace will be taken into account if the first parameter is a name.
result{XMLNode or null}
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Example:

XML File "testfile.xml":

<?xml version="1.0" encoding="UTF-8"?>
<TS>
  <message>
    <source>OK</source>
    <translation>OK</translation>
  </message>
  <message>
    <source>Cancel</source>
    <translation>Abbrechen</translation>
  </message>
</TS>

Script code:

The sample code will output the content of every <translation> node to the server log file.

var doc = new XMLDoc("testfile.xml", "file");
var message = doc.root.first("message");
for (; message; message = message.next("message"))
{
  var trans = message.first("translation");
  console.log(trans.first(XMLDoc.TEXT_NODE).content);
}

The sample code below will output the names of the SVG arguments of the default display to the
server log file.

var atv = "http://webmi.atvise.com/2007/svgext";
var display = new UaNode("AGENT.DISPLAYS.Default");
var xmlDoc = new XMLDoc(display.value);

for (var svg = xmlDoc.root.first("svg"); svg; svg = svg.next("svg")){
    for (var param = svg.first("argument", atv); param; param = param.next("argument", atv)){
       var name = param.attribute("name");
       console.log("argument name=", name);
    }
}

XMLNode object properties

content {String} Content of the node.
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line {Number} Line number of the node in the source text.

name {String} Name of the node.

namespace {String} The name space of the node.

prefix {String} The name space prefix of the node.

parent {XMLNode} Parent of the node.

type {Number} Type of the node. 

Note: The XMLNode Object denotes an internal JavaScript object that can not be
created in server scripts directly. It just denotes the object returned from the
corresponding functions.

Note: The text content of a node can only be read with the child node of type
XMLDoc.TEXT_NODE – like in the example above. If the content is inside a CDATA
section, then the type XMLDoc.CDATA_SECTION_NODE must be used.
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HTTPClient functions
New HTTPClient

new HTTPClient(options)

Creates a new HTTP client.

options{Object, Optional}
o maxredirects{Number, Optional:Default=10} Specifies the maximum number of redirects for

requests.
o agent{String, Optional:Default="atvise-agent/1.0"} Specifies the user agent for requests.

Returns the new HTTP client object.

var http = new HTTPClient();

HTTPClient.request

HTTPClient.request(options)

Sends the given request.

options{Object, Mandatory}
o protocol{String, Optional:Default="http"} Specifies the protocol of the request, "http" or "https".

o hostname{String, Optional:Default="localhost"} Specifies the name of the web server the

request should be sent to. 
o port{Number, Optional} Specifies the port of the web server. If not specified, the default port of

the protocol will be used.
o path{String, Optional:Default="/"} Specifies the path of the resource that is requested from the

web server. 
o method{String, Optional:Default="GET"} Specifies the method of the request. All methods

supported by the web server can be used.
o data{String, Optional:Default=""} Method "POST" only: specifies the data that is sent as the

body of the request.
o headers{Object, Optional:Default={}} Specifies HTTP headers to be sent with the request.

Returns the result of the request.

Example 1, GET request:

var res = http.request({
  protocol: "https",
  hostname: "www.example.com",
  path: "/data.txt"
});

Example 2, POST request to a "webMI method":
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var res = http.request({
  method: "POST",
  path: "/webMI/?MyMethod",
  data: "id[]=1&id[]=2",
  headers: { "Pragma" : "no-cache" }
});

HTTPClient.get

HTTPClient.get(url, options)

Sends the given request. Like the function "request", but allows to specify the URL as string instead
of single properties of the options object.

url{String, Mandatory} Specifies the URL of the request.
options{Object, Optional}
o method{String, Optional:Default="GET"} Specifies the method of the request. All methods

supported by the web server can be used.
o data{String, Optional:Default=""} Method "POST" only: specifies the data that is sent as the

body of the request.
o headers{Object, Optional:Default={}} Specifies HTTP headers to be sent with the request.

Returns the result of the request.

Example:

var res = http.get("https://www.example.com/data.txt");

Properties of the result object

The result of "request" and "get" is an object with following properties:

status HTTP status of the request

url URL of the request

headers HTTP headers of the response

data Content of the response of the web server

error In case of an error: the error text
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SMTPClient functions
New SMTPClient

new SMTPClient(obj)

Creates the specified SMTP client. The SMTP server will be contacted in the send command. The
connection parameters are stored internally until sending.

obj input parameter
server{String, Mandatory} Specifies the name of the SMTP server to be opened.
port{Number, Optional:Default=25} Specifies the port number of the SMTP server to be opened.
security{Number, Optional:Default=SMTPClient.TLS_OFF} Specifies the encryption type of the
connection. Possible values are SMTPClient.TLS_OFF, SMTPClient.TLS_EXPLICIT and
SMTPClient.TLS_IMPLICIT
authentication{Number, Optional:Default=SMTPClient.AUTH_LOGIN} Specifies the
authenthication method. Possible values are SMTPClient.AUTH_NONE,
SMTPClient.AUTH_PLAIN, SMTPClient.AUTH_LOGIN and SMTPClient.AUTH_MD5.
user{String, Optional:Default=""} Specifies the login user of the SMTP server. "" = no
authentication.
password{String, Optional:Default=""} Specifies the login password of the SMTP server.

Returns the SMTPClient object created or null on error.

Description of the encryption types:

SMTPClient.TLS_OFF SMTPClient.TLS_EXPLICIT SMTPClient.TLS_IMPLICIT

SMTPClient communicates
with the server over an
unencrypted channel.
Username and password are
sent unencrypted.

SMTPClient explicitly requests
TLS/SSL encryption to be
switched on by sending
STARTTLS. If the server
supports STARTTLS,
SMTPClient communicates
with the server using an
encrypted channel. Username
and password are sent
encrypted.
Explicit mode usually uses the
same port as plain (unsecure)
mode. Common ports are 25
and 587.

SMTPClient connects to the
server and TLS/SSL encryption
is switched on implicitly as
soon as the channel is
established. SMTPClient
communicates with the server
using an encrypted channel.
Username and password are
sent encrypted.
Implicit mode requires a
dedicated port. This port cannot
be the same port used for plain
(unsecure) mode or for TLS/
SSL explicit mode. Common
port is 465.

Example:

var smtp = new SMTPClient({server:"mail.isp.com", port:"25",
security:SMTPClient.TLS_OFF, authentication:SMTPClient.AUTH_LOGIN,
user:"myname", password:"mypassword"});
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SMTPClient.send

SMTPClient.send(obj)

Send the given email message.

obj input parameter
from{String, Mandatory} Specifies the name of the sender.
to{String, Mandatory} Specifies the name of the recipient(s). Multiple recipients are separated by
';'. 
cc{String, Optional:Default=""} Specifies the carbon copy recipient(s). 
bcc{String, Optional:Default=""} Specifies the blind carbon copy recipient(s). 
subject{String, Optional:Default=""} Specifies the subject of the mail.
body{String, Optional:Default=""} Specifies the message of the mail.
reply_to{String, Optional:Default=""} "Reply-To" field of the mail.
content_type{String, Optional:Default="text/plain"} "Content-Type" of the email.
head{String, Optional:Default=""} Specifies the message header. The Date field will be filled in
automatically and cannot be redefined. The following fields are filled in if the header = "":

Reply To
MIME Version
Content Type

Returns true if sending was successful false otherwise.

Example:

smtp.send({from:"me", to:"you", subject:"hello", body:"hello again!"});
console.log(smtp.diagnostic);

If the SMTP server does not support explicit TLS/SSL, implicit TLS/SSL can be used if it is
supported by the server: E.g:

var smtp = new SMTPClient({server:"smtp.mail.yahoo.com", port:465,
security:SMTPClient.TLS_IMPLICIT, user:"certec.test@yahoo.com",
password:"test", authentication:SMTPClient.AUTH_LOGIN});

SMTP servers supporting explicit TLS/SSL can be used in the following way:

var smtp = new SMTPClient({server:"smtp.live.com", port:587, security:
SMTPClient.TLS_EXPLICIT, user:"certec.test@hotmail.com",
password:"test", authentication:SMTPClient.AUTH_PLAIN});

Whether an SMTP server supports explicit TLS/SSL or not can be checked with
SMTPClient.serverinfo.

smtp.send({from:'"Certec Yahoo" <certec.test@yahoo.com>',
to:"name@url.com", subject:"yahoo mail test", body:"yahoo mail test"});
console.log(smtp.serverinfo);
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SMTPClient.serverinfo will be set in SMTPClient.send(). After calling send(), SMTPClient.serverinfo
can be searched for ‘250-STARTTLS’. If it is found then the server supports explicit TLS/SSL.

SMTPClient object properties

diagnostic SMTP server diagnostic after send()

serverinfo SMTP server information after send()

server SMTP server name

port SMTP port

secure SMTP security mode: TLS_OFF, TLS_EXPLICIT, TLS_IMPLICIT

authentication Specifies the authentication method to talk to the SMTP server

user Specifies the user name to login into the SMTP server

password Specifies the password to login into the SMTP server



554 atvise® - documentation

© 2018 Certec EDV GmbH

TCPClient functions
New TCPClient

new TCPClient(host, port);

Creates a TCP connection. 

host{String, Optional:Default=NULL} Name of server for connection.
port{Number, Optional:Default=0} Port of server for connection.

Returns the TCP client object created or 0 on error.

var t = new TCPClient("www.google.at", 80);

TCPClient.connect

TCPClient.connect(host, port)

Connect the TCPClient to the server

host{String, Optional:Default=this.host} Name of the server for connection.
port{Number, Optional:Default=this.port} Port of the server for connection.

Example:

var t = new TCPClient();
t.connect("www.google.at", 80);

TCPClient.close

TCPClient.close( )

Closes the connection

Example:

t.close();

TCPClient.send

TCPClient.send(data)

Send data.



555Reference manual

© 2018 Certec EDV GmbH

data{String, Mandatory} Send the given data to the TCP socket.

Example:

t.send("HELLO");

TCPClient.receive

string TCPClient.receive(length)

Receive data.

length{Number, Mandatory} Specifies the maximum number of characters to receive. The function
will return if the receive buffer is not empty, otherwise it blocks until something arrives.

The return value is the received string. The received data is assumed to be UTF-8 encoded.

Example:

var buff = t.receive(1024);
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ODBCClient functions
new ODBCClient

new ODBCClient(connectionString);

Create an ODBCClient.

connectionString{String, Optional:Default=NULL} Specifies the connection string to the ODBC

Server.

ODBCClient.open

Boolean ODBCClient.open();

Opens a connection to the specified OBDC server. The connectionString specifies the ODBC server.

The return value is true if the ODBC server successfully connected. In case of an error an exception

is thrown.

If the connectionString uses a DSN that is not configured correctly the ODBC Server
may block the atvise server.

ODBCClient.close

Boolean ODBCClient.close();

Closes the connection to the OBDC server. The return value is true if the connection successfully

closed. In case of an error an exception is thrown.

ODBCClient.query

array ODBCClient.query (queryString, callback)

Executes the SQL query specified by the query string on the connected ODBC server. The return
value is an array containing the rows of the query. Each row contains an array containing the column
elements of the corresponding row. If callback object with property onData() is defined, the return
value is empty. The column description will be delivered to the onHead() callback.

queryString{String, Mandatory} Specifies the SQL query.

callback{Object, Optional:Default=undefined} Specifies the optional event handler properties:

o onError:{Function(msg), Optional:Default=undefined}
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If defined, it will be called, if an error occurred. Otherwise an exception is thrown.

msg:{String} The error message.

o onHead:{Function(columnInfo), Optional:Default=undefined}

If defined, it will be called before fetching any data of the query.

columnInfo:{Array} Array of objects containing info about the columns:

digits:{Number} Number of decimal digits of the column.

label:{String} Column label or title

name:{String} Column name.

size:{Number} Size (in characters) of the column.

table:{String} Name of the base table that contains the column.

type:{Number} SQL data type of the column.

typename:{String} Data source–dependent data type name.

o onData:{Function(rowIndex, row), Optional:Default=undefined}

If defined, it will be called on each row fetched and the return array will remain empty.
Returning ODBCClient.STOP will stop processing of query.
Returning ODBCClient.CONTINUE or no return value means continue processing.

rowIndex:{Number} Current zero based row index.

row:{Array} Current row as an array of columns of fetched data

o onReady:{Function(numRows, msg), Optional:Default=undefined}

If defined, it will be called if all data are fetched.

numRows:{Number} Total number of rows fetched.

Example with callback:

var o = new ODBCClient();
//see http://www.connectionstrings.com/
o.source = "DSN=ODBC Acron7";
if (o.open()) {
var from = "2010-10-21 10:36:34";
var callback = {
onData : function (rowIdx, row){ console.log("OnData: ", rowIdx, " ",
row); },
 onHead : function(columns){ console.log("OnHead: ", columns); },
 onReady : function(num, msg) { console.log("OnReady: ", num, " ",
msg); },
 onError : function(msg) { console.log("OnError: ", msg); }
};
o.query("SELECT Timestamp,NumData,'' AS a1_psum,'' AS a1_pcount FROM
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FastProcess WHERE (Timestamp>={ts '"+from+"'} AND Timestamp<={ts '2012-
11-21 14:38:34'})", callback);
o.close();
}

Example without callback:

var o = new ODBCClient();
//see http://www.connectionstrings.com/
o.source = "DSN=ODBC Acron7";
if (o.open()) {
var from = "2010-10-21 10:36:34";
var result = o.query("SELECT Timestamp,NumData,'' AS a1_psum,'' AS
a1_pcount FROM FastProcess WHERE (Timestamp>={ts '"+from+"'} AND
Timestamp<={ts '2012-11-21 14:38:34'})");
o.close();
}

Example using Excel:

var o = new ODBCClient();
var sources = o.sources();
for (var i in sources) console.log(sources[i]);
// How to use Excel Odbc Driver see http://stackoverflow.com/
questions/15844633/using-excel-as-an-odbc-database
// How to create a DSN for Excel see http://support.microsoft.com/
kb/2721825/EN-US
o.source = 'DSN=Excel32Test';
if (o.open()){
  console.log("Opened:", o.info());
  var types = o.types();
  for (var t in types) console.log("TYPE:",types[t]);
  var tables = o.tables();
  for (var t in tables) {
    console.log("TABLE:",tables[t]);
    var columns = o.columns(tables[t].name);
    for (var c in columns) console.log("COLUMN:", columns[c]);
  }
  var result = o.query("SELECT * FROM [Table1$]");
  console.log("RESULT:", result);
  o.close();
}

ODBCClient.info

result ODBCClient.info()

Returns general info about the connected data source.

result – return object:
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dbmsname{String}: The name of the DBMS product accessed by the driver.
dbmsversion{String}: The version of the DBMS product accessed by the driver.
maxconcurrentactivities{Number} Specifies the maximum number of active statements that the
driver can support for a connection.
getdataanyorder{Boolean}: SQLGetData can be called for any unbound column.
getdataanycolumn{Boolean}: SQLGetData can be called for unbound columns in any order.

Example:

var o = new ODBCClient();
o.source = 'DSN=Excel32Test';
if (o.open()){

console.log("Opened:", o.info());

o.close();
}

ODBCClient.sources

array ODBCClient.sources()

Returns the available data sources as an array of objects:

object – return object in the array

name{String}: The data source name.
description{String}: The description of the driver associated with the data source.

Example:

var o = new ODBCClient();
var sources = o.sources();
for (var i in sources) console.log(sources[i]);

ODBCClient.types
array ODBCClient.types()

Returns the available data types of the connected data source as an array of objects:

object – return object in the array

typename{String}: Data source–dependent data-type name.
datatype{Number}: SQL data type.
precision{Number }: Maximum column size or maximum precision.
prefix{ String }: Used to prefix a literal.
suffix{String}: Used to terminate a literal.
create{String }: A list of keywords, separated by commas.
nullable{Number }: Whether the data type accepts a NULL value.
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casesensitive{Number}: Whether a character data type is case-sensitive in comparisons.
searchable{Number }: How the data type is used in a WHERE clause.
unsigned{Number}: Whether the data type is unsigned.
fixedprecscale{Number }: Whether the data type has predefined fixed precision and scale.
autoincrement{Number }: Whether the data type is autoincrementing.
localtype{String }: Localized version of the data source–dependent name of the data type.
minimumscale{Number }: The minimum scale of the data type.
maximumscale{Number}: The maximum scale of the data type.
sqldatatype{Number }: The value of the SQL data type.
sqldatetimesub{Number }: The datetime/interval subcode.
numprecradix{Number }: If data type is an approximate numeric type, this has the value 2.
intervalprecision{Number}: The value of the interval leading precision.

ODBCClient.tables
array ODBCClient.tables()

Returns the available tables of the connected data source as an array of objects:

object – return object in the array

name{String}: Table name.
type{String}: Table type name.
description{String}: Description of the table.
catalog{String}: Catalog name.
schema{String}: Schema name.

Example:

var o = new ODBCClient();
o.source = 'DSN=Excel32Test';
if (o.open()){

var tables = o.tables();

for (var t in tables) console.log(tables[t]);

o.close();
}

ODBCClient.columns

array ODBCClient columns (tablename)

Returns the available columns of the given table of connected data source as an array of objects:

object – return object in the array

catalog{String}: Catalog name.
schema{String}: Schema name.
table{String}: Table name.
column{String}: Column name.
datatype{Number}: SQL data type.
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typename{String}: Data source–dependent data type name.
columnsize{Number}: Maximum length in characters of the column.
bufferlength{Number}: Length in bytes of data transferred on an operation.
digits{Number}: Total number of significant digits to the right of the decimal point.
radix{Number}: For numeric data types, either 10 or 2.
nullable{Number}:
0 if the column could not include NULL values.
1 if the column accepts NULL values.
2 if it is not known whether the column accepts NULL values.
remarks{String}: Description of the column.
default {String}: Default value of the column.
sqldatatype{Number}: SQL data type. Same as datatype, except for datetime and interval.
datetimesubtype{Number}: Subtype code for datetime and interval.
charoctetlength{Number}: Maximum length in bytes of character or binary type column.
ordinalposition{Number}: 1-based ordinal position of the column in the table.
isnullable{Boolean}: true if the column could include NULLs.

ODBCClient object properties

connectionString {String} The ODBC connection string.
See http://www.connectionstrings.com/

source {String} Synonym for connectionString.

Constants
CONTINUE

STOP
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History functions
history.write

status history.write(values, callback, ignoreDuplicate)

Writes the data values to the history archive. The result of the write operation will be delegated to
the function defined in the callback object. Returns the status code of the function call. It is not
the status of the write operation.
If no callback object is defined, the function executes asynchronously. It returns immediately
and does not wait for the result of the write operation. 
If a callback object is defined, the function executes synchronously. Errors and completion of
write operation are reported to the appropriate function of the callback object if they are defined.

values{ArrayOfDataValues, Mandatory} Specifies the values to write to the history archive.
DataValue is an object with the following properties:
o node{NodeId, Mandatory} Specifies the node id of the value to write.

o value{Value, Mandatory} Specifies the value to write.

o status{Number, Optional:Default=0} Specifies the status to write.

o servertime{Date, Optional:Default=now} Specifies the server time to write.

o sourcetime{Date, Optional:Default=servertime} Specifies the source time to write.

callback{Object, Optional:Default=undefined} Specifies the optional event handler properties:
o onError:{Function(dataIdx, status, msg), Optional:Default=undefined}

If defined, it will be called if an error occurred.
dataIdx:{Number} The zero based index of the data of the write operation.
status:{Number} The database specific error code of the write operation.
msg:{String} The error message of the write operation.

o onReady:{Function(dataIdx, status, msg), Optional:Default=undefined}.

If defined, it will be called when write is finished.
dataIdx:{Number} The total number of the data processed in the write operations.
status:{Number} The last database specific error code of the write operations. If all data
was written successful then the status is 0.
msg:{String} The last error message of the write operations.

ignoreDuplicate{Boolean, Optional:Default=false} Specifies behavior when trying to write a
value with already existing source time:
o true - The new value will be ignored.

o false (default) - 100 nanoseconds are repeatedly added to the source time until it is unique.

This can be expensive when history.write() is called with the same values again and again.

Note: Calling history.write() is expensive. It is worth to collect values into an array and
call history.write() with the populated array.

Example of a bad solution:

 var values = [];
…// populate values;
// *** Don’t do that!
for (var i in values) history.write([values[i]]);



563Reference manual

© 2018 Certec EDV GmbH

Example of a good solution:

var values = [];
…// populate values;
history.write(values);

Example of synchronous call:

var n = new UaNode("AGENT.OBJECTS.WriteArchiveTest.x");
history.write([{node:n, value:15, status:0, sourcetime:new Date(2012,11,12,12),
servertime:new Date(2012,11,12,14)}],
{onError:function(dataIdx, status, msg)
{console.log("Error at ", dataIdx, " error:", status, " ", msg);},
onReady:function(dataIdx, status, msg)
{console.log("Ready written ", dataIdx, " data. error:", status, " ", msg);}
});

Example of asynchronous call:

var n = new UaNode("AGENT.OBJECTS.WriteArchiveTest.x");
history.write([{node:n, value:15, status:0, sourcetime:new Date(2012,11,12,12)}]);

history.query

result history.query(filter)

This function reads historical values (incl. aggregates) and alarms respectively event entries. The
parameter "filter" is used to constrain the requested data. The function uses the same filter as 
webMI.data.queryFilter . There you will also find an example filter and the format of the returned
data.
The return value of the function is the requested data.

The function history.query differs from webMI.data.queryFilter as follows:

If an error occurs (e.g. an invalid parameter), history.query throws an exception.
webMI.data.queryFilter returns an error object in the callback.
history.query returns the requested data as return value of the function, webMI.data.queryFilter
passes the data to the given callback.

Example 1: 

Query of all value changes between Nov. 20 2013 11:00 PM and 11:05 PM for variables starting with
"AGENT.OBJECTS.MyData." (0 = January, 1 = February etc.)

var from = new Date(2013, 10, 20, 23, 0, 0).getTime();
var to = from + 5*60*1000; // 5min in milliseconds
var result = history.query({

type: ["v:1"], // data values
timestamp: ["n:>=" + from + "<" + to],

479
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address: ["g:AGENT.OBJECTS.MyData.*"]
});
console.log(result);

Example 2: 

Query of all alarm status changes of the last hour, alarm texts in German

var from = new Date().getTime() - 60*60*1000; // 1h in milliseconds
var result = history.query({

type: ["v:2"], // alarms
timestamp: ["n:>=" + from],
language:  ["v:de"]

});
console.log(result);

Example 3: 

Query of all alarm status changes of the last hour, where the alarm active/inactive text is "my
text".The alarm text filter is applied to the text in the english language

var from = new Date().getTime() - 60*60*1000; // 1h in milliseconds
var result = history.query({
  type: ["v:2"], // alarms
  timestamp: ["n:>=" + from],

eventtext: ["v:my text"] 
language:  ["v:en"]

});
console.log(result);

history.aggregate

status history.aggregate(nodes[], startTime, endTime, callback)

Starts post-aggregation for the given nodes and the given time period. The result of the post-
aggregate operation will be delegated to the function defined in the callback object. Returns the
status code of the function call. It is not the status of the post-aggregate operation.
If no callback object is defined, the function executes asynchronously. It returns immediately and
does not wait for the result of the post-aggregate operation. 
If a callback object is defined, the function executes synchronously. Errors and completion of the
post-aggregation operation are reported to the appropriate function of the callback object if they are
defined.

nodes{ArrayOfNodes, Mandatory} Specifies the nodes for the post-aggregation.
startTime{Date, Mandatory} Specifies the start time of the time period for the post-aggregation.
endTime{Date, Mandatory} Specifies the end time of the time period for the post-aggregation.
callback{Object, Optional:Default=undefined} Specifies the optional event handler properties:
o onError:{Function(dataIdx, status, msg), Optional:Default=undefined}
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If defined, it will be called if an error occurred.
dataIdx:{Number} The zero based index of the data of the post-aggregate operation.
status:{Number} The error code of the post-aggregate operation.
msg:{String} The error message of the post-aggregate operation.

o onReady:{Function(dataIdx, status, msg), Optional:Default=undefined}.

If defined, it will be called when post-aggregate is finished.
dataIdx:{Number} The total number of the data processed in the post-aggregate operations.
status:{Number} The last error code of the post-aggregate operations. If no error occured then
the status is 0.
msg:{String} The last error message of the post-aggregate operations.

For the usage of the callbacks see history.write .

Example: 

var node = new UaNode("AGENT.OBJECTS.floatNode");
var startTime = new Date(2017, 2, 3, 14, 0, 0);
var endTime = new Date(2017, 2, 3, 15, 0, 0);
history.aggregate([node], startTime, endTime);

history.directory

history.directory contains the absolute directory (including the trailing directory separator) with
historical data of the current project. Normally this is the directory "database" inside the project
directory, but it can be set to an arbitrary directory in atserver.ini .

Example: 

console.log(history.directory);
// => "C:/projects/myproject/database/"

history.swapin

history.swapin contains the absolute directory (including the trailing directory separator) with
swapped in historical data of the current project. Normally this is the directory "database/swapin"
inside the project directory, but it can be set to an arbitrary directory in atserver.ini .

Example: 

console.log(history.swapin);
// => "C:/projects/myproject/database/swapin/"
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Archive locking functions
These functions allow to lock as well as unlock archive files and to generate the name of an archive
file by specifying the name of an archive group and a timestamp. Locks ensure that corresponding
files are not used by atvise and can therefor be copied or moved without shutting down the atvise
server before. The functions are wrapper scripts for the respective OPC UA methods and can be
found in the atvise library (Library->ATVISE->Script Library->Methods->ArchiveLocking).

ArchiveName

call("Methods.ArchiveLocking.ArchiveName", options)

Returns the name (path) of the archive file for the given archive group, where values for the given
timestamp can be found (whether or not values for the exact timestamp actually exist). The function
considers the partition interval of the archive group (see Historizing data ). The function returns a
file name only, if the archive file actually exists on the file system.

options{Object, Mandatory}
o archive{String, Mandatory} The name of the archive group.

o timestamp{Date, Mandatory} The desired timestamp.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an object with the result of the call:
archivename: The generated name (path) of the archive file

Example:

var res = call("Methods.ArchiveLocking.ArchiveName", {
  archive: "datavalues",
  timestamp: new Date(2017, 9, 20, 14, 0, 0)
});
if (res.error)
  console.log("ArchiveName error: " + res.errorstring);
else
  console.log(res.result);

Lock

call("Methods.ArchiveLocking.Lock", options)

Locks the given archive file for the given period of time. An archive file can only be locked, if it is not
the currently active archive file of an archive group.

options{Object, Mandatory}

311



567Reference manual

© 2018 Certec EDV GmbH

o archivename{String, Mandatory} Name (path) of the archive file (e.g. determined with the

function ArchiveName).
o timeout{Number, Optional:Default=10} Period of time in seconds the file should be locked. The

file will be unlocked automatically when the timeout expires.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an empty object

Example:

var res = call("Methods.ArchiveLocking.Lock", {
  archivename: "C:/Program Files/atvise/database/datavalues_raw.db",
  timeout: 10
});
if (res.error)
  console.log("Lock error: " + res.errorstring);
else
  console.log("Lock successful");

Unlock

call("Methods.ArchiveLocking.Unlock", options)

Unlocks the given archive file.

options{Object, Mandatory}
o archivename{String, Mandatory} Name (path) of the archive file (e.g. determined with the

function ArchiveName).

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an empty object

Example:

var res = call("Methods.ArchiveLocking.Unlock", {
  archivename: "C:/Program Files/atvise/database/datavalues_raw.db"
});
if (res.error)
  console.log("Unlock error: " + res.errorstring);
else
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  console.log("Unlock successful");



569Reference manual

© 2018 Certec EDV GmbH

XML export and import functions
These functions allow to export nodes to XML and to import nodes from XML into the address space.
The functions are wrapper scripts for the respective OPC UA methods and can be found in the atvise
library (Library->ATVISE->Script Library->Methods).

For more information about XML in atvise see XML export and import  in the atvise builder
documentation.

ExportNodes

call("Methods.ExportNodes", options)

Exports the specified nodes in XML format and returns the XML.

options{Object, Mandatory}
o address{ArrayOfNodes, Mandatory} Specifies the nodes to be exported.

o withouthierarchy{Boolean, Optional:Default=false} If true, only the specified nodes are

exported as a flat list. Otherwise the whole hierarchy of the nodes is exported.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an object with the result of the call:
xmlnodeset: The exported nodes in XML format

Example:

var res = call("Methods.ExportNodes", {
  address: ["AGENT.OBJECTS.instance1", "AGENT.OBJECTS.instance2"],
  withouthierarchy: true
});
if (res.error)
  console.log("XML export error: " + res.errorstring);
else
  console.log(res.result.xmlnodeset);

ExportNodesToFile

call("Methods.ExportNodesToFile", options)

Exports the specified nodes in XML format to a file.

options{Object, Mandatory}
o address{ArrayOfNodes, Mandatory} Specifies the nodes to be exported.

o withouthierarchy{Boolean, Optional:Default=false} If true, only the specified nodes are

233
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exported as a flat list. Otherwise the whole hierarchy of the nodes is exported.
o file{String, Mandatory} The name of the file to write the exported XML to. The name can be

specified with an absolute path or relative to the current project directory. If the file already
exists, it will be overwritten.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an object with the result of the call:
success: indicates success (true) or failure (false) of the export

Example:

var res = call("Methods.ExportNodesToFile", {
  address: ["AGENT.OBJECTS.instance1", "AGENT.OBJECTS.instance2"],
  withouthierarchy: true,
  file: "C:/temp/mynodes.xml"
});
if (res.error)
  console.log("XML export error: " + res.errorstring);
else
  console.log(res.result.success);

ImportNodes

call("Methods.ImportNodes", options)

Imports the nodes from the specified XML.

options{Object, Mandatory}
o address{NodeId, Optional:Default=""} If empty, then the import is absolute, otherwise the import

is relative to the specified node.
o xmlnodeset{String, Mandatory} The XML to import.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an object with the result of the call:
success: indicates success (true) or failure (false) of the import

Example:

var xml = "<?xml version=\"1.0\" encoding=\"UTF-8\" ?><UANodeSet ...";
var res = call("Methods.ImportNodes", {
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  xmlnodeset: xml
});
if (res.error)
  console.log("XML import error: " + res.errorstring);
else
  console.log(res.result.success);

ImportNodesFromFile

call("Methods.ImportNodesFromFile", options)

Imports the nodes from the specified XML file.

options{Object, Mandatory}
o address{NodeId, Optional:Default=""} If empty, then the import is absolute, otherwise the import

is relative to the specified node.
o file{String, Mandatory} The name of the XML file to import. The name can be specified with an

absolute path or relative to the current project directory.

The result is an object with following properties:

error error code; supplied only if an error occurred

errorstring error text; supplied only if an error occurred

result On success an object with the result of the call:
success: indicates success (true) or failure (false) of the import

Example:

var res = call("Methods.ImportNodesFromFile", {
  file: "C:/temp/mynodes.xml"
});
if (res.error)
  console.log("XML import error: " + res.errorstring);
else
  console.log(res.result.success);
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Data Source functions
These functions allow various operations on data sources. Depending on the type of the data source,
not all functions may be available (e.g. you cannot browse a webMI data source). The functions are
wrapper scripts for the respective OPC UA methods and can be found in the atvise library (Library-
>ATVISE->Script Library->Methods->DataSource).

In case of a redundant data source, the function will be called on the active connection.

The format of addresses is specific to the data source. For OPC UA data sources, it is the so called
"XML format" of a NodeId (e.g. "ns=1;s=AGENT.OBJECTS.var1").

Browse

call("Methods.DataSource.Browse", options)

Browses the address space of a data source.

options{Object, Mandatory}
o datasource{String, Mandatory} Specifies the data source to browse.

o address{ArrayOfStrings, Mandatory} Specifies the addresses to browse.

o continuation{ArrayOfStrings, Mandatory} Specifies the continuation points to use (to begin

browsing, use an empty string as continuation point). A data source can use continuation points
to allow the user to call the Browse function repeatedly to retrieve huge result sets.

The result is an object with following properties:

error{Number} The error code, supplied only if an error occurred.
errorstring{String} The error text, supplied only if an error occurred.
continuation{ArrayOfStrings} On success the continuation points for each browsed address
which can be passed to subsequent calls of the Browse function. A null element in the array
means that browsing of the corresponding address is finished.
result{ArrayOfArrayOfObjects} On success a two-dimensional array of objects with the result (see
example for details):
o displayname{String} The display name.

o browsename{String} The browse name.

o address{String} The address.

o datatype{Number} The data type, if applicable. E.g. UaNode.BOOLEAN, UaNode.DOUBLE, ...

o valuerank{Number} The OPC UA value rank, if applicable. E.g.

UaNode.VALUERANK_SCALAR, UaNode.VALUERANK_ONEDIMENSION, ...
o class{Number} The OPC UA node class, if applicable. E.g. UaNode.NODECLASS_VARIABLE,

UaNode.NODECLASS_OBJECT, ...
o type{String} The type definition. E.g. "i=61" for an OPC UA folder.

Example:

var res = call("Methods.DataSource.Browse", {
  datasource: "ds1",
  address: ["Data1", "Data2"],
  continuation: ["", ""]
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});
if (res.error)
  console.log("Browse error: " + res.errorstring);
else
{
  // output the address of the first browsed element of "Data1"
  console.log(res.result[0][0].address);
  // output the array of addresses browsing "Data2"
  console.log(res.result[1]);
}
if (res.continuation[0] || res.continuation[1])
{
  // call Browse again to get more results
  // recurse until all returned continuation points are null
}

Read

call("Methods.DataSource.Read", options)

Reads values of variables from a data source.

options{Object, Mandatory}
o datasource{String, Mandatory} Specifies the data source to read.

o address{ArrayOfStrings, Mandatory} Specifies the variables to read.

The result is an object with following properties:

error{Number} The error code, supplied only if an error occurred.
errorstring{String} The error text, supplied only if an error occurred.
result{ArrayOfObjects} On success an array of objects with the values of the variables.
o status{Number} The status code of the variable.

o value{Object} The value of the variable as an object with the properties:

type{Number) The data type of the value (UaNode.BOOLEAN, UaNode.INT32,
UaNode.STRING, ...).
value{AnyType} The value of the variable in the given data type.

o timestamp{Number} The source time stamp of the variable.

o servertimestamp{Number} The server time stamp of the variable.

Example:

var res = call("Methods.DataSource.Read", {
  datasource: "ds1",
  address: ["Data.var1"]
});
if (res.error)
  console.log("Read error: " + res.errorstring);
else
  console.log(res.result[0].value.value);
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Write

call("Methods.DataSource.Write", options)

Writes values of variables to a data source.

options{Object, Mandatory}
o datasource{String, Mandatory} Specifies the data source to write.

o address{ArrayOfStrings, Mandatory} Specifies the variables to write.

o value{Object, Mandatory} Specifies the values to write, where each value is an object with the

properties:
type{Number, Mandatory) The data type of the value (UaNode.BOOLEAN, UaNode.INT32,
UaNode.STRING, ...).
value{AnyType, Mandatory} The value of the variable in the given data type.

The result is an object with following properties:

error{Number} The error code, supplied only if an error occurred.
errorstring{String} The error text, supplied only if an error occurred.
result{ArrayOfNumbers} On success an array of status codes.

Example:

var res = call("Methods.DataSource.Write", {
  datasource: "ds1",
  address: ["Data.var1"],
  value: [{type: UaNode.INT32, value: 42}]
});
if (res.error)
  console.log("Write error: " + res.errorstring);
else
  console.log(res.result[0]);
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Scheduling rules
The scheduling rules in atvise – e.g. timer/interval triggered scripts – are based either on local time or
standard time. Which one is used, is explicitly stated at the corresponding documentation part.

Local Time Scheduling
The scheduling rules using local time are similar to the rules of crontab: Based on the supplied
parameters a daily list of triggering times will be composed. Since days with daylight saving time
changes do not have 24 hours they have either 23 or 25 hours which leads to duplicated or
nonexistent triggering times:
If a triggering time in the list does not exist on a day then it will be ignored.
If a triggering time in the list exists twice on a day then it will trigger on both times.

Example:
The list of triggering times contains one element – 2:30, time zone is UTC +1.
On 26.10.2013 it triggers at 2:30 (2:30 exists only once)
On 27.10.2013 it triggers at 2:30 (UTC 0:30) and at 2:30 (UTC 1:30) (due to daylight saving time
changes 2:30 exists twice)
On 30.03.2014 it does not trigger at all. (2:30 doesn’t exist)

Standard Time Scheduling
In case of standard time scheduling - as before - based on the supplied parameters a daily list of
triggering times will be composed. However triggering times are not influenced by daylight saving
time changes. This is possible, because the standard time is shifted by one hour if daylight saving
time is switched on. The interval between the daily triggering times is always 24 hours.

Example:
The list of triggering times contains one element – 2:30, time zone is UTC +1.
On 26.10.2013 it triggers at local time 3:30 (standard time 2:30, UTC 1:30)
On 27.10.2013 it triggers at local time 2:30 (standard time 2:30, UTC 1:30)
On 30.03.2014 it triggers at local time 3:30 (standard time 2:30, UTC 1:30)

The mapping between UTC, standard and local time is shown on the next diagram.
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Known issues
We recommend not to use special characters in node names (e.g. displays, alarms, scripts) and
for parameters. In no case the characters "?" (question mark), "." (dot) and "/" (slash) shall be
used.

A manual login is necessary when using NTLM authentication with the browsers Edge, Chrome
(Android) or Safari (iOS). In redundancy mode this means, that the username and password must
be entered up to 4 times. Additionally, for the browser Edge in redundancy mode, each server
address has to be input in the address bar of the browser once.

NTLM authentication can be used in Firefox without restrictions, if the server address is added to
network.automatic-ntlm-auth.trusted-uris in about:config (in redundancy mode all addresses must
be added). e.g. primary.mydomain.com, secondary.mydomain.com.

When using "digest" authentication in redundancy mode with the browsers Chrome (Desktop),
Chrome (Android), Firefox or Safari (iOS), the username and password must be entered up to 4
times. Additionally, for the browsers IE11 and Edge in redundancy mode each server address has
to be input in the address bar of the browser once.

"digest" authentication for Edge connected locally via loopback adapter to the atvise server only
works when you add "/?" to the URL. E.g. instead of "http://localhost" enter "http://localhost/?"
when you start your visualization.

Calculation of aggregate functions other than "Sampled" is currently not officially supported in
redundancy mode.

Reaggregation of chained aggregates is currently limited.

When writing a value with a source time in the past, only the intervals including the value change
will be reaggregated and not all possibly affected intervals.

For operational reasons (offline calculation), interpolating aggregate functions may not fully
conform to the OPC UA specification.

Swap in of archive files can only take place when there is currently no active query of historical
data.

The result of queryFilter is only sorted chronologically and no longer chronologically and then
sorted by NodeId.

If a querylimit is set (see atserver.ini ), the archive files are queried one after the other until the
querylimit is reached. It is therefore possible, that matching data in the remaining archive files is
not returned. In this case we recommend to reduce the time range of the query respectively to
specify the archive group in the query.

Editing a display in the atvise builder can be very slow if the display contains an element (e.g. a
simple text) with a "font-family" SVG attribute not matching an existing font exactly (e.g. "courier"
is used instead of the correct "Courier").

When an event archive in redundancy mode is replicated, the error message "UNIQUE constraint
failed: data.uaeventid" can occur in the log file of the passive server. As there is no negative impact
on the archive, the message can be safely ignored.
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Apple forbids automatic playback of audio sequences without user interaction on its iOS devices.
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Support and further information
Please visit our website at www.atvise.com for additional information on products and support
questions.

http://www.atvise.com/
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